# Contents

## Chapter 1. Introduction  .................................................. 1
- Using the Carlson Software Manual ........................................ 2
- Product Overview .......................................................... 2
- System Requirements ....................................................... 4
- Installing Carlson Software .................................................. 4
- Authorizing Carlson Survey .................................................. 10
- Carlson Registration ......................................................... 12
- Setting Up a Project ......................................................... 13
- Startup Wizard ............................................................. 13
- Command Entry ............................................................ 16
- Layer and Style Defaults .................................................... 16
- What is New .................................................................. 17
- Standard Report Viewer ..................................................... 19
- Report Formatter .............................................................. 21
- Instruction Manual and Program Conventions ............................. 24
- Carlson File Types ............................................................ 24
- Quick Keys .................................................................. 28
- Obtaining Technical Support ................................................ 29

## Chapter 2. Tutorial .......................................................... 31
- Basic Road Design With Volumes .......................................... 32

## Chapter 3. AutoCAD Overview ............................................ 52
- Issuing Commands ............................................................. 53
- General Commands ........................................................... 54
- Selection of Items ............................................................. 55
- Properties and Layers ......................................................... 56
- Properties Toolbar ............................................................. 57
### Chapter 4. File Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>59</td>
</tr>
<tr>
<td>Open</td>
<td>60</td>
</tr>
<tr>
<td>Close</td>
<td>60</td>
</tr>
<tr>
<td>Save</td>
<td>61</td>
</tr>
<tr>
<td>Save As</td>
<td>61</td>
</tr>
<tr>
<td>Page Setup</td>
<td>62</td>
</tr>
<tr>
<td>Plot Preview</td>
<td>62</td>
</tr>
<tr>
<td>Plot</td>
<td>62</td>
</tr>
<tr>
<td>Import Xref to Current Drawing</td>
<td>66</td>
</tr>
<tr>
<td>Xref Manager</td>
<td>67</td>
</tr>
<tr>
<td>Import/Export LandXML Files</td>
<td>69</td>
</tr>
<tr>
<td>Write Polyline File</td>
<td>71</td>
</tr>
<tr>
<td>Draw Polyline File</td>
<td>72</td>
</tr>
<tr>
<td>Clipboard</td>
<td>72</td>
</tr>
<tr>
<td>Drawing Cleanup</td>
<td>73</td>
</tr>
<tr>
<td>Audit</td>
<td>76</td>
</tr>
<tr>
<td>Recover</td>
<td>77</td>
</tr>
<tr>
<td>Remove Reactors</td>
<td>77</td>
</tr>
<tr>
<td>Remove Groups</td>
<td>77</td>
</tr>
<tr>
<td>Purge</td>
<td>78</td>
</tr>
</tbody>
</table>

### Chapter 5. Edit Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>81</td>
</tr>
<tr>
<td>Redo</td>
<td>81</td>
</tr>
<tr>
<td>Erase Select</td>
<td>81</td>
</tr>
<tr>
<td>Erase by Layer</td>
<td>81</td>
</tr>
<tr>
<td>Erase by Closed Polyline</td>
<td>82</td>
</tr>
<tr>
<td>Erase Outside</td>
<td>83</td>
</tr>
<tr>
<td>Move</td>
<td>83</td>
</tr>
<tr>
<td>Standard Copy</td>
<td>84</td>
</tr>
<tr>
<td>Copy To Layer</td>
<td>84</td>
</tr>
<tr>
<td>Copy Polyline Section</td>
<td>85</td>
</tr>
<tr>
<td>Standard Offset</td>
<td>85</td>
</tr>
<tr>
<td>Variable Offset</td>
<td>85</td>
</tr>
<tr>
<td>Standard Explode</td>
<td>86</td>
</tr>
</tbody>
</table>
Block Explode .......................................................... 87
Trim ........................................................................ 87
Extend To Edge .......................................................... 88
Extend to Intersection .................................................. 88
Extend Arc .................................................................. 89
Extend by Distance ...................................................... 89
Break by Crossing Polyline ........................................... 91
Break Polyline at Specified Distances .............................. 92
Break at Intersection ................................................... 93
Break, Select Object, 2nd Point ..................................... 93
Break, Select Object, Two Points .................................. 93
Break, At Selected Point .............................................. 93
Change Properties ...................................................... 94
Change Elevations ....................................................... 94
Change Attribute Style ............................................... 95
Change Style ............................................................. 96
Change Block/Inserts Rotate ......................................... 96
Change Block/Inserts Substitute ..................................... 97
Change Block/Inserts Resize ......................................... 98
Pivot Point Rotate by Bearing ....................................... 98
Rotate by Pick ............................................................ 99
Entity Insertion Point Rotate ........................................ 99
2D Scale ................................................................ 99
Scale ....................................................................... 100
Edit Text ................................................................... 100
Text Enlarge/Reduce .................................................... 100
Rotate Text .................................................................. 101
Change Text Font ........................................................ 101
Change Text Size ........................................................ 102
Change Text Width ....................................................... 102
Change Text Oblique Angle .......................................... 103
Flip Text .................................................................... 103
Split Text into Two Lines .............................................. 103
Text Explode To Polylines ............................................. 104
Replace Text ............................................................... 104
2D Align .................................................................... 105
Chapter 6. View Menu

Redraw .................................................. 134
Regen .................................................. 134
Zoom - Window ....................................... 134
Zoom - Dynamic ....................................... 134
Zoom - Previous ....................................... 134
Zoom - Center ......................................... 135
Zoom - Extents ....................................... 135
Zoom IN ............................................... 135
Zoom OUT ............................................. 135
Zoom Selection ....................................... 136
Zoom Points .......................................... 136
Pan .................................................... 136
3D Viewer Window .................................... 137
Surface 3D Viewer .................................... 140
Surface 3D FlyOver ................................... 140
Viewpoint 3D .......................................... 142
Twist Screen: Standard ................................ 143
Twist Screen: Line Pline or Text ................. 144
Twist Screen: Surveyor .............................. 144
Restore Due North .................................... 145
Display Order .......................................... 145
Layer Control .......................................... 145
Set Layer ............................................... 148
Change Layer .......................................... 148
Freeze Layer .......................................... 149
Thaw Layer ........................................... 149
Isolate Layer .......................................... 149
Restore Layer .......................................... 149
Chapter 7. Draw Menu

Line ........................................................................................................ 152
2D Polyline .......................................................................................... 152
3D Polyline .......................................................................................... 154
Circle ....................................................................................................... 156
3 Point .................................................................................................... 156
PC, PT, Center ...................................................................................... 156
2 Tangents, Radius ................................................................................. 157
PC, Radius, Chord ................................................................................ 157
PC, Radius, Arc Length ........................................................................ 157
2 Tangents, Arc Length ......................................................................... 158
2 Tangents, Chord Length ..................................................................... 158
2 Tangents, Mid-Ordinate ..................................................................... 159
2 Tangents, External .............................................................................. 159
2 Tangents, Tangent Length .................................................................. 160
2 Tangents, Degree of Curve .................................................................. 160
Tangent, PC, Radius, Arc Length ....................................................... 160
Tangent, PC, Radius, Tangent Length ................................................... 161
Tang, PC, Radius, Chord Length ........................................................... 161
Tang, PC, Radius, Delta Angle ............................................................... 162
Compound or Reverse ............................................................................ 162
3-Radius Curve Series .......................................................................... 163
Best Fit Curve ......................................................................................... 164
Curve Calc ................................................................................................ 164
Spiral Curve ............................................................................................ 165
Insert Symbols ........................................................................................ 166
Insert Multi-Point Symbols .................................................................... 168
Hatch ......................................................................................................... 171
Raster Image ............................................................................................ 175
Place Image by World File ..................................................................... 177
Draw By Example .................................................................................... 178
Sequential Numbers ............................................................................... 178
Arrowhead ............................................................................................... 180
Curve - Arrow ........................................................................................ 180
Boundary Polyline ................................................................................ 181
Shrink-Wrap Entities .............................................................................. 182
Polyline by Nearest Found ............................................... 183
Drawing Block ................................................................ 184
Write Block ..................................................................... 186
Insert ............................................................................. 187

Chapter 8.  Inquiry Menu ................................................. 189
List .............................................................................. 190
Point ID ........................................................................ 191
Layer ID ........................................................................ 191
Layer Report ................................................................... 192
Layer Inspector .............................................................. 192
Drawing Inspector .......................................................... 193
List Elevation .................................................................. 194
Bearing & 3D Distance ..................................................... 195
Find Point ........................................................................ 195
Curve Info ....................................................................... 196
Polyline Info ................................................................. 197
Display-Edit File ............................................................ 197
Display Last Report .......................................................... 197
Load Saved Report ........................................................... 197

Chapter 9.  Settings Menu .................................................. 198
Drawing Setup ................................................................. 199
Set Project/Data Folders .................................................. 201
Drawing Explorer ............................................................ 204
Project Explorer ............................................................ 207
Store Project Archive ....................................................... 209
Extract Project Archive .................................................... 210
Preferences ..................................................................... 211
Configure ........................................................................ 220
Mouse Click Settings ....................................................... 231
Toolbars ......................................................................... 232
Edit Symbol Library ........................................................ 232
Title Block ...................................................................... 233
Mortgage Block .............................................................. 236
Rescale Drawing .............................................................. 236
Chapter 10. Points Menu

Point Defaults .................................................. 250
Draw-Locate Points ......................................... 252
List Points ....................................................... 255
Import Text/ASCII File ....................................... 257
Export Text/ASCII File ....................................... 258
Set Coordinate File ........................................... 260
CooRDinate File Utilities .................................... 261
Point Group Manager ....................................... 276
Edit Points ...................................................... 285
Erase Points ..................................................... 286
Freeze Points ................................................... 286
Thaw Points ..................................................... 287
Translate Points ............................................... 287
Rotate Points ................................................... 289
Align Points ..................................................... 291
Scale Points ..................................................... 292
Move Points ..................................................... 294
Edit Point Attributes ........................................ 295
Edit Multiple Pt Attributes ................................. 296
Move Point Attributes Single ............................. 299
Move Point Attributes with Leader ...................... 300
Scale Point Attributes ....................................... 300
Erase Point Attributes ....................................... 301
Twist Point Attributes ....................................... 301
Resize Point Attributes ..................................... 302
Fix Point Attribute Overlaps .............................. 302
Trim by Point Symbol .......................................................................................... 306
Change Point LayerColor .................................................................................. 306
Renumber Points ................................................................................................. 307
Explode Carlson Points ....................................................................................... 308
Convert Surveyor1 to CRD .................................................................................. 309
Convert CRD to TDS CR5/Convert TDS CR5 to CRD ........................................... 309
Convert CRD to Land Desktop MDB .................................................................... 309
Convert Land Desktop MDB to Carlson Points .................................................. 309
Convert Civil 3D to Carlson Points ..................................................................... 310
Convert Carlson Points to Land Desktop ............................................................ 311
Convert Softdesk to Carlson Points ..................................................................... 311
Convert Carlson Points to C&G .......................................................................... 311
Convert C&G to Carlson Points ........................................................................... 312
Convert Carlson Points to Simplicity ................................................................... 312
Convert Simplicity to Carlson Points .................................................................. 313
Convert Leica to Carlson Points ......................................................................... 314
Convert Geodimeter to Carlson Points ............................................................... 314
Convert Carlson Points to Ashtech GIS ............................................................. 314
Convert Carlson Points to Softdesk .................................................................... 314
Convert PacSoft CRD to Carlson CRD ............................................................... 314
Convert Carlson Points to Eagle Point ............................................................... 315
Convert Eagle Point to Carlson Points ............................................................... 315

Chapter 11. Profiles Menu ................................................................................ 317
Profile Defaults .................................................................................................. 318
Quick Profile ...................................................................................................... 319
Profile from Surface Entities .............................................................................. 320
Profile from Grid or Triangulation Surface .......................................................... 322
Profile from 3D Polyline ..................................................................................... 322
Profile from Points on Centerline ....................................................................... 323
Profile from Pipe Polylines ............................................................................... 324
Enter Profile On-Screen .................................................................................... 324
Input-Edit Road Profile ..................................................................................... 326
Design Road Profile .......................................................................................... 331
Design Sewer/Pipe Profile .................................................................................. 333
Input-Edit Profile File ........................................................................................ 342

Contents ix
Chapter 14. Surface Menu

Triangulate & Contour .......................................................... 543
Contour from TIN File ............................................................. 555
Draw Triangular Mesh ............................................................. 556
Contour Elevation Label .......................................................... 558
Move Label Along Contour ...................................................... 560
Volumes By Triangulation ......................................................... 560
Triangulation File Utilities ....................................................... 561
Surface Manager ................................................................. 567
Make 3D Grid File ................................................................. 574
Draw 3D Grid File ................................................................. 578
Two Surface Volumes .............................................................. 580
Volumes By Layer ................................................................. 584
Spot Elevations By Surface Model ........................................... 586
Tag Hard Breakline Polylines .................................................. 588
Untag Hard Breakline Polylines ............................................... 589
Design Pad Template ............................................................. 589
Slope Zone Analysis .............................................................. 598
Profile Defaults ................................................................. 602
Quick Profile ................................................................. 603
Profile from Surface Entities .................................................. 605
Export Topcon Grid or TIN File ........................................... 607
Profile from Points on Centerline ...................................... 610
Input-Edit Profile File .................................................. 611
Draw Profile ................................................................... 613
Profile to 3D Polyline ...................................................... 628
Profile To Points ............................................................. 629
Convert LDD Contours ..................................................... 630
Profile Conversions ......................................................... 631
Introduction
Using the Carlson Software Manual

This manual is designed as a reference guide. It contains a complete description of all commands in the Carlson Software product. The chapters are organized by program menus, and are arranged in the order that the menus appear in Carlson Software.

Product Overview

Carlson Software offers a full suite of commands for downloading, entering, and processing field survey data and for generating final plats and drawings. Carlson Software can function as a total and complete software solution for the land surveying firm, or as an affordable downloading, calculation, and preparatory solution used in conjunction with the more full-featured Carlson Software. Built around the Autodesk 2007 OEM graphics engine, Carlson Software reads and writes standard AutoCAD drawings and assures familiarity to AutoCAD trained staff.

Data Collection

The power of Carlson Survey begins with data collection. Carlson Survey downloads all major collectors ranging from Geodimeter and TDS to Leica, Nikon, Sokkia, and SMI. The raw data is stored in "RW5" format and can be viewed, edited and processed. The processing, or calculation of coordinates, recognizes "direct and reverse" and other forms of multiple measurement, and processes sets of field measurements. Surveys can be balanced and closed by selective use of angle balance, compass, transit, Crandall, and least squares methods—or simply by direct calculation with no adjustment. Commands exist for finding bad angles and for plotting the traverse and sideshot legs of the survey in distinct colors as a means of searching for "busts" or errors. In addition to downloading of data from electronic data collectors, the program accepts manual entry of field notes directly into a spreadsheet format, permitting review, storage, and editing. Alternatively, field notes can be entered for immediate calculation and screen plotting of points, with the "raw notes" stored simultaneously, permitting re-processing and re-calculation as needed. For data that was not field-surveyed, but was provided in the form of an ASCII or binary point file, Carlson Software offers the "Import Text/ASCII File" command, unrivaled in its flexibility to read foreign data sources.

Field to Finish

The survey world is recognizing the power of coding field shots with descriptions that lead to automatic layering, linework, and symbol work. Office drafting time can be reduced by 50% or more with intelligent use of descriptions, leading to "field to finish" plotting. For example, breaklines, which act as barriers to triangulation, should be placed on streams, ridges, toe-of-slopes and top-of-banks for more accurate contouring. With the field to finish command, breaklines can be created by field coding, with descriptions such as DL, for creating 3D polyline ditch lines, or TB for creating top-of-bank polylines, etc. and this coordinate data can be simply plotted to the screen as undifferentiated points. However, with the field to finish command, the data can be plotted in one step, creating 3D polyline break lines, building lines, light poles, manholes, edge-of-pavements, that are all distinctly layered and fully annotated. The field to finish command within Carlson Survey is extremely robust, so much so that it can adapt to a coding system made up on-the-fly, or a coding system that has been received from an outsourced survey. Field crew coding and office processing using the field to finish command can save valuable hours of drafting and eliminate misinterpretations, paving the way for quick plat generation or supporting supplemental engineering work.

Deed Work

Carlson Survey allows you to enter old deeds and plot the linework, then add bearing and distance annotation optionally. Distances can be entered in meters and feet, and even in the old measurement forms of chains, poles, links, and varas. Both tangent and non-tangent arcs can be entered. Closures, distances traversed, and areas are
automatically reported. Working in reverse, the command Legal Description creates a property description suitable for deed recording directly from a closed polyline on the screen. If that polyline has point numbers with descriptions at any of the property corners, these descriptions will appear in the deed report, as in "...thence N 45 degrees, 25 minutes, 10 seconds E to a fence post...". Deed files can be saved, re-loaded, edited, re-drawn and printed or plotted to the screen in a report form.

Drafting and Design

Carlson Software offers approximately 150 different symbols and north arrows, broken down by categories (for example, points, trees, map symbols). You can create new categories or supplement or change the available point symbols within any category. The program is designed to receive entire sets of new, customized point symbols in a single command. Attributes of points, such as elevation and point number, can be selectively "frozen," allowing the creation of final plats with symbols and optional descriptions remaining on points, as desired. Linework, typically in the form of polylines, can be drawn by any combination of point number and "snap" selection, to create property lines, street lines, easements and right-of-ways, building lines and borders. In addition to Carlson Software's standard line types, dozens of special line types are available, including tree lines, fence lines, all manner of utility lines, stonewalls, and customizable line types. Design features include automatic street intersections and cul-de-sacs, and automatic lot layout. For lots, you can pick your right-of-way and back property polylines, specify desired acreages and frontage/rear lot parameters, and the lots are automatically calculated and drawn. Hinged Area, Sliding Side Area, and Area Radial from Curve are excellent design tools, with an easy, graphic interface. All design polylines can be converted to point numbers at vertices and radius points for purposes of field stakeout.

Annotation

With a full slate of annotation commands, Carlson Survey is all you need to finalize your boundary surveys and plats. There is a wide range of bearing and distance annotation options, including the Auto-Annotation command, which allows you to annotate an entire selection set of polylines in one step. Station and offset annotating, as for right-of-way lines, is provided. Use commands such as Special Leader, Station Polyline, Draw North Arrow, and Draw Bar Scale to dress up the drawing and give it a hand-drafted look. Commands such as Title Block and Draw Legend, as well as sequential lot numbering and the area labeling commands, help you complete the finished drawing quickly.

Powerful Utilities

Carlson Software contains many strong utilities, particularly polyline utilities. You can Join Nearest disconnected polylines, turn 2-sided figures into closed, 4-sided figures, offset, trim, and extend 3D polylines, create building "footprints" with left and right entries using Extend by Distance, even reverse polyline directions. There are over 20 significant polyline utilities available, including Reduce Vertices, which weeds out duplicate or unnecessary vertices and cuts down on drawing size. Boundary Polyline is a simplified version of the AutoCAD command Boundary, and its opposite, Shrinkwrap Entity. Other categories of utilities include point attribute editing, scaling, twisting and re-sizing, text editing, font alteration and re-sizing, and advanced layer manipulation. Raster images such as aerial photos and scanned images can be placed on drawings.

Contouring and Terrain Modeling

There are many higher order features in Carlson Survey. Full contouring is provided, with options for smoothing and labeling contours, highlighting index contours and clipping contours to selected perimeters. Carlson Survey can be used to create both grid files and TIN files (.flt format). Volumes can be computed between grid files, inside any selected polyline perimeter. Profiles can be extracted from contour maps or hand-entered, as generic "point-to-point" profiles or as road profiles with vertical curves. The Design Pad Template command carves in building pads, pits, parking lots, roads, and other 3D features into any existing terrain. Land forms created by contouring and Design
Pad Template can be viewed in 3D and rotated in real time, using the 3D Viewer Window command. In addition to all the commands needed to create final drawings, Carlson Survey also contains commands to perform many engineering tasks typically encountered by survey firms.

Carlson Software is the ideal stand-alone solution for the survey and drafting organization, but it is also the perfect go-between product for the large civil engineering firm with in-house or outsourced survey operations. It compliments Carlson Roads. Carlson Survey enables Carlson Software to serve the full spectrum of the surveying and civil engineering design world.

**System Requirements**

Carlson's system requirements are no greater than that of the AutoCAD version you are running. See your AutoCAD installation guide for minimum system configuration. It is always recommended that you use the highest performance PC possible.

Note: Carlson does require a minimum screen resolution of 800x600.

Carlson 2008 will operate with the following versions of AutoCAD:


64 bit version of AutoCAD 2008 is not currently supported.

**Installing Carlson Software**

If you're installing Carlson Software on Microsoft® Windows NT® 4.0 or Windows 2000, you must have permission to write to the necessary system registry sections. To do this, make sure that you have administrative permissions on the computer on which you're installing. Before you install Carlson Software, close all running applications. Make sure you disable any virus-checking software. Please refer to your virus software documentation for instructions.

Note: If you are upgrading from an older version of Carlson Software, you must uninstall the older version before installing Carlson Software. This is required for successful software installation and to meet the guidelines of the EULA (End User License Agreement).

1 Insert the CD into the CD-ROM drive.

If Autorun is enabled, it begins the setup process when you insert the CD.

To stop Autorun from starting the installation process automatically, hold down the SHIFT key when you insert the CD.

To start the installation process without using Autorun, from the Start menu (Windows), choose Run. Enter the CD-ROM drive letter, and setup. For example, enter d:\setup.

2 The Windows Installer dialog box is displayed briefly, followed by a dialog box for entering in your serial number.
In the Enter Carlson Software 2008 Serial Number dialog box, you must enter the serial number provided with your copy of Carlson Software. Then click OK.

3 The Setup dialog box appears briefly, followed automatically by the Carlson Software 2008 Setup dialog. If this is the initial installation, you will see the dialogs shown below.
After reading this second dialog box, press Next. If this version of Carlson Software has already been installed, you will see a different Add/Remove dialog instead. In this case, it is recommended that you Cancel the current install and go to Windows > Control Panel > Add/Remove Programs and remove Carlson Software 2008. After the old installation is removed, you may start the install process once more to continue.

4 Review the End-user License Agreement, accept it with the correct click choice, and then click Next. You can optionally print it out.

5 On the Select Installation Type dialog box, select the type of installation you want: Typical or Custom. Choose Next.
Typical installs the following features:

- Program files: Executables, menus, toolbars, Help templates, TrueType® fonts, and additional support files
- Internet tools: Support files
- Fonts: SHX fonts
- Samples: Sample drawings
- Help files: Online documentation

Custom installs only the files you select. By default, the Custom installation option installs all Carlson Software features. To install only the features you want, choose a feature, and then select one of the following options from the list:

- Will be installed on local hard drive: Installs a feature or component of a feature on your hard drive.
- Entire feature will be installed on local hard drive: Installs a feature and its components on your hard drive.
- Feature will be installed when required only: Installs a feature on demand.
- Entire feature will be unavailable: Makes the feature unavailable.

6 On the Destination Folder dialog box, do one of the following:
Choose Next to accept the default destination folder/directory.

Choose Browse to specify a different drive and folder where you want Carlson Software to be installed. Choose any directory that is mapped to your computer (including network directories), or enter a new path. Choose OK and then Next.

Setup installs some files required by Carlson Software in your system folder (for example, c:\Windows\System, or c:\Winnt\System32). This folder may be on a different drive than the folder you specify as the installation folder (for example, d:\Program Files\Carlson Software). You may need up to 60 MB of space in your system folder, depending on the components you select to install. Setup alerts you if there is insufficient free space on the drive that contains your system folder.

On the Start Installation page, choose Next to start the installation.
The Updating System dialog box is displayed while Carlson Software is installed.

When the installation is complete, the Setup Complete dialog box is displayed. Choose Finish to exit the installation program.

It is strongly recommended that you restart your computer at this point in order for the new configuration settings to take effect.

Congratulations! You have successfully installed Carlson Software. You are now ready to register your product and
start using the program. To register the product, double-click the Carlson Software icon on your desktop and follow the instructions.

Authorizing Carlson Survey

The first time you start Carlson Software, the Registration Wizard is displayed.

Carlson Software has installed an automated procedure for registering your software license. Change keys are no longer given over the telephone. Please choose one of the following registration methods.

**Form:** This method allows you to fill out a form that you can print out and fax or mail to Carlson Software for registration.

**Internet:** If your computer is online, you may register automatically over the Internet. Your information is sent to a Carlson Software server, validated and returned in just a few seconds. If you are using a dial-up connection, please establish this connection before attempting to register.

**Enter change key:** Choose this method after you have received your change key from Carlson Software (if you previously used the Form method above).

**Register Later:** Choose this method if your want to register later. You may run Carlson Software for 30 days before you are required to register.

After you choose the registration method, press Next.
Choose the reason for installation. The very first time you install Carlson Software is the only time you will choose the first reason. All subsequent installations require a choice from the remaining options.

**New install or maintenance upgrade of Carlson Software**: If you are installing Carlson Software for the first time, choose this reason.

**Home use. See License Agreement**: Choose this reason if you are installing on your home computer. See your license agreement for more details!

**Re-Installation of Carlson Software**: Choose this reason if you are reinstalling on the same computer with no modifications.

**Windows or AutoCAD upgrade**: Choose this reason if you have reinstalled Carlson Software after installing a new version of Microsoft Windows.

**New Hardware**: Choose this reason if you are installing Carlson Software on a new computer or if your existing computer has had some of its hardware replaced such as the hard disk, network adapter, etc.

After you choose the reason for installation, press Next, and then enter the required information into the dialog.

---

If you are using the Form method, press the Print Fax Sheet button, to print out the form. You may fax this form to the number printed on the form, or mail it to Carlson Software, 102 W. Second St., Suite 200, Maysville, KY.
41056-1003.

If you are using the Internet method, press Next. After a few seconds, your registration will complete. If your registration is successful, you will receive a message such as the one below. If your registration is unsuccessful, please note the reason why and try again. Keep in mind that each serial number may be registered to a single computer only.

If you do not have access to the Internet, and do not have a printer, you must write down the information from the User Info tab (shown above) and fax it to 606-564-9525, or mail it to Carlson Software, 102 W. Second St., Suite 200, Maysville, KY 41056-1003.

Carlson Registration

Each Carlson program is licensed for use on one workstation which must be registered. The registration records your company name and AutoCAD serial number. To register your copy of Carlson, start Carlson and choose "Register Now". The following dialog will appear.

Note: Carlson Software will no longer issue change keys over the telephone. There are four registration options.

**Fax:** This method allows you to print out the required information on a form which you then fax to Carlson Software. The fax number is printed on the form. The change key will be faxed back to you within 72 hours.

**Internet:** Register automatically over the Internet. Your information is sent to a Carlson Software server, validated and returned in just a few seconds. If you are using a dial-up connection, please establish this connection before attempting to register.

**Enter pre-authorized change key:** If you originally chose the Fax method above, you will need to choose this method now to enter the change key that is faxed back to you.
Register Later: If you wish, you may defer registration up to 30 days. After this time, Carlson will enter demo mode which displays a message each time a Carlson command is run.

After you select the registration method, choose Next and select the type of installation you are performing, choose Next again to review the copyright information and to fill out the required information. At this point, if you are using the Fax method, press the Print Fax Sheet button. If you are registering using the Internet method, press Next and the process will start.

If you have any problems with Internet registration, please repeat this process and use the Fax method. The registration form is available on the Carlson Software website at http://www.carlsonsww.com/registration.html.

Tip: If Carlson is running, you may access the registration dialog by choosing About Carlson from the Help menu, then pick the Change Registration button.

Setting Up a Project

Over 200 Carlson Software settings can be specified in the Configure command on the Settings menu. These values are used to initialize Carlson Software options when opening a new or existing drawing. Among these settings is the coordinate point number format, object linking options, and settings for the COGO portion of Carlson Software. The template drawing is the default drawing that opens up each time Carlson Software is started. To customize the template drawing, run the OPEN command under the File pulldown menu, change the files of type setting to Drawing Template and choose the template drawing, "survey.dwt". Then make your changes and SAVE the drawing as survey.dwt in the Template folder.

When starting a new drawing, one of the first steps is to run Drawing Setup in the Settings menu. Drawing Setup sets the drawing scale, the units mode as either english or metric, and the text, symbol and linetype size scalers. The initial values for these Drawing Setup variables are set in Configure > General Settings. When a drawing is saved, the Drawing Setup variables are saved with the drawing. Carlson Software will set the text height according to the drawing scale and text size scaler set in Drawing Setup. For example, if the horizontal scale is set to 50 and the text size scaler is 0.1, Carlson Software will draw the text with a height of 5 (50 * 0.1). Then, when the drawing is plotted at 1"=50', the text will be 0.1 inches.

Every drawing remembers the data files that are being used for the drawing. When the drawing (.DWG) file is saved with the SAVE or SAVEAS command, Carlson Software writes a settings file that contains all the active data file names. Then, when the drawing is reopened, the data files default to their previous settings. For example, you won't have to choose which coordinate file to use unless you want to change it. The settings file is stored in the same folder as the drawing file, and has the same name as the drawing, with an .INI extension. For example, a drawing called survey.dwg would have a settings file called survey.ini.

The Drawing Explorer command, in the Settings menu within the Project command, tracks and stores project files associated with each saved drawing. You may use this command to generate a report of all files used in a particular drawing. Project Explorer takes this concept one level further and allows you to group drawing files and their associated project files. Reports can also be generated using this tool.

Startup Wizard

For creating a new drawing in Carlson Software, the Startup Wizard can guide you through starting and setting up the drawing. This wizard is optional, and it can be turned on or off in the Settings menu by clicking Configure, then General Settings. You can also exit out of the Startup Wizard at any time. When the Startup Wizard is turned on and the New drawing command is executed, you will see the Select template dialog box.
Typically, you want to choose the drawing template SURVEY.DWT when you are using Carlson Survey, and then click Open. Remember that for Carlson Roads you will use ROADS.DWT. For Carlson Field you will use ROADS.DWT. The drawing template will set some of the basic drawing parameters, such as the default layer names. The Startup Drawing Wizard dialog appears.

Typically, you want to choose the drawing template SURVEY.DWT when you are using Carlson Survey, and then click Open. Remember that for Carlson Roads you will use ROADS.DWT. For Carlson Field you will use ROADS.DWT. The drawing template will set some of the basic drawing parameters, such as the default layer names. The Startup Drawing Wizard dialog appears.

Here, you need to set the new drawing name and scale. Set the drawing (.dwg) name by picking the Set button. The Drawing to Create dialog box opens. Change to the directory/folder ("Save in" field) where you want to store the drawing. You can either select an existing folder or create a new folder. Type in the drawing name in the File name field and click the Save button.
Then you can set the drawing horizontal scale, symbol size, text size and unit mode (English or Metric). Clicking the Next button brings up the Startup Wizard Data Files dialog box. This is for setting the Data Path and CRD File. The Set button for the Data Path is for setting the folder where Carlson Software will store the data files, such as raw (.RW5) files and profile (.PRO) files. The Set button for the Data Path allows you to select an existing folder or create a new folder. See the Set Data Directory command for more information.

The Coordinate (.CRD) File is the coordinate file for storing the point data. There is an option to create a new or existing coordinate file. The New option will erase any point data that is found in the specified CRD file. The Existing option will retain any point data in the specified coordinate (.CRD) file. If the specified coordinate (.CRD) file does not exist, the wizard will create a new file.

The next wizard step depends on the Import Points option. The Data Collector option will start the data collection routines to download data from a collector. The Text/ASCII option will import point data from a text/ASCII file. See the Data Collection and Import Text/ASCII File commands for more information on running these routines. If the None option is set, then the Startup Wizard is finished.
Once point data has been imported from the data collector or text/ASCII file, the wizard guides you through drawing the points. There are options to run Draw/Locate Points, Field To Finish or None. If None is selected, then the Startup Wizard is finished. Draw/Locate Points will import the points into the drawing using the same symbol and layer for all the points. From the Draw/Locate Points dialog, set the symbol, layer and point attributes to draw (description, elevation) and then pick the Draw All button. The Field To Finish command will import the points into the drawing using different layers and symbols depending on the point descriptions that refer to the code table defined in Field to Finish. Also Field to Finish can draw linework. See the Draw/Locate Point and Field To Finish commands for more information on running these routines. After drawing the points, the wizard will zoom the display around the points. Then the wizard is finished.

Command Entry

Commands may be issued by selecting a pulldown menu, screen menu, digitizer tablet item, or by typing a command at the AutoCAD command prompt. Pressing Enter at the command prompt repeats that last command. Pulldown menus have a row of header names across the top of the screen. Selecting one of these header names displays the possible commands under that name. Screen menu items are shown in the screen menu (typically on the right side of the screen). The screen menu can be toggled off and on inside of the AutoCAD Preferences dialog. The Pulldown menus are the primary method for Carlson command selection. Each section of this manual shows the pulldown menu which contains the commands that are explained in that section. Pulldown menus are sometimes also referred to as dropdown menus.

Command availability depends on which menu is loaded. Carlson menus have a mixture of both Carlson and AutoCAD commands. This allows you to execute the commonly used AutoCAD commands from the menus while running Carlson.

Quick Keys are user-defined short cut names that can be typed in to start commands. To review the current set of Quick Keys, run the Quick Keys command in the Settings pulldown menu. Quick Keys are explained in more detail in the next section.

Layer and Style Defaults

Many Carlson Software commands have default layers such as AREATXT for area labels and BRGTXT for bearing and distance annotations. These layers can be specified in dialogs for the corresponding commands, and several can be set in the Configure command under the Settings menu. Sometimes you may want to use the current layer, and it can be an extra step to have to open the dialog to set the layer. In this case, instead of using the default layer that is set in the dialog, the default layer can be set as "CLAYER", which will use the current layer.

For example, if the annotation layer is set to CLAYER, then annotation will be drawn in the current layer instead of BRGTXT or whatever the annotation layer used to be. This same concept applies for text styles. Several commands have specific text styles and if you want to use the current style instead of the command style, use the name "CSTYLE" for the style name.
What is New

General Commands

- **Reports** - Added option to output reports directly to Microsoft Word.
- **Report Formatter** - Added output options to create a table in the drawing for the selected fields and to create an HTML format report. Added ability to save report with all the settings, data and user defined attributes.
- **Perpendicular From Osnap** - Added ability to snap perpendicular from linework within the ‘CL transparent command.
- **Drawing Inspector** - Added option to show curve data. Added setting for high precision data display.
- **New Scale 2D** - New command to scale entities in x,y coordinates without effecting their elevation.
- **Join Nearest** - When layers or elevations don't match, add option to prompt for which one to use. Added option to stop at intersections with more that two connections.
- **Highlight Crossing Polylines** - Added tolerance settings for intersection points to merge by average.
- **3D Viewer Window** - Added options to show axis icon, bounding box and vertical scale amount. Lighting conditions automatically saved and recalled. Additional formats in bitmap output.
- **Insert Symbol** - Added option to align symbols by centerline or polyline.
- **New Draw Arc (PC,PT,Radius len)** - New command to draw an arc with these inputs.
- **New Draw Polyline Start/End** - New command draw different symbols for the start and end points of selected polylines.
- **Layer Inspector** - Added ability to select multiple layers to highlight.

Roads Commands

- **Profile From Surface Entities** - Add support for railroad stationing.
- **Profile From Grid or Triangulation Surface** - Add support for railroad stationing.
- **Profile From 3D Points** - Add method to create sewer profiles using depth or invert elevation in point description fields.
• **Profile From Points On Centerline** - Added option to record point offsets to centerline into profile descriptions.

• **Draw Profile** - Added support for drawing a user-specified number of profiles at a time. Added draw grid option to use grid ticks and dots. Added setting to control width of profile polylines. For horizontal label box, added option for user-defined rows and option to draw above profile grid. For vertical curves, added option to auto-place labels above highest vertical curve, added option to label high/low points, added more PVI-V linework styles, added control of the curve symbols, added option whether to label the grades on the profile polyline and added prefix/suffix settings for all the curve labels. For profile grid, added setting for vertical grid adder to top and bottom. For profile crossings, added settings to control each label prefix, suffix, style, size, decimals and rotation. For plan-profile sheets, added options to draw sheet layout border in plan view, to draw a north arrow in plan view and to draw plan-view only sheets. For sewer/pipe profiles, added options to draw flow direction arrows on the pipes and to close pipe connections at the structures. For pipe crossings, added method to calculate and draw crossing on-the-fly and new method to specify swath width for drawing any parallel pipes. For drawing additional profiles onto an existing grid, added a button to pick the existing grid to get the grid dimensions. For station and elevation grid text, added settings for offset amount from grid lines. Added separate settings for road, sewer, pipe and crossing labels for label size, color, style and layer. New option to label profile name at start of profile polylines. Added Draw Grid options for grid ticks with checks and whether to label elevations on the left side only.

• **Sections From Points** - Added option to record point offsets to section alignments into section descriptions.

• **Input-Edit Profile** - For road profiles, added ability to set vertical curve to make a sag/crest at the specified through point. Added report function within editor. Added graphic display option to show slopes.

• **Sag & Crest Report** - Added option to draw symbol at sag/crest points. Added label settings for prefix/suffix, layer and text size.

• **Station Polyline/Centerline** - Labels linked to centerline to update labels if centerline is changed. Added options to label deflection angles, to label northing/easting of start, to draw symbols at curve PC/PT stations, and to label curve radius on PC lines. Added setting for text style for labels. Added functions to save/load settings by settings file.

• **Input-Edit Centerline** - Add function to reverse centerline. For assign point number, added option to include CL type in description.

• **Calculate Section Volumes** - Added support for railroad stationing.

• **Calculate End Areas** - Added settings for layer names, decimal places and prefix/suffix on labels.

• **Design Road Profile** - Added graphic display option to show slopes. Added field for depth to spreadsheet.

• **Input-Edit Section File** - Added graphic display option to show slopes and descriptions of offset points.

• **Draw Section** - For section crossings, added settings to control each label prefix, suffix, style, size, decimals and rotation.

• **Input-Edit Template Series** - Added an option for detailed template data in the report function.

• **Input-Edit Super Elevation** - Updated AASHTO method to use 2004 greenbook equations. Added horizontal speed tables for lookup.

• **Process Road Design** - Added support for railroad stationing. Added option to draw 3D road breaklines on different layers.

• **Road Network** - Added output option to create points with control of types of stations to output and contents of description field. Added method for creating intersections between new and existing roads. Added ability to use template series file for road templates. Added option for curb grades radial to center of intersection. Added function to set cul-de-sac offset for full left or right. Added option to process road design without applying cut/fill slopes. Added option to draw 3D road breaklines on different layers. Also added options to draw 3D faces on different layers and to color in red/blue shades by cut/fill depth. Added option to set default names for existing profile and section output files. Added ability to reset project folders. Added option to output 3D polylines for subgrade breaklines. Added option to output all road network design data and final sections to single data file for stakeout in SurvCE. Added options to elevate pad and lot edges by using a specified road template ID as the elevation reference and applying grading rules.
• **Road Design Inspector** - Added ability to pick on profile graphic to set station to inspect.
• **Locate Template Points** - Added support for railroad stationing.

**Standard Report Viewer**

Many Carlson routines display output in the Standard Report Viewer as shown below. The report can be edited directly in the report viewer. Report Viewer commands are described below.

**Open:** This allows you to open an ASCII file and display the contents in the report viewer.

**Save:** Save the contents of the report viewer to a text file.

**SaveAs:** This allows you to save the contents of the report viewer to a file.

**Append To:** This allows you to append the contents of the report viewer to another file.

**Print:** Print the contents of the report viewer. This will open the standard windows Print dialog where you can choose the printer and modify any of the printer settings before you actually print.

**Screen:** Draws the report in the current drawing. The program will prompt you for a starting point, text height, rotation, layer and whether you want it inserted as Mtext or Text.

**Undo:** Reverses the effect of your last action. If you mistakenly deleted some text, stop and choose the Undo command to restore it. The key combination Ctrl+Z also performs this action.
Select All: Selects all the text in the report viewer.

Cut: Deletes the selected text and places it on the Windows® clipboard.

Copy: Copies the selected text to the Windows® clipboard.

Paste: Inserts ASCII text from the Windows® Clipboard into the report viewer at the cursor.

Search: Opens the Find Text dialog. Allows you to search for text in the report viewer.

Replace: Opens the Find and Replace Text dialog. Allows you to search for text and replace it.

Options: Opens the Report Viewer Options dialog. In this dialog, you can specify print settings, such as lines per page and margins. You can also specify the font used in the report viewer. This font is used for both the display and for printing.

Hide: This button allows you to minimize the report viewer window and give focus back to the Carlson CAD screen. This allows you to return to working on the Carlson CAD screen without closing the report. You can re-activate the report by picking on the minimized report viewer icon.
Report Formatter

A number of Carlson routines use a dialog box called Report Formatter Options to allow you to specify how and which results of calculations should be presented in the report. This report routine lets you select a set of data to report and the format of the selected data. The report can be displayed in either the standard report viewer as described in the previous section, Microsoft® Excel or Microsoft® Access.

The data set in the Report Formatter may be thought of as a spreadsheet, where columns are various fields related to a single item such as time period, drillhole, area and etc. Each new row represents a new item. Descriptions of these field names are displayed in the Available list of the Report Formatter. To include a data field in the report, highlight the field name in the Available list on the left and pick the Add button. This moves the field name to the Used list on the right. The order of items in the right list defines the order in which they will be displayed. In addition, the items may be sorted as specified by the user in the right column. Items are first sorted by the first column, then items with the same value in the first column are sorted as specified for the second column, and so on.

These subsequent sortings do not modify sortings of previous columns. If you specify no sorting for some column (even the first one) then no sorting will happen in subsequent columns either. For example, you may want to sort production by mining panel name but not by month.

To generate the report after selecting columns and other preferences, click on Display button. It will bring up a standard report viewer showing the report data. Upon exiting the viewer, you come back into the Report Formatter for further data manipulation if needed. The other data output and destination options include saving the specified data into a comma-delimited text or CSV file, creating a spreadsheet preview whereby the data may be exported using several methods, and direct export to Microsoft® Excel. Due to the popularity of the Excel output choice, you can also customize certain Excel options, including setting mirror output, just prior to export. Data can also be merged to combine current and old reports, and it be exported to XML format files. There is an option for output to other database formats as well.
You may define new columns as equations based on existing columns. Click on the Edit User Attributes button to add a new field name. A list of the existing attributes is available for reference.

User attributes may have one of the several summation options just like program-generated ones (except that for them these options are set by program). The summation level is defined by the “Total” pop-up list in the middle of the dialog. By default only grand total will be displayed at the bottom of the list. By picking the next item in that box, you will get subtotals added each time the value in first column is changed. It makes most sense to use this kind to summation if the corresponding column is sorted. For example if the first column is “Area Name” and it is sorted, and “Total” is set to ”Grand, Area Name” the report will have a sub-total for each distinct Area Name. This feature makes the Report Formatter a very flexible tool for results exploration, even before or without using a spreadsheet.

Various forms of reports may be saved and recalled using controls in the top line of the dialog.
To save a new version of the format, type in a new name (or use default to overwrite old one) and click on the Save button. The next time that you come to the Report Formatter from the same Carlson routine it will recall this last format. To pick another format just pull down on list of formats in the left top corner and pick which format to use. To Delete an unwanted format, pick it from the list first and then click on Delete button.

There are several Microsoft® Excel export options provided. You may specify a spreadsheet file to load before export, as well as a left upper cell to start with and sheet number to use. Totals which are reported when using built-in viewer may be skipped when using Microsoft® Excel export.

For commands that process reports using perimeter polylines, the Report Formatter has an option to create GIS links between the polylines and the database records when the Export to MS Access function is used. When the polyline data is available for the GIS Links, there will be a report field called Handle. This Handle field is the AutoCAD entity name for the polyline and serves as the hook for the GIS link. The Handle field does not need to be put into the report Used list in order to create the links. When the Export function is called with the MS Access method, there is a pop-up window prompt for whether to create the GIS links. When these links are created, you can then use the GIS menu commands to manage and report the data.
Instruction Manual and Program Conventions

*Westwood*

Italic text represent responses by the user that should be typed in and followed by the Enter key.

**Number/**Pick point**: Bold text represents prompts or questions that the computer program will ask the user.

*<90.0000>*

Values enclosed in corner brackets represent default values obtained by pressing Enter with a blank response to AutoCAD or Carlson commands.

[end on]

Lower case text enclosed in brackets in Command prompts denotes an *OSNAP* mode that is turned on by the command.

**Carlson File Types**

-AAN Auto-Annotate Settings
-ADF Annotation Default Settings
-ARX AutoCAD Runtime Extension For Carlson Program
-ATR Strata attribute definitions
-AVG Mining Composite Quality Analysis
-BLK Mining Block Model
-CAL Mining equipment calendar
.CAP Capacity file for hydrology (stage-storage)
.CDF Geology Channel Sample File Format
.CDS MDL Laser Raw Data
.CDT Mining custom date table
.CFG Configure Configuration Settings
.CFZ Cut/Fill Color Map Zones
.CGC C&G Coordinate File
.CGR C&G Raw Data
.CH Corehole definition
.CL Centerline file
.CLT Culvert Settings
.CN Hydrology CN Factors
.COG Cadvantage Coordinate Data
.COT Multiple Outlet Design Data
.CQT Mining custom quantity table
.CRB Template Curb Definition
.CRD Coordinate file (point#, northing, easting, elevation, description) in binary form
.CTL SDMS Format Raw Data
.CTR Auto-Run Strata Isopach Maps
.CUI Customized User Interface AutoCAD Menu
.CUT SMI Format Cutsheet
.CVT SEDCAD Format Hydro Network
.DAT GPS Localization Definition
.DCF Deed Correlation File
.DCL Carlson dialogs
.DEM Digital Elevation Model
.DEQ Drillhole equations
.DHF Drillhole Text File
.DHT Dragline History
.DIL StrataCalc Convert As-Determined Qualities
.DLL Carlson programs files
.DTF Drillhole Data Format
.DTS Drillhole Text Settings
.DWG AutoCAD drawings
.DXF Drawing Exchange Format
.DZR Dozer Push Settings
.EQO Mining equipment options
.EQU Mining equipment definitions
.ERD Erodible Channel Settings
.EW Earthwork Section End Areas
.EXE Carlson programs
.FCL Feature Code List for SurvCE
.FEN Fence Diagram Settings
.FLD Field to Finish code definitions
.FLT Triangulation mesh
.FMS Report Formatter Settings
.FRM Ferm Codes
.GCL Geologic Column Settings
.GEO Settings for Draw Geologic
.GFU Grid File Utilities macro command recorder file
Chapter 1. Introduction
Quick Keys

"Quick Keys" allows you to enter in the coding shown here on the left, and by doing so run the commands shown on the right.

2DP = 2D Polyline
3DP = 3D Polyline
A = Arc
AL = Align
B = Block
BB = Bearing-Bearing Intersect
BD = Bearing-Distance Intersect
BH = Boundary Hatch
C = Circle
CH = Change Properties
CO = Color
CP = Copy
DD = Distance-Distance Intersect
DI = Distance
DT = Draw Text
E = Erase
EA = Enter-Assign Point
EX = Extend
F = Fillet
H = Hatch
I = Inverse
L = Line
LI = List
LP = Draw-Locate Point
LS = List
M = Move
MI = Mirror
O = Osnap
Obtaining Technical Support

via Discussion Groups

• Carlson Software operates user discussion groups located at news://news.carlsonsw.com. You can participate in user-to-user discussions on tips, tricks and problems. Our staff monitors these groups to ensure that all the issues are addressed. Visit our website at http://www.carlsonsw.com for information on how to access these groups.
• You may also access the Carlson Software Knowledge Base. Visit it directly at http://update.carlsonsw.com/kbase_main.php.

via Electronic Mail

• The Technical Support e-mail address is support@carlsonsw.com.

via Phone/Fax

• Phone: (606) 564-5028
• Fax: (606) 564-6422
via Web Site

Check the Carlson Software web site at http://www.carlsonsw.com for:

- Knowledge Base, discussion groups, technical support documents and newsletters
- Carlson Software manuals (PDF) and training movies
- Training and seminar schedules
- Step by step procedures on popular called-in topics
- Carlson Software and Autodesk downloads and updates (Feel free to register for automatic update notification of updates when you come to that area.)

via Training

- Basic, advanced and update training is available from Carlson College. Enroll on our webpage or call 606-564-5028 and ask for Carlson College.
Tutorial

This section contains tutorials designed to assist you in learning this Carlson Software product. It is recommended that you try it out when you are first starting to learn the software, or when you need some pointers later on. You will see how to create a basic road design with volumes. You will also see how to work with profiles, sections, and section templates.

This tutorial will ask you to open drawing and data files that are provided to you at purchase. Good luck!
1 First we need to open an example drawing supplied with Carlson. Issue the File Open command and choose EXAMPLE2.DWG. It should be in the Carlson work folder, and will look like the example (without the curved road).

2 Draw Road Centerline. Issue the Draw > 2D Polyline command and generate the road centerline as shown below. In this case it was drawn from the left, down and toward the right. Include a curve segment with the Arc option of the command.

3 Profile from Surface Entities. Now we will make a profile file, *.pro. This will be from the centerline shown in the drawing as the lines with the curve. Under the Profiles menu choose Create Profile From ..., then Profile from Surface Entities. This will create a new file. Type in a file name in the dialog and click Save. On the next dialog, we will use the default values and click OK. Pick the centerline, and without hitting enter, select all of the contours. The data is written to file.

4 Draw Profile. This will give us a profile view of the contours at our centerline. Under Profiles, go down to Draw Profile and open our new file. The window will appear as shown. With the horizontal scale set to 50 and the vertical scale set to 5, there will be a 10X vertical exaggeration of the profile. Fill this dialog box it out as shown below and click OK.
Next, there is the Profile Grid Elevation Range dialog. Accept the top and bottom elevations it gives by hitting OK. Pick a spot in the drawing to draw the profile, then view the profile on the grid by zooming as required. Your profile should look similar to this.

5 Design Road Profile. Now we will design how the road centerline profile will be, in relation to the existing ground (which is the first profile we have made). This routine will create another Profile file. Under Profiles, go to Design Road Profile, and then Design Road On Profile Grid (this method is suggested for this tutorial).

The following dialog box will appear. Since we followed up the Draw Profile command with this one, it was able to determine proper startup values for the dialog.
Choose OK on this dialog. A new file creation dialog box will appear, asking for an output file name. Enter a name such as DESIGN, and click Save.

**Pick Lower Left Grid Corner <0.00,0.00>[endp on]:** Pick Lower Left Grid Corner of the profile grid (Carlson has endpoint osnap active to make the pick accurate).

At this point another dialog will appear in the upper left corner. Initially, it will display only station and elevation. Once a beginning point has been designated, it will also display the relative difference from the last point to the cursor position. This can be an aid in determining acceptable slopes for your design.

**Enter a station or pick a point (Enter to End):** ENDoF (pick the left-most endpoint of the existing ground profile as a tie in point). The following dialog will appear, choose OK to accept the defaults.
Station of second PVI or pick a point (U,E,D,Help): 1111.01
Percent grade entry/<Elevation of PVI>: 1999.37
Station of next PVI or pick a point (U,E,D,Help): 1911.64
Percent grade entry/<Elevation of PVI>: 2002.66
View table/Unequal/Through pt/Sight dist/K-value/<Vert Curve Length>: 500.00
For Sag with Sight Distance>VC and Vertical Curve => 500.00
Sight Distance => 2334.40, K-value => 243.2
Use these values (<Y>/N)? Y
Station of next PVI or pick a point (U,E,D,Help): END of (pick the far-right endpoint of the existing road as a tie in point).

The following dialog appears. Choose OK to accept the defaults.

View table/Unequal/Through pt/Sight dist/K-value/<Vert Curve Length>: 500.00
For Sag with Sight Distance>VC and Vertical Curve => 500.00
Sight Distance => 1000.00, K-value => 697.0
Use these values (<Y>/N)? Y
Station of next PVI or pick a point (U,E,D,Help): press Enter
At this point the following dialog appears. Change settings to match, and choose OK.

![Vertical Curve Text Options dialog box]

Pick vertical position for VC text: *pick a point above the top of the grid*

Carlson will now finish the road design, and your drawing should look like the following:

![Road design preview]

6 Polyline to Centerline File. This step will create a centerline file necessary for the final road design routine. We will do the simplest variation, which is simply picking a polyline. There are other methods to design a centerline. They are documented in the manual.

First (if necessary), zoom back to the plan view area, as we will be working with the polyline first created in this exercise. Go to Polyline to Centerline File command, under Centerline, and name a *.cl file to create.

**Beginning Station <0+00>: press Enter**

Polyline should have been drawn in direction of increasing stations.

Select polyline that represents centerline: *pick the plan-view polyline*

<table>
<thead>
<tr>
<th>Station</th>
<th>North (y)</th>
<th>East (x)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0000</td>
<td>159460.9658</td>
<td>1857580.2082</td>
<td>LI</td>
</tr>
<tr>
<td>446.2825</td>
<td>159541.3445</td>
<td>1858019.1926</td>
<td>PC</td>
</tr>
<tr>
<td>1178.1130</td>
<td>159254.1689</td>
<td>1858643.2229</td>
<td>LI</td>
</tr>
<tr>
<td>2707.2962</td>
<td>157932.5436</td>
<td>1859412.4483</td>
<td>LI</td>
</tr>
</tbody>
</table>

Press ENTER to continue, *press Enter*

7 Input-Edit Section Alignment. Now we will layout the alignment for our cross-section file. This step gives the
section interval, and the offset left and right from our centerline. Under Sections, go to Input-Edit Section Alignment. Choose the New tab, which brings up the dialog to make a new MXS file (multi-xsection file). Type in a new name and click Open. Notice how all files can have the same name in this road design portion, as they all have a unique file extension. So for the organization of various jobs, it is sometimes helpful to have all of the files with the same name.

Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>: pick the centerline polyline
Enter Beginning Station of Alignment <0.00>: press Enter

The dialog will appear as shown, enter in the stations and offsets exactly as they appear here. This will give the needed detail for the road design routine.

Choose OK, and another window appears that allows for any station editing or changes. It all looks good here, so hit Save.

The Alignment file is now written. There is now a preview of the section alignment lines shown on the centerline. These are just images, if the drawing is regenerated, they will disappear. (They can be drawn permanently if desired.)
Sections from Surface Entities. Next, we will create the actual section file (*.SCT) from the contours, in combination with the alignment file (*.MXS). Under Sections, go to *Sections from Surface Entities*. We will use the contours and breaklines for surface elevations, as we did with generating the profile. Specify the MXS file that we just created to read for the alignment. Click Open to select it. Then choose a new file name for the section file, and click Open.

We’ll enter a distance of 1000 feet to add to our MXS limit of 70. This will search farther for contour elevations, then choose OK. Now, select the surface entities which are the contours and the breaklines. Once you are back to the command prompt, you are done with the making of sections.

Design Template. Let’s design a wide boulevard, 30’ of drivable pavement, with curb and gutter on the outside. Whenever a cut is within rock, the cut slope will go from a typical 2:1 to 0.5:1. At the top of rock, the cut will continue on at 2:1. In fill, the condition will be 3:1 in all fill under 6’ and 2:1 in all fill over 6’ in depth. Pavement depths will be 8 of stone and 4 of asphalt.

First, Select *Design Template*, found under Roads, within the Civil Design module of Carlson. Click on the New tab.
We’ll give it the same name as the drawing. Choose Open. A large dialog box appears as shown below. In it, you enter segments of the template, which work outwards from the middle as you add more lanes, curbs and shoulders. We will enter a symmetrical template, with 13.5' pavement sections either side of centerline, connecting to a 2’ curb and gutter, with 18” of gutter and 6” of curb. Then we’ll add a 6’ shoulder.
For the lanes, click the Grades icon. This leads to a child dialog as shown next:

![Grades Dialog]

Fill out as shown. It's important to note that a downhill pavement from a crown in the middle is entered as a negative slope. That is, it is 2% heading from centerline outward, regardless of which side of centerline we are speaking of. Slope is in reference to the centerline of the template, and it is independent of the profile grade point. It is also important to enter an ID whenever requested. ID’s can be referenced later.

A break point in a shoulder in superelevation could be defined as occurring at EP+3, as opposed to the exact offset distance from centerline. The advantage of EP+3 is that if the road lane width expands (e.g., for a passing lane), but the shoulder always breaks 3 feet beyond edge of pavement, then EP+3 is the only effective way to reference the break point. Now click OK. You'll note that the lanes show up in the preview window at the top.

Next, we will add a curb. Click the Curb icon. Fill out as shown:

![Curb Dialog]

It is especially a good idea to match crown – to make the curb match the slope of the last pavement lane (2% above). But if your curb tilts downward more (like 3%), then use a Special Base Slope Type. If it is flat, by all means click on Flat Base. Now click OK. Here's what our screen looks like so far:
Next, we will add a shoulder, going uphill at 4% for 8'. Notice what is happening. You are lit up on the Curb line, so if you add another Grade, it will append after the curb, and add to the back of curb. If you were to click on the GRADE: 13.500, -2.000%, EP line, highlight it, then click on GRADES, you would add a second lane before the curb. Now click on GRADES. Fill out the dialog as shown:

That's it for the surface! Here's what our screen looks like now:
Now we have subgrades and outslopes still to consider. Let's turn our attention to subgrades. Let's think about this: if our pavement is a total of 12 deep (8 stone, 4 asphalt) and our concrete gutter is 6 deep, then the stone will run 6 deep under the gutter. Do we want this stone to come back up at the back of the gutter, behind the gutter, or even wrap around back into the gutter, like a layer of bedding that is covered by dirt. The most complex concept is the wrap around, so let's go for it.

Select the Subgrade icon, second from the right (yellow color). We'll do two subgrades: first asphalt, which will run straight out and hit the curb, and then stone, which will run out, go under the curb, and wrap back.

For any sub-grade, we still do the vertical offset as a negative distance (negative meaning down). But follow this concept: we start it out 13 feet from offset 0, and keep going at "Continue Slope" until it hits something (the curb). This won't work if there is nothing to hit. But it will run into the curb. Or if there is a fill slope, downhill 6:1 recovery zone lane, or something to intersect, it will also. This Continue Slope concept works perfectly for shallow asphalts and concretes that will bump into a curb, when extended.
Complete as shown above, and click OK.

Now for the other subgrade: the stone beneath the asphalt. Follow this: if the stone can't Match Surface (note this option under Slope Type), it will start up hill with the shoulder as it passes beyond the curb (it goes out 17'). So it must have a Special Slope Type, the same 2% all the way. The Wrap Height is the vertical rise at the end of the 17', before it wraps back and hits the curb. Select the Subgrade icon again (second from the right).
Fill out the Sub-Grad Dimensions dialog, as shown above, and click OK. Note the preview screen:

We still need to enter the outslope conditions. They are done with the Cut and Fill icons. Fill is easy in our example. Click on Fill.
Just 3 entries total: 3 (for 3:1), 6 (up to 6’), then 2 (for 2:1 over 6’). Click OK. Next, click the icon for Cut.

This is actually easier (in terms of total entries). Just 2 entries do it: 2 (for 2:1 normal cut) and down below, 0.5 (for 0.5:1 cut when in rock). Click OK.
The template is complete, so click Save. Now let's prove we have a good template by doing the command Draw Typical Template.

10 Draw Typical Template. The file extension for templates will be tpl. Select Draw Typical Template under the Roads pulldown menu, select Example2.tpl (or as named above), choose Open and the following dialog shown here is displayed:

![Typical Section Dialog](image)

We have doubled the text scaler to 0.5 for better appearance in this tutorial. Click on Draw, and pick a starting position point. Here is the look of the plotted template.

![Plotted Template](image)

11 Drawing Explorer. As more files are created, edited, loaded and reviewed within a work session, the drawing ini file takes note. You can review your active files as you work, or days later, because they save to the ini file that shares the same name as the drawing file. To see the files associated with this tutorial drawing file, select Drawing Explorer by sliding over from Project, under the Settings menu.
Input-Edit Section File has many uses. One of them is to translate or lower the elevations of a file and re-save. If we lower the elevations of our ground sections 8 feet, we can call that the rock line. Rock lines react with templates and profiles to create rock cuts and rock quantities, within the final step, which is called Process Road Design (Step 13). Select Input-Edit Section File under the Section pulldown menu. Under the Existing tab section, select the SCT file you created earlier and click Open.
The next dialog that appears is shown below:

![Input-Edit Section File dialog](image)

Click the Translate button. The Translate Selections dialog appears. The Ending Station might differ from what is showing here, but it should be close to this value. Make sure the rest of the dialog looks the same as shown below, and click OK.

![Translate Sections dialog](image)

Now back at the Input-Edit Section File dialog, click Save As, and enter a different name, such as Rock, and save the file. Then click Exit.

Input-Edit Section can do much more through the Edit option. In the case of Edit, you would first highlight one station, then click Edit to review and revise it.
13 Process Road Design. This is the routine that weaves everything together. Select *Process Road Design*, as the lower command under the *Roads* pulldown in the Civil Design module. Fill out the dialog as shown below. Be sure to select, under Specify Output Files, the Section File option and click New. Enter a new file name and Save. Then click OK.

On the next dialog, be sure to click on Triangulate & Contour at the lower left of the dialog.
Now click OK. Here is a partial view of the final report, with itemized quantities:

![Image of Carlson Software interface]

Click Exit when finished reviewing the report. You will get this command prompt:

**Trim existing contours inside disturbed area [Yes/<No>]?** press Enter

Here is the resulting graphic, in 3D, obtainable by using 3D View Window, found under the View pulldown:
This completes this tutorial: Basic Road Design with Volumes.
AutoCAD Overview

This chapter explains the essentials of using AutoCAD including command entry, selection sets and layers. Since Carlson Software is built on the AutoCAD OEM engine, it is helpful to know the AutoCAD basics. Several of the Carlson Software command are native AutoCAD commands and many others have an AutoCAD style user-interface.
Issuing Commands

Virtually all commands in Carlson Software have three or more ways they can be initiated. The two most common are the menu and the toolbar, but the command line can many times be a very easy method of working through commands. Using the menu and toolbar should be second nature to Windows users, so this section will mainly focus on the command line usage in Carlson Software.

Command Line Prompt-Command:

Carlson Software has a command line prompt where commands are "issued" and the status of a command is reported. When you select a command from the menu or toolbar, that command name is sent to the command line and is executed. Before most commands can begin, all other commands must be terminated. The exceptions are referred to as transparent commands. The easiest way to see if no commands are running is to look at the command line. If it displays Command: no commands are currently in progress.

Enter

When you are required to press the Enter key in Carlson Software, you can use the Enter key on the keyboard or you can press the spacebar or click the right mouse button.

Pressing the Enter key will perform different operations depending on your location within Carlson Software. If you are in the process of running a command, the Enter key will end the command (if there are no available options) or it will select one of the options available (see below). If you are at the command line Command: prompt, pressing the Enter key will repeat the last command.

Right Mouse Button

As mentioned above, the right mouse button can be used as enter. However, you can set the right mouse button to perform different functions. The control for the Right Mouse Button behavior is in the Mouse Click Settings command. When you click the right mouse button, you will get a drop down list of the options and can select the desired one. Move the cursor the desired option and click on it with the left mouse button.

Getting Out of a Command-Esc

For commands that provide no options, the Enter key (or spacebar or right mouse button) will end the command you are using. Also, when a command is issued in Carlson Software, this action will also automatically end the previous command. However, there are exceptions to these two rules.

To avoid any problems with using the above methods to end a command, you can press the Escape (Esc) key. For example, if the command line displays something other than Command: or if a command you want to run does not start because you are using another command, you will want to end the command and return to the command prompt. Using the Escape (Esc) key will accomplish this every time.

Note: Some commands have several optional levels which will require the escape key to be pressed more than once.

If you accidentally select a location on the screen and start a selection window, the command prompt will prompt for another corner. Either select another point on the screen to finish the selection (not advised) or press the Esc key to return to the Command: prompt.

Commands Option
When any command is issued, the command line acts as a status bar that will show the available options and "ask" for input from you.

When there are options for the command you are currently running, these options will be shown on the command line with capital letters in the option name. To use one of the options, type the capital letter(s) at the prompt. For example, if you issue the Zoom command, the command prompt will show All/Center/Dynamic/Extents/...<Realtime>: To select the Dynamic option, type D at the command line, then press the Enter key. If you do not input an option and just hit enter, you will be selecting the option that appears in the <> brackets. For the example shown, that is the Realtime Zoom option.

**Transparent Commands**

Several commands in Carlson Software can be run transparently. This means that they can be performed while another command is running. For example, if you are in a command and are trying to select something in the drawing but it is too small to see, you can use the zoom command transparently. Zoom to the area where the object is, then select the object without ending the initial command. The most commonly used commands are the View commands of Zoom and Pan, and the Properties commands including the Layer dialog box.

To issue a transparent command, type an ' (apostrophe) before the command name. For example, 'Z would be transparent zoom. Note that many commands will automatically be assumed to be transparent if they are issued from the toolbar while another command is running.

When you are in a command that is running transparently, this will be indicated with a >> at the far left of the command line preceding any options or other text. When a transparent command is complete, you will return to the command you were previously running. If you are in a transparent command and want to end the command to get back to the command prompt, you will need to press the Esc key twice.

**Note:** If you select a View command while running another command, the other command will not end. You will be running the View command transparently. This is one of the exceptions to the rules for ending a command. If you do not want to run the View command transparently, you need to complete the other command or end it by pressing the Esc key.

**General Commands**

**Enter**

When you are required to press the Enter key in Carlson Software, you can use the Enter key, the spacebar on the keyboard or click on the right mouse button.

**Repeating Commands**

When you press the Enter key at the command line Command: prompt, you will repeat the last command.

**Cancel**

The Escape key (Esc) key can be used to cancel any command. Some commands may require pressing the Escape key more than once.

**Command Options**
The command line changes as a command is running. When there are options available for the command you are running, they will display at the command line. To select one of the options, type the capital letter(s) in the name of the option and press the Enter key.

Selection of Items

Most commands in Carlson Software require the selection of objects. When you need to select objects, the command line will prompt Select objects:. When you are at this prompt, your next step will be to create a selection set. While creating the selection set, the prompt Select Objects: repeats and you can continue to select objects until you press the Enter key, at which time the command you are using will continue and use the objects selected. If you are selecting object for an Eagle Point Software command, the objects selected will be then used for that command.

Selection Sets

There are several ways to create a selection set from the Select objects: prompt. With all selection methods, the number of objects selected will be displayed in the command line along with any objects that were duplicated. Following are the most commonly used methods for creating a selection set:

Single

A single selection is made when you move the object selection target to an object on the screen and click on it. The selected object will highlight and the select objects prompt will return. The cursor changes to a small square when the command line displays Select objects:.

Window

A Window will select all objects completely inside of the rectangle drawn. Create a window by selecting a point on the view screen and then moving the cursor right. The window will display as a solid rectangle. You can also create a window by typing W at the select object prompt. In this case you can move the cursor to the left to create the window.

Crossing

A crossing will select all objects within the rectangle as well as those touched by the rectangle. If you select a point on the view screen and move the cursor to the left, you are creating a crossing. The crossing will display as a dashed rectangle. You can force a crossing by typing C at the select objects prompt, allowing you to move the cursor to the right and create the crossing.

Previous

After you select several objects, they will be temporarily stored as a selection set. Should you want to re-use the same objects that were selected by the last command, you can type P at the Select objects: prompt.

Remove
If you select incorrect objects, you can type `R` to remove objects from the selection set. When you are in Remove mode, the prompt will be Remove objects:. Click on the objects that you do not want to include in your selection. To return to select or add mode, type `A` at the command line.

**Grips**

Objects may also be selected before issuing the command and receiving the `Select objects:` prompt. This selection will turn on Carlson Software "grips." Grips appear as small blue squares in the drawing. All objects with grips will be used when a command is issued. Grips are turned on similar to selecting objects as described in the previous section, but with the command line at the `Command:` prompt, not the `Select Objects:` prompt. You can select single objects by clicking on an object with the standard cursor or you can select multiple objects by clicking in the view where there are no objects, then creating the window (right) or crossing (left). To remove grips, press the `Esc` key twice.

**Using Grips**

Grips can also be used to edit or change the location of objects in the drawing. Move your cursor to a grip and click. You should notice the cursor "snap" to the grip. The grip will turn from blue to red. The object grip is now attached to the cursor so you can move the object to the desired location and release it by clicking again.

**Properties and Layers**

Properties define how an object in Carlson Software is stored. One of the most common properties is the Layer. Layers can be turned off or frozen so the objects on that layer are hidden from the view of the drawing. Layers that are turned off can still be selected while frozen layers are essentially removed from the working set of the drawing. After layers are turned off or on, a redraw (which is done automatically) will update the view. A redraw of a file is a rather quick process. After a frozen layer is thawed, a regeneration may be required to update the view. Regenerations on large files may take a considerable amount of time depending on your hardware.

**Layer Dialog Box**

The Layer dialog box provides control of the drawing layers. You can turn layers on, off, freeze or thaw them, change the layer color and linetype, set the current layer, add new layers, delete layers, etc. To perform any of these functions, click on the Layers button.

In the Layer dialog box, you can highlight several individual layers to perform actions on at once by holding down the Control key and clicking on the desired layers. You can also highlight a continuous range of layers by highlighting one layer, holding down the Shift key, and clicking on another layer. All layers between the two will be selected. To select all of the layers, hold down the CTRL key and press A on the keyboard.

**Layer Drop List**

To turn layers on/off or freeze/thaw, you can also use the drop list on the toolbars. When you click on the symbols in the list, the layer's status will be changed appropriately.

**Setting Current Layer**

The current layer will be the one shown in the Layer drop list box. You can change the current layer by selecting the desired current layer from the drop list. You can also use the Set Current Layer button and select an object on the
layer. The layer the object is on will become the current layer. Finally, you can highlight a layer in the Layer dialog box and click on the **Current** button to make the highlighted layer current.

You cannot freeze the current layer, but you can turn that layer off (not recommended).

**Changing Properties**

To change the properties of an object in the drawing, use the Properties button on the toolbar or the Change command from the command line. This command will allow you to change the layer an object is on, the color or linetype of the object. The color and linetype can be set to bylayer or to a specific setting. Bylayer means that when the property for a layer is changed, so does the property for the object. For example, the specific setting of an object may be the color blue. No matter what color you set for the layer the object is on, that object will be blue.

**Properties Toolbar**

![Properties Toolbar Image]

If this toolbar (or any toolbar) is not displayed, you can open it using the Toolbars dialog box. Type `toolbars` at the command line.

**Layer**

The Layer dialog box is used to modify layers properties (color or linetype) or status (on/off, freeze/thaw).

*Key-in:* LA or `ddlmodes`

*Toolbar:* 

**Current Layer**

The Current Layer is the layer that you are on and will be working with. The Current Layer is the one shown in the Layer drop list. For example, in the above toolbar illustration, the Current Layer is **Water**.

*Toolbar:* 

**Change**

The Change command allows you to modify the properties of an object, such as layer and color.

*Key-in:* CH

*Toolbar:* 

The Carlson Software programs share some of the same pull-down menus, such as File, Edit, View, Draw, Settings and Points. Within each program, the other pull-down menus, typically, are specific to that program. The common pull-down menus contain general commands that are applicable within all programs. Many of these commands are AutoCAD commands which are described in your AutoCAD Reference manual. The Carlson commands located in the more common pull-down menus are explained in the next sections.

All the options on the File menu not described here are AutoCAD commands, which are discussed in the AutoCAD Reference Manual.
New

This command allows you to create a new drawing file. This routine defines the settings for a new drawing. You can start a new drawing file by selecting New, and then picking a template file. SURV.DWT is the default template file for use in Carlson Survey. After choosing the template, click the Open button at the lower-right. Next, you will either see the New Drawing Wizard dialog box or you will be taken to a blank screen. Should you use the wizard, a new drawing name will need to be chosen in order to get to the next step.

There are two methods that you can use to create a new drawing. One is this New command. The other is Open, also under the File pulldown menu. If you need to open an existing drawing, use the OPEN command, under File, then choose an existing file name.

The opening dialog, Select Template, lists all template files that currently exist in the drawing template file location. Choose a file to use as a starting point for your new drawing. A preview image of the selected file is displayed to the right. If the wizard is in use, the following options will be available to you in the New Drawing Wizard dialog. The New command starts a new drawing using default settings defined in either the surv.dwt or surviso.dwt template, depending on the measurement system you've chosen. You cannot modify the surv.dwt or surviso.dwt templates. To start a new drawing based on a customized template, see Use a Template.
English: This option starts a new drawing based on the Imperial measurement system. The drawing is based on the surv.dwt template, and the default drawing boundary (the drawing limits) is 12 × 9 inches.

Metric: This option starts a new drawing based on the metric measurement system. The drawing is based on the surviso.dwt template, and the default drawing boundary (the drawing limits) is 429 × 297 millimeters.

The New command creates a new drawing using the settings defined in a template drawing you select. Template drawings store all the settings for a drawing and may also include predefined layers, dimension styles, and views. Template drawings are distinguished from other drawing files by the .DWT file extension. They are normally kept in the template directory. Several template drawings are included with Carlson Survey. You can make additional template drawings by changing the extensions of drawing file names to .DWT.

Pulldown Menu Location: File
Keyboard Command: new
Prerequisite: None

Open

Function

This command allows you to open an existing drawing file. Carlson TakeOff displays the Select File dialog box (a standard file selection dialog box). Select a file and click Open.

Prerequisite: None
Keyboard Command: OPEN

Close

Function

This command allows you to close the current drawing. Carlson TakeOff closes the current drawing if there have been no changes since the drawing was last saved. If you have modified the drawing, the program prompts you to save or discard the changes. You can close a file that has been opened in Read-only mode if you have made no changes or if you are willing to discard changes. To save changes to a read-only file, you must use the SAVEAS command.

Prerequisite: None
Save

Function

If the drawing is named, Carlson TakeOff saves the drawing without requesting a file name. If the drawing is unnamed, the program displays the Save Drawing As dialog box (see SAVEAS) and saves the drawing with the file name you specify. If the drawing is read-only, use the SAVEAS command to save the changed file under a different name. This command allows you to save the drawing under the current file name or a specified name.

Prerequisite: None

Keyboard Command: SAVE or QSAVE

Save As

Function

This command allows you to save an unnamed drawing with a file name or renames the current drawing.

Carlson TakeOff displays the Save Drawing As standard file selection dialog box. Enter a file name and type. You can select any of the following file types:

- Carlson Software 2002/AutoCAD 2000 (*.dwg)
- AutoCAD R14/LT 98/LT 97 Drawing (*.dwg)
- AutoCAD R13/LT 95 Drawing (*.dwg)
- Drawing Template File (*.dwt)
- Carlson Software 2002 DXF (*.dxf)
- AutoCAD R14/LT 98/LT 97 DXF (*.dxf)
- AutoCAD R13/LT 95 DXF (*.dxf)
- AutoCAD R12/LT2 DXF (*.dxf)

Carlson TakeOff saves the file under the specified file name. If the drawing is already named, the program saves the drawing to the new file name. If you save the file as a drawing template, the program displays the Template Description dialog box, where you can provide a description for the template and set the units of measurement.

Saving a drawing in Release 14/LT 98/LT 97 format is subject to the following limitations:

- Hyperlinks are converted to Release 14 attached URLs.
- Database links and freestanding labels are converted to Release 14 links and displayable attributes.
- Database attached labels are converted to MText and leader objects, and their link information is not available. Attached labels are restored if you open the drawing in AutoCAD 2000 or later.
- Lineweight information is not available. Lineweights are restored if you open the drawing in AutoCAD 2000 or later.

Saving a drawing in Release 13/LT 95 format is subject to the following limitations:

- Lightweight polyline and hatch patterns are converted to R13 polylines and hatch patterns.
• Raster objects are displayed as bounding boxes. Raster objects are restored if the drawing is opened in AutoCAD 2000 or later.

• Draw order information is not applied for display or print.

• Xrefs that have been clipped with a boundary box are displayed in full as attached xrefs because Release 13 does not support xref clipping. Clipping is restored if the drawing is opened in AutoCAD 2000 or later.

Saving a drawing in Release 12/LT 2 DXF format is subject to the following limitations:

• Lightweight polylines and hatch patterns are converted to R12 polylines and hatch patterns.

• All solids, bodies, regions, ellipses, leaders, multilines, rays, tolerances, and xlines are converted to lines, arcs, and circles as appropriate.

• Groups, complex linetypes, OLE objects, and preview images are not displayed.

• Many objects are lost if you save a drawing as Release 12 and open it later in AutoCAD 2000 or later.

Prerequisite: None
Keyboard Command: SAVEAS

Page Setup

Function

This command allows you to configure your drawing for plotting. The Page Setup dialog box has the same options as the Plot dialog box. See the PLOT command below for a detailed description of options.

Menu Location: File
Prerequisite: None
Keyboard Command: PAGESETUP

Plot Preview

Function

This option displays the drawing as it will appear when plotted on paper. To exit the print preview, right-click and choose Exit. This command is the same as the Full Preview option under Plot.

Menu Location: File
Prerequisite: None
Keyboard Command: PREVIEW

Plot

Function

This command allows you to plot a drawing to a plotting device or file.

Carlson TakeOff displays the Plot dialog box. Choose OK to begin plotting with the current settings and display the Plot Progress dialog box.
1 The Plot dialog box includes the tabs, Plot Device and Plot Settings, and several options to customize the plot.

- **Layout Name:** This option displays the current layout name or displays "Selected layouts" if multiple tabs are selected. If the Model tab is current when you choose Plot, the Layout Name shows "Model."
- **Save Changes to Layout:** This option saves the changes you make in the Plot dialog box in the layout. This option is unavailable if multiple layouts are selected.
- **Page Setup Name:** This option displays a list of any named and saved page setups. You can choose to base the current page setup on a named page setup, or you can add a new named page setup by choosing Add.
- **Add:** This option displays the User Defined Page Setups dialog box. You can create, delete, or rename named page setups.

2 Under the Plot Device Tab you can specify the plotter to use, a plot style table, the layout or layouts to plot, and information about plotting to a file.

- **Plotter Configuration:** This field displays the currently configured plotting device, the port to which it's connected or its network location, and any additional user-defined comments about the plotter. A list of the available system printers and PC3 file names is displayed in the Name list. An icon is displayed in front of the plotting device name to identify it as a PC3 file name or a system printer.
- **Properties:** The option displays the Plotter Configuration Editor (PC3 Editor), where you can modify or view the current plotter configuration, ports, device, and media settings.
- **Hints:** This option displays information about the specific plotting device.
- **Plot Style Table (Pen Assignments):** This option sets the plot style table, edits the plot style table, or creates a new plot style table.
- **Name:** This option displays the plot style table assigned to the current Model tab or layout tab and a list of the currently available plot style tables. If more than one layout tab is selected and the selected layout tabs have different plot style tables assigned, the list displays "Varies."
• Edit: This option displays the Plot Style Table Editor, where you can edit the selected plot style table.
• New: This option displays the Add-a-Plot-Style-Table wizard, which you can use to create a new plot style table.
• Plot Stamp: This option places a plot stamp on a specified corner of each drawing and/or logs it to a file.
• On: This option turns on plot stamping.
• Settings: This option displays the Plot Stamp dialog box, where you can specify the information you want applied to the plot stamp, such as drawing name, date and time, and plot scale.
• What to Plot: This field defines the tabs to be plotted.
• Current Tab: This option plots the current Model or layout tab. If multiple tabs are selected, the tab that shows its viewing area is plotted.
• Selected Tabs: This option plots multiple preselected Model or layout tabs. To select multiple tabs, hold down CTRL while selecting the tabs. If only one tab is selected, this option is unavailable.
• All Layout Tabs: This option plots all layout tabs, regardless of which tab is selected.
• Number of Copies: This option denotes the number of copies that are plotted. If multiple layouts and copies are selected, any layouts that are set to plot to a file or AutoSpool produce a single plot.
• Plot to File: This option plots output to a file rather than to the plotter.
• File Name: This option specifies the plot file name. The default plot file name is the drawing name and the tab name, separated by a hyphen, with a .plt file extension.
• Location: This option displays the directory location where the plot file is stored. The default location is the directory where the drawing file resides.
• [...] option displays a standard Browse for Folder dialog box, where you can choose the directory location to store a plot file.

3 Under the Plot Settings Tab you specify paper size, orientation, plot area and scale, offset, and other options.
• Paper Size and Paper Units: This field displays standard paper sizes available for the selected plotting device. Actual paper sizes are indicated by the width (X axis direction) and height (Y axis direction). If no plotter is selected, the full standard paper size list is displayed and available for selection. A default paper size is set for the plotting device when you create a PC3 file with the Add-a-Plotter wizard. The paper size you select is saved with a layout and overrides the PC3 file settings. If you are plotting a raster image, such as a BMP or TIFF file, the size of the plot is specified in pixels, not in inches or millimeters.

• Plot Device: This field displays the name of the currently selected plot device.

• Paper Size: This field displays a list of the available paper sizes.

• Printable Area: This field displays the actual area on the paper that is used for the plot based on the current paper size.

• Inches: This option allows you to specify inches for the plotting units.

• MM: This option allows you to specify millimeters for the plotting units.

• Drawing Orientation: This option specifies the orientation of the drawing on the paper for plotters that support landscape or portrait orientation. You can change the drawing orientation to achieve a 0-, 90-, 180-, or 270-degree plot rotation by selecting Portrait, Landscape, or Plot Upside-Down. The paper icon represents the media orientation of the selected paper. The letter icon represents the orientation of the drawing on the page.

• Portrait: This option orients and plots the drawing so that the short edge of the paper represents the top of the page.

• Landscape: This option orients and plots the drawing so that the long edge of the paper represents the top of the page.

• Plot Upside-Down: This option orients and plots the drawing upside down.

• Plot Area: This option specifies the portion of the drawing to be plotted.

• Layout: This option plots everything within the margins of the specified paper size, with the origin calculated from 0,0 in the layout. Available only when a layout is selected. If you choose to turn off the paper image and layout background on the Display tab of the Options dialog box, the Layouts selection becomes Limits.

• Limits: This option plots the entire drawing area defined by the drawing limits. If the current viewport does not display a plan view, this option has the same effect as the Extents option. Available only when the Model tab is selected.

• Extents: This option plots the portion of the current space of the drawing that contains objects. All geometry in the current space is plotted. TakeOff may regenerate the drawing to recalculate the extents before plotting.

• Display: This option plots the view in the current viewport in the selected Model tab or the current paper space view in the layout.

• View: This option plots a previously saved view. You can select a named view from the list provided. If there are no saved views in the drawing, this option is unavailable.

• Window: This option plots any portion of the drawing you specify. If you select Window, the Window button becomes available. Choose the Window button to use the pointing device to specify the two corners of the area to be plotted or enter coordinate values.

• Plot Scale: This option controls the plot area. The default scale setting is 1:1 when plotting a layout. The default setting is Scaled to Fit when plotting a Model tab. When you select a standard scale, the scale is displayed in Custom.

• Scale: This option defines the exact scale for the plot. The four most recently used standard scales are displayed at the top of the list.
• Custom: This option creates a custom scale. You can create a custom scale by entering the number of inches or millimeters equal to the number of drawing units.

• Scale Lineweights: This option scales lineweights in proportion to the plot scale. Lineweights normally specify the linewidth of printed objects and are plotted with the linewidth size regardless of the plot scale.

• Plot Offset: This field specifies an offset of the plotting area from the lower-left corner of the paper. In a layout, the lower-left corner of a specified plot area is positioned at the lower-left margin of the paper. You can offset the origin by entering a positive or negative value. The plotter unit values are in inches or millimeters on the paper.

• Center the Plot: This option automatically calculates the X and Y offset values to center the plot on the paper.

• X: This field specifies the plot origin in the X direction.

• Y: This field specifies the plot origin in the Y direction.

• Plot Options: This field specifies options for lineweights, plot styles, and the current plot style table. You can select whether lineweights are plotted. By selecting Plot with Plot Styles, you plot using the object plot styles that are assigned to the geometry, as defined by the plot style table.

• Plot object lineweights: This option plots lineweights.

• Plot with Plot Styles: This option plots using the plot styles applied to objects and defined in the plot style table. All style definitions with different property characteristics are stored in the plot style tables and can be easily attached to the geometry. This setting can replace pen mapping in earlier versions of AutoCAD.

• Plot Paperspace Last: This option plots model space geometry first. Paper space geometry is usually plotted before model space geometry.

• Hide Objects: This option plots layouts with hidden lines removed for objects in the layout environment (paper space). Hidden line removal for model space objects in viewports is controlled by the Viewports Hide property in the Object Property Manager. This is displayed in the plot preview, but not in the layout.

• Full Preview: This option displays the drawing as it will appear when plotted on paper. To exit the print preview, right-click and choose Exit.

• Partial Preview: This option quickly shows an accurate representation of the effective plot area relative to the paper size and printable area. Partial preview also gives advance notice of any warnings that you might encounter when plotting. The final location of the plot depends on the plotter. Changes that modify the effective plot area include those made to the plot origin, which you define under Plot Offset on the Plot Settings tab. If you offset the origin so much that the effective area extends outside the preview area, the program displays a warning.

Prerequisite: None

Keyboard Command: PLOT

Import Xref to Current Drawing

Function

This command allows you to import external reference files (Xrefs) into the current drawing. Before Xrefs are imported, the drawing data from the Xrefs can be viewed but not modified. This import routine has a simpler method for importing than the Xref Manager command. A list is shown of the Xrefs that are attached to the current drawing. If the Xref file is not found, you can pick the Set Path button to locate the drawing file. To import an Xref, highlight the file name and Pick Import.
**Prerequisite:** files to import

**Keyboard Command:** `import_xref`

**Xref Manager**

**Function**

Attaches, overlays, lists, binds, detaches, reloads, unloads, renames, and modifies paths to external references (Xrefs) in the current (or host) drawing. Displays the Xrefs in the drawing in a tree view or a list view. You can use the F3 and F4 keys to switch between list view and tree view.
**List View:** Displays a flat listing of the attached Xrefs and their associated data. You can sort the list of references by name, status, type, file date, file size, or the saved path and file name.

**Reference Name:** Lists the names of the Xrefs as stored in the definition table for the drawing. **Status:** Shows whether the Xref is loaded, unloaded, unreferenced, not found, unresolved, orphaned, or marked for unloading or reloading.

- **Loaded:** Currently attached to the drawing.
- **Unloaded:** Marked to be unloaded from the drawing once the Xref Manager is closed.
- **Unreferenced:** Attached to the drawing but erased.
- **Not Found:** No longer exists in the valid search paths.
- **Unresolved:** Cannot be read by AutoCAD.
- **Orphaned:** Attached to another Xref that is unreferenced, unresolved, or not found.

**Size:** Shows the file size of the corresponding reference drawing. The size is not displayed if the Xref is unloaded, not found, or unresolved.

**Type:** Indicates whether the Xref is an attachment or an overlay.

**Date:** Displays the last date the associated drawing was modified. This date is not displayed if the Xref is unloaded, not found, or unresolved.

**Saved Path:** Shows the saved path of the associated Xref (this is not necessarily where the Xref is found).

**Tree View:** Displays a hierarchical representation of the Xrefs, displaying the relationships between Xref definitions. Tree view shows the level of nesting relationship of the attached Xrefs, whether they are attached or overlaid, and whether they are loaded, unloaded, marked for reload or unload, or not found, unresolved, or unreferenced.

**Attach:** Displays the External Reference dialog box if an external reference is selected or displays the Select Reference File dialog box if no external reference is selected.

**Detach:** Detaches one or more Xrefs from your drawing, erasing all instances of a specified Xref and marking the Xref definition for deletion from the symbol table. Only the Xrefs attached or overlaid directly to the current drawing can be detached; nested Xrefs cannot be detached. Carlson TakeOff cannot detach an Xref referenced by another Xref or block.

**Reload:** Marks one or more Xrefs for reloading. This option rereads and displays the most recently saved version of the drawing.

**Unload:** Unloads one or more Xrefs. Unloaded Xrefs can be easily reloaded. Unlike detaching, unloading does not remove the Xref permanently. It merely suppresses the display and regeneration of the Xref definition to improve performance.

**Bind:** Displays the Bind Xrefs dialog box Xref. The Bind option makes the selected Xrefand its dependent symbols (such as blocks, teXref styles, dimension styles, layers, and linetypes) a part of the current drawing.

**Found At:** Displays the full path of the currently selected Xref. This is where the Xref is actually found and is not necessarily the same as the saved path.

**Browse:** Displays the Select New Path dialog boXref (a standard file selection dialog boXref), in which you can select a different path or file name.

**Save Path:** Saves the path, as it appears in XrefFound At, to the currently selected Xref.
Prompts

Command: \_Xref
Overlay Xref "example1": ..\..\..\..\Program Files\Carlson TakeOff
2004\WORK\example1.dwg
"example1" loaded: G:\oem4\src2\work\example1.dwg

Specify insertion point or [Scale/X/Y/Z/Rotate/PScale/PX/PY/PZ/PRotate]:
Command: Specify opposite corner:
Select objects: Enter

Prerequisite: multiple files

Keyboard Command: Xref

Import/Export LandXML Files

This command performs two functions: Export Carlson files to LandXML and Import LandXML files into Carlson. This command supports version 1.0 of LandXML and the following Carlson file types: Coordinate (.CRD) files, Centerline (.CL) files, Profile (.PRO) files, Section (.SCT) files, Grid (.GRD) files, Triangulation (.FLT) files, and Lot (.LOT) files.

Export to LandXML: Allows you to export a Carlson file to LandXML. Choose a new or existing LandXML file, then choose an existing Carlson file.
Import to Carlson: Allows you to import a LandXML file into Carlson. First, choose a new or existing Carlson file, then choose an existing LandXML file.

You first see the Import/Export LandXML dialog. To Export, for example, first click Export to LandXML. Then click Current Drawing Data Files button. You will then see the Select LandXML File dialog box. Select an existing .XML file to be exported from the list of files on the right and click Open.
The next dialog appears, showing the new buttons to be used for the Export. Choose the Add, Remove, Change Directory and/or Report buttons, and then Continue.

Choosing the Continue button takes you further into the Export process. The Report button will give you the Report Formatter Options dialog box.

Data protection is turned on by default, meaning that if you are importing/exporting to an existing file, you will be prompted before the program overwrites existing data. There is a Point Protection option that will not allow any points to be overwritten if the same number appears more than once in the XML file being imported. If you decide to Import From LandXML, go back to the opening dialog and choose the existing LandXML file.

**Pulldown Menu Location:** File  
**Keyboard Command:** imp_exp  
**Prerequisite:** Files to convert
Write Polyline File

This command creates a polyline file that contains the point data of the select polylines. The objects supported by this tool include polylines, arcs and lines. If you want to include text, you must use the Text Explode To Polylines command found in the Edit menu to convert the text to polylines before running this command. This polyline file is a text file that has three formats. The Carlson format (.PLN) is used by some Carlson commands and by machine control (Carlson Grade, Dozer 2000, GradeStar) for the plan view. Each polyline begins with a line of "POLYLINE, Color number". Then the points for the polyline are listed on separate lines in X,Y,Z format. Here is a list of the available color numbers:

0 = Black 8 = Dark Gray
1 = Blue  9 = Light Blue
2 = Green 10 = Light Green
3 = Cyan 11 = Light Cyan
4 = Red  12 = Light Red
5 = Magenta 13 = Light Magenta
6 = Brown 14 = Yellow
7 = Light Gray 15 = White

The MicroStation format (.txt) can be imported into MicroStation. This format has the coordinates as space delimited for each polyline point. There is an extra column with a 1 or 0 where 1 specifies the start of a new polyline. The DTM and Idan formats create linework files for the DTM and Idan programs.

Prompts

Polyline file format [Carlson>/DTM/Idan/MicroStation]? press Enter for Carlson format
Specify File to Write dialog create a new file or append to existing
Polyline file for Grid File Utilities macro [Yes/<No>]? press Enter The option will write a polyline file that can be used with Grid File Utilities for inclusion/exclusion perimeters.
Include Z coordinate in polyline file [Yes/<No>]? press Enter This option controls whether the polyline vertices are written in 2D or 3D.
Specify Exclusion/Warning Polylines [Yes/<No>]? press Enter This option applies to machine control for warning areas.
Specify WorkZone Polylines [Yes/<No>]? press Enter This option applies to machine control for working areas.
Reduce Polyline Vertices [Yes/<No>]? press Enter This option applies Reduce Polyline to the polyline vertices before writing the file.
Enter reduce offset cutoff <0.1>: press Enter
Decimal places for coordinates <2>: press Enter
Select polylines, lines and arcs to write.
Select objects: pick the entities to process
Done.

Sample Polyline File:

POLYLINE,15
47639.82,74540.11,0.00
Draw Polyline File

This command draws polylines from the selected polyline file. These polylines are drawn in the current layer. This command supports the following formats: Carlson (.PLN), Idan (.DIS), MicroStation (.TXT), MOSS (.INP, .PRN) and Topcon Pocket 3D (.TXT).

Prompts

Polyline File to Read Dialog select existing .PLN file

Clipboard

Function

This command allows for different cut, copy, and paste options.

Cut

To cut objects to the Clipboard.

• Select the objects you want to cut.

• From the Clipboard command, choose Cut.

The objects are available to be pasted into other Windows applications.

Copy

To copy objects to the Clipboard.

• Select the objects you want to copy.
• From the Clipboard command, choose Copy.

**Copy with Base Point**

To copy objects to the Clipboard. When the objects are pasted into a drawing, the program places them relative to the specified base point.

• Select the objects you want to copy.
• From the Clipboard command, choose Copy with Base Point.
• Specify the base point.

**Paste**

The objects currently on the Clipboard are pasted into the drawing at the specified insertion point.

• From Clipboard command, choose Paste.

**Paste as Block**

The objects currently on the Clipboard are pasted into the drawing as a block at the specified insertion point.

• From Clipboard command, choose Paste as Block.

**Paste to Original Coordinates**

The objects currently on the Clipboard are pasted into the drawing using the coordinates from the original drawing.

• From Clipboard command, choose Paste to Original Coordinates.

**Drawing Cleanup**

The Drawing Cleanup dialog box allows you to perform many functions that fix common errors, and it removes unnecessary data found in many drawing files. It also converts incompatible data into useful entities. This command offers many filters that audit the drawing file and allows you to select which options and settings you want to use. A report of the cleanup results will be displayed upon completion. Always save your file when the drawing cleanup routine is complete.
Set UCS to World Coordinates
This sets the UCS (user coordinate system) to the world coordinate system (WCS). Carlson works exclusively in the world coordinate system and there is no way to change this setting. In AutoCAD, it is possible to change the coordinate system from WCS. If you receive a drawing in which the coordinate system is not set to world, click this on to restore the UCS.

Remove Layers With No Entities
AutoCAD drawings work with a "BYLAYER" concept meaning that layer definitions define the drawing. For example, the layer named EOP might be used to display polylines at the Edge Of Pavement in the drawing. Many times extra layers get defined by a user but not used to display any objects. This function removes any layers defined in the drawing that are not being used.

Remove Unused Blocks, Linetypes and Styles
This functions removes this unused information from the drawing.

Remove Zero Length Linework
This function seeks out and removes any linework definition that have zero length. Point nodes are not removed.

Remove Duplicate Linework
This function finds any duplicate linework in the drawing and removes all but one set.

Remove Overlapping Polyline Loops
Polylines that completely overlap themselves are broken into two different polylines.

Join Linework With Same Endpoint
This function finds common endpoints on linework on common layers with common elevations and joins the linework into a continuous polylines. This is very helpful for future selection sets.
Convert Splines, Multilines and Regions Into Polylines
Some CAD applications utilize Spline Object Definitions and Regions. Carlson utilizes basic polyline/polygon definitions. This function finds any Splines and/or Regions defined in the drawing and re-defines them as simple polylines or polygons.

Convert Lines, Arcs, Circles, Ellipses, 3DFaces and Solids Into Polylines
By converting Lines, Arcs, Circles, Ellipses, 3D Faces, and Solids into Polylines, you can use the variety of Polyline commands available in Carlson.

Convert LDD-AEC Contours and Points Into Carlson Format
Drawings created in the Land Development Desktop CAD program can contain special objects known as LDD-AEC contours that define their topographic contour display. This function locates those special objects and re-defines them as simple 2D polylines retaining their elevation values.

Convert Entities With Extrusion To World Coordinates
Drawings created in the Land Development Desktop CAD program can contain special objects known as LDD-AEC contours that define their topographic contour display. This function locates those special objects and re-defines them as simple 2D polylines retaining their elevation values.

Erase Hatch Entities
Carlson offers many hatch display options, however hatch entities have no 3D value. This function removes all hatch entities in the original drawing to help reduce the size and clutter of the drawing file.

Remove Arcs From Polylines - Offset Cutoff
This function replaces arcs in polylines with a series of short chord segments. The purpose is to prepare the polylines for modeling since arcs need to be converted into segments to be part of the triangulation model. The density of chord segments is controlled by the offset cutoff. This cutoff represents how much the polyline can move horizontally. A smaller cutoff will result in more chord segments. The option for 3D Only controls whether only polylines at zero elevation or both zero and elevated polylines get processed. Sometimes you may want to leave the arcs in zero elevation polylines when these polylines represent road alignments and are not part of the surface model.

Reduce Polylines Vertices - Offset Cutoff
This function utilizes a predetermined offset amount and removes unnecessary polyline vertices that fall within the offset amount.
Set Elevations Outside Range to Zero and Elevation Range
This function comes with a "Scan DWG" option that audits the elevation range in the drawing file. Once the minimum and maximum elevation range has been set, manually or by a scan, all objects that fall outside the set range are moved to elevation zero. All objects at zero elevation do not contribute to the 3D model.

Entities To Process...
This allows you to run the command for the entire drawing or for a selected set.

Default
This allows you to return to the Carlson Drawing Cleanup default settings.

Final Report
This example report displays the results of drawing cleanup. Like all reports in Carlson, this report can be saved to a text file, sent directly to your printer, or pasted onto the screen as text entities.

Pulldown Menu Location: File
Keyboard Command: dwg_cleanup
Prerequisite: None
File Name: \lsp\poly3d.arx

Audit
Function
This command scans your current drawing and looks for any corruption and has the option to fix any errors.

Prerequisite: none
Keyboard Command: audit

Recover

Function

This command opens a drawing file and scans it for errors. Use this command if Carlson TakeOff crashes while using the regular Open command.

Prerequisite: none

Keyboard Command: recover

Remove Reactors

This command removes the reactor links from the selected points, text, polylines and lines. This disables the links for points to the coordinate (.CRD) file, annotation with linework and linework with points. Note that is General Settings there is a section called Object Linking. This is the specific section that contains the options for creating these reactors to the drawing entities. Reactors can be turned off for entities created later by clicking off the four link options in General Settings. To get to this dialog go to Settings > Configure > General Settings.

Prompts

Select entities to remove reactors from:
Select objects: pick the entities

Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: delreact
Prerequisite: Entities with reactors
File Name: \lsp\crdutil.arx

Remove Groups

This command is used to "ungroup" selected entities that, prior to using this command, were part of an AutoCAD group. For our purposes, we might more specifically be referring to Carlson's Point Entity Grouping feature. A group is a named selection set of objects. This routine removes selected entities from groups. It is especially useful when dealing with our Carlson points.

More on Point Entity Grouping: As mentioned in the Points chapter, remember that for each point, the point attribute block, node, and symbol can be bound together. This means that if you choose to use the Move command (or other AutoCAD tools) the entire collection moves together. This is done using the grouping functionality in AutoCAD. To disable this system altogether, go to Configure, choose General Settings, and turn off the toggle for Group Point Entities. If you need to temporarily disable grouping in a drawing, you can use the AutoCAD toggle for grouping, which is Ctrl-A. Holding down the Ctrl key, and pressing the letter A on the keyboard, activates this two-way toggle, with the current status echoed to the command prompt area.
Prompts

Select entities to remove from groups.
Select objects: select entities
Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: rmgroup
Prerequisite: Entities in group(s)
File Name: \lsp\poly3d.arx

Purge

Function

Displays a tree view summary of all named objects that can and can't be purged in the current drawing. The View Items You Can Purge and View Items You Cannot Purge options toggle the dialog box display, showing different options and tree view summaries.

Items Not Used in Drawing: Displays a tree view of all named object categories (blocks, layers, and so on) in the current drawing. A plus sign appears next to the object category names that you can purge. Clicking the plus sign or double-clicking an object category expands the tree view, displaying all unused named objects that exist for the category. To purge all unused named objects, select All Items in the tree view, and choose Purge All. To purge a specific named object category, select the category in the tree view, and choose Purge.

Confirm Each Item to Be Purged: Displays the Verify Purge dialog box when you purge an item.
Purge Nested Items: Removes all unused named objects from the drawing even if they are contained within or referenced by other unused named objects. The Verify Purge dialog box is displayed, and you can cancel or confirm the items to be purged.

Prerequisite: None

Keyboard Command: purge
In addition to AutoCAD’s powerful editing commands, the Carlson Edit menu has the additional commands which are explained in this section. Commands that are pure AutoCAD are not detailed here. They can be found in the AutoCAD manual.
Undo

Function

This command allows you to reverse the effect of previously issued commands.

Prerequisite: None

Keyboard Command: U

Redo

Function

This command allows you to reverse the effects of the previous UNDO command.

Prerequisite: None

Keyboard Command: REDO

Erase Select

Function

This command allows you to remove objects from a drawing.

Prerequisite: None

Keyboard Command: ERASE, E

Erase by Layer

This command will ERASE all the entities on the specified layers but will not delete these layers from the drawing. The command prompts for the layer name to erase and then erases all entities on that layer. In addition to typing in the layer name, you can also specify a layer to delete by picking an entity on that layer. To select layers by picking, first click the Select Layers from Screen button and then select the entities on the layers to be deleted. The Select Layers by Name button allows you to choose a layer name from a list of layers in the drawing. You can also specify which types of entities to erase. For instance, if you have both linework and points on the same layer and you want to erase only the linework, you can click off All and check Line and Polyline.
Pulldown Menu Location: Edit > Erase
Keyboard Command: ldel
Prerequisite: Something to erase
File Name: \lsp\dellayr.lsp

**Erase by Closed Polyline**

This tool is used to clean up drawing geometry at the extents of a polyline boundary. It provides options to erase adjacent geometry as well as trim geometry crossing the fence of the polyline.

First, select the boundary polyline. Only one can be selected. Designate the desired options in the following dialog. The top section of the dialog allows you to toggle which object types should be affected by the operation. Note that some of the objects, such as text and inserts, cannot be trimmed.
In the middle of the dialog is a toggle that determines whether to prompt for objects to process. If you want to isolate the drawings contents to that of the selected polyline, turn this toggle on. Note that all geometry in the drawing is effected, even geometry that is outside of the current viewport. Many users will prefer to turn this toggle off, so that they can be prompted to manipulate the geometry.

The bottom row allows you to choose whether to erase all the entities on the inside or outside of the polyline.

**Pulldown Menu Location:** Edit > Erase  
**Keyboard Command:** erasepline  
**Prerequisite:** Entities and a closed polyline  
**File Name:** \ lsp\poly3d.arx

### Erase Outside

This command erases all the entities outside of a user specified window. This can be useful if you somehow place entities way outside your drawing limits and want to easily erase them.

**Prompts**

**Pick 1st corner of window to erase outside of:** Pick point location  
**Pick 2nd corner:** Pick second point location  
**Pulldown Menu Location:** Edit > Erase  
**Keyboard Command:** eraseout  
**Prerequisite:** Entities to erase  
**File Name:** \ lsp\surv1.lsp

### Move

**Function**

This command allows you to displace objects a specified distance in a specified direction.  
**Prerequisite:** None
Keyboard Command: MOVE, M

**Standard Copy**

**Function**

This command copies all objects you select to the Clipboard. You can paste the contents of the Clipboard into a document or drawing as an OLE object.

You can also use CTRL+C to run this command. If the cursor is in the drawing area, Carlson TakeOff copies the selected objects to the Clipboard. If the cursor is on the command line or in the text window, the program copies the selected text to the Clipboard.

**Prerequisite:** None

**Keyboard Command:** COPY

**Copy To Layer**

This command is used to copy a selected entity or entities and put the copy in a specified layer. Once copied to the chosen layer the entity or entities will take on the characteristics of that layer (color, linetype, etc.).

![Select Layer Dialog]

**Prompts**

Select entities to copy.

Select objects: select entities

Select Layer dialog select a layer from list and click OK

Pulldown Menu Location: Edit > Copy

Keyboard Command: copy2layer

Prerequisite: Entities to be copied

File Name: \lsp\surv1.lsp
Copy Polyline Section

This command is used to copy a portion of a polyline, at specified points, and put the copied portion onto another layer. The portion of existing polyline that is being copied still remains as part of the original entity (with no break), while the new portion, with its chosen layer designation, is a new polyline.

Prompts

Select polyline to copy: Pick a polyline
Select first break point along polyline: Pick location on the polyline
Select second break point along polyline: Pick the second location on the same polyline
Layer name <CTR>: wall

Pulldown Menu Location: Edit > Copy
Keyboard Command: copy_pl
Prerequisite: Polyline to be copied

Standard Offset

Function

This command creates a new object at a specified distance from an existing object or through a specified point. Offset does not support 3D polylines. Use Offset 3D Polyline to offset these entities.

Prompts

1 Specify offset distance or [Through] <Through>: Press Enter
   The Through option allows you to screen pick the location of the offset. You can also enter a value for the interval of the offset.
2 Select object to offset or <exit>: select entity
3 Specify through point: pick point

Menu Location: Edit
Prerequisite: None
Keyboard Command: OFFSET

Variable Offset

This is a command to offset a polyline, with different offset amounts for each polyline segment of the same polyline. The offset distances can be variable, and you choose between a Line or a Point method at the command line.

Prompts

Vary offsets by line segments or at points [<Line>/Point]? press Enter
Select a polyline to offset (Enter for none): pick polyline
Select side to offset: pick a point on the side to offset to
As you go from segment to segment, you can enter in different offset values for each line segment.
Enter the segment horizontal offset <0.000>: 56
Enter the segment horizontal offset <56.000>: 33
Enter the segment horizontal offset <33.000>: 12
Select a polyline to offset (Enter for none): press Enter

Pulldown Menu Location: Edit > Offset
Keyboard Command: VOFFSET
Prerequisite: A polyline to offset

**Standard Explode**

**Function**

This command allows you to break a compound object into its component objects.

Results differ depending on the type of compound object you're exploding. The following is a list of objects that can be exploded and the results for each.

- **All Explodable Objects**: Produces object geometry that may look the same, but the color, linetype, and lineweight of the object may change.

- **Block**: Removes one grouping level at a time. If a block contains a polyline or a nested block, exploding the block exposes the polyline or nested block object, which must then be exploded to expose its individual objects.

Blocks with equal X, Y, and Z scales explode into their component objects. Blocks with unequal X, Y, and Z scales (nonuniformly scaled blocks) might explode into unexpected objects.

When nonuniformly scaled blocks contain objects that cannot be exploded, they are collected into an anonymous block (named with a "*E" prefix) and referenced with the nonuniform scaling. If all the objects in such a block cannot be exploded, the selected block reference will not be exploded. Body, 3D Solid, and Region entities in a nonuniformly scaled block cannot be exploded.

Exploding a block that contains attributes deletes the attribute values and redisplays the attribute definitions.

- **2D and Lightweight Polyline**: Discards any associated width or tangent information.

- **Wide Polyline**: Places the resulting lines and arcs along the center of the polyline. TakeOff discards any associated width or tangent information.

- **3D Polyline**: Explodes into line segments. Any linetype assigned to the 3D polyline is applied to each resulting line segment.

- **Text Explode to Polylines**: Explodes polylines depending on the font used for various annotations, this can make the resulting polylines more efficient in terms of vertex count.

- **Leaders**: Explodes into lines, splines, solids (arrow heads), block inserts (arrow heads, annotation blocks), Mtext, or tolerance objects, depending on the leader.

- **Mtext**: Explodes into text entities

- **Multiline**: Explodes into lines and arcs.

- **3D Solid**: Explodes planar surfaces into regions. Nonplanar surfaces explode into bodies.
• **Region**: Explodes into lines, arcs, or splines.
• **Body**: Explodes into a single-surface body (nonplanar surfaces), regions, or curves.
• **Polyface Mesh**: Explodes one-vertex meshes into a point object. Two-vertex meshes explode into a line. Three-vertex meshes explode into 3D faces.
• **Circle Within a Nonuniformly Scaled Block**: Explodes a circle within a nonuniformly scaled block into ellipses.
• **Arc Within a Nonuniformly Scaled Block**: Explodes an arc within a nonuniformly scaled block into elliptical arcs.

**Prerequisite**: None

**Keyboard Command**: EXPLODE, X

### Block Explode

This command retains the values of attributes when a block is exploded. The standard AutoCAD *Explode* command changes the attribute values back to the attribute type. For example, using *Explode*, a Carlson point block would become PNTNO, PNTELEV, PNTDESC. *Block Explode* would keep the point attribute values, such as 10, 1000.0, EP. The layer names of the exploded block attributes can be either the insert layer of the parent block or the original attribute layers from the block definition.

**Pulldown Menu Location**: Edit

**Keyboard Command**: explode2

**Prerequisite**: A block to be exploded

**File Name**: \lsp\blkattex.lsp

### Trim

**Function**

This command allows you to trim objects at a cutting edge defined by other objects.

**Prompts**

1 Select cutting edges ...

Select objects: **pick entity**

2 Select object to trim or shift-select to extend or [Project/Edge/Undo]: **select entity to be trimmed**

• **Project**: You can project the object to be trimmed in order to trim objects that do not intersect.
• **Edge**: You can project the trimming edge in order to trim objects that do not intersect.
• **Undo**: This option allows you to undo the above projections.

**Prerequisite**: None

**Keyboard Command**: TRIM, TR
Extend To Edge

Function

This command allows you to extend an object to meet another object.

Prompts

1 Select boundary edges ...
Select objects: pick entity

2 Select object to extend or shift-select to trim or [Project/Edge/Undo]: pick entity
You have the option of trimming or projecting objects and edges.

Prerequisite: None

Keyboard Command: EXTEND

Extend to Intersection

This command extends the end points of two lines and/or polylines, at the same time, to their intersection point.

Prompts

Select first line or polyline to extend: pick a line or polyline
Select second line or polyline to extend: pick another line or polyline

Before Extend to Intersection

After Extend to Intersection

Pulldown Menu Location: Edit > Extend
Keyboard Command: extint
Prerequisite: Two lines or polylines
File Name: \lsp\poly3d.arx
**Extend Arc**

This command extends an arc entity.

**Prompts**

**Pick arc to extend:** select an arc entity  
**Break Arc at Extension [Yes/No]?** N Answering Yes will create a new arc starting at the end of the existing arc.  
**Enter or pick the distance to extend:** 5 This extends the arc 5 units  
**Enter or pick the distance to extend ('U' to Undo):** press Enter to end

**Pulldown Menu Location:** Edit > Extend  
**Keyboard Command:** extarc  
**Prerequisite:** An arc  
**File Name:** \lsp\scadutil.arx

---

**Extend by Distance**

This command extends a line or polyline, or creates new lines or polylines off of an existing one. By specifying a distance, a new segment of the line or polyline can be drawn from the current position. The current position and direction along the line or polyline is indicated by an arrowhead. Extend by Distance starts by selecting an existing line or polyline. Initially, the current position will be the closest vertex to where the line or polyline was selected. Extending from the endpoint of a polyline will add a new point to that polyline, while extending from any other point will create a new polyline.

There are two modes of operation: draw mode (D) and move mode (M). When in draw mode, extending will draw line or polyline segments. In move mode, the current position arrowhead can be moved without drawing segments. The orientation of the current position arrowhead can be changed with the Right, Left, and Angle commands.

The second prompt for this command offers numerous options in the form of key letters. These key letters are listed below along with their full names and actions. The list of the Extend by Distance commands are:

- **# - Number:** Distance to draw or extend  
- **A# - Angle change:** Rotates pointer by specified number of degrees  
- **A - Align:** Rotates pointer to align with segment  
- **B - Bearing:** Sets pointer direction by bearing in format: Qdd.mmss with Q- quadrant, d-degrees, m-minutes, s-seconds (e.g. 130.1005 is NE 30 degrees, 10 minutes, and 5 seconds)  
- **C - Close:** Closes the polyline
D - **Draw Mode**: Actions draw or extend the line or polyline
E - **Extend to Edge**: Extends to intersection with a selected line or polyline
I - **Input mode**: Toggles distance input between decimal feet and feet-inches
L - **Left rotate**: Rotates counterclockwise 90 degrees
M - **Move Mode**: Actions only move the pointer
N - **Next**: Moves pointer forward to next point
O - **Open**: Opens the polyline
P - **Previous**: Moves pointer backward to previous point
R - **Right rotate**: Rotates clockwise 90 degrees
S - **Switch**: Reverses pointer direction
T# - **Total distance**: Sets current segment to specified distance
U - **Undo**: Undo the last Extend by Distance command
Z - **Zoom mode**: Toggles auto-zoom between on/off
? - **Info**: Displays lengths of current polyline

**H - Help**: The Help option also displays this Extend by Distance Commands list. **Press <Enter>:** Ends the routine

---

**Prompts**

*Select line or polyline to extend: select line or polyline near the place to extend*

**Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):** 50 The line is extended by 50 units. Use the Pick option to pick a distance.

**Pick/Horizontal Distance to Extend ([Enter] for new line):** R Rotate right 90 degrees.

**Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):** 50 The line is extended by 50 units. Use the Pick option to pick a distance.

**Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help):** press Enter

**Extend another (<Yes>/No)? No**

*Note: R50 and L10 can be used to go right 50, left 10, etc.*
The result of using the Help (H) option

**Pull-down Menu Location:** Edit > Extend

**Keyboard Command:** extend

**Prerequisite:** An existing line or polyline with at least one segment from which to start.

**File Name:** \lsp\scadutil.arx

---

**Break by Crossing Polyline**

This tool is used to break drawing geometry at the edge of a polyline boundary. It provides options to change the layers of the interior and exterior geometry after it is broken.

First, select the boundary polyline. Only one can be selected. Then select the polylines and lines to be clipped. You will be prompted for options on specifying the layers for the newly broken geometry. Respond with a "Y" if you want to specify a new layer, then enter the new layer name. If the layer name does not exist, it will be created.

**Prompts**

- **Select the clip edge polyline:** *pick a closed polyline*
- **Select the polylines and lines to be clipped.**
- **Select Objects:** *pick the entities to break*
- **Specify layer names for Inside segments (Yes/<No>)? Yes**
- **Enter a layer name for the Inside segments <0>:** *press Enter*
- **Specify layer names for Outside segments (Yes/<No>)? Yes**
- **Enter a layer name for the Outside segments <0>:** *Final*
Break Polyline at Specified Distances

This command allows you to pick a polyline and break it at a specified distances along the polyline. Following the prompts below, the beginning of the polyline in the illustration was broken into three 55-foot segments.

Prompts

Select polyline to break: *select polyline*
Total Distance: **779.429** This is the length of the polyline reported.
Distance Along Polyline For Break: **55.0**
Distance Along Polyline For Break (Enter to end): **110**
Distance Along Polyline For Break (Enter to end): **165**
Distance Along Polyline For Break (Enter to end): *press Enter*
3 polyline breaks created.
Break at Intersection

This command will break a line, arc or polyline at the intersection of another line, arc or polyline. In many cases this command is used in conjunction with the Area by Lines & Arcs command. In order to get the correct area of a figure, it is often necessary to break it from adjoining lines.

Prompts

Select Line, Arc, or Polyline to Break
Select object: select object to break
[int on] Pick Intersection to break at: pick intersection point

Pulldown Menu Location: Edit > Break
Keyboard Command: breakat
File Name: \lsp\surv1.lsp

Break, Select Object, 2nd Point

> 

Function

This command allows you to break an object by selecting the object, then the second break point. The first break point is the point where you select the object.

Prompts

1 Select object: selectentity to break
2 Specify second break point or[First point]: select second break point

Break, Select Object, Two Points

Function

This command allows you to break an object by selecting the object, then two points. First select the object, then the program will prompt you to select two points that define where the object will be broken.

Prompts

1 Select object: selectentity to break
2 Specify second break point or[First point]: First
3 Specify first break point: pick first point
4 Specify second break point: pick second point

Break, At Selected Point

Function
This command allows you to break an object by selecting the object. Only one pick is necessary since TakeOff both selects the object and treats the selection point as the break point.

**Prompts**

1 Select object: select entity to break

Select an object to break

**Prerequisite:** None

**Keyboard Command:** BREAK

---

**Change Properties**

**Function**

This command allows you to change certain properties of existing objects.

1 In the Change Properties dialog box, you must choose the properties to modify.

- **Color:** This option allows you to change the color of the object.
- **Layer:** This option allows you to change the layer of the object.
- **Linetype:** This option allows you to change the linetype of the object.
- **Linetype Scale:** This option specifies the linetype scale factor for the new linetype.
- **Thickness:** This option specifies the distance to extrude the object above or below its elevation.

Note: The Properties command allows you to modify entity specific properties such as the radius of a circle or the height of a text entity.

**Prerequisite:** None

**Keyboard Command:** DDCHPROP

---

**Change Elevations**

This command will change the elevation of selected entities. It can move the entity to a specified elevation from its current elevation (absolute) or do a differential change by adding or subtracting a value from its current elevation. If Carlson points are selected, their attribute text and z axis coordinate are changed.
Prompts

Ignore zero elevations (<Yes>/No)?  press Enter
If you answer No, then entities with elevation 0 will be changed.
[A]bsolute or [D]ifferential Change <A>: A
Elevation to change to: 125 By using the Absolute option all entities selected are changed to the elevation 125.
Select Entities for elevation change.
Select objects: C
First corner: pick a point
Other corner: pick a point
Select objects: press Enter

If Carlson points are selected, the command warns:
This command DOES NOT change the elevations in the Coordinate file!
Use Coordinate File Utilities menu option F to update the file.

Pulldown Menu Location: Edit > Change
Keyboard Command: chgelev
Prerequisite: Something to change
File Name: \lsp\scadutil.arx

Change Attribute Style

This command will globally change the text style of attributes on the drawing. This can be very useful if all the label styles (such as the point symbol attribute labels) on a drawing must be changed to accommodate a different plotting specification. The default STYLE used for the point symbol attributes is PTXT.

Under Existing Style, select the style that is currently applied to the attributes you want to change. If you are unsure of the existing text style, select the Pick Attr button, then pick an existing attribute on the screen. When the dialog returns, the text style applied to that attribute will be selected in the list.

Select the New Style that you want to apply to the attributes.

Enter a New Height for the attributes. An entry of zero (0) will not modify the existing height.

Pulldown Menu Location: Edit > Change
Keyboard Command: chgattr
**Prerequisite:** You may want to use the *LIST* command to check the current Text size.

**File Name:** \lsp\chgattr.lsp

---

**Change Style**

This command will globally change the style and height of text on the drawing. This can be very useful if all the text sizes on a drawing must be changed to accommodate a different plotting scale.

Under **Existing Style**, select the style that is currently applied to the text you want to change. If you are unsure of the existing text style, select the **Pick TEXT** button, then pick an existing text entity on the screen. When the dialog returns, the text style applied to that text entity will be selected in the list.

Select the **New Style** that you want to apply to the text.

Enter a **New Height** for the text. An entry of zero (0) will not modify the existing height.

![Change Style](image)

**Pulldown Menu Location:** Edit > Change

**Keyboard Command:** chgstyl

**Prerequisite:** Text entities

**File Name:** \lsp\chgstyl.lsp

---

**Change Block/Inserts Rotate**

This is a command to set the angle of blocks by various methods. This command optionally can change the rotation of a block by twist screen angle, azimuth, entity segment or by follow polyline. It will work with Carlson point symbol blocks, or any AutoCAD block. For example, you may receive an AutoCAD drawing from another firm, insert it in, and then want to change the rotation.

**Prompts**

Twist by [Twist screen/Azimuth/Entity segment/Follow polyline]? press Enter

Enter angle relative to current twist screen <0.0>: 30

Select Symbols to Rotate. pick symbol

---

*Chapter 5. Edit Menu*
**Change Block/Inserts Substitute**

This command is used to replace selected block(s) with a different block. The command optionally can change the size and rotation angle. This command will work with Carlson point symbol blocks, or any AutoCAD block. For example, you may receive an AutoCAD drawing from another firm and want to replace certain inserts with inserts of your own specification. In the dialog shown, we are replacing the block named NASTAR with a block named COHNORTH, which will be inserted at 50 scale and zero rotation.

- **Existing Block:** Select the block name to be replaced. If the block name is unknown, choose the Select from Screen button, then select the block from the current drawing.
- **Replace With:** Select the block that will replace the existing block. You may choose from the list of defined blocks, select an existing block from the current drawing, choose a point symbol from the standard Carlson point library, or select an AutoCAD drawing file.
- **Retain Size and Rotation:** When checked, the new block will retain the size and rotation values from the old block.
- **New Size:** Available if Retain Size and Rotation is not checked. Enter the size for the new block.
- **New Rotation Angle:** Available if Retain Size and Rotation is not checked. Enter the rotation angle for the new block.

**Pulldown Menu Location:** Edit > Change > Block/Inserts

**Keyboard Command:** `TWISTSYM`

**Prerequisite:** None

**File Name:** `\lsp\chgblk.lsp`
Change Block/Inserts Resize

This command resizes blocks inserts while maintaining their insertion position. When prompted to select objects, choose the inserts to resize. Note that this routine does not rescale attributes that may be associated with the selected inserts.

Prompts

Scaling Multiplier <0.5>: Enter the size scale factor.
Select symbols and blocks to scale.
Select objects: select entities
Pulldown Menu Location: Edit > Change > Block/Inserts
Keyboard Command: sizeblk
Prerequisite: block/inserts in drawing
File Name: \lsp\sizeblk.lsp

Pivot Point Rotate by Bearing

This command allows you to rotate the selected entities from the drawing. The rotation angle is defined by the difference between a reference line and an entered bearing or azimuth. The reference line is defined by two points that can be picked on the screen or entered by point number.

Prompts

Select entities to rotate.
Select objects: select the entities
Base pivot point ?
Pick point or point number: 2 The program then reads the coordinate value for pt#2 from the current CRD file.
Reference Bearing point ?
Pick point or point number: pick a point
Reference Bearing N 44d31'1'' E The program then displays the reference bearing defined by the two points selected.
Azimuth/<Bearing (Qdd.mmss)>: 245.3030 Enter an A to input an Azimuth or enter the bearing. The above response is a bearing of South 45 degrees, 30 minutes, and 30 seconds East. The program then rotates the database to the new bearing.

If Carlson Points are selected the program warns:
This command DOES NOT change the coordinates in the CooRDinate file!
Use CooRDinate File Utilities menu, Update CRD from Drawing.
This warning applies if the points entities are not linked to the CRD file. This link option is set in the Configure command.

Pulldown Menu Location: Edit > Rotate
Keyboard Command: brot
Prerequisite: None
File Name: \lsp\scrot.lsp
Rotate by Pick

Function

This command allows you to move objects about a base point using a point as a rotation reference.

Prompts

1 Select objects: **pick entities**
2 Specify base point: pick point on screen as reference
3 Specify rotation angle or [Reference]: **rotate to desired location**

Prerequisite: None

Keyboard Command: ROTATE

Entity Insertion Point Rotate

This command allows you to rotate the selected entities from the drawing where they will follow one of the following alignments: Twist screen, Azimuth, Entity Segment, Follow or Pick.

Prompts

**Rotate by [<Twist screen>/Azimuth/Entity segment/Follow/Pick]? F**

Select polyline to follow: **pick a polyline**

Select Entities to Rotate.

Select objects: **pick entities to rotate**

Flip text for twist screen [Yes/<No>]? Y

Rotating ....

Pulldown Menu Location: Edit > Rotate

Keyboard Command: ss_twist

Prerequisite: None

File Name: \lsp\scrot.lsp

2D Scale

This command will scale the selected entities using specified scale factor and base point. This 2D Scale function is the same as the AutoCAD Scale function except that this 2D Scale function only scales the entities in the x,y coordinates and does not change the elevations of the entities. One application of this routine is to convert a drawing from architectural to decimal units when the architectural units have the drawing x,y coordinates in inches and the elevations in feet. In this case, 2D Scale can be used to apply a 1/12 scale factor (0.08333333) to convert the inches to feet for the x,y coordinates and leave the elevations unchanged.

Prompts

Select entities to scale.

Select objects: **pick entities to process**
Specify base point: 0.0
Specify scale factor: 0.0833333333

Pulldown Menu Location: Edit > Scale
Keyboard Command: scscale
Prerequisite: None
File Name: \lsp\surv1.lsp

Scale

Function

This command allows you to enlarge or reduce selected objects equally in the X, Y, and Z directions.

Prompts

1 Select objects: pick entities
2 Specify base point: pick point on screen as reference
3 Specify scale factor or [Reference]: scale to desired size

Prerequisite: None
Keyboard Command: SC

Edit Text

Function

This command allows you to edit text and attribute labels.

1 Select Text to Edit: select the text
You can modify text in provided text field.

Prerequisite: Text
Keyboard Command: EDITXT

Text Enlarge/Reduce

This command will scale text entities up or down in size. The routine prompts for a scale multiplier and a selection set of text objects. If you want to enlarge the text enter a value greater than one. If you want to reduce text enter a decimal fraction such as .5. This would reduce the text size by 50%. This command is very useful if you have set up your drawing for one plotting scale and decide to change to a new plotting scale. The Change Text Size command can alternatively be used to set the text size to a specific value.

Pulldown Menu Location: Edit > Text
Prerequisite: Text entities to be changed
Keyboard Command: txtenl
File Name: \lsp\surv1.lsp
Rotate Text

This command sets the rotation of the selected text to the current twist screen, an entered azimuth, or to align with a line or polyline. The text keeps the same insertion point and justification. The Twist Screen option sets the text rotation to align horizontal with the current twist screen. With the Azimuth option you can enter the angle or pick two points to define the text rotation. The Entity segment aligns the text with a selected line or polyline segment. The Follow option aligns the text with the closest polyline segment.

Prompts

Rotate by (<Twist Screen>/Azimuth/Entity segment/Follow/Pick)? press Enter
Enter angle relative to current twist screen <0.0>: 23
Select Text to rotate.
Select objects: select the text

Pulldown Menu Location: Edit > Text
Keyboard Command: twisttxt
Prerequisite: Text
File Name: \lsp\twisttxt.lsp

Change Text Font

This command can change multiple text entities to a user specified style. The routine prompts for a selection set of TEXT and/or MTEXT objects. Once the selection is made, the Select Style dialog appears. You can then select a text Style Name, such as MONO or ROMANS, that you would like to change to. Click OK. To the right on Style Name, you can enter a style name that does not exist. If you do, it will be created for you using the font with the same name.

Pulldown Menu Location: Edit > Text
Keyboard Command: chgtxtstyle
Prerequisite: Text entities to be changed
File Name: \lsp\chgtxtst.lsp
Change Text Size

This command will change the size of the selected text objects to the user specified size. The Text Enlarge/Reduce command also changes text size. The difference is that this routine sets the text to an absolute size whereas Text Enlarge/Reduce scales, or relatively changes, the text size.

Prompts

Select the text to size.
Select objects: select the text
Enter new text size: enter value

Pulldown Menu Location: Edit > Text
Keyboard Command: chgtxtsize
Prerequisite: Text entities to be changed
File Name: \lsp\surv1.lsp

Change Text Width

This command changes the width of the selected text entities, after a new width factor is entered. The insertion point of each text entity is maintained as the routine lengthens or shortens the text.

Effect of different width factors on the same text line

Prompts

Select the text to change.
Select objects: select text entities
Enter new width factor <1.0>: enter new width factor

Pulldown Menu Location: Edit > Text
Keyboard Command: chgtxtwidth
Prerequisite: Text entities to be changed
File Name: \lsp\surv1.lsp
Change Text Oblique Angle

This command allows you to change the text oblique angle on existing text in the drawing. The oblique angle for a specific text style is defined during the creation of the style. The default value for the oblique angle for text styles is 0 until defined to another value by the user. When changing the oblique angle, a minus (-) sign in front of the angle indicates a backward slant and a positive value results in a forward slant. Remember that the reference base point for the oblique change is always 0 degree. This means that if an existing text string has an oblique angle of 20, changing the oblique angle to 25 will not add 25 degrees to the existing 20 degree oblique resulting in a text oblique angle of 45 degrees, but rather a 25 degree oblique will be established by referencing 0 oblique as the base, and then slanting the text to 25 degrees. This works the same for slanting text backward as well as forward. Below is an example showing original text created with the default oblique angle of zero, then changed to a backward slant of 20 and a forward slant of 25 degrees.

Prompts

Select the text to change.
Select objects: Select text to change oblique angle on. Note that one or more text strings can be selected. When all desired text has been selected, press Enter.
Enter new oblique angle <0.0>: Enter the desired oblique angle.

Iron Pin
Iron Pin
Iron Pin

Iron Pin
Oblique Angle = 0
Oblique Angle = -20
Oblique Angle = 25

Pulldown Menu Location: Edit > Text
Prerequisite: Text entities to be changed
Keyboard Command: chgtxtoblique
File Name: \lsp\surv1.lsp

Flip Text

This command will change the alignment of text entities by 180 degrees.

Pulldown Menu Location: Edit > Text
Keyboard Command: fliptext
Prerequisite: Text entities to be changed
File Name: \lsp\surv1.lsp

Split Text into Two Lines

This tool allows you to break a single line of TEXT into two separate lines. First, select the text string you would like to break. The Text Break dialog then appears. Initially, the slider is all the way to the right. Begin dragging it...
toward the left until it reaches the point where the split is at the desired position. Then choose OK to complete the break operation.

Text Break

This should be a paragraph break.

Result

This should be a paragraph break.

OK Cancel

Pulldown Menu Location: Edit > Text
Keyboard Command: txtbrk
Prerequisite: Text entity to break
File Name: \lsp\txtbrk.lsp

Text Explode To Polylines

This command converts the selected text into polylines. This function is generally used when preparing a plan view file for machine control, before using the Write Polyline File command.

Prompts

Select text to be EXPLODED.
Select objects: select the text
Substitute With Simple Font [<Yes>/No]? Y
1 text object(s) have been exploded to lines.
The line objects have been placed on layer 0.
Reading the selection set ...
Joining ...
Converting ...

Pulldown Menu Location: Edit > Text
Keyboard Command: textexp
Prerequisite: Text
File Names: \lsp\textexp.lsp, \lsp\poly3d.arx

Replace Text

This command will replace one text string with another. For example, if the text LEGEL is on a drawing, you could use this command to replace it with LEGAL. In AutoCAD 2000 and later, the command Find and Replace Text includes more options, including replacing partial strings and searching attributes and MTEXT.

Pulldown Menu Location: Edit > Text
Keyboard Command: chgtext
Prerequisite: Text entities to be changed
File Name: \lsp\chgtex.lsp

2D Align

This command will align (translate, rotate and scale) the selected objects using two pairs of source and destination control points. The difference between the first source point and first destination point determines the translation amount. The difference between the angle and distance from the first and second source points compared to the angle and distance from the first and second destination points determines the rotation and scale. The scale part of the alignment is optional. This 2D Align function is the same as the AutoCAD Align function except that this 2D Align function does not use elevations so that the alignment is always in 2D. The control points can be screen picked or entered by point numbers.

![2D Align diagram]

Prompts

Select entities to align.
Select objects: pick entities to process
First Source Point?
Pick point or point number: pick point 84

First Destination Point?
Pick point or point number: pick point 18

Second Source Point?
Pick point or point number: pick point 85

Second Destination Point?
Pick point or point number: pick point 19

Scale factor: 1.00434258

Scale objects based on alignment points [Yes/No]? Y

This command DOES NOT change the coordinates in the CooRDinate file!
Use Coordinate File Utilities menu, Update CRD File from Drawing.

Pulldown Menu Location: Edit > Align
Keyboard Command: scalign
Prerequisite: None
File Name: \sp\scalig.lsp

Standard Align

Function

Aligns objects with other objects in 2D and 3D

You use ALIGN to move, rotate, or scale objects into alignment with other objects. Add source points to the objects you want to align, and add destination points to the objects to which you want the source objects to align. You can add up to three pairs of source and destination points to align an object.

The first set of source and destination points defines the base point for the alignment. The second set of points defines the angle of rotation.

When you select three point pairs, you can move and rotate the selected objects in 3D to align with other objects.

If you use two source and destination points to perform a 3D alignment on nonperpendicular working planes, you get unpredictable results.

After you enter the points, Takeoff prompts you to scale the object. The program uses the distance between the first and second destination points as the reference length to which the object is scaled. Scaling is available only when you are aligning objects using two point pairs.

Prompts

1 Specify first source point: pick point
2 Specify first destination point: pick point
3 Specify second source point: pick point
4 Specify second destination point: pick point
5 Specify third source point or <continue>: Press Enter
6 Scale objects based on alignment points? [Yes/No] <N>: Press Enter

Prerequisite: None
Keyboard Command: ALIGN

**Fillet**

**Function**

This command allows you to round and fillet the edges of objects. You can enter a radius for rounding (default radius is 0). You can also trim an object that extends beyond the intersection.

![Fillet before and after](image)

FILLET rounds or fillets the edges of two arcs, circles, elliptical arcs, lines, polylines, rays, splines, or xlines with an arc of a specified radius. FILLET trims the intersecting lines to the endpoints of the fillet arc. If the selected lines do not intersect, Carlson Survey extends or trims them so that they do. FILLET also rounds or fillets the edges of 3D solids.

If both objects you want to fillet are on the same layer, the program creates the fillet line on that layer. Otherwise, the program creates the fillet line on the current layer. The same is true for the fillet color, lineweight, and linetype.

You can fillet line segments of a polyline that are adjacent, nonadjacent, intersecting, or separated by one segment. If they are nonadjacent, the polyline segments are extended to accommodate the fillet. If they are intersecting, the polyline segments are trimmed to accommodate the fillet. To create a fillet, the polyline segments must converge within the drawing limits when limits checking is on.

The result is a single polyline that includes the fillet as an arc segment. All the properties of this new polyline, such as its layer, color, and linetype, are inherited from the first polyline selected.

Filleting an associative hatch whose boundary is defined by lines removes hatch associativity. Carlson Survey maintains associativity when the boundary is a polyline.

**Prompts**

1. Select first object or [Polyline/Radius/Trim]: **select entity**
2. Select second object: **select entity**

**Menu Location:** Edit

**Prerequisite:** None

**Keyboard Command:** FILLET

---

**Mirror**

**Function**

This command allows you to create a mirror image copy of objects. The two specified points become the endpoints of a line about which the selected objects are reflected. In 3D, this line orients a mirroring plane perpendicular to the XY plane of the user coordinate system (UCS) containing the mirror line.
Prompts

1 Select Objects: select objects to be mirrored

2 Specify first point of mirror line: pick point

3 Specify second point of mirror line: pick point

4 Delete source objects? [Yes/No] <No>: Press Enter

Menu Location: Edit

Prerequisite: None

Keyboard Command: MIRROR

Properties Manager

Function

Carlson Survey displays the Properties window. The Properties window is the main method for viewing and modifying properties of AutoCAD objects.

There are some general properties common to all objects. These include Color, Layer, Linetype, Linetype Scale, Plot Style, Plot Style Table, Lineweight, and Thickness. All other object properties are specific to the type of entity. In the example below, a line has been selected. In addition to the properties mentioned above, you may modify the X, Y, and Z coordinate for each endpoint. Notice that you may not directly modify the delta, length or angle. These are read-only properties. Obviously, modifying either end point will cause these values to change.

The Properties window can be docked in the drawing area. Right-click the Properties window and choose Allow Docking or Hide to undock or hide it.

You can enter commands and work in Carlson Survey while the Properties window is open.
When you select an object in the drawing area, the Properties window displays the properties of that object. If you select multiple objects, the Properties window displays all the properties they have in common.

Object properties are displayed either alphabetically or by category, depending on the tab you choose. To modify properties using the Properties window select the object whose properties you want to change and use one of the following methods:

- Enter a new value
- Select a value from a list
- Change the property value in a dialog box
- Use the Pick Point button to change a coordinate value

The Select Objects button in the Properties window provides access to the full complement of selection methods, such as Fence and Crossing Polygon, from the Command prompt. You choose Select Objects, select the desired objects using any selection method, and press ENTER. The properties common to the selected objects are displayed in the Properties window. You can then modify the properties of the selected objects in the Properties window or you can make other changes to the selected objects by entering an editing command.

In the next example, 3 circles have been selected. Each circle has a different radius, color and linetype. Notice that these three fields do not show a default value. Remember, when multiple objects are selected, only their common properties are shown.

This last illustration shows how the properties window can be docked inside the main application window.
Menu Location: None
Prerequisite: None
Keyboard Command: Properties

**Entities to Polylines**

This command converts selected lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids into individual polylines. Use *Join Nearest* to convert adjoining lines and arcs into continuous polylines.

**Prompts**

Select lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids to convert.
Select objects: *select entities*

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: topline
Prerequisite: lines, arcs or other entities to convert
File Name: \lsp\poly3d.arx

**Reverse Polyline**

This command reverses the order of the line and/or arc segments of a POLYLINE. This can be useful in conjunction with the commands *Station Polyline, MXS by Polyline, Profile from Surface Model* or *CL File from Polyline*, since
the polyline must be plotted in the direction of increasing stations. If it is more convenient to draft a polyline in
one direction do so and then use the Reverse Polyline command to change it’s order. Temporary arrows along the
polyline are drawn to graphically show the new polyline direction.

Prompts

Select the Polyline to Reverse: pick a point on polyline

Pulldown Menu Location: Edit > Polyline Utilities

Keyboard Command: revpline

Prerequisite: A polyline

File Names: \lsp\revpline.lsp, \lsp\poly3d.arx

Reduce Polyline Vertices

This command removes points from a polyline, without significantly changing the polyline. The offset cutoff is the
maximum amount that the polyline can move horizontally and vertically when removing a point. For example, in a
polyline with three points in a straight line, the middle point can be removed without changing the polyline. This
command is explained further in the Triangulate & Contour command.

Prompts

Enter the offset cutoff <0.1>: .5

Select polylines to reduce.

Select objects: pick polylines

Processed polylines: 1

Total number of vertices: 10

Number of vertices removed: 1

Pulldown Menu Location: Edit > Polyline Utilities

Keyboard Command: reduce

Prerequisite: A polyline

File Name: \lsp\tri4.arx

Densify Polyline Vertices

This command adds vertices to the selected polylines at the specified interval. These points are interpolated between
existing points in the polyline. This command is the opposite of Reduce Polyline Vertices.

Original Polyline

After Densify Polyline Vertices
Prompts

Select polylines to densify.
Select objects: select polylines
Point interval <10.0>: press Enter
Testing Entity > 1
Added 17 points to 1 polyline.
Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: densepl
Prerequisite: A polyline
File Name: \lsp\poly3d.arx

Smooth Polyline

This command smooths the selected polylines using a modified Bezier method that makes the smooth polyline pass through all the original points and only smooths between the original points. The looping factor controls smoothing amount. A higher factor gives more looping. This command is explained further in the Surface menu section.

Prompts

Enter the looping factor (1-10) <5>: 7
Enter the offset cutoff <0.05>: press Enter This is the same reducing filter described above.
Select polylines to smooth.
Select objects: pick polylines
Smoothed 1 PolyLines
Total original vertices: 9 Total final vertices: 50
Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: smoothpl
Prerequisite: A polyline
File Name: \lsp\tri4.arx

Draw Polyline Blips

This command will draw temporary markers, "blips", at each polyline vertex. This allows you to identify the actual location of each vertex. The Blips are temporary. Any change to the viewport (pan, zoom, regen) will make the blips disappear. In later versions of AutoCAD, you can also click on the polyline to activate the grips which will remain visible during and after viewport changes.
Prompts

Select polylines to draw blips.
Select objects: select polyline(s)

Pull-down Menu Location: Edit > Polyline Utilities
Keyboard Command: plblip
Prerequisite: A polyline
File Name: \lsp\poly3d.arx

Add Intersection Points

This command adds points into lines or polylines where there are intersections. This can be useful for other commands such as Auto-annotate. For example in the drawing shown, Add Intersection Points adds points to the boundary polyline where the lot lines intersect. Then Auto Annotate for the boundary polyline will label the boundary distance along each lot. This routine does not add intersection points on arcs.

Prompts

Select lines and polylines to check.
Select objects: pick lines or polylines
Reading the selection set ...
Adding intersection points ...
Added 3 intersection points.
Add Polyline Vertex

This command adds points into a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you can pick or enter the coordinates for the new point(s). A new point is inserted into the polyline at the nearest polyline segment. On a 3D polyline, the elevation of the new vertex will be calculated for you. You can continue to pick points to add. Press Enter when you are done.

Prompts

Select polyline to add to: pick a polyline
Pick or enter point to add: pick a point
Select polyline to add to: press Enter to end

Edit Polyline Vertex

This tool allows you to make changes in the coordinates of vertices on all polyline types. Upon execution, you will be asked to select a polyline to edit. Upon selection, a temporary marker will be placed at all of the vertices of
the polyline, making them easy to distinguish. You must then pick near the vertex you wish to edit. The following
dialog appears.

At the top of the dialog it identifies the type of polyline as being 2D or 3D. In the case of 2D polylines, it allows
you convert the polyline. You have the ability to type in new northing, easting or elevation values. You can also
determine the 3D coordinate position by using distances and slope to/from adjacent points. As you change the
values in the dialog, new values for derivatives are being calculated. For example, if you change the horizontal
distances, the coordinates will change.

![Edit Polyline Vertex dialog](image)

Prompts

Select polyline to edit: pick a polyline
Pick point on polyline to edit: pick a point to be modified
Edit Polyline Vertex dialog click "Pick Position"
Pick vertex position: pick a new location for the vertex
Edit Polyline Vertex dialog click OK
Make changes as needed. You will see the polyline vertices relocated based upon the new picked positions and
coordinate changes. Use Previous and Next to move along the polyline. Note the dialog values changing.
Select polyline to edit (Enter to end): press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: editpl
Prerequisite: A polyline
File Name: \lsp\poly3d.arx
Edit Polyline Section

This command revises a segment of a polyline. Begin by picking a point on the polyline where you want to start editing. Then pick new points for the polyline. When finished picking new points press Enter, and then pick a point on the polyline to connect with the new points. The polyline segment between the start and end points is then replaced with the new points.

Prompts

Select polyline to edit: *pick the polyline at the place to start editing*
Pick intermediate point (Enter to End): *pick a point*
Pick intermediate point ('U' to Undo, Enter to End): *pick a point*
Pick intermediate point ('U' to Undo, Enter to End): *press Enter*
Pick reconnection point on polyline: *pick the polyline at the place to join*

Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: editpl2
Prerequisite: Polylines
File Name: \lsp\poly3d.arx

Remove Duplicate Polylines

This command analyzes the selected polylines and erases any duplicate polylines found. They must be exactly the same for one to be deleted.

Prompts
Select lines, arcs and polylines to process.
Select objects: select linework to process
Reading the selection set ...
Removed 1 duplicate linework entities.

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmduplwork
Prerequisite: Polylines that have duplicates
File Name: poly3d.arx

Remove Polyline Arcs

This command replaces arc segments in polylines with chords. Removing arcs is a prerequisite to some Carlson commands that don't handle arcs, such as Break by Closed Polyline and Make 3D Grid File. This process can add many vertices to the polyline. The Offset cutoff is the maximum any point on the arc will be allowed to shift.

Prompts

Select polylines to remove arcs from.
Select objects: pick polylines
Offset cutoff <0.5>: press Enter

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmarc
Prerequisite: polyline with arcs
File Name: \lsp\poly3d.arx

Remove Polyline Segment

This command removes the user specified segment from a polyline. A polyline segment is the section between two vertices of the polyline. There are two options for removing the segment. Either the two vertices of the removed segments are averaged together to keep polyline continuous, or the segment is left missing in the polyline, which creates two separate polylines. The keywords Continuous and Break respectively identify these two options. The first image is of the Original Polyline. The second is with the Continuous Removal option. The third is using the Break Removal option.
Prompts

Break polyline at removal or keep continuous (Break/<Continuous>)? press Enter
Select polyline segment to remove: pick point on polyline
Select polyline segment to remove: press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: removepl
Prerequisite: A polyline
File Names: \lsp\removepl.lsp, \lsp\poly3d.arx

Remove Polyline Vertex

This command removes vertices from a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you pick near the vertex you wish to delete. You can continue to pick vertices to delete, press Enter when you are done.

Prompts

Select polyline to remove from: pick point on polyline
Pick point to remove: pick point
Pick point to remove (Enter to end): press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmvertex
Create Polyline ID Labels

This command labels the selected polylines with either the AutoCAD "Handle", which can be seen with a list, or with unique text numbers, such as 1, 2, 3, 4, etc.. When using the Text option, the following window appears to choose the text settings.

Prompts

Select Polylines to label.
Select objects: pick polyline
Label polylines by Text or Handles [Handles/<Text>]? press Enter
Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: label.polys
Prerequisite: A polyline
File Name: \lsp\poly3d.arx

**Change Polyline Width**

This command sets the width of the selected polylines. In later versions of AutoCAD, the command `PEDIT` can also modify the width of multiple polylines.

**Prompts**

New width <1.0>: 2
Select Polylines/Contours to change width of:
Select objects: pick polylines

Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: cwidth
Prerequisite: A polyline
File Name: \lsp\surv1.lsp

**Set Polyline Origin**

This command sets the starting vertex of a closed polyline. Simply pick the polyline and then pick near the point to set as the starting point.

**Prompts**

Select Polyline: pick a polyline
Pick Near New Origin Point: pick a point on the polyline to be the starting point
Processing ...
Select Polyline: press Enter

Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: plchgorg
Prerequisite: A closed polyline
File Name: \lsp\plchgorg.lsp

**Remove Polyline Arcs**

This command replaces arc segments in polylines with chords. Removing arcs is a prerequisite to some Carlson commands that don't handle arcs, such as `Break by Closed Polyline` and `Make 3D Grid File`. This process can add many vertices to the polyline. The Offset cutoff is the maximum any point on the arc will be allowed to shift.

**Prompts**

Select polylines to remove arcs from.
Select objects: pick polylines
Offset cutoff <0.5>: press Enter
Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmarc
Prerequisite: polyline with arcs
File Name: \sp\poly3d.arx

Change Polyline Elevation

This command will change the elevation of selected entities. It can move the entity to a specified elevation from its current elevation (absolute) or do a differential change by adding or subtracting a value from its current elevation. If Carlson points are selected, their elevation attribute text and the elevation stored in the external coordinate file are changed. If the points are in the drawing at their real Z, this is also adjusted, however, if they are in the drawing at a fixed elevation, e.g. 0, the point blocks remain at that elevation.

There are options to move the changed objects to a new layer, and alternately to select a source object’s elevation to supply the value of the elevation to change the selected object(s) to.

Prompts

Type of elevation change [Absolute]/Differential]: press A to change to a specific (absolute) value, or press D to enter an amount of elevation change to apply to object’s current elevation.
Change Layer for changed entities [Yes/No]: press Enter or N to keep on same layer, press Y to change layer of object after changing elevation.
Select/<Enter Elevation <100.0000> >: 125 By using the Absolute option all entities selected are changed to the elevation 125. You may simply press Enter to keep the value shown in brackets. Press S to select a source object’s elevation for the new elevation to change the selected object(s) to.
Select objects: 1 found
Select objects: press Enter to conclude selection.
Tested 1 Entities
Carlson Software Points Changed > 1
Select/<Input another Elevation (Enter to end)>: press Enter

Pulldown Menu Location: 3D Data
Keyboard Command: chgelev
Prerequisite: Something to change
File Name: \sp\scadutil.arx

Check Elevation Range

This command analyzes a selection set of polylines, and highlights the ones that fall outside of a specified elevation range. There is an option to set the polylines that are outside of the range to zero. Every polyline vertex that is outside of the range will be highlighted with an X.
Prompts

Enter elevation range minimum: 0
Enter elevation range maximum: 4900
Select polylines to check.
Select objects: pick polylines to process
Found 1 polylines outside of elevation range.
Set polylines outside elevation range to zero elevation [Yes/<No>]? N

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: checkpl
Prerequisite: Polylines with elevations
File Names:

Highlight Crossing Plines

This command highlights selected polylines that are crossing in the drawing and have different elevations at the crossing. Every intersection point where the polylines cross are marked with a temporary X. A report is provided at the end where the X and Y of the intersection points are displayed with the two Z values and the Z difference. The command has the ability to repair crossing polylines by inserting a vertex in each polyline at the intersection and assigning a common elevation at this intersection.
Prompts

Select polylines to check.
Select objects: pick polylines to process
Ignore zero elevations [<Yes>/No]? press Enter for Yes to filter out polylines at zero elevation
Reading points ... 1677
Finding points on breaklines ...
19 crossing polylines are highlighted.
Use Report Formatter [Yes/<No>]? press Enter for No. Use the Report Formatter to customize the report layout or export to Excel.
Minimum delta Z to report <0.0>: 2
Add polyline vertices at intersections [Yes/<No>]? Y
Set 3D polyline to crossing contour elev or average elevs [Set/<Average>]? press Enter for Average. The Set option applies to crossing polylines where one polyline is a 3D polyline with varying elevations and the other polyline is a contour polyline with a fixed elevation. For this case, the Set method will hold the elevation of the contour polyline and set the 3D polyline elevation to match the contour. The Average method sets the elevation of the intersection point as the average of the crossing polyline elevations at that point.
Maximum delta Z to average <1.0>: press Enter. This option will only add the intersection point with the averaged elevation if the elevation difference is less than this tolerance.

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: xing_plines
Prerequisite: Polylines with elevations

Offset 3D Polyline

This command allows you to offset a 3D polyline entity in both the horizontal and vertical directions. There are three offset methods. The Interval method applies one horizontal and one vertical offset to all the vertices of the polyline. The Constant method has a horizontal offset and sets the elevation of the polyline to one constant elevation. The Variable method allows you to specify each horizontal and vertical offset individually either by polyline segment or for each point. The vertical offset can be specified by actual vertical distance, percent slope or slope ratio.

Prompts

Enter the offset method [<Interval>/Constant/Variable]: press Enter
Vertical/<Horizontal offset amount>: 15
Percent/Ratio/Vertical offset amount <0>: 10
Select a polyline to offset (Enter for none): select a 3D poly
Select side to offset: pick a point
Select a point on the graphics screen that is in the direction of the side of line to offset.
Select a polyline to offset (Enter for none): press Enter

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: offset3d
Prerequisite: Plot the 3D Poly lines to use for selection.
File Name: \lsp\poly3d.arx
**Fillet 3D Polyline**

This command fillets two segments of a 3D polyline with the given radius. AutoCAD's FILLET command does not support 3D Polyline entities. Since 3D polylines cannot have arcs, this command draws the fillet arc as a series of short chords. The elevations along the curve are interpolated from the 3D polyline.

**Prompts**

*Fillet corner of a polyline or intersection of two polylines [Corner]/Intersection?* press Enter  
*Enter fillet radius <10.00>:* press Enter  
*Select a corner point on polyline:* pick 3D polyline near meeting point of two segments  
*Select a corner point on polyline:* pick 3D polyline near meeting point of two segments  
*Select a corner point on polyline:* press Enter (to end command)

**Pulldown Menu Location:** Edit > 3D Polyline Utilities  
**Keyboard Command:** fillet3d  
**Prerequisite:** 3D polyline  
**File Name:** \lsp\poly3d.arx

**Join 3D Polyline**

This command joins 3DPOLY entities into a single 3D polyline entity.

**Prompts**

*Select the 3D polyline to join:* pick a 3D polyline  
*Select the other 3D polyline to join:* pick a 3D polyline that has a common endpoint with the first  
*3 segments added to the polyline.*

**Pulldown Menu Location:** Edit > 3D Polyline Utilities  
**Keyboard Command:** join3d  
**Prerequisite:** Plot the 3DPoly lines to use for selection  
**File Names:** \lsp\join3d.lsp, \lsp\poly3d.arx

**Add Points At Elevation**

This command inserts vertices into a 3D Polyline at a specific elevation, or elevation interval, by interpolating between existing elevations in the polyline.

**Prompts**

*Add single elevation or elevation interval [Single]<Interval>?* press Enter  
*Enter Elevation Interval: 50*  
*Select 3D polylines to process.* pick 3D polyline(s)  
*Select objects: 1 found*  
*Select objects:*  
*Processing polylines ...*  
*Added 10 points to polylines.*
3D Polyline by Slope on Surface

This command creates a 3D polyline at a user-specified slope. The user picks the starting point and then the polyline continues along the surface at the slope until it reaches a point where the maximum slope at the point is less than the design slope. The surface is defined by a grid or TIN file which must be created before running this routine. Applications for this command include designing haul roads or ditches.

Prompts

Enter the polyline layer \textless\textit{SLOPE\_ROAD}\textgreater : press Enter
Select the Grid File dialog
Reading row \textgreater 51
Extrapolate grid to full grid size (Yes/\textless No\textgreater )? \textit{Y}
Limiting length for polyline (Enter for none):
Pick origin point of 3D polyline: pick a starting point
Direction of 3D Polyline (\textless Up\textgreater /Down)? press EnterThe slope must go either uphill or downhill.
Direction of 3D Polyline facing up slope (\textless Left\textgreater /Right)? \textit{R} Imagine facing uphill. Do you want the polyline to go to the left or right?
Enter the design slope: 10 This value is in percent slope.

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: addplz
Prerequisite: 3D Polylines
File Name: \textls\poly3d.arx

Chapter 5. Edit Menu 126
Join Nearest

This command joins lines, arcs and/or polylines together. While AutoCAD's \textit{PEDIT-Join} command requires the endpoints to match, Join Nearest will allow you to join entities whose endpoints do not exactly meet. You specify the maximum separation distance to join, along with other options, in the dialog box shown below. Also you can join many entities at once.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{join_nearest_dialog.png}
\caption{Join Nearest Options dialog box.}
\end{figure}

- **Max Separation to Join**: Entities whose endpoints are spaced apart greater than this value will not be joined. You may use the pick button to specify this value by picking two points on the screen.
- **Max Deflection Angle (degrees)**: This option will not join any lines if the angle between them is greater than this angle in degrees.
- **Connection Method**: Determines how to connect the endpoints. See the illustration below.
  1. **Average Endpoints Together**: New vertex will be located at midpoint between two original endpoints (see illustration below on left).
  2. **Directly Connect Endpoints**: Original endpoints are connected with new segment (see the middle illustration below).
  3. **Fillet with Radius Zero**: Same as AutoCAD \textit{FILLET} command using zero radius (see the illustration on right).

- **Convert Lines and Arcs Into Polylines**: When checked, automatically converts lines and arcs into polylines. If not checked, lines and arcs are joined but remain separate entities.
- **Join Across Intersections**: This option applies to cases where more than two linework endpoints come together such as a Y intersection. In these cases, there are multiple possible connections. When this option is on, the program will automatically choose one of the possible connections. Otherwise, the program will not connect any of them.
- **Join Only Identical Layers**: When checked, only entities on the same layer will be joined.
- **Join Only Common Elevations**: When checked, only endpoints located on the same elevation will be joined.
- **Different Layer Prompt**: When Join Only Identical Layers is off, then this option will prompt for which layer to use when it finds a connection between two different layer names.
Different Elevation Prompt: When Join Only Common Elevations is off, then this option will prompt for which elevation to use when it finds a connection between two different elevations.

Pullown Menu Location: Edit  
Keyboard Command: nearjoin  
Prerequisite: Lines or polylines to be joined  
File Names: \lsp\nearjoin.lsp, \lsp\poly3d.arx

3D Entity to 2D

This command changes a 3D Line, Arc, Circle, Polyline, Insert or Point to 2D, i.e. an entity with the elevations of the endpoints at the same Z coordinate. When the program detects a 3D polyline with all vertices with the same elevation, there is an option to convert to a 2D polyline with this elevation. Otherwise, the entered elevation here is used.

Prompts

Select/<Enter Elevation <0.00>: press Enter  
Select Lines, Ares, Circles, Polylines, Inserts and Points for elevation change.  
Select objects: pick a 3D polyline  
3DPOLY to 2DPOLYLINE  
Number of entities changed > 1

Pullown Menu Location: Edit  
Keyboard Command: 3dto2d  
Prerequisite: None  
File Name: \lsp\3dto2d.lsp

Select by Filter

This command can be used to build a selection set of objects inside a drawing based on layer and entity type. When the tool is executed it displays the following dialog. Select the layer(s) on the left you wish to select, then turn on the toggle(s) for the entity types to consider. The tool then builds a selection set of those objects that resides on those layers. When you execute your command following this selection building process, when you are prompted to select objects simply enter "P" for previous.
Select by Elevation

This command builds a selection set of entities that are greater than, less than or in between a specified elevation that you enter in on the command line. Entities selected, based upon this elevation criteria, go into a selection set. With the Window selection method, the entities must be entirely inside of the inclusion area to be included in the selection set. With the Crossing selection method, an entity is added to the selection set if any part of the entity is inside the inclusion area.

Prompts

Select by greater, less or between elevations [<Greater>/Less/Between]? press Enter
Enter elevation for greater than: 19
Ignore zero elevations [<Yes>/No]? press Enter
Select objects to build selection set. pick objects
Processing selection set ...
Built selection of 120 objects for elev more than 19.00.
To use type ‘P’ at Select objects: prompt.
Select by Area

This command builds a selection set using inclusion and/or exclusion closed polylines. Entities within the inclusion polylines are selected and entities within the exclusion polylines are not selected. With the Window selection method, the entity must be entirely inside the inclusion area and entirely outside the exclusion area to be included in the selection set. With the Crossing selection method, an entity is added to the selection set if any part of the entity is inside the inclusion area.

Prompts

Select the Inclusion perimeter polylines or ENTER for none:
Select objects: pick the closed polyline
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: press Enter
Type of selection (Window/<Crossing>)? press Enter
Select objects to build selection set.
Select objects: All These selected objects are checked with the inclusion/exclusion polylines.
Select objects: press Enter
Built selection set with 43 objects.
Command: Erase
Select objects: P To use previous selection set created by Select by Area.
43 found
Select objects: press Enter

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: ssgetarea
Prerequisite: Closed perimeter polylines
File Name: \lsp\volcalc.arx

Image Frame

Function

This command controls whether TakeOff displays the image frame or hides it from view.
Because you select an image by clicking its frame, setting the image frame to off prevents you from selecting an image.

Prompts

1 Enter image frame setting [ON/OFF] <current>: enter an option or Press Enter
   • On: Displays image frames so you can select images.
   • Off: Hides image frames so you cannot select images.
Prerequisite: None
Keyboard Command: IMAGEFRAME
Image Clip

Function

This command allows you to create new clipping boundaries for an image object.

Prompts

1 Select image to clip: select the edge of an image
2 Enter image clipping option [ON/OFF/Delete/New boundary] <New>: enter an option or Press Enter

The boundary you specify must be in a plane parallel to the image object.

- **On**: Turns on clipping and displays the image clipped to the previously defined boundary.
- **Off**: Turns off clipping and displays the entire image and frame. If you reclip the image while clipping is turned off, the program automatically turns clipping back on. The program prompts you to delete the old boundary even when clipping is turned off and the clipping boundary is not visible.
- **Delete**: Removes a predefined clipping boundary and redisplays the full original image.
- **New Boundary**: Specifies a new clipping boundary. The boundary can be rectangular or polygonal, and consists only of straight line segments. When defining a clipping boundary, specify vertices within the image boundary. Self-intersecting vertices are valid. Rectangular is the default option. If you use the pointing device to specify a point at the Enter Clipping Type prompt, the program interprets the point as the first corner of a rectangle.

3 Enter clipping type [Polygonal/Rectangular] <Rectangular>: enter P or Press Enter

- **Polygonal**: Uses specified points to define a polygonal boundary.

Specify first point: Specify a point
Specify next point or [Undo]: specify a point or enter u
Specify next point or [Undo]: specify a point or enter u
Specify next point or [Close/Undo]: specify a point, or enter c or u

You must specify at least three points to define a polygon.

If the image already has a clipping boundary defined, TakeOff displays the following prompt:

Delete old boundary? [No/Yes] <Yes>: enter N or Press Enter

If you choose Yes, the program redraws the entire image and the command continues; if you choose No, the command ends.

- **Rectangular**: Specifies a rectangular boundary by its opposite corners. TakeOff always draws the rectangle parallel to the edges of the image.

Specify first corner point: specify a point
Specify opposite corner point: specify a point

Prerequisite: None

Keyboard Command: IMAGECLIP
Image Adjust

Function

This command controls the display of the brightness, contrast, and fade values of images.

The Image Adjust dialog box controls how the image is displayed by adjusting the brightness, contrast, and fade settings of the selected image. Adjusting these values changes the display of the image but does not change the image file itself.

- **Brightness**: Controls the brightness, and indirectly the contrast, of the image. Values range from 0 through 100. The greater the value, the brighter the image and the more pixels that become white when you increase contrast. Moving the slider to the left decreases the value; moving the slider to the right increases the value.

- **Contrast**: Controls the contrast, and indirectly the fading effect, of the image. Values range from 0 through 100. The greater the value, the more each pixel is forced to its primary or secondary color. Moving the slider to the left decreases the value; moving the slider to the right increases the value.

- **Fade**: Controls the fading effect of the image. Values range from 0 through 100. The greater the value, the more the image blends with the current background color. A value of 100 blends the image completely into the background. Changing the screen background color causes the image to fade to the new color. In plotting, the background color for fade is white. Moving the slider to the left decreases the value; moving the slider to the right increases the value.

- **Image Preview**: Displays a preview of the selected image. The preview image updates dynamically to reflect changes to the brightness, contrast, and fade settings.

- **Reset**: Resets values for brightness, contrast, and fade to default settings (50, 50, and 0, respectively).

**Prerequisite**: None

**Keyboard Command**: IMAGEADJUST
In addition to AutoCAD's powerful display and view commands, the Carlson View menu has some additional commands. The commands in the top section effect the screen display size and location, and the bottom section commands change layers.
Redraw

Function

This command refreshes the display in the current viewport.

Prerequisite: None

Keyboard Command: R

Regen

Function

This command regenerates the drawing and refreshes the current viewport.

Prerequisite: None

Keyboard Command: REGEN

Zoom - Window

Function

This command zooms to display an area you specify by two opposite corners of a rectangular window.

Prerequisite: None

Keyboard Command: ZOOM, W

Zoom - Dynamic

Function

This command zooms to display the generated portion of the drawing using a view box. The view box represents your viewport, which you can shrink or enlarge and move around the drawing. Positioning and sizing the view box pans or zooms the viewport, filling it with the image inside the view box.

Prerequisite: None

Keyboard Command: ZOOM, D

Zoom - Previous

Function

This command zooms to display a previous view. You can restore up to 10 previous views.

Prerequisite: None

Keyboard Command: ZOOM, P
Zoom - Center

Function

This command zooms to display a window you define by picking a center point and a magnification value or height. A smaller value for the height increases the magnification. A larger value decreases the magnification.

Prompts

1 Specify center point: **pick a point**
2 Enter magnification or height <226.66>: **enter a value**

Prerequisite: None

Keyboard Command: ZOOM, C

Zoom - Extents

Function

This command zooms to display the drawing extents. You can use Zoom Extents transparently, but it always regenerates the drawing.

Prerequisite: None

Keyboard Command: ZOOM, E

Zoom IN

Function

This command increases the zoom factor of the current viewport by a factor of 2.0.

Prerequisite: None

Keyboard Command: ZOOM, 2.0x

Zoom OUT

Function

This command decreases the zoom factor of the current viewport by a factor of 0.5.

Prerequisite: None

Keyboard Command: ZOOM, 0.5x
**Zoom Selection**

This command zooms the display to fit the selected entities. For example, if you run Viewpoint 3D and your viewport only shows two small dots of entities that are far apart, then you can use *Zoom Selection* to select the entities of one of these dots and quickly zoom the display to these entities.

**Prompts**

* Select objects to zoom onto:  
  * Select objects: select entities

Pulldown Menu Location: View
Keyboard Command: zoom_on
Prerequisite: Entities
File Name: \lsp\mineutil.arx

**Zoom Points**

This command centers the screen to a user-specified point. The point can be specified by either the point number or description. The command searches the current coordinate (.CRD) file. Besides centering the screen, the magnification can also be changed. The default value is the current magnification. To zoom in, enter a smaller value and to zoom out, enter a greater value.

**Prompts**

* Find by point number or description [<Number>/Desc]?  
  * Point number or range of point numbers to find <1>: 2079
  
We want to find point number 2079

* Magnification or Height <179.50>: press Enter

Accept the default zoom magnification

Pulldown Menu Location: View
Keyboard Command: zoompnt
Prerequisite: A .CRD file
File Names: \lsp\fpoint.lsp, \lsp\crdutil.arx

**Pan**

**Function**

This command moves the drawing display in the current viewport. The cursor changes to a hand cursor. By holding down the pick button on the pointing device, you lock the cursor to its current location relative to the viewport coordinate system. The drawing display is moved in the same direction as the cursor.

![hand cursor]

When you reach a logical extent (the edge of the drawing space), a bar is displayed on the hand cursor on the side where the extent has been reached. Depending on whether the logical extent is at the top, bottom, or side of the drawing, the bar is either horizontal (top or bottom) or vertical (left or right side).
When you release the pick button, panning stops. You can release the pick button, move the cursor to another location in the drawing, and then press the pick button again to pan the display from that location.

To stop panning at any time, press Enter or ESC.

**Prerequisite:** None

**Keyboard Command:** P

### 3D Viewer Window

This command views in 3D, the selected 3D faces, polylines, lines and points. This routine uses the OpenGL graphics library for rendering, which gives it superior performance. Some of it's features include the ability to zoom in and out, pan, rotate around the X,Y,Z axis and shade in user-positioned lighting.

#### View Control

- **Ignore Zero Elevations:** When checked, the 3D viewer ignore entities at zero elevation.
- **Color By Elevation:** This will color the contours or 3D faces by elevation. The elevation scale legend is displayed on the left of the window.
- **Vert. scale:** Sets the vertical scale factor for the 3D viewer. Flat surfaces can be exaggerated by increasing the vertical scale.
This control represents position of the sun in the sky if looked from above. Therefore, the position of the sun in the center means that the sun is in a zenith, and position near the edge of the circle means that the sun is near the horizon. To move the sun, simply drag it to a new location, or click on the new location. The slide bars on the sides are the intensity and brightness of the display.

- **Zooms IN.**
- **Zooms OUT.**
- **Switch to Dynamic Zoom mode.**
- **Switch to Pan mode. Click and drag to pan.**
- **Switch to Rotation mode.**
- **Switch to initial view.**
- **Toggles shading on and off.**
- **This is an inquire tool. Point the arrow to any entity to display entity data including the layer, type, elevation and length.**
- **Resets the 3D view to plan.**
- **Exit the 3D viewer window.**

- **Clip Plane:** This slider will clip the image based on the location of the slider. When the slider is all the way to the left, the entire image is displayed. Moving the slider to the right will clip the image, going deeper as the slider is moved to the right. This is useful to view items that are hidden behind something else.
- **Scroll Bars:** Use X,Y,Z scrollbars near the bottom to rotate the view. The range of these scrollbars is -180 to +180 degrees with middle being 0 which is the default position when the viewer starts. When the cursor is near the middle of the window, the XY icon will allow for rotating the image with the mouse, while holding the left mouse button. Move the cursor to the edge, and the icon switches to Z. This allows for rotating around the Z axis with the mouse, while holding the left mouse button.
Advanced Tab

- **Block Model Objects**: This option has three choices when loading block model entities. 1. To leave as points. 2. To Render and 3. To prompt each time. If render is selected, it will apply to all face objects such as a TIN or GRD.
- **Block Model layers**: This will display the block color scheme. Colors of the blocks can be turned on or off to view blocks in the middle.
- **Shading Mode**: There are 3 shading modes to render 3D faces. They are 1. Shade Front, 2. Shade Both, and 3. Shade Back. This will render the top and bottom of the faces if desired.
- **Display Axis Icon**: This controls whether to show the X/Y/Z axis icon in the lower left of the graphic window.
- **Display Bounding Box**: This controls whether to display a 3D box around the limits of the data.
- **Display Vertical Scale**: This controls whether to display the current vertical scale in the graphic window.

This function exports the graphic display to an image file. Several different image file formats are supported including bmp, png, jpg, xpm and gif. There is a Export Image Selections dialog to choose the image resolution and color depth.

Sets the AutoCAD view to match the view shown in the 3D viewer window.

- **Saved Views**: This option allows for naming and saving a 3D view. These can be selected from the pulldown. They can be deleted from the list.

Pulldown Menu Location: View
Keyboard Command: cube
Surface 3D Viewer

This command is identical to the 3D Viewer Window, except that this one loads a Carlson Grid GRD, TIN or FLT file. After the file is selected, the same viewer documented in 3D Viewer Window appears.

Surface 3D FlyOver

This command allows you to view a self guided animation of following a path through a 3D surface model. There are two variations to this command. When the command is started, you must specify whether you want to use a surface model from file or screen entities.

Surface model from file: Using this method, you can select either a triangulation (.TIN) file or a grid (.GRD) file, then you have the option of following a polyline or following a "free" path. If you choose the polyline method, then the animation is limited to following the polyline. If you choose the "free" path method, you first specify two points to obtain a starting direction, the while inside the viewer you can point the animation in any direction.

Screen entities: Using this method, you must select a 3D polyline to follow. The animation is limited to following the polyline.
After making the above selections, the 3D graphics window is opened. The main window is for the animation, the smaller upper right window shows you the overall plan view, and the smaller window located at middle right shows you the current elevation, slope and azimuth. While following a “free” path, you will have a 3rd small window located at lower right which shows you the amount of roll at your current position.

This button raises the elevation of your viewing position.

This button lowers the elevation of your viewing position.

This button turns your viewing position to the left.

This button turns your viewing position to the right.
This button allows you to zoom in and out.

This button allows you to rotate the main animation window in any X, Y or Z direction.

This button allows you to pan.

This button toggles shading on and off.

This button starts the animation in the main window.

This button stops the animation.

This button exits the 3D Surface FlyOver command.

Control for position of the light source, viewed from above.

**Prerequisite:** Surface Model and optionally a 3D Polyline  
**Keyboard Command:** flyby

**Viewpoint 3D**

**Function**

This command allows you to define 3D view settings.
1 Under Set Viewing Angles, you must set the direction of the view relative to either the world coordinate system (WCS) or a user coordinate system (UCS).

- **Absolute to WCS**: This option sets the view direction relative to the WCS.
- **Relative to UCS**: This option sets the view direction relative to the current UCS.

2 You must specify the viewing angles.

- **X Axis**: This field specifies the angle from the X axis.
- **XY Plane**: This field specifies the angle from the XY plane. You can also use the sample image to specify viewing angles. The black arm indicates the new angle. The red arm indicates the current angle. Specify an angle by selecting the inner region of the circle or half-circle. Selecting the bounded outer regions rounds off the angle to the value displayed in that region.
- **Set to Plan View**: This option sets the viewing angles to display the plan view relative to the selected coordinate system.

**Prerequisite**: None.

**Keyboard Command**: DDVPOINT

**Twist Screen: Standard**

This command will twist the screen orientation to where something other than the north direction is toward the top of the screen/drawing. It does not do a coordinate rotation, the drawing coordinates remain unchanged. Use commands on the *Points* menu, such as Rotate Points and Translate Points, if you want to do a coordinate rotation or translation.

**Prompts**

This routine prompts for the twist angle then adjusts the screen and cross-hairs to that angle. This is a modification of AutoCAD's DVIEW command. The twist angle is always measured counterclockwise with 0 degrees being to the east/right.
Twist Screen: Line Pline or Text

This is a variation of the previous command that allows you to select a line, polyline, or text in your drawing that you want to be aligned parallel to the east-west direction of the graphics screen. Think of the entity you select as a pointer or arrow that will point in the east direction of the screen after you select it. Select the line, polyline, or text closest to the end point which you want to be the horizontal or east direction of the screen.

Prompts

Pick a line, polyline or text to make horizontal: *pick a line or polyline*

Twist Screen: Surveyor

This is another variation of twisting the screen that allows you to input an angle/azimuth that you want to be aligned parallel to the east-west direction of the graphics screen.

Prompts

Angle to set to horizontal: *0* This would align due north with respect to real world coordinates to the east or horizontal direction of the graphics screen.
**Pulldown Menu Location:** View > Twist Screen  
**Prerequisite:** None  
**Keyboard Command:** twist3  
**File Name:** lsp\scadutil.arx

## Restore Due North

This command twists the screen to make due north vertical.

**Pulldown Menu Location:** View > Twist Screen  
**Keyboard Command:** twist4  
**Prerequisite:** None  
**File Name:** lsp\surv1.lsp

## Display Order

**Function**

This command allows you to change the display order of objects by repositioning an entity from either the background to the forefront of the drawing view or from the forefront to the background of the drawing view.

**Prerequisite:** None  
**Keyboard Command:** draworder

## Layer Control

**Function**

This command allows you to manage layers and layer properties.
This Layer Properties Manager dialog box makes a layer current, adds new layers to the layer name list, and-renames an existing layer. You can assign properties to layers, turn layers on and off, freeze and thaw layers globally or by viewport, lock and unlock layers, set plot styles for layers, and turn plotting on and off for layers. You can filter the layer names displayed in the Layer Properties Manager, and you can save and restore layer states and properties settings.

1. **Under Named Layer Filters**, you determine which layers to display in the list of layers. You can filter layers based on whether they’re xref-dependent, or whether they contain objects. You can also filter layers based on name, visibility, color, linetype, lineweight, plot style name, whether they are plotted, or whether they are frozen in the current viewport or in new viewports.

   - **[...]**: This button displays the Named Layer Filters dialog box.
   - **Invert Filter**: This option displays layers based on the opposites of the criteria you select when you are using a named layer filter. Layers that fit the inverse criteria are displayed in the layer name list.
   - **Apply to Object Properties Toolbar**: This option displays in the Object Properties toolbar only layers that match the current filter. The layer list tooltip on the Object Properties toolbar displays the filter status of layers in the drawing. (To display the layer list tooltip, position the pointing device over the layer list on the Object Properties toolbar.)
   - **New**: This option creates a new layer. After you choose New, the list displays a layer named LAYER1. You can edit this layer immediately. To create multiple layers quickly, you can select a layer name for editing and enter multiple layer names separated by commas. If you create a new layer, the new layer inherits the properties of the currently selected layer in the layer list (such as Color, and On/Off state). To create layers with default settings, make sure that there are no selected layers in the list or that you select a layer with default settings before beginning layer creation.
   - **Current**: This option sets the selected layer as the current layer. The CLAYER system variable stores the layer name.
   - **Delete**: This option deletes selected layers from the drawing file definition. You can delete only unreferenced layers. Referenced layers include layers 0 and DEFPPOINTS, layers containing objects (including objects in block
definitions), the current layer, and xref-dependent layers. Layers that don't contain objects (including objects in block definitions), are not current, and are not xref-dependent can be deleted by using the PURGE command. Be careful about deleting layers if you are working on a drawing in a shared project or one based on a set of layering standards.

- **Show/Hide Details**: This option controls whether the Details section is displayed in the Layer Properties Manager.

- **Save State**: This option displays the Save Layer States dialog box, in which you save layer state and layer properties settings of all layers in a drawing. You can choose which layer states and properties you want to preserve. You save a layer state by assigning it a name.

- **Restore State**: This option displays the Layer States Manager, in which you can manage named layer states.

2 The Layer Properties Manager dialog box displays all layers and their properties. To modify a property, click its icon. To quickly select all layers, right-click your pointing device and use the shortcut menu. The following are the layer properties you can modify:

- **Name**: This field displays the names of the layers. You can select a name, and then click and enter a new name.

- **On/Off**: This field turns layers on and off. When a layer is on, it is visible and available for plotting. When a layer is off, it is invisible and not plotted, even if Plot is on.

- **Freeze/Thaw in All Viewports**: This field freezes and thaws layers in all floating viewports. A frozen layer is invisible and excluded from regeneration, hiding objects, rendering, and plotting. A thawed layer is visible and available for regeneration, hiding objects, rendering, and plotting.

  You can freeze layers to speed up ZOOM, PAN, and many other operations, improve object selection performance, and reduce regeneration time for complex drawings. TakeOff does not display, plot, or regenerate objects on frozen layers. Objects on frozen layers do not hide objects and are not rendered.

  You can freeze layers in all viewports, in the current viewport, or in new viewports.

  Freeze layers that you want to be invisible for long periods. When you thaw a frozen layer, the program regenerates and displays the objects on that layer. If you switch between visible and invisible states frequently, use the On/Off setting.

- **Lock/Unlock**: This field locks and unlocks the layers. You cannot select or edit objects on a locked layer. Locking a layer is useful if you want to view information on a layer for reference but do not want to edit objects on that layer.

- **Color**: This field changes the color associated with the selected layers. Clicking the color name displays the Select Color dialog box.

- **Linetype**: This field changes the linetype associated with the selected layers. Clicking any linetype name displays the Select Linetype dialog box.

- **Lineweight**: This field changes the lineweight associated with the selected layers. Clicking any lineweight name displays the Lineweight dialog box.

- **Plot Style**: This field changes the plot style associated with the selected layers. If you are working with color-dependent plot styles (the PSTYLEPOLICY system variable is set to 1), you cannot change the plot style associated with a layer. Clicking any plot style displays the Select Plot Style dialog box.

- **Plot/Don't Plot**: This field controls whether the selected layers are plotted. If you turn off plotting for a layer, the objects on that layer are still displayed. Turning off plotting for a layer affects only visible layers in the drawing (layers that are on and thawed). If a layer is set to plot, but is currently frozen or off in the drawing, TakeOff does not plot the layer. Turning off plotting for layers containing reference information such as construction lines can be useful.
Prerequisite: None
Keyboard Command: LAYER

Set Layer
This command allows the user to change the current layer to a different layer by picking an entity on that layer.

Pulldown Menu Location: View
Keyboard Command: lset
Prerequisite: None
File Name: \lsp\picklayr.lsp

Change Layer
This command allows you to change the layer of a group of entities by selecting the group of entities. The layer name to assign can be either typed it or read from an existing entity by picking an entity that is on the layer that you want to change the group to.

Prompts
Select entities to be changed.
Select objects: pick entities
The Select Layer dialog appears select a layer from the list, or select Screen Pick
If Screen Pick is chosen,
Pick entity with layer to change to: pick another entity This assigns the selected entities to the layer of this entity.
or
Enter new layer name or pick entity with layer (Enter/<Pick>)? E
Enter new layer name: FINAL This assigns the selected entities to the FINAL layer.

Pulldown Menu Location: View
Keyboard Command: lchg
Prerequisite: None
File Name: \lsp\chglayr.lsp
**Freeze Layer**

This command will freeze layers by picking entities on that layer.

**Pulldown Menu Location:** View  
**Keyboard Command:** loff  
**Prerequisite:** None  
**File Name:** \lsp\loff.lsp

**Thaw Layer**

This command thaws the layers frozen by the Freeze Layer command.

**Pulldown Menu Location:** View  
**Keyboard Command:** lon  
**Prerequisite:** None  
**File Name:** \lsp\lon.lsp

**Isolate Layer**

This command freezes all the layers except the ones you select an entity on. The program prompts to see if you would like to retain the POINT layers which keeps the Carlson point layers from freezing. By default, these layers include PNTNO, PNTMARK, PNTDESC, and PNTELEV.

**Prompts**

Select objects on layers to isolate.  
Select objects: pick entities  
Retain POINT layers [Yes/No]? Press Enter

Isolate the wall layer by picking one wall line

**Pulldown Menu Location:** View  
**Keyboard Command:** isolate  
**Prerequisite:** None  
**File Name:** \lsp\isolate.lsp

**Restore Layer**

This command thaws the layers that were frozen by the Isolate Layer command.
Pulldown Menu Location: View
Keyboard Command: restore
Prerequisite: None
File Name: \lsp\restore.lsp
Most of the Draw Menu commands are AutoCAD commands for creating entities in your drawing. Carlson commands that are part of the Draw menu are documented here. Any items not appearing in the Carlson manual are AutoCAD commands that can be referenced in the AutoCAD manual.
Line

Function

This command allows you to draw a line entity by picking points on the screen or by supplying the coordinate values using the point number and associated coordinates stored in the current coordinate file. The Line command links the line with the points when the line is drawn using point numbers if the Link Linework with Points option is turned on. This option is set under General Settings in the Configure command in the Settings menu. With links active, changing a point with a command like Move Points automatically updates the line. This command always draws 2D lines with a zero elevation.

Prompts

1 Pick point or point numbers: 1-3
You may enter a single point number or a range of point numbers
2 Undo/Distance/<Pick point or point numbers>: 16
3 Undo/+/-/Close/Distance/<Pick point or point numbers>: 35
4 Undo/+/-/Close/Distance/<Pick point or point numbers>: +
The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line.
5 Perpendicular Distance Right: 80
6 Undo/+/-/Close/Distance/<Pick point or point numbers>: -
The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line.
7 Perpendicular Distance Left: 105.12
8 Undo/+/-/Close/Distance/<Pick point or point numbers>: D
The distance option allows you to input a distance for the next line segment. The position of the cursor determines the angle.
9 Enter distance: 174.32
10Undo/+/-/Close/Distance/<Pick point or point numbers>: C
The close option draws a line segment back to the original starting point

Prerequisite: None

Keyboard Command: 2DLINE

2D Polyline

A polyline is a series of line and/or arc segments joined together in one entity or object. In addition to the regular AutoCAD Draw Polyline command (PL), there is this Carlson command that has several key features and options. This command allows you to draw a polyline entity in a variety of ways, including: Continue, Extend, Follow, Arc, Direction, Close, Pick point or point numbers. This dialog shown below automatically appears when you run the command.
The **Show Options on Startup** dialog will appear every time the command is run, unless this is turned off. If you do not want it to come up, then toggle it off. In this dialog you can set the elevation of the polyline, as well as the layer it will appear on.

**Offset from centerline** allows you to make another choice. First, a unique command line appears.

[Continue/Extend/Follow/Offset/Options/\(\text{Pick point or point numbers}\)]:

**Auto-Zoom mode** regenerates the screen as you draw your polyline, to give you the best view as you are working. **Always** means it will always regenerate the screen. **Proximity** regenerates the screen according to the **Proximity Zoom Level %** value. **Never** toggles off this feature. The **Elevation** of the polyline can be set here. The default is 0. If it is off, then the last settings will apply. To get the box back, choose O for Options on the command line.

If **Use Current Drawing Layer** is on, the layer of the new polyline will be the current layer. If the current layer is not used, the **Layer** option allows you to Select from a list or Pick from the screen.

There are three options under **Auto-Zoom Mode**. **Never** will not zoom to the last point picked. **Proximity** will zoom to the percent proximity set below. **Always** will always zoom center on every point.

If the **Proximity** Auto-Zoom mode is checked, the percent of the proximity is set in the box on the right.
Annotate closed pads, when checked, will make available the Settings button on the right side. When Settings is chosen, the Annotate pad dialog appears. Here is where you can enter in values that will result in annotation for the closed polyline.

With regards the options available on the command line, they are explained as follows:

Continue allows you to run Arc, Direction, Close, Extend, or Follow for an existing polyline.

Extend allows you to extend an existing polyline by picking or entering in a distance.

Follow allows you to match the path of your polyline with an existing polyline. You are prompted to select the point in which your polyline first intersects with the existing polyline and the point in which it exits. If the existing polyline is a closed polyline than you will be prompted to approve the direction in which your polyline follows the existing closed polyline.

Options brings up the Polyline 2D Options dialog that appears when you first run the command, unless Offset from centerline is checked, in which case the letter indicates this feature, and a centerline will be requested.

Pick point allows you to pick a point on the screen to start your polyline.

Point numbers allows you to enter in coordinates to start your polyline.

Arc allows you to draw an arc by Arc length/Chord/Radius/Second point in your polyline. The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line. This is useful for plotting buildings.

Distance for an angle code, a backsight point, an angle (dd.mmss), and a distance to draw your polyline.

Close will connect the ends of your polyline making it a closed polyline.

Prompts

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: pick a point
Segment length: 0.00, Total length: 0.00

[Arc/Close/Direction/Extend/Follow/Line/Undo/<Pick point or point numbers>]: pick a point
Segment length: 3.83, Total length: 3.83

[Arc/Close/Direction/Extend/Follow/Line/Undo/<Pick point or point numbers>]: pick a point
Segment length: 2.94, Total length: 6.77 press Enter to end

Pulldown Menu Location: Draw
Keyboard Command: 2DP
Prerequisite: None
File Names: \lsp\poly3d.arx

3D Polyline

In addition to the regular AutoCAD Draw 3D Polyline command, there is this Carlson command that has several options.
The **Show Options on Startup** dialog will appear every time the command is run, unless this is turned off. If it is off, then the last settings will apply. To get the box back, choose O for Options.

**Prompt for Elevation/Slope** controls whether the elevation of each picked point will be entered in, or hit S for slope to draw a slope line.

**Use Surface Model from File** will use a grid or triangulation file as a surface model. Wherever the points are picked on the surface, the elevation of the surface will be assigned to the polyline.

If **Use Current Drawing Layer** is on, the layer of the new polyline will be the current layer.

If the current layer is not used, the **Layer** option allows you to Select from a list or Pick from the screen.

There are 3 options under **Auto-Zoom Mode**. Never will not zoom to the last point picked. Proximity will zoom to the percent proximity set below. Always will always zoom center on every point.

If the Proximity Auto-Zoom mode is checked, the percent of the proximity is set in the **Proximity Zoom Level %** box.

**Prompts**

```
[Continue/Extend/Follow/Options/<Pick point or point numbers>]: pick a point
Elevation <0.00>: 435
Z: 435.00, Hz dist: 0.00, Slope dist: 0.00, Slope: 0.0% Ratio: 0.0:1
[Arc/Direction/Close/Follow/Undo/<Pick point or point numbers>]: pick a point
Slope/Ratio/Interpolate/Degree/<Elevation> <0.00>: 444
Z: 444.00, Hz dist: 3.67, Slope dist: 9.72, Slope: 245.3% Ratio: 0.4:1
[Arc/Direction/Close/Extend/Follow/Undo/<Pick point or point numbers>]: pick a point
Slope/Ratio/Interpolate/Degree/<Elevation> <0.00>: 399
Z: 399.00, Hz dist: 3.16, Slope dist: 45.11, Slope: -1425.2% Ratio: -0.1:1
[Arc/Direction/Close/Extend/Follow/Undo/<Pick point or point numbers>]: press Enter to end
```

**Pulldown Menu Location:** Draw

**Keyboard Command:** 3DP

**Prerequisite:** None
Circle

Function

This command allows you to draw a circle.

Prompts

1 Pick center point or point number or [3P/2P/TTR]: pick point or specify option
   • 3P: This option draws a circle based on three points on the circumference.
   • 2P: This option draws a circle based on two endpoints of the diameter.
   • TTR-Tangent, Tangent, Radius: This option draws a circle with a specified radius tangent to two objects.

2 Specify radius of circle or [Diameter]: enter a value

Sometimes more than one circle matches the criteria specified in the command. The circle whose tangent points are closest to the selected points is drawn.

Prerequisite: None

Keyboard Command: SCIRCLE

3 Point

This command draws an arc between three points. The first point is the PC, the second is a point on the arc and the third is the PT. The points can either by picked on-screen or specified by point number.

Prompts

Pick PC point or point numbers: 101 (For point number 101.)
Pick Second point or point number: 102
Pick PT point or point number: 103

Pulldown Menu Location: Draw > Arc
Keyboard Command: 3PA
Prerequisite: None
File Name: \lsp\3ptarc.lsp

PC, PT, Center

This command draws an arc between the PC point, radius point and PT point. The points can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Pick PC point or point number: 101
Pick Radius point or point number: 102
Pick PT point or point number: 103
Is the direction of this arc correct? No/<Yes>: N

Pulldown Menu Location: Draw > Arc
Keyboard Command: pca
Prerequisite: None

2 Tangents, Radius

This command fits a curve between two tangent lines by entering a known radius. It prompts for the radius and then prompts to pick points on the two tangent lines.

Prompts

Radius of Arc <300.00>: press Enter
[nea] Pick Point on 1st Tangent Line: pick a point
[nea] Pick Point on 2nd Tangent Line: pick a point

PC, Radius, Chord

This command draws an arc, given the PC point, radius length, chord length and chord bearing. The PC point can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counter-clockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Radius of Arc <-40.00>: 500
PC Start Point?
Pick point or point number: pick a point
Chord bearing or chord endpoint (<Bearing>/Point)? Press Enter
Enter Bearing (Qdd.mmss) <90.0000>: 145.1041 (for NE 45d10'41")
Chord Length <200.46>: 200
Is this arc in the correct direction (<Yes>/No)? Press Enter

PC, Radius, Arc Length

This command draws an arc given the PC point, radius length, and arc length. The PC point can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counter-clockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.
Prompts

Pick PC Point or point number: pick a point
Pick Radius point or point number: pick a point
Arc length <5.00>: 150
Is this arc in the correct direction (<Yes>/No)? press Enter
Pulldown Menu Location: Draw > Arc
Keyboard Command: pra
Prerequisite: None
File Name: \lsp\cenarc.lsp

2 Tangents, Arc Length

This command fits a curve between two tangent lines and a known arc length. It prompts for the arc length then pick the P.I. (intersection of tangent lines) and points on the two tangent lines.

Prompts

Arc Length <100.00>: press Enter or enter distance
[int on] Pick P.I. of curve: pick intersection of tangent lines
[nea on] Pick pnt on 1st Tangent Line: pick a point
[nea on] Pick pnt on 2nd Tangent Line: pick a point
Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlal
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlal.lsp

2 Tangents, Chord Length

This command fits a curve between two tangent lines and a known chord length. It prompts for the chord length, the P.I. and points on the two tangent lines.

Prompts

Chord Length <100.00>: press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point
Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlcl
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlcl.lsp
2 Tangents, Mid-Ordinate

This command fits a curve between two tangent lines and a known middle ordinate. It prompts for the middle ordinate length, the Point of Intersection and points on the two tangent lines.

Prompts

Middle Ordinate <50.00>: press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlmo
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlmo.lsp

2 Tangents, External

This command fits a curve between two tangent lines and a known external secant distance. It prompts for the P.I. and points on the two tangent lines then the external distance.

Prompts

[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point
External Distance <50.00>: press Enter

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlex
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanlex.lsp
2 Tangents, Tangent Length

This command fits a curve between two tangent lines and a known curve tangent length. It prompts for the tangent length, P.I. and points on the two tangent lines.

Prompts

Tangent Length <50.00>: press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanltl
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanltl.lsp

2 Tangents, Degree of Curve

This command fits a curve between two tangent lines by entering a known degree of curve. It prompts for the degree of curve and then prompts to pick points on the two tangent lines.

Prompts

Degree of Curve (ddd.mmss) <5.0000>: press Enter
Define by [C]hord or [A]rc length <A>: press Enter
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanldo
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\2tanldo.lsp

Tangent, PC, Radius, Arc Length

This command draws a curve from a perpendicular tangent line with a known radius and arc length. It prompts for the radius, the arc length and then to pick the P.C. start point of the curve (endpoint of previously drawn tangent line) and a point along the tangent line.

Prompts

Precede radius with - sign for curve to the right.
Radius of Arc <15.00>: 55
Arc Length <25.00>: 30
PC Start Point ?
Pick point/<point Number>: 14
PtNo. North(y) East(x) Elev(z) Desc
14 4869.06 4390.3 10.00
[nea on] Pick point along perpendicular tangent line: pick a point on tangent line
Radius Point Coordinates: (4355.2 4911.4 0.0)

Pulldown Menu Location: Draw > Arc
Keyboard Command: sral
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\sral.lsp

**Tangent, PC, Radius, Tangent Length**

This command draws a curve from a perpendicular tangent line with a known radius and tangent length. It prompts for the radius, the tangent length and then to pick the P.C. start point of the curve and a point along the tangent line.

![Diagram](image)

**Prompts**

Precede radius with - sign for curve to the right.
Radius of Arc $<300.000>$: press Enter
Tangent Length $<236.000>$: press Enter
PC Start Point ?
Pick point or point number: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point
(5270.39 4840.36 0.0)
Radius Point Coordinates: (5251.37 4534.71 0.0)

Pulldown Menu Location: Draw > Arc
Keyboard Command: srtl
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\srtl.lsp

**Tang, PC, Radius, Chord Length**

This command draws a curve from a perpendicular tangent line with a known radius and chord length. It prompts for the radius, the chord length and then to pick the P.C. start point of the curve and a point along the tangent line.

**Prompts**
Precede radius with - sign for curve to the right.
Radius of Arc <300.0000>: press Enter
Chord Length <25.0000>: press Enter
PC Start Point ?
Pick point or point number: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point
(5142.38 4911.57 0.0)
Radius Point Coordinates: (5221.51 5209.63 0.0)

Pulldown Menu Location: Draw > Arc
Keyboard Command: SRCL
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\srcl.lsp

Tang, PC, Radius, Delta Angle
This command draws a curve from a perpendicular tangent line with a known radius and delta angle. It prompts for the radius, the delta angle and then to pick the P.C. start point of the curve and a point along the tangent line.

Prompts
Precede radius with - sign for curve to the right.
Radius of Arc <300.00>: press Enter
Enter Delta Angle <90.00>: press Enter
PC Start Point ?
Number/<Pick point>: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point
Pulldown Menu Location: Draw > Arc
Keyboard Command: srda
Prerequisite: Tangent lines should be drawn before execution
File Name: \lsp\srda.lsp

Compound or Reverse
Function
This command draws a compound or reverse off an existing curve. It prompts whether the curve is reverse or compound, for the P.C. start point (endpoint of an existing arc) and the known radius. Then the user selects the other known from the choices of tangent length, arc length, chord length or delta angle and enters that value. This command can be confused and malfunction if there is another entity such as a point symbol at the P.C. (If this happens, freeze the PNTMARK layer or temporarily erase the point symbol.)
Reverse curve off an existing curve

**Prompts**

[end on] Select ARC at PC Start point of the curve: *pick a point*
Type of curve [<Compound>/Reverse]: *press Enter*
Enter the Radius: 300
Define arc method [Tangent/Chord/Delta/<Length>]: *press Enter*
Enter the arc length: 236

**Pulldown Menu Location:** Draw > Arc
**Keyboard Command:** srcr
**Prerequisite:** Tangent arc should be drawn before execution
**File Name:** \lsp\srcr.lsp

**3-Radius Curve Series**

This command is used to best fit a series of three curves with different radii between 2 tangents. The "Offsets from the Tangents" is the distance perpendicular to the tangent from both ends of the second curve.
Offset from the tangents is the x value

**Prompts**

Please pick two tangents...
Pick first tangent: *pick a point*
Pick second tangent: *pick a point*

Pulldown Menu Location: Draw > Arc
Keyboard Command: 3curves
Prerequisite: Two tangents

**Best Fit Curve**

This command draws an arc between endpoints with a radius that is derived from sampling points and averaging the radius of an arc that passes though these points.

**Prompts**

Starting Point ?
Pick point or point number: *pick a point*
Ending point ?
Pick point or point number: *pick a point*
Select points from screen or by point number [<Screen>/Number]: *press Enter*
Select Points to sample.
Select objects: W Use window to select a group of points. After selecting all the points to sample, end selection by pressing Enter.

Pulldown Menu Location: Draw > Arc
Keyboard Command: bfitcrv
Prerequisite: Points for sampling should be drawn before execution.
File Name: \lsp\bfitcrv.lsp

**Curve Calc**

This Curve Calculator command displays a dialog box with a series of edit boxes that are filled in with the values of a curve. You can input two known values and the program calculates the other values. One of the known values must be the radius or the delta angle. The 3 Points option allows you to simply select three on-screen point locations. All of the fields will immediately be filled in after the picking of the third point. Optionally, you can also input point numbers from a coordinate file.

Chapter 7. Draw Menu 164
**Roadway or Railroad**: Allows you to choose which type of curve you would like information on. Toggling between the two, after data is entered, will reveal different values.

**Select**: Allows you to select an arc from the drawing. The information for the selected arc is displayed in the dialog box.

**3 Points**: Allows you to specify three points on the screen to define an arc. The information for this defined arc is displayed in the dialog box.

**Plot**: Allows you to plot the currently defined arc in the drawing.

**Clear**: Clears all edit boxes in the dialog.

### Prompts

**Curve Calculator dialog** Enter at least two values, as described above

The dialog box first pops up without any data in the fields. The above dialog graphic is a result of entering in the radius and the arc length values of a known curve, then the Enter or Tab key.

**Pulldown Menu Location**: Draw > Arc

**Keyboard Command**: curvcalc

**Prerequisite**: None

**File Names**: \lsp\curvcalc.lsp, \lsp\scadcfu.dcl

### Spiral Curve

This command plots a spiral curve. The user must provide the P.I. (point of intersection), the length of spiral and the radius length of the simple curve. The command will plot a symmetrical spiral or a spiral in or spiral out (choose the S option for the first prompt if you only want to plot a spiral out). If you have an unsymmetrical spiral then plot a spiral in using the T or P option then use the S option to plot the spiral out. The command plots a polyline to represent the spiral as line segments at the resolution specified by the user. You can use the Calculate Offsets, Station Polyline/Centerline or Offset Point Entry commands, found in the Centerline menu, to calculate points and/or stations and offsets from the spiral.

Chapter 7. Draw Menu 165
Prompts

Spiral method [TS/ST/<PI>] \( \text{press Enter} \)
PI Point ?
Pick point or point number: pick intersection of tangent lines
TS Direction point (tangent in) ?
Pick point or point number: pick point along tangent in line
ST Direction point (tangent out) ?
Pick point or point number: pick point along tangent out line
Tangent in direction= N 56d24'9'' E Azimuth= 56d24'9''
Tangent out direction= S 65d9'1'' E Azimuth= 114d50'59''
Overall Delta= 58d26'50''
Point calculating distance resolution <10.0>: \( \text{press Enter} \)
Length of Spiral <350.0>: \( \text{press Enter} \)
Radius of simple curve (precede with - sign if curve to left) <954.93>: 954.93
Degree of curve: 6d0'0''
Theta of Spiral= 0.18325951 (radians) 10d30'0'' (dd.mmss)
Distance along tangent line from TS to SC= 348.82
Distance offset from tangent line to SC= 21.33
(k) Shift along tangent line of PC= 174.80
(p) Shift offset from tangent line of PC= 5.34
Distance from PI to TS= 712.00
North(Y) of TS= 4583.08 East(X) of TS= 4244.46
North(Y) of SC= 4758.34 East(X) of SC= 4546.82
North(Y) of Offset PC= 4675.36 East(X) of Offset PC= 4393.02
[P]lot spiral or
[I]ntermediate distances for staking (deflection angle calc) <P>: \( \text{press Enter} \)
Point calculating distance resolution <10.0>: 5 Enter the resolution at which you would like the line segments of
the representative polyline plotted.
North(Y) of Radius Pt= 3879.96 East(X) of Radius Pt= 4921.44
\(<\text{press [Enter] for symmetrical spiral out} \> / [D]elta of simple curve: \( \text{press Enter} \) If you want a spiral in only
enter D then input the delta angle of the curve.
Simple Curve Delta= 37d26'50'' Length of Arc= 624.12
North(Y) of CS= 4805.10 East(X) of CS= 5158.11
Pulldown Menu Location: Draw > Arc
Keyboard Command: spiral
Prerequisite: For a symmetrical spiral, draw the tangent in and tangent out lines. For spiral in or out only, draw the
tangent line in or out.
File Name: \lsp\spiral.lsp

Insert Symbols

This command inserts symbols from the symbol library into the drawing. The symbol library may be edited using
the Edit Symbol Library command.

In the Insert Symbols options dialog, choose a symbol by entering the Symbol Name or by picking the Select
button which brings up the Select Symbol dialog. The default Symbol Category choices are Points, Trees and Map
Symbols. You may select a category by choosing the Symbol Category dropdown list. Within each category, use the
scroll bar to view all of the symbols. The Prompt For Rotation option will add a prompt for each symbol rotation.

Chapter 7. Draw Menu 166
The Rotate By Centerline option will prompt to select linework and then rotate the symbols to make them parallel to the nearest linework. The Symbol Rotation Angle is applied relative to horizontal of the current twist screen or to the nearest linework angle when Rotate By Centerline is active. The Erase Existing Symbols options apply if you specify a symbol location that already has a symbol on it. There are also settings for the symbol layer name and size.

After the options dialog, the program prompts at the Command line for the symbol locations. The locations can be specified by picking points, specifying point numbers in the current coordinate (.CRD) file or by entering the northing and easting. Using the Select entities option, symbols can also be placed on arcs, faces, points, text, lines and polylines. Selecting the Enter coords option allows you to insert the symbol by entering an easting, northing and elevation in x,y,z order.
Prompts

**Insert Symbols dialog** Choose parameters and click OK

Options/Select entities/Enter coords/<Pick point or point numbers>: pick a point

Options/Select entities/Enter coords/<Pick point or point numbers>: 5-10 Inserts symbols at points 5-10 from the current coordinate file.

Options/Select entities/Enter coords/<Pick point or point numbers>: S

**Insert Symbols dialog**

Select arcs, faces, points, text, lines and polylines. select objects

Options/Select entities/Enter coords/<Pick point or point numbers>: press Enter to end

**Pulldown Menu Location:** Draw > Symbols

**Keyboard Command:** ptsym

**Prerequisite:** None

**File Name:** \lsp\lptsym.lsp

---

**Insert Multi-Point Symbols**

This command allows you to locate symbols using multiple insertion points. Up to three insertion points can be defined for an individual symbol. When defining only two insertion points for a particular symbol, the symbol will be scaled and rotated. With three insertion points defined, the symbol is rotated and scaled in both the X and Y directions. The two point insertion definition will aid in the drawing of tree symbols with a specific drip line width. For instance, a surveyor could locate the tree and then locate the drip line, two shots for each tree, and allow the program to size the tree symbol accordingly so that the map will have various tree symbol sizes that reflect the actual field conditions.

The multiple insertion points are defined in the Field to Finish codes. The **Insert Multi-Point Symbols** command reads the Field to Finish code table and finds all of the codes with multi-point symbol definitions. Then you can select from these codes for the symbol to draw. Both the two and three point insertion definitions can aid with the insertion of concretes and buildings symbols during final drawing preparations and design phases of a project.

Here are the various steps to define two point and three point insertion point symbols. First, you must decide on the symbol to use for the desired code, as well as the specific placement points for the symbol. Once a symbol has been chosen, open the desired symbol drawing. To do this, identify the symbol name and then locate the symbol by its drawing name under the SUP sub-directory found under the Carlson installation directory. Next, determine the placement points for the symbol. As shown below, the placement points for the BLD code symbol, which will be explored later in this section, were determined by identifying X and Y values of the desired placement points by using the id command and specifying the end points of the lines.
Next, the symbol insertion points must be defined in the Field to Finish code table (.FLD) file. To do this, open your FLD file by choosing Draw Field to Finish under the Survey pulldown. Then select a particular code from the list of codes displayed in the Field to Finish dialog box. Edit it by highlighting the code and picking the Edit button, or define a new code with the Add button. Either choice will display the Edit Field Code Definition dialog. In the Edit Code Definition dialog, choose the desired symbol for the code by pressing the Set Symbol button and selecting the desired symbol. Next, select the Symbol Pts button. This brings up a dialog called Define Symbol Placement Points. Here is where you define the symbol by three points. You do this by entering an X and Y coordinate and a description for the symbol. Enter the X and Y values for each placement point into the appropriate fields. The description fields are used as the prompts when placing the symbol in the drawing. A two insertion point symbol is defined in the same way. An example is the Symbol Pnts definition for the code TREE. The placement points for the Tree code symbol were determined by opening the symbol drawing and finding the X and Y values at the insertion points. The center of the large circle was chosen for Point 1 and the East Quadrant was chosen for point 2. In both cases osnaps were used in picking the points.

Now that we have the codes defined, lets go through the Insert Multi-Point Symbol command and see the results. The command starts with a dialog that lists all the codes with Multi-Point Symbols defined. At this point you can select the symbol to draw. The symbol size applies only to using one point to place the symbol. When two or more points are used, the symbol is scaled to fit the points. Lets look at the BLD code three point insertion definition. Shown below are three points that represent a building pad. We want the building to be exactly the same dimensions defined by the point locations.

The three point PAD and the tree with drip line examples follow. We start by specifying the building pad codes.

Prompts

Insert Multi-Point Symbol Dialog
Choose a symbol to draw. In this example, the Pad symbol is a 3 point multi-symbol.

Specify LTFNT PAD point.
Pick Point or Point Number (Enter to End): 15
Specify LT REAR PAD point.
Pick Point or Point Number (Enter to End): 16
Specify RT REAR PAD point.
Pick Point or Point Number (Enter to End): 17
Insert another BLD symbol [<Yes>/No]? N

Insert Multi-Point Symbol Dialog
Choose a symbol to draw. In this next example, the Tree symbol is a 2 point multi-symbol. Now specify the location of the trunk and the drip line by point number.

Specify Trunk Location point.
Pick Point or Point Number (Enter to End): 1
Specify Drip Line Point.
Pick Point or Point Number (Enter to End): 13
Insert another TREE symbol [<Yes>/No]? N
From the Field to Finish routine

Chapter 7. Draw Menu
Two points symbol placement for TREE

Three points for building PAD

Two point tree with drip line

**Pulldown Menu Location:** Draw > Symbols

**Keyboard Command:** multisym

**Prerequisite:** Field to Finish file (.FLD) with codes defined with Multi-Point Symbols

**File Name:** \lsp\finish.arx

### Hatch

#### Function

This command allows you to fill an enclosed area or selected objects with a hatch pattern.

The Hatch command first defines the boundaries of the area you want to hatch, either by computing a region or polyline boundary from a specified point within an enclosed area, or by using selected objects as boundaries. It then fills the boundaries with a hatch pattern or a solid color. You can create an associative hatch, which updates when its boundaries are modified, or a nonassociative hatch, which is independent of its boundaries. You can preview any hatch and adjust the definition.

Due to the large number of combinations of geometry that you can hatch, editing hatched geometry can produce unexpected results. In this event, delete the hatch object and rehatch.
The Boundary Hatch dialog box defines the boundary, pattern type, pattern properties, and attributes for hatch objects. Use the Quick Tab to work with hatch patterns and quickly create a hatch. Use the Advanced Tab to customize how TakeOff creates and hatches boundaries.

1 Under the Quick Tab you define the appearance of the hatch pattern to be applied.

- Type: This field sets the pattern type.
- Pattern: This field lists the available predefined patterns. The six most recently used predefined patterns appear at the top of the list. The Pattern option is available only if you set Type to Predefined.
- […]: This button displays the Hatch Pattern Palette dialog box, in which you can view preview images for all predefined patterns at once to help you make a selection.
- Swatch: This field displays a preview of the selected pattern. You can click the swatch to display the Hatch Pattern Palette dialog box.
- Custom Pattern: This field lists the available custom patterns. The six most-recently used custom patterns appear at the top of the list. The Custom Pattern option is available only if you set Type to Custom.
- Angle: This field specifies an angle for the hatch pattern relative to the X axis of the current UCS.
- Scale: This option expands or contracts a predefined or custom pattern. This option is available only if you set Type to Predefined or Custom.
- Relative to Paper Space: This option scales the hatch pattern relative to paper space units. Using this option, you can easily display hatch patterns at a scale that is appropriate for your layout. This option is available only from a layout.
- Spacing: This option specifies the spacing of lines in a user-defined pattern. This option is available only if you set Type to User Defined.
- ISO Pen Width: This option scales an ISO predefined pattern based on the pen width you choose. This option is available only if you set Type to Predefined and set Pattern to one of the available ISO patterns.

2 Under the Advanced Tab you define how TakeOff creates and hatches boundaries.
• Island Detection Style: This option allows you to specify the method for hatching objects within the outermost hatch boundary. If no internal boundaries exist, specifying an Island Detection style has no effect. Because you can define a precise set of boundaries, it's often best to use the Normal style.

The illustrations that accompany each style show how the program hatches a group of three nested boundary objects in each case.

Normal

Hatches inward from the outer boundary. If the program encounters an internal intersection, it turns off hatching until it encounters another intersection. Thus, areas separated from the outside of the hatched area by an odd number of intersections are hatched, and areas separated by an even number of intersections are not.

Outer

Hatches inward from the outer boundary. The program turns hatching off if it encounters an internal intersection. Because this process starts from both ends of each hatch line, the program hatches only the outermost level of the structure and leaves the internal structure blank.

Ignore

Ignores all internal objects and hatches through them.

Hatching concave curves with the Outer and Ignore styles can cause hatching discrepancies.
The Normal, Outer, and Ignore options are also available from a shortcut menu by right-clicking in the drawing area while you specify points or select objects to define your boundaries.

- **Object Type:** This option allows you to specify whether to retain boundaries as objects, and specifies the object type TakeOff applies to those boundary objects. Object Type controls the type of the new boundary object. TakeOff creates the boundary as a region or a polyline. This option is available only if you select Retain Boundaries.
- **Retain Boundaries:** This option adds the temporary boundary objects to the drawing.
- **Boundary Set:** This field defines the set of objects TakeOff analyzes when defining a boundary from a specified point. The selected boundary set has no effect when you use Select Objects to define a boundary. By default, when you use Pick Points to define a boundary, the program analyzes all objects visible in the current viewport. By redefining the boundary set, you can disregard certain objects when defining boundaries without having to hide or remove those objects. For large drawings, redefining the boundary set can also produce the boundary faster because the program examines fewer objects.
- **New:** This option prompts you to select the objects that define the boundary set. When you choose this option, the dialog box temporarily closes, prompting you to select objects. TakeOff includes only the hatchable objects you select when it constructs the new boundary set. TakeOff discards any existing boundary set, replacing it with the new boundary set defined by the objects you select. If you don't select any hatchable objects, the program retains any current set. Until you exit the Hatch command or create a new boundary set, TakeOff ignores objects that do not exist in the boundary set when you define your boundaries using Pick Points.
- **Island Detection Method:** This option allows you to specify whether to include objects within the outermost boundary as boundary objects. These internal objects are known as islands.
- **Flood:** This option includes islands as boundary objects.
- **Ray Casting:** This option runs a line from the point you specify to the nearest object and then traces the boundary in a counterclockwise direction, thus excluding islands as boundary objects.

3 In the Boundary Hatch dialog box, you set the options that define the selection set.

- **Pick Points:** This option determines a boundary from existing objects that form an enclosed area. How TakeOff detects objects using this option depends on the selected Island Detection Method on the Advanced tab. For example, if the Island Detection Method is Flood, the program detects objects within the outermost boundary as islands and includes them in the boundary definition. The Island Detection Style (which you also set on the Advanced tab) then determines how to hatch the detected islands. When you choose Pick Points, the dialog box closes temporarily, and the program prompts for point specification.
- **Select Objects:** This option allows you to select specific objects for hatching. The dialog box closes temporarily, and the program prompts you for object selection. When you define your boundaries using Select Objects, the program does not detect interior objects automatically. You must select the objects within the selected boundary to hatch those objects according to the current Island Detection Style (which you set on the Advanced tab). Each time you choose Select Objects, the program clears the previous selection set. While selecting objects, you can right-click at any time in the drawing area to display a shortcut menu. You can undo the last or all selections, change the selection method, change the island detection style, or preview the hatch.
- **Remove Islands:** This option removes from the boundary definition any of the objects that the program detects as islands when you use Pick Points. You cannot remove the outer boundary.
- **View Selections:** This option temporarily dismisses the dialog box and displays the currently defined boundaries with the hatch settings that you last previewed. This option is unavailable when you have not yet specified points or selected objects.
- **Inherit Properties:** This option hatches specified boundaries using the hatch properties of one object. After selecting the associative hatch object whose properties you want the hatch to inherit, you can right-click in the
drawing area and use the shortcut menu to toggle between the Select Objects and Pick Internal Point options to create boundaries.

- **Double**: For user-defined patterns, this option draws a second set of lines positioned at 90 degrees to the original lines, creating a crosshatch. This option is available only if you set Type to User Defined on the Quick tab.

- **Associative**: This option creates an associative hatch, meaning that the hatch is updated when you modify its boundaries.

- **Nonassociative**: This option creates a nonassociative hatch, meaning that it is independent of its boundaries.

- **Preview**: This option temporarily dismisses the dialog box and displays the currently defined boundaries with the current hatch settings. This option is not available when you have not yet specified points or selected objects to define your boundaries.

**Prerequisite**: None

**Keyboard Command**: BHATCH

## Raster Image

### Function

This command allows you to manage raster images.

![Image Manager dialog box](image)

1. The Image Manager dialog box lists all the image files attached to the current drawing. You can view the parameters and details for selected images. You can attach new image files and detach, locate, reload, and unload existing images.

- **List View**: This button lists the image definitions attached to the drawing. Each image name appears only once regardless of how many times you attach (insert) the image. You can sort the list of images by name, status (loaded, unloaded, or not found), size, type (TIFF, for example), date, or the saved path and file name. By default, TakeOff displays the list alphabetically by image name.

To select multiple images, hold down SHIFT or CTRL while selecting items.

To sort the list alphabetically or numerically by a specific column, click that column's heading.
To change the width of the column, drag the line between the column headings to the right or left. The program saves and restores the settings when you reopen the dialog box.

To change an image name, select it and then click it again, or select it and then press F2. You cannot edit names of images that reside in external references (xrefs). Image names can include up to 255 characters and can contain letters, digits, spaces, and any special characters not used by Microsoft® Windows® or TakeOff. The image name can be identical to the file name, but changing the image name does not change the file name.

- Tree View: This button displays all the image definitions and the levels of nesting of images within xrefs. The top level of the tree view shows images that you attached directly to the drawing, images nested in block references, and the names of externally referenced drawings containing images. The names of the images attached to the externally referenced drawings appear nested within the drawing at the next tree level. To insert a copy of an already attached image, select it, and then choose Attach.

Tree view lists the image names only (not file names) and lists the image name just once, regardless of how many times you attach (insert) the image.

You can edit an image name by selecting it and then clicking it again, or by selecting it and then pressing F2. However, you cannot select more than one image at a time.

- Attach: This option displays the Select Image File dialog box. When you unload and then reload an image, the program draws that image on top. Images remain loaded or unloaded from one drawing session to the next.
- Detach: This option removes the selected image definitions from the drawing database and erases all the associated image objects from the drawing and from the display.
- Reload: This option loads the most recent version of an image or reloads an image that was previously unloaded. Reloading does not control whether the image is displayed, but it ensures display of the most current image.
- Unload: This option unloads image data from working memory without erasing the image objects from the drawing. It is recommended that you unload images no longer needed for editing to improve performance. An unloaded image cannot be displayed or plotted. You can selectively load and unload individual images from a working list of images associated with the drawing file.
- Details: This option opens the Image File Details dialog box, which displays the image name, saved path, active path, file creation date and time, file size and type, color system, color depth, width and height in pixels, resolution, default size in units, and a preview image.
- Image Found At: This field shows the path of the selected image. If you select multiple images, this field remains blank. The path shown is the actual path where the image resides.
- Browse: This option opens the Select Image File dialog box (a standard file selection dialog box). The path you select appears under Image Found At.
- Save Path: This option stores the new path information. Press ESC while editing the path to restore the old path. If the program cannot find the referenced image in the new path, the image's status changes to Not Found. If you do not choose Save Path after editing the path, the program uses the original image path the next time you load the drawing.

2 Under the Image dialog box, you can attach an image.
3 In the Image dialog box, you must first identify the image and the path.

- **Name:** This field identifies the image you have selected to attach, either from the Select Image File dialog box (an unattached image) or from the list of previously attached images. To add another instance of an image file that is already attached, select the image name from the list and choose OK.

- **Browse:** This option opens the Select Image File dialog box (a standard file selection dialog box). If Show Preview is selected, the program displays a preview of the selected file.

- **Retain Path:** This option saves the path of the image file with the image definition. If Retain Path is not selected, only the image name is saved and TakeOff searches the Support File Search Path.

4 Under Insertion Point, you must specify the insertion point for the selected image. Specify On-Screen is the default. The default insertion point is 0,0.

- **Specify On-Screen:** This option directs input to the command line or the pointing device. If Specify On-Screen is cleared, enter the insertion point in X, Y, and Z.

- **X:** This field sets the X coordinate value.

- **Y:** This field sets the Y coordinate value.

- **Z:** This field sets the Z coordinate value.

5 Under Scale, you must specify the scale factor of the selected image. Specify On-Screen directs input to the command line or the pointing device. If Specify On-Screen is cleared, enter a value for the scale factor. The default scale factor is 1.

6 Under Rotation, you must specify the rotation angle of the selected image. If Specify On-Screen is selected, you may wait until you exit the dialog box to rotate the object with your pointing device or enter a rotation angle value on the command line. If Specify On-Screen is cleared, enter the rotation angle value in the dialog box. The default rotation angle is 0.

**Prerequisite:** Raster image

**Keyboard Command:** IMAGE

### Place Image by World File

**Function**
This function allows you to insert Geo-Referenced TIF files into AutoCAD drawings. This process requires the presence of an accompanying TFW file. The TFW file contains information about the location and scaling of the actual raster image TIF file. This eliminates the guesswork in inserting, moving, and rotating raster images to the project area. You begin by selecting the TFW or JGW file to process. If the related TIF file is present in the same directory, the image will be inserted into the proper coordinates.

**Prompts**

**Select World File:** choose existing .TFW or .JGW file  
**Keyboard Command:** geotiff  
**Prerequisite:** None

---

**Draw By Example**

This command prompts you to pick an entity and then starts the appropriate draw command to begin creating another one of the selected type of entity. The properties such as layer and color of the original entity are used for creating the new one. For example, if you pick a polyline, this command will start the *Pline* command. Likewise if you pick text, this command will begin the *Text* command using the layer and style of the selected text.

**Prompts**

**Pick Object for Command:** pick an entity  
The remaining prompts depend on the type of the selected entity.

**Pulldown Menu Location:** Draw  
**Keyboard Command:** drawbyex  
**Prerequisite:** Entities  
**File Name:** \lsp\drawbyex.lsp

---

**Sequential Numbers**

This command draws a text label and then increments to the next value for additional labels. The label and optionally be placed inside a circle, square or other symbol. The size of the symbol adjusts to fit the label size. First, pick one of the seven formats.
Specify the **Text Size** (height). Defaults to size set in *Drawing Setup*.
Specify the **Text** label.
Specify an optional text **Prefix**.
Specify an optional text **Suffix**.
When **Auto Increment Labels** is checked, the value entered in the Text field will be incremented by the value in the Increment field.
When **Prompt for Alignment Every Time** is checked, you will be prompted for the alignment angle for each label, otherwise the alignment from the first label is automatically used for the other labels.
If Auto Increment Labels is checked, Text value is incremented by the **Increment** value.

The label is drawn by combining the Prefix, Text and then Suffix into one text label. When placing multiple labels, the text portion of the label will increment by the value in the Increment field. For example, this command could be used to quickly label a series of boundaries by setting the Prefix to "Perimeter" and the Text field to the starting number. Then pick points inside the boundaries to label as "Perimeter 1", "Perimeter 2", etc.

**Prompts**

Select Symbol for Numbers dialog *select your symbol*
Sequential Numbering Options dialog *make your choices*
Pick point at beginning of label: *pick a point*
Pick point for label alignment: *pick a point to the right of the first point*
Pick point at beginning of label: *press Enter to end the routine*

Pulldown Menu Location: Draw
Keyboard Command: numbers
Prerequisite: None
File Name: \lsp\cir_num.lsp

**Arrowhead**

This command draws an arrowhead at the end of the selected line or polyline.

**Prompts**

Enter the arrow size *<5.00>*: *press Enter*
Pick a line or pline to add arrow: *pick a line or polyline*
Pick a line or pline to add arrow (Enter to End): *press Enter*

Pulldown Menu Location: Draw
Keyboard Command: arrowhd
Prerequisite: None
File Name: \lsp\scadutil.arx

**Curve - Arrow**

Curve - Arrow can be used to draw a section of contour line or create leader pointer lines. Curve - Arrow draws a Bezier curve through user specified points. After choosing endpoints, each time an intermediate points is picked the curve will be redrawn through all the points. There is an option to draw an arrowhead at the starting point.
The arrowhead size is determined by the AutoCAD system variable "DIMASZ". In order to change this size, type DIMASZ at the AutoCAD command prompt. This routine also has a Zorro option which creates a Z leader curve.

**Prompts**

Create a Zorro (Yes/<No>)? N
Include an arrow (Yes/<No>)? Y
Enter the arrow head size <4.00>: press Enter This defaults to the DIMASZ system variable.
Pick a starting point: pick a point
Pick an ending point: pick a point
Pick an intermediate point (U to Undo): pick a point
Pick an intermediate point (U to Undo): press Enter

![Examples of Curve - Arrow](image)

**Pulldown Menu Location:** Draw
**Keyboard Command:** carrow
**Prerequisite:** None
**File Names:** \lsplsp\lsp\cir_num.lsp, \lsplsp\scadutil.arx

**Boundary Polyline**

This is a streamlined analog of the AutoCAD command Boundary. The Carlson version is faster and works in many cases where Boundary fails. Boundary Polyline supports a snap tolerance, which means that you may specify a maximum gap to close when creating a closed polyline.

To create closed polylines from any existing linework, simply select all entities you would like to use and specify desired snap tolerance. Then click inside openings you would like to trace and the routine will generate corresponding closed polylines. The duplicate polylines are detected and not created, so that clicking more than once in the same area does not change anything. These new polylines are always created in the current layer. Layers of the original linework do not matter.

**Prompts**

Select polylines: pick an entities to be used
Enter snap tolerance or press Enter for none:
Pick an internal point: pick the points to enclose
These three polylines are created from original linework by clicking at shown locations

**Pulldown Menu Location:** Draw  
**Keyboard Command:** boundpl  
**Prerequisite:** Entities  
**File Names:** \lsp\scbpol.arx

**Shrink-Wrap Entities**

This command creates a closed polyline which encloses a given set of entities. The resulting polyline is created in the current layer. The program works on either point entities or polylines. For points, the program creates a closed polyline through the points around the perimeter of the area defined by the points. For polylines, the shrink-wrap polyline follows the outside border of the selected polylines. The polylines that are processed have to be connected to be shrink-wrapped. The snap tolerance is the maximum gap that will be joined to make the closed polyline. For open polylines, as in the bottom figure, the Gap method works better, as it jumps across the gaps and connects the end points.
Prompts

Shrink-wrap across gaps or bounded linework only [<Gap>/Bound]? G
Shrink-wrap layer <FINAL>:
Select points and linework to shrink-wrap.
Select objects: select entities to process
Reading points... 46
Inserted 46 points.
Inserted 23 breakline segments
Perimeter reduction level 0-3 (0-None, 3-Most) <2>: 2
Reduce Perimeter Pass: 1 Removed: 5
Reduce Perimeter Pass: 2 Removed: 3
Reduce Perimeter Pass: 3 Removed: 4
Reduce Perimeter Pass: 4 Removed: 2
Reduce Perimeter Pass: 5 Removed: 1
Reduce Perimeter Pass: 6 Removed: 0
Create 2D or 3D Polyline [<2D>/3D]? 2D

Pulldown Menu Location: Draw
Keyboard Command: swplines
Prerequisite: Entities
File Name: \lsp\scbpoly.arx

Polyline by Nearest Found

This command draws a polyline by connecting points using a nearest found method. The points to connect can be specified either by entering point numbers or picking POINT entities on the screen. The nearest found method
draws a polyline by starting at one of the points and then connecting to the closest of the remaining points. Then a remaining point that is closest to one of the polyline end points is added until all points are part of the polyline.

**Prompts**

Create 2D polyline at zero elevation or 3D polyline [<2d>/3d]? press Enter
Select point from screen or by point number (<Screen>/Number)? press Enter
Select points.
Select objects: pick points

**Pulldown Menu Location:** Draw
**Keyboard Command:** plinear
**Prerequisite:** None
**File Names:** \lsp\crdutil.arx

**Drawing Block**

**Function**

This command allows you to create a block definition from objects you select.
1 In the Block Definition dialog box, you must first name the block. The Name field, names the block. The name can have up to 255 characters and can include letters, numbers, blank spaces, and any special character not used by Microsoft® Windows® and Carlson Survey for other purposes. The block name and definition are saved in the current drawing. You cannot use DIRECT, LIGHT, AVE_RENDER, RM_SDB, SH_SPOT, and OVERHEAD as valid block names.

2 Under Base Point, you must specify a base point for the block. The default value is 0,0,0.
   - **X**: This field specifies the X coordinate value.
   - **Y**: This field specifies the Y coordinate value.
   - **Z**: This field specifies the Z coordinate value.
   - **Pick Point**: This option allows you to temporarily close the dialog box so that you can specify an insertion base point in the current drawing.

3 Under Objects, you specify the objects to include in the new block and whether to retain or delete the selected objects or convert them to a block instance after you create the block.
   - **Retain**: This option retains the selected objects as distinct objects in the drawing after you create the block.
   - **Convert to Block**: This option converts the selected objects to a block instance in the drawing after you create the block.
   - **Delete**: This option deletes the selected objects from the drawing after you create the block.
   - **Select Objects**: This option dismisses the Block Definition dialog box temporarily while you select the objects for the block. When you finish selecting objects, press Enter to redisplay the Block Definition dialog box.
   - **Quick Select**: This option displays the Quick Select dialog box, which defines a selection set.
   - **Objects Selected**: This option displays the number of selected objects.

4 Under Preview Icon, you determine whether to save a preview icon with the block definition and specify the source of the icon.
   - **Do Not Include an Icon**: This option specifies that no icon is created.
• **Create Icon from Block Geometry**: This option creates a preview icon to be saved with the block definition from the geometry of the objects in the block.

5 In the Block Definition dialog box, you must describe and link the block.

• **Insert Units**: This field specifies the units to which the block is scaled when it is inserted.

• **Description**: This field specifies the text description associated with the block definition.

• **Hyperlink**: This button opens the Insert Hyperlink dialog box, which you can use to associate a hyperlink with the block definition.

**Menu Location**: Draw

**Prerequisite**: Drawing entities.

**Keyboard Command**: BLOCK

### Write Block

**Function**

This command allows you to write objects or a block to a new drawing file.

![Write Block Dialog Box](image)

The Write Block dialog box displays different default settings depending on whether nothing is selected, a single block is selected, or objects other than blocks are selected. For example, if you have a single block selected when you open the Write Block dialog box, the Source radio button is set to Block.

1 Under Source, you write selected blocks and objects out as a file, and specify insertion points.

• **Block**: This option specifies an existing block to save as a file. Select a name from the list.

• **Entire Drawing**: This option selects the current drawing as a block.

---

Chapter 7. Draw Menu 186
Objects: This option specifies objects to be saved as a file.

2 Under Base Point, you must specify a base point for the block. The default value is 0,0,0.

- X: This field specifies the X coordinate value.
- Y: This field specifies the Y coordinate value.
- Z: This field specifies the Z coordinate value.

Pick Point: This option allows you to temporarily close the dialog box so that you can specify an insertion base point in the current drawing.

3 Under Objects, you specify the objects to include in the new block and whether to retain or delete the selected objects or convert them to a block instance after you create the block.

- Retain: This option retains the selected objects as distinct objects in the drawing after you create the block.
- Convert to block: This option converts the selected objects to a block instance in the drawing after you create the block.
- Delete from drawing: This option deletes the selected objects from the drawing after you create the block.
- Select objects: This option dismisses the Block Definition dialog box temporarily while you select the objects for the block. When you finish selecting objects, press Enter to redisplay the Block Definition dialog box.
- Quick Select: This option displays the Quick Select dialog box, which defines a selection set.
- Objects Selected: This option displays the number of selected objects.

4 Under Destination, specify the name, location, and unit value used for the objects in the file.

- File Name: This field specifies a file name that the block or objects will be saved to.
- Location: This field specifies the drive and directory path for the file.
- Insert Units: This field specifies the unit value to be used when the new file is inserted as a block. Enter 0 (zero) if you do not want to scale the drawing to a specific value as you insert it.

Prerequisite: Drawing entities

Keyboard Command: WBLOCK

Insert

Function

This command allows you to place a named block or drawing into the current drawing.
1 In the Insert dialog box, you specify the block to insert and define the position for the inserted block. The last block you insert during the current editing session becomes the default block for subsequent uses of this command.

• Name: This field specifies the name of a block to insert or the name of a file to insert as a block.
• Browse: This button opens the Select Drawing File dialog box (a standard file selection dialog box) where you can select a block or a file to insert.

2 Under Insertion Point, you specify the insertion point for the block.

• Specify On-Screen: This option specifies the insertion point of the block using the pointing device.
• X: This field sets the X coordinate value.
• Y: This field sets the Y coordinate value.
• Z: This field sets the Z coordinate value.

3 Under Scale, you specify the scale for the inserted block. Specifying negative values for the X, Y, and Z scale factors inserts a mirror image of a block.

• Specify On-Screen: This option specifies the insertion point of the block using the pointing device.
• X: This field sets the X coordinate value.
• Y: This field sets the Y coordinate value.
• Z: This field sets the Z coordinate value.
• Uniform Scale: This option specifies a single scale value for X, Y, and Z coordinates. A value specified for X is also reflected in the Y and Z values.

4 Under Rotation, you specify the rotation angle for the inserted block.

• Specify On-Screen: This option specifies the rotation angle of the block using the pointing device.
• Angle: This field sets a rotation angle for the inserted block.

5 You can explode the block and inserts to the individual parts of the block. When you select Explode, you specify only an X scale factor.

Prerequisite: None

Keyboard Command: DDINSERT
Inquiry Menu

Shown here is the Carlson Inquiry menu. The top section contains detailed inquiry commands. The lower section of the menu includes report and file editing commands.
List

Function

This command lists the object type, object layer, and X,Y,Z position relative to the current user coordinate system (UCS) and whether the object is in model space or paper space.

The List command reports color, linetype, and lineweight information if these items are not set to BYLAYER. The thickness of an object is displayed if it is nonzero. Z coordinate information defines the elevation. If the extrusion direction of the entry differs from the Z axis (0,0,1) of the current UCS, the List command also reports the extrusion direction in UCS coordinates. The List reports additional information related to the specific object selected.

Prompts

Command:
LIST
Select objects: 3 found, 1 group

Select objects:

BLOCK REFERENCE Layer: "PNTS"
Space: Model space
Handle = 1F3D
Group = *A1
"SPT4"
at point, X=6135023.7190 Y=2190074.2098 Z= 800.0000
X scale factor 5.0000
Y scale factor 5.0000
rotation angle 0d0'0"
Z scale factor 5.0000

BLOCK REFERENCE Layer: "PNTS"
Space: Model space
Handle = 1F4D
Group = *A1
"SRVPN01"
at point, X=6135023.7190 Y=2190074.2098 Z= 800.0000
X scale factor 5.0000
Y scale factor 5.0000
rotation angle 0d0'0"
Z scale factor 5.0000

ATTRIBUTE Layer: "PNTNO"
Space: Model space
Handle = 1F4E
Style = "PTXT"
Font file = TXT
center point, X=6135023.7190 Y=2190077.9598 Z= 800.0000
height 5.0000
Point ID

This command reports complete information pertaining to a Carlson point. Although similar in function to the AutoCAD ID command, this routine is much more detailed. With this command, you are given the point number, as well as the northing, easting and elevation coordinates. You also are given the point description, and you are shown the name and the location of the coordinate file for the point.

Prompts

Pick point or point number: 255

<table>
<thead>
<tr>
<th>PointNo.</th>
<th>Northing(Y)</th>
<th>Easting(X)</th>
<th>Elev(Z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>255</td>
<td>4379.83</td>
<td>4265.48</td>
<td>19.01</td>
<td>GROUND/SHOT</td>
</tr>
</tbody>
</table>

Pulldown Menu Location: Inquiry

Keyboard Command: PT_ID

Prerequisite: None

File Name: \lsp\pt_id.lsp

Layer ID

This command reports the layer name of the selected entity.

Prompts
Layer Report

This command generates a report containing each layer name, the number of entities on each layer, the color and the linetype applied to each layer.

![Layer Report](image)

Layer Inspector

This command is used to inspect and work with layers in the drawing. This command is ideal when you are working on a very dense and complex drawing which has many layers and you want to review the entities on different layers. In some cases, there will be layers that you would want to erase. Another scenario might be that you'd like to highlight a layer that is hard to find and see.

The Layer Inspector command has a dialog that docks to the bottom of the drawing window which keeps the drawing window visible while running the command. On the left of the dialog is a list of all the layers in the drawing. To inspect a layer, highlight the layer name from this list. You can inspect multiple layers at a time by selecting multiple layers in the list using the Shift and Ctrl keys while picking in the list. When a layer is selected, the Entity Count reports how many entities in the drawing are set to that layer. The Zoom toggle will
zoom the drawing window to the extents of the entities on the layer. The Isolate toggle will freeze all other layers. The Highlight toggle will highlight all the entities on the layer. The Restore View On Exit will set the drawing window to the original position when Layer Inspector was started. The magnify and arrow buttons are used to zoom in/out and pan the drawing window. The Rename button allows you to rename the layer. The Erase Entities button will erase all the entities on the layer. The Purge button will purge the layer from the drawing which is only available when there are no entities on the layer. The Current button sets the layer as the current layer for the drawing.

Pulldown Menu Location: Inquiry
Keyboard Command: layer.inspect
Prerequisite: None
File Name: \lsp\contour4.arx

**Drawing Inspector**

This command reports object properties to you as you move the cursor over an entity. You can simply move the pointer over an entity and the selected property will be displayed either in a pop-up window next to the pointer and/or on the status bar, depending on the selected option. Drawing Inspector is a transparent command that can run while other commands are running. Once Drawing Inspector is started, it will stay active even while running other commands until you turn it off. To turn off Drawing Inspector, run the command again to toggle it off by pick Drawing Inspector from the Inquiry pull-down menu or from the toolbar or by typing the command name, or right-click and choose Turn off Drawing Inspector. The options for this command are set in the menu that pops up by clicking the right mouse button. The available properties are: Layer Name, Elevation, Azimuth-Distance, Bearing-Distance, Point Data, Text Data, Curve Data, 3D Face Data, Polyline Data and Polyline Blips.

In the *Drawing Inspector* menu, you can choose one or more properties to display.

**Display Layer Name**: Allows you to display the layer name of the entity.
**Display Elevation**: Allows you to display the elevation of the entity.
**Display Azimuth-Distance**: Allows you to display the azimuth and distance of a line.
**Display Bearing-Distance**: Allows you to display the bearing and distance of a line.
**Display Point Data:** Allows you to display the coordinate data of a point.

**Display Text Data:** Allows you to display the attributes of text.

**Display Curve Data:** Allows you to display the radius, arc length, chord length, and delta angle of a curve.

**Display 3D Face Data:** Allows you to display the Z elevations at the face corners.

**Display Polyline Data:** Allows you to display the end point elevations, horizontal distance, slope distance, and slope ratios.

**Display Polyline Blips:** Allows you to display temporary blip plus marks at the vertex locations of polylines.

In the *Drawing Inspector* menu, you can also choose how the property information is reported.

**Enable Highlighting:** Allows you to highlight the object that the *Drawing Inspector* is reporting.

**Enable Tag Display:** Enables you to view the information next to the cursor on the screen.

**Show Data On Status Bar:** Enables you to view the information on the status bar, in the lower corner of the screen.

**Use Default Cursor:** When enabled, only the AutoCAD cursor shows. When disabled, the mouse pointer is also shown.

**Report In High Precision:** When enabled, displays 8 decimals on distance and 4 decimal seconds on angles.

---

**Example of Drawing Inspector reporting Bearing-Distance using the Tag Display**

**Pulldown Menu Location:** Inquiry

**Keyboard Command:** inspector

**Prerequisite:** None

**File Name:** \lsp\autotag.arx

---

**List Elevation**

**Function**

This command displays the elevation of a polyline or line. With a 3D polyline, the elevation of the 3D polyline at the pick point is reported along with the elevation of each vertex. See also, the *Drawing Inspector* command on the *Inq-Set* menu.

**Prerequisite:** an entity

**Keyboard Command:** LSTELEV
Bearing & 3D Distance

This command reports the slope distance, slope ratio, bearing, azimuth and vertical angle between two 3D points. Pick or enter the coordinates of two points or select a line or polyline segment to calculate between the segment endpoints.

Prompts

Specify bearing-distance from (Line/PLine/<Points>)? press Enter
Pick point or enter point number: pick a point
Pick second point or enter point number: pick a point
Horiz Dist: 233.4 Slope Dist: 233.4 Elev Diff: 0.0 Vert Ang: 0d0'0''
Slope: 0.0% 0.0:1 Bearing: S 71d15'37'' W Azimuth: 198d44'23''

Find Point

This command can be used to find a point in the current CRD file with a certain point number or description. For example, if you entered RAD* the command would plot a preview arrow at all the points that have the letters RAD as part of the description. i.e. RADPT1, RADPT2, RADPT3, etc. This command is not case sensitive (test is considered the same as TEST). Matching points are highlighted on the graphics screen with the preview arrow and listed on the text screen.

Prompts

Find by point [N]umber or [D]escription <N>: press Enter
Point number or range of point numbers to find <1>: 8*10
8 4856.75 4747.20 0.00
9 4909.25 4648.37 0.00
10 4223.30 4545.46 0.00 RADPT

If you respond with D for the first prompt the program prompts:
Conforms to AutoCAD's wild card matching.
Point Description(s) text to search for <>: rad*
Searching file C:\Carlson\DATA/LOT.CRD for point descriptions matching RAD* ...
7 4817.02 4662.73 0.00 RADPT
10 4223.30 4545.46 0.00 RADPT
Point(s) found 2

Pulldown Menu Location: Inquiry
Keyboard Command: fpnt
Prerequisite: None
File Name: \lsp\fpnt.lsp
Curve Info

This command displays information about a curve/arc. The curve can be defined by an arc entity or polyline arc segment or by selecting three points on the arc. The three points can be defined by point number or picked on the screen. The curve data is displayed in the text window with an option to be displayed in the Standard Report Viewer. Click Exit to return to the graphics window.

Prompts

Define arc by, Points/<select arc or polyline>: select the arc entities
Endpoint: (4923.81 5193.15 0.0)
Other Endpoint: (5168.27 5274.03 0.0)
Radius Point Coords: (5126.64990.09 0.0)
Chord Bearing: N 71d41'33'' E
Chord Azimuth: 71d41'33''
Delta angle in radians: 0.9304628295
RoadWay Degree of Curve: 19d57'56''
RailRoad Degree of Curve: 20d4'4'' Chord Crv Length: 265.66 Excess: 1.36
External: 34.13 Mid Ord: 30.50 Tangent: 144.06
Delta: 53d18'42''
Chord: 257.49
Length: 267.02
Radius: 286.97
Display curve data in report viewer [Yes/<No>]? Y

Pulldown Menu Location: Inquiry
Prerequisite: None
Keyboard Command: cinfo
File Name: \lsp\curvinfo.lsp
Polyline Info

This command reports the length and elevation of the selected polyline or line.

Prompts

Pick Polyline or Line: pick a polyline or line
Polyline length: 7702.75 Slope distance: 7702.75 Avg elev: 1700.00 Avg slope: 0.00%

Pulldown Menu Location: Inquiry
Keyboard Command: polylen
Prerequisite: None
File Name: \lsp\polylen.lsp

Display-Edit File

This command allows you to edit or review an ASCII/text file. Files are displayed in the Standard Report Viewer section of this manual.

Pulldown Menu Location: Inquiry
Keyboard Command: scedit
Prerequisite: A file to edit
File Names: \lsp\scedit.lsp, \lsp\scadutil.arx, \lsp\scedit.dcl

Display Last Report

This brings up the last report generated by any Carlson command that uses the standard report viewer.

Pulldown Menu Location: Inquiry
Keyboard Command: report_up
Prerequisite: A previously viewed report
File Name: \lsp\quickkey.lsp

Load Saved Report

This brings up the Report Formatter for the report data file saved previously by the Report Formatter.

Pulldown Menu Location: Inquiry
Keyboard Command: load_report
Prerequisite: A saved report
File Name: \lsp\scadutil.arx
Shown here is the Carlson Software Settings menu. The top section contains the commands most important for setting up the drawing. You should run Drawing Setup prior to beginning your drawing. Additional setup and settings features are found in the middle section. The last section of the menu includes AutoCAD settings commands, including the System Variable Editor.
Drawing Setup

This command allows you to specify drawing parameters, including the plotting scale, size of symbols, label annotation size, and the angle mode.

- Specify **English 1in=?ft** or **Metric 1m=?m** as the unit mode to use. This affects the prompting and reports. When you are working on a drawing in English units, one unit equals one foot. In metric, one unit equals one meter.
- Specify the **Horizontal Scale** of the drawing. For example, if the horizontal scale is set to 50, then 1" = 50' is your drawing scale.
- The **Symbol Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The **Drawing Units** field shows the result of the Symbol Plot Size value (the scaler) multiplied by the horizontal scale.
- The **Text Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The Text Plot Size is not entered in Drawing Units. The **Drawing Units** field shows the result of the Text Plot Size value (the scaler) multiplied by the horizontal scale.
- The **Line Type Scaler** option sets the linetype scale by multiplying this scaler by the horizontal scale.
- **Angle Mode-Bearing** sets reporting to bearing mode for any of the inquiry commands. (Modifies the settings in the AutoCAD UNITS command.)
- **Angle Mode-Azimuth** sets reporting to north based azimuth mode for any of the inquiry commands. (Modifies the settings in the AutoCAD UNITS command.)
- **Angle Mode-Gon** sets reporting to gon mode for any of the inquiry commands. (Modifies the settings in the AutoCAD UNITS command.)
- **Angle Mode-Other** lets the user determine angle mode by using the AutoCAD UNITS command.
• **Coordinate System** is an optional setting to define the drawing coordinate system. The coordinate system settings are used in commands like List Points and Label Lat/Lon to report geodetic coordinates from the drawing coordinates. The Grid System setting applies to drawing coordinates that are in a grid projection system such as state plane coordinates. The Projection list selects the grid projection from the list of supported projections. Along with the Projection, there are selections for the zone and datum to use with the projection. When the drawing setup is in English mode, there is a projection setting for whether the feet are in US Feet or International Feet units. The Local System setting applies to all other coordinate system beside grid projections. The Define Localization button has settings to define the transformation from local coordinates to grid coordinates. With a localization defined, you can work in a drawing in local coordinates and still report lat/lon. The localization definition contains pairs of local and grid coordinates that define the transformation. See the section on Localization under the Coordinate File Utilities command for more information.

• **Distance Scale Factor for Labels and Reports** is used to show distances in a second system besides the drawing units. For example, this factor can be used to report distances in meters when the drawing is in feet, or it can be used to report grid distances when the drawings is in a ground coordinate system. This factor is applied in commands that have an option to label/report a second scaled distance such as the Inverse command and Annotate Defaults that applies to the angle/distance label routines. The scale factor can be entered directly into the edit box or calculated using the Calculate button which has feet-meters conversions as well as combined scale factor calculations for grid-ground factors. See the Scale Points command for more information on calculating the combined scale factor.

• The **Set Paper** button allows you to draw a rectangle on the screen that represents the edge of your paper. After you have set the horizontal scale, press the Set Paper button and the Set Paper dialog appears.

![Set Paper Dialog]

– The **Layout** option lets you specify landscape or portrait paper orientation. Landscape layout is where the width of the page is greater than the height of the page. Portrait layout is the opposite.
– The **Paper Size** option allows you to specify the paper size. The numbers in parenthesis represent drawing units and will be multiplied by the horizontal scale to determine the rectangle to be drawn. If you select the Other option, you will be prompted on the command line for the horizontal and vertical sizes of the paper.
Prompts (for Set Paper)

Pick or Type lower left corner point for border <(5000.00 5000.00 0.0)>: pick a point
Erase existing Set Paper boundary [<Yes>/No]? Y This prompt only appears if there is an existing paper boundary in this drawing.
Set Limits [Yes/<No>]? Y If you answer Yes to Set Limits, drawing limits are enabled, and AutoCAD restricts the coordinates you can enter to within the paper boundary. Drawing limits also determines the area of the drawing that can display grid dots, and the minimum area displayed by the Zoom All command on the View menu. To turn drawing limits off, type in LIMITS on the command line and set to Off.
Drawing Setup also sets the AutoCAD dimension scale (DIMSCALE) and linetype scale (LTSCALE) to the Horizontal Scale.

Pulldown Menu Location: Settings
Keyboard Command: setup
Prerequisite: None
File Names: \lsp\survset.lsp, \lsp\scadenvr.dcl

Set Project/Data Folders

This command sets both the project work folder and the data folder to use as the default folders for your Carlson drawing and data files. The \PROJECT folder typically contain the .DWG and .BAK files, while the \DATA folder typically contains files such as coordinate (.CRD), Field to Finish code definition (.FLD), profile (.PRO) and centerline (.CL) files. This routine also shows you the tree structure of existing folders available on your computer. The first dialog provides you with a choice of three for the Data Folder Setup. The three options are Project Folder, Drawing Folder or Fixed Folder. You will choose one.

Project Folder: This option will make available the two buttons (rectangular boxes) in the middle of this dialog box. These large option buttons are labeled Project Sub-Folders Setup and Data Type Sub-Folders, respectively. Clicking the left-side Project Sub-Folders Setup button will produce a dialog called Project Folders.

In the Project Folders dialog you are able to Add, Rename and Delete folders and sub-folders for your project.
Clicking the Data Type Sub-Folders button on the right-side will produce a dialog that has a spreadsheet look and function. Here you have the ability to define the Data Folders and Sub-Folders by matching them up with the Data Types and Descriptions. Be sure to scroll down, using the scroll tool on the right, to review the dozens of rows of Data Types in the list. You can also edit the sub-folder structure (note the dropdown arrows in the Sub-Folder column) as described above.
**Drawing Folder:** When this option is clicked, all of the options below become grayed out. The drawings will automatically be stored in the Current Project Folder, and the data files will automatically go into the same folder as the drawing.

**Fixed Folder:** With the Fixed Folder option, you will "Set" a folder for all of your data to be stored in. The \DATA folder is the default folder, but you can also create and set any folder you would like.
To create a new data folder, for example, first note the Current Data Folder section at the bottom of the dialog box, and notice the Set button to the right. Click Set. A new dialog appears that will allow you to select the data folder of your choice. Here, you can create or remove any folder.

If you choose Create Directory, the program will prompt you for the new directory name. The Remove Directory button allows you to delete directories that have no files inside. After you have made your choices, click OK.

**Pulldown Menu Location:** Settings > Project  
**Keyboard Command:** settmpdir  
**Prerequisite:** None

---

**Drawing Explorer**

The Drawing Explorer command presents a list of all Carlson data files that are made in association with a drawing. The knowledge of these files is contained in the .INI file that shares the drawing name (e.g. Estates.dwg, Estates.ini). If a drawing was not made in Carlson or does not have a companion .INI file, then Drawing Explorer will display "No Files". In Configure > General Settings, if Save Drawing INI Files is clicked off, then Drawing Explorer will again display "No Files". Drawing Explorer will also not show any data files where the drawing name starts with the seven letters "Drawing". Using any other file name, once data files are created such as a coordinate (.CRD) file, then Drawing Explorer will track these files in the order that they are created. Drawing Explorer helps manage drawing-related data.

**Example 1**

If we are working in a drawing called Estates.dwg and create a coordinate file Estates.crd, then later create a second coordinate file called Estates-GPS.crd, Drawing Explorer would display the following:

The coordinate file created or modified last appears at the top of the list. All data files are displayed in the order of most recent to oldest. If the Estates.crd file is set as current by the command *Set Coordinate File*, then added to or
revised, Estates.crd will move to the top of the list. Thus old, relatively unused files will gravitate to the bottom of the list.

Files are displayed by category. So far, we have only the Coordinate Files category. There are also Raw Field Note files (.RW5), profiles (.PRO), section files (.SCT) - in fact dozens of file type categories that will display once these files are actually created.

If a data file is selected and highlighted, the Up and Down keys will become enabled, and the user can move files up to the top of the list or otherwise alter their position. The position of files affects only the reporting of the files using the Report option in the lower left of the dialog. When highlighted, a file can be removed from the list (but it won't be deleted from the hard drive!). The Add option will add other older or non-referenced data files to the list of files associated with the drawing.

Example 2

As we do more work in the file Estates.dwg, data files will begin to proliferate and will appear in Drawing Explorer. Shown below is a more comprehensive list of files, with occasional examples of multiple files within the same category. Categories themselves float to the top of the list if any of their data files have been used more recently than data files in other categories.

Note that there is even a Miscellaneous Files category, that includes ASCII point files created by the command Export Text/ASCII File.

When many data files are involved, the Report option becomes very useful. Here you can use the Report Formatter to display, in any order, the File Name, File Type, Date last modified, Time last modified, Size in bytes, and whether it is Found (e.g. exists) in the specified directory. For example, if a file was created in a certain directory but moved using Windows Explorer to another directory without being further altered in Carlson, it would show up here as not found. ("No" would appear in the Found column).

Shown here is a summary of our data files by size, with reporting of the found status. In this case, the Estates.Lot
file has been moved or deleted.

The Report Formatter can be used to move to the right side all items that are desired for reporting, with the up-down options used to set the report order (e.g. File type first, File name second, etc.). Click the Display button (not shown above) that appears at the bottom of the Report Formatting Options dialog, to obtain the report shown here.

A deleted or missing file such as Estates.Lot will appear in Drawing Explorer with a special red [no entry] symbol as shown here.
Pulldown Menu Location: Settings > Project

Keyboard Command: dwgxplore

Prerequisite: None

File Name: \lsp\gisutil.arx

Project Explorer

This tool is used for management of a complete project. A project can contain numerous drawings, and each drawing within that project can contain numerous related files.

Think of the Project Explorer as the trunk of the hierarchical tree structure that develops into a project. While within each drawing, Carlson keeps track of the files that you create (such as grids and coordinates). These are related to the drawing and you can use Drawing Explorer to manage them. When management reaches the top level, the Project Explorer is used to tie these together.

Prompts

When you initiate the Project Explorer, you will be prompted to select an existing or create a new Project File. Project files end in the PRJ extension. Once a project file is open, the following dialog will appear.
**Add:** When you choose the Add button, you are prompted to select a drawing file to add to the project. The selected drawing file is added to the project tree along with any files related to the drawing.

**Remove:** When any branch of the tree structure (except the top root) is selected, it is removed. Keep in mind that removing any node of a tree structure removes all nodes under it.

**Up/Down:** When you select a branch of the tree structure that can be moved, the Up and Down buttons become available. This allows you to rearrange the items vertically.

**Report:** This option displays the Report Formatting Options for formatting the report of the Drawing Explorer (see Drawing Explorer).

When you choose the Add button you will be presented with a dialog to select a drawing to add to the project. Once a drawing is selected, it will be added to the project tree along with any files related to the drawing.

The Report Formatter can be used to move to the right side all items that are desired for reporting, with the up-down options used to set the report order (e.g., File type first, File name second, etc.). Click the Display button that appears at the bottom of the Report Formatting Options dialog, to obtain the report shown here.
Pulldown Menu Location: Settings > Project
Keyboard Command: prjxplore
Prerequisite: None
File Name: \lsp\gisutil.arx

Store Project Archive

This command will zip and archive an entire project. The archive contains the drawing file (.dwg) and all the associated data file such as the surfaces. The data files associated with the current project can be reviewed with the Drawing Explorer command. The format of the archive file is a standard .zip file which can be used by WinZip. This file can be sent to someone who can unzip it and use all the same files. If the drawing hasn't been saved recently, the following window appears first.
Pulldown Menu Location: Settings > Project
Keyboard Command: zip_project
Prerequisite: A project file
File Name: \lsp\contour4.arx

Extract Project Archive

This command will unzip an archive file that has been previously created with the command Store Project Archive. It prompts for the directory to unzip to. If any of the files already exist in the folder it is extracting to, there is a window prompting to overwrite the files.
Pulldown Menu Location: Settings > Project
Keyboard Command: unzip_project
Prerequisite: A project file that has been zipped (ZIP)

Preferences

Function

This command opens the Options dialog box where you can customize the settings in CSI related to the CAD engine. Some settings are available in this command that are not applicable to CSI, these settings are not documented below.

Files Tab

Under the Files Tab, you specify the directories in which the program searches for support, driver, menu, and other files. Generally, you will never need to modify any of the settings found here. Advanced users may want to view/modify the following:
• Automatic Save File Location: This is the location that CSI will save drawings when it performs an automatic save.
• Temporary Drawing File Location: This is the location that CSI writes and stores any temporary drawings during the current drawing session.

**Display Tab**

Under the Display Tab, you specify settings related to the graphics and text display.

1 Window Elements

• **Display scroll bars in drawing window**: Specify whether or not to show the scrollbars in the drawing window.

**Colors**: Use this command to change colors for items such as drawing background, and text background.

**Fonts**: Use this command to change the font for text displayed on the command line and in the text window.

2 Display resolution

• **Arc and circle smoothness**: Controls the smoothness of circles, arcs, and ellipses. A higher number produces smoother objects, but CSI requires more time to regenerate, pan, and zoom the objects. The default setting is 100, and the maximum setting is 20000

• **Segments in a polyline curve**: Sets the number of line segments to be generated for each polyline curve. The default setting is 8.

3 Display performance

• **Apply solid fill**: Specify whether or not to show fill for hatches and wide polylines.

• **Show text boundary frame only**: Displays the frames for text objects instead of displaying the text objects

4 Crosshair size: Specify the crosshair size in percentage of screen size.

5 Layout elements: These options are not applicable to CSI
Open and Save Tab

1 File Save

- Save as: Specify the file formats used when saving a file with SAVE and SAVEAS.
- Save a thumbnail preview image: Specifies whether an image of the drawing should be displayed in the Preview area of the Select File dialog box.
- Incremental save percentage: Sets the percentage of potential wasted space in a drawing file. When the specified percentage is reached, CSI performs a full save instead of an incremental save. Full saves eliminate wasted space. If you set Incremental Save Percentage to 0, every save is a full save.

2 File Open

- Number of recently used files to list: Controls the number of recently used files that are listed in the File menu for quick access. Valid values are 0 to 9.
- Display full path in title: Displays the full path of the active drawing in the drawing’s title bar, or in the CSI title bar if the drawing is maximized.

3 File Safety Precautions

- Automatic save: Saves a copy of your drawing automatically at the interval you specify. See Automatic File Save Location above to specify where the drawing should be saved.
- Minutes between saves: Specifies how often the drawing is saved when using Automatic Save
- Create backup copy with each save: Specifies whether a backup copy of a drawing is created when you save the drawing. The backup copy is created in the same location as the drawing
- Maintain a log file: Specifies whether the contents of the text window are written to a log file. To specify the location and name of the log file, use the Files tab in the Options dialog box
• File extension for temporary files: Specifies a unique extension for the current user to identify temporary files in a network environment. The default extension is .ac$.

4 External References: (These options apply to external referenced drawings, you cannot create external references with CSI, but you can open drawings that have external references).

• Demand Load Xrefs: Controls demand loading of xrefs.

• Retain changes to Xref layers: Saves changes to layer properties and states for xref-dependent layers.

Chapter 9. Settings Menu

Plotting Tab

1 Under Default Plot Settings For New Drawings, you control default plotting settings for new drawings.

• Use As Default Output Device: Sets the default output device for new drawings. The list displays any plotter configuration files (PC3) found in the plotter configuration search path and any system printers that are configured in the system.

• Use Last Successful Plot Settings: Sets the plotting settings according to the settings of the last successful plot.

• Add or Configure Plotters: Displays the Autodesk Plotter Manager (a Windows system window). You can add or configure a plotter with the Autodesk Plotter Manager.

2 Under General Plot Options, you control options that relate to the general plotting environment.

• Keep the Layout Paper Size If Possible: Uses the paper size specified on the Layout Settings tab in the Page Setup dialog box under the File menu as long as the selected output device can plot to this paper size. If the selected output device cannot plot to this paper size, the program displays a warning message and uses the paper size specified either in the plotter configuration file (PC3) or in the default system settings if the output device is a system printer.

• Use the Plot Device Paper Size: Uses the paper size specified either in the plotter configuration file (PC3) or in the default system settings if the output device is a system printer.
• **OLE Plot Quality**: Determines the quality of plotted OLE objects. The values are Line Art, Text, Graphics, Photograph, and High Quality Photograph.

• **Use OLE Application When Plotting OLE Objects**: Launches the application used to create the OLE object when plotting a drawing with OLE objects. You can use this option if you want to optimize the quality of plotted OLE objects. This setting is saved in the drawing. You can also control this option by using the OLESTARTUP system variable.

• **Hide System Printer**: Controls whether Windows system printers are displayed in the Plot and Page Setup dialog boxes under the File menu. This option hides standard Windows system printers only. You can control the size of the list of devices in the Plot and Page Setup dialog boxes by moving a device's PC3 file out of the Plotters directory and its subdirectories.

3 Under Default Plot Style Behavior, you control options related to plot style behavior in all drawings. Changing the default plot style behavior using the Options dialog box does not affect the current drawing.

• **Use Color Dependent Plot Styles**: Uses color-dependent plot styles in both new drawings and drawings created in earlier versions of Autodesk products. Color-dependent plot styles use the numbers from the color index to create a plot style table with a .ctb file extension. Each color is defined by a name or number ranging from 1 to 255. You can assign each color number to a different pen on a pen plotter to achieve different property settings in the plotted drawing. If this option is selected, a plot style is created for each color setting. If you want to change the default plot style behavior for a drawing, select this option or Use Named Plot Styles before opening or creating a drawing. Changing the default plot style behavior using the Options dialog box affects only new drawings or drawings created in an earlier release of an Autodesk product that have never been saved in CSI 2000 format. This setting is saved with the drawing. Once a drawing is saved with either setting, it cannot be changed.

• **Use Named Plot Styles**: Uses named plot styles in both new drawings and drawings created in earlier versions of Autodesk products. CSI plots the drawing according to the property settings you specify in the plot style definition. The plot style is defined in the plot style table attached to the layout or viewport. Named plot style tables are files with the file extension .stb.

• **Default Plot Style Table**: Specifies the default plot style table to attach to new drawings. A plot style table is a file with a .ctb or an .stb extension that includes and defines plot styles. If you are using color-dependent plot styles, this option lists all color dependent plot style tables found in the search path as well as the value of None. If you are using named plot styles, this option lists all named plot styles tables.

• **Default Plot Style for Layer 0**: Sets the default plot style for Layer 0 for new drawings. The list displays the default value Normal and alphabetically displays any plot styles defined in the currently loaded plot style table.

• **Default Plot Style for Objects**: Sets the default plot style that is assigned when you create new objects. The list displays a BYLAYER, BYBLOCK, and Normal style, and it alphabetically displays any plot styles defined in the currently loaded plot style table.

• **Add or Edit Plot Style Tables**: Displays the Autodesk Plot Style Table Manager (a Windows Explorer window). You can create or edit plot style tables with the Autodesk Plot Style Table Manager.
System Tab

1 Current Pointing Device can only be set to Current System Pointing Device. Do not change this setting.

2 General Options include the following:
   - **Single-drawing compatibility mode**: Allows CSI to work with one drawing at a time. Leave this checked.
   - **Display OLE properties dialog**: Controls the display of the OLE Properties dialog box when inserting OLE objects.
   - **Beep on error in user input**: Specifies whether CSI should sound an alarm beep when it detects an invalid entry.
   - **Allow long symbol names**: If this is checked, symbol names such as layers can be 255 characters long.
User Preferences Tab

1 Windows Standard Behavior
   • Windows standard accelerator keys:
   • Shortcut menus in drawing area:
   • Right-click Customization:

2 Priority for Coordinate Data Entry
   • Running object snap: Specifies that running object snaps override coordinate entry at all times. Not Recommended
   • Keyboard entry: Specifies that coordinate entry overrides running object snaps at all times.
   • Keyboard entry except scripts: Specifies that coordinate entry overrides running object snaps, except in scripts.

3 Object Sorting Methods determines the sort order of objects. Generally speaking, objects are displayed in the order they were created. This means that newer objects will display on top of older objects. Use the Display Order commands on the View menu to change the display order.
Drafting

1 AutoSnap Settings
   - **Marker**: Controls the display of the AutoSnap™ marker. The marker is a geometric symbol that displays the object snap location when the crosshairs move over a snap point on an object.
   - **Magnet**: Sets the AutoSnap magnet on or off. The magnet is an automatic movement of the crosshairs that locks the crosshairs onto the nearest snap point.
   - **Display AutoSnap tooltip**: Controls the display of the AutoSnap tooltip. The tooltip is a text flag that describes which part of the object you are snapping to.
   - **Display AutoSnap aperture box**: Controls the display of the AutoSnap aperture box. The aperture box is a box that appears inside the crosshairs when you snap to an object.

2 Tracking Settings
   - **Display polar tracking vector**: Sets polar tracking behavior on or off. With polar tracking, you can draw lines along angles relative to a drawing command From or To point.
   - **Display Tracking tooltip**: Controls the display of the AutoTrack tooltip. The tooltip is a text flag that displays the tracking coordinates.

3 AutoSnap Marker Size allows you to set the display size for the AutoSnap marker. Values range from 1 to 20 pixels.

4 Aperture Size allows you to set the aperture size. The size of the aperture determines how close to a snap point you can be before the magnet locks the aperture box to the snap point. The smaller the aperture, the closer you must be to the snap point to activate the magnet.
Selection Tab

1 Selection Modes

- **Noun/verb selection**: Allows you to select an object before starting a command.
- **Use Shift to add to selection**: Adds or removes an object to the selection set when you press SHIFT and select an object.
- **Press and drag**: Draws a selection window by selecting a point and dragging the pointing device to a second point.
- **Implied windowing**: Initiates the drawing of a selection window when you select a point outside an object.
- **Object grouping**: Selects all objects in a group when you select one object in that group. Control-A also toggles this setting.
- **Associative Hatch**: Determines which objects are selected when you select an associative hatch. If this option is selected, boundary objects are also selected when you select an associative hatch.

2 Grips

- **Enable Grips**: Controls whether grips are displayed on an object after you select it.
- **Enable Grips within blocks**: Controls how grips are displayed on a block after you select it
- **Unselected grip color**: Determines the color of an unselected grip.
- **Selected grip color**: Determines the color of a selected grip.

3 Pickbox Size controls the display size of the pickbox. The pickbox is the object selection tool that appears in editing commands. The default size is set to 3 pixels; values range from 0 to 20.

4 Grip size controls the display size of grips. The default size is set to 3 pixels; values range from 1 to 20.
Configure

This command allows you to set up the default settings that are used each time you start a new drawing, or load an existing drawing. These settings are stored in files called Carlson.INI, COGO.INI, SCTPRO.INI, DTM.INI, HYDRO.INI, and MINE.INI in the Carlson USER directory. Configure will restore the current drawing settings to these default settings. These global settings can be saved and loaded on a new computer, or for a new installation of Carlson.

The settings for the modules apply to the commands within those modules. Refer to the associated manual chapters for additional descriptions of these settings. Under General Settings there are options that apply to all modules. Many of these options are only accessed in Configure, and will be described here.
Use Startup Wizard: The Use Startup Wizard controls whether this wizard appears when creating a new drawing.

Generate Report Log: When the Generate Report Log option is on, output from several commands will be accumulated in a report buffer. Commands that output to the report log include Inverse, Traverse, Curve Info, etc. Also any report that is displayed in the standard report viewer is also added to the report log. While activated, the report log resides in the lower left corner of the desktop as a minimized title bar that shows how many lines are in the report buffer. To view the report log, pick on the maximize icon on this title bar. You can also view the report log by running the Display Report Log function in the Misc menu. The report log can be edited, saved to a file or printed. To quickly turn the report log on and off, you can type REPORT at the command prompt. This function toggles the report log on/off.

Save Drawing INI Files: Save Drawing INI Files will create an .INI with the same name as the .dwg file to store the project data files for the drawing.

Auto Zoom Center for New Points: This option zooms the display to center the new, located point. If it is off, the screen does not center the new point.

Ignore Zero Elevs: This option will ignore any entities with a zero elevation. It is used for many commands, such as Triangulate and Contour or Make Grid File.

Use South Azimuth: Turning on this option will use a South Azimuth instead of a North Azimuth, which is the default.

Use Dview Twist Angle: This will use the screen Twist Angle defined with the AutoCAD command DVIEW. This is similar to Twist Screen.

Set Dimscale to Drawing Scale: This will set the dimension scale to match the drawing scale. By default, it is set to 40.0.

Set PDSIZE to Symbol Size: This will set the PDSIZE scale to match the symbol size defined in Drawing Setup. By default, it is set to 4.0.

Set INSUNITS to Unitless: This will set the INSUNITS (Insertion Units) AutoCAD system variable to Unitless when the drawing is opened.

Point Layer: This is the default layer to draw any new points.

Coordinate Report Order: You can choose the traditional north-east format, or reverse these in reports with east-north.

Date Format: You can control the display of dates in Carlson reports with this dropdown menu. The default is 'Windows Setting' which allows you to control it with Windows Control Panel. Several other common formats are available.

Report Viewer: This option chooses between the Carlson Report Viewer, Windows Notepad and Microsoft Word for the viewer to use for reports that the Carlson commands generate.

AutoCAD Menu: This option chooses which AutoCAD menu to load when picking the AutoCAD menu from the Carlson Menus toolbar or from the Settings->Carlson Menus pull-down menu. When AutoCAD Map is installed, there are different layouts of the Map menu to choose from. When Autodesk LandDesktop is installed, those menus are available.

Object Linking: The Object Linking section contains options for creating reactors to the drawing entities. The Link Points with CRD File option will attach a reactor to the Carlson point entities so that any change to the entities such as MOVE or ROTATE will update the coordinates in the CRD file. The Link Linework with Points option will attach reactors to line and polyline entities that are drawn by point number so that moving the points will automatically move the linework. The Link Labels with Linework applies to bearing/distance annotation. This link with update
the annotation when the linework is modified. The Group Point Entities option joins the three entities of a Carlson point (attribute block, symbol, node). For each point, selecting any one of these entities selects all three entities for the point. See the Points Menu Commands and Dynamic Annotation sections of the manual for more information about linking.

Database Format: The Database Format chooses between Microsoft® Access 97 or 2000 (and higher) format. This database format applies to creating new database (.MDB) files in the GIS module, the drillhole database and the Export to Microsoft® Access option in the Report Formatter.

CRD File Pt# Format: Carlson can run live on any of these coordinate file formats. The CRD File Pt# Format option sets point number format for coordinate files as one of the following. Here are the options:

- **Carlson Numeric**: This is the default format upon installation. Point numbers cannot contain letters and must be in the range from 1 to 32767.
- **Carlson Alphanumeric**: This native Carlson format allows letters in the point numbers, and the point name can be up to 10 characters. Any combination of letters and numbers is acceptable.
- **C&G Numeric**: This format of the C&G division supports up to 5 digits, with a 65000 point limit.
- **C&G Alphanumeric**: This format of the C&G division supports up to 10 characters, with no limit to the number of points.
- **Simplicity ZAK**: This is the Simplicity Systems coordinate file format.
- **LDT Points.mdb**: This is a Microsoft Access database used by Autodesk Land Desktop. The file is typically named "points.mdb" and is found in a projects \COGO directory. The number limitation is established by the database structure, but is frequently numeric and allows unlimited point numbers.

Digitizer Puck Layout & View: There are two main formats for the digitizer puck. They are numbered 1 and 2. Selecting the View button brings up the window showing the two formats.

![Digitizer Puck Layouts](Image)

Use Mouse: This option allows you to use the mouse instead of the digitizer puck for the digitize commands.

Auto Tablet On for Digitize Commands: This option will activate the auto tablet when using the digitize commands.

Drawing Setup:
The settings under Drawing Setup are very similar to the AutoCAD Drawing Setup, which is also shown below for comparison. There are a few additions, such as Vertical Scale, Point Prompt-Label Settings, Point Number Settings and Vertical Angle Mode.
There is also the ability to maintain two different sets of defaults (English and Metric). The user can maintain a comfortable set of settings for either unit system, especially if they constantly switch back and forth. Also added was support for meters/metres, tons/tonnes and various date representation. This dialog is accessed from the **Configure** menu choice, using the Localization Settings button.

**Survey Settings:**
There are five different areas for default Survey Settings. These all appear elsewhere in Survey, but if you set them there, they will just apply for that drawing. If you make changes here, it will apply to the current and/or future drawings. Since each is defined elsewhere in the Survey chapter, each is not detailed here, just the dialog for viewing.
DTM-Contour Settings:

Most of the DTM-Contour commands will remember the settings and parameters used from drawing to drawing. There are some in this screen that will be used for gridding and modeling.

**Inverse Distance/LeastSquares Modeling Parameters:** The modeling methods of Inverse Distance and Least Squares are similar ways to create a grid from datapoints or drillholes. It is not recommended to use these methods for gridding contour or breaklines. Triangulation is better for that. These methods need a search radius defined. Anything past this distance from one data point to the next will be ignored for influence. The Max Samples are the number of data points that will be used to influence each data point. The area is broken into 4 quadrants. The Min and Max Quadrant are the numbers of data points that will be used in each quadrant.

**Specify Grid Resolution As:** There are two ways to create a grid file. Once the boundary has been selected, the cells need to be determined. Number of Cells in X and Y will divide the boundary up into the specified number of
cells. These will then be odd shaped rectangles, with the size calculated by the boundary dimensions and the number of cells. The Dimensions of Cells is the more commonly used method. This will allow for a set cell size for the X and Y directions. Most of the time the grid cells should be square, where you set the size.

**Grid Precision:** This is the number of decimals that are stored in the grid file.

**Section-Profile Settings:**
This configuration box is used mainly for text and drafting settings. Items such as text size scalers and station types are set here and will apply to the current and/or future drawings. These are very self explanatory and are up to the user to set if something other than the defaults is desired.

![Section-Profile Settings](image)

**Hydrology Settings:**
This section contains only three configuration settings. The first is the format of the stage-storage capacity file. The second is the location of the HEC program files. The third is the SEDCAD directory location, if it is installed on the computer.

![Hydrology Settings](image)
Mine Note Options:
These options are settings for prompting when entering the mine notes. They are simply turned on or off for customized mine note entry.

![Mine Note Entry Options](image)

Mine Settings:
This is the configuration screen for default settings used with the Mining Modules. Each item is detailed below.

![Mining Settings](image)

**Inverse Distance/Least Squares Search Radius, Samples and Quadrants:** The modeling methods of Inverse Distance and Least Squares are similar ways to create a grid from datapoints or drillholes in that they use the same settings. It is not recommended to use these methods for gridding contour or breaklines. Triangulation is better for that. These methods need a search radius defined. Anything past this distance from one data point to the next will be ignored for influence. The Max Samples are the number of data points that will be used to influence each data point. The area is broken into 4 quadrants. The Min and Max Quadrant are the numbers of data points that will be used in each quadrant.

**SDPS Directory:** This is the directory that the SDPS program (Subsidence Deformation Prediction System) is installed in, if it is on the computer.

**Fill in Missing Strata Above/Below Existing Strata (Seam Stacking/Conformance):** This important setting is used for gridding and modeling from drillholes. It does two things. The first item it controls is to fill in missing
strata. For example, if a drillhole does not go deep enough to penetrate a deep seam, or a drillhole is drilled down in a valley or low spot, it will either fill in (carry the seam through the hole) or pinch it out at the hole. None will not fill it in, meaning it will pinch the seam out at the shallow or partial hole. All will not pinch the seams out at the shallow or partial hole. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The second modeling concept this controls is conformance. In these same partial holes where certain seams are not encountered, when it fills them in, it controls how it behaves. None will let each seam do what they want, independent of any other seam. All has all the seams looking at each other and they all conform to each other. Seam-Specific will use the Define Strata settings where the marker and target beds are defined there. The marker bed is the "main" seam and other seams will conform to it. There can be more than one marker seam. There is also a hierarchy for conformance, so if the main marker seam is not present, then the next marker seam in line will prevail.

**Calculate Strata Pinchout and slide bar:** This setting determines if the thickness of a seam is pinchout when it does not occur in a drillhole. Turn it on to activate pinchout. If a seam is not present, it will pinch it out using that drillhole. If it is off, it will carry the seam through the hole where the seam is not encountered. The slide bar determines the distance between the drillholes for pinchout. Near zero will pinch the seam closer to the hole where it does not appear. Non-zero will pinch the seam closer to the drillhole where it does appear. Most of the time, the best "guess" is to leave it in the middle, where it will pinch the seam half way between the holes. It is also recommended to have the pinchout turned on when making thickness grids. This will model the thickness properly. But, when modeling the bottom elevation of a seam, turn OFF pinchout. If it is on, many times it will bring the elevation of the seam up to the next seam to pinch it out. Turning the off for elevation grids will keep them down where they belong. Then just add the thickness and the bottom elevation to obtain the roof elevation grid.

**Process Only Strata with Beds:** This setting is used mostly when duplicate strata appear in a drillhole. It will only model with strata that have a bed name, ignoring those that don't. This useful in a situation where only the KEY strata have a bed name. It will ignore all the NONKEY strata, and just model the KEY strata. This can be used when modeling geology such as lignite or bentonite, where thin seams have bed names and the overburden, partings and interburdens do not.

**Prompt for Advancement Pline for Quantities:** When running the quantity routines in the standard mining module, turning this on will prompt for the Advancement pline for quantities.

**Composite Bed Qualities by Density:** When modeling the quality attributes from drillholes, and they are sampled at multiple intervals, by default, they are averaged by thickness and that one value will be used for gridding. This option will weight the quality attribute by a Density value instead of thickness. The Density attribute needs to be in each drillhole and the name is entered in the box to the right. It is usually DENSITY, and is in pounds per cu. ft or kg/cu m.

**Use Strata Limit Lines:** When using Strata Limit Polylines for modeling, this needs to be turned on or the program will not use them, even if they are on screen. If just this one is on, then you will be prompted to select them for all commands.

**Auto Select All Strata Limit Lines:** Turning this on will automatically select all the Strata Limit Polylines for all commands that use them. They will not have to be selected each time.

**Use 0 Values for Blank Entries in Coal Sections:** When using the Coal Sections in the standard mining module, if a value is blank, this option will assign a 0 value instead of a blank or Null value.

**Report Format for Quantities by Avg/Grid Methods:** This setting determines the report format from the quantity commands in the standard mining module. Standard is the regular text editor. Column puts them in columns in the editor and Formatter will use the powerful Report Formatter.

**Key Material Name:** This is the name of the KEY material you are mining. Enter in COAL or LIMESTONE or GOLD, or whatever ore you are mining.

**Include Strata Name in Bed Composite:** This will add the strata name to the bed name when running the bed composite commands, such as Split Bed by Parameters.
**Startup Options:**
These options are used for starting Carlson. Defaults are set here, and will be used at the beginning of each session.

- **Template Name:** This is the drawing template file that will be used when starting a new drawing. The Browse button allows for selecting a new file.
- **Carlson 2008 Folder:** This is the folder where Carlson is installed. The Browse button allows for selecting a new file.
- **Carlson 2008 Launch Folder:** This is the folder where Carlson will initially look for, and save a drawing file. The Browse button allows for selecting a new file.
- **Profile Name:** This is the AutoCAD Profile that will be used when working in Carlson and AutoCAD.
- **AutoCAD command switches:** This turns off the AutoCAD "splash" screen upon launching the program. The /nologo takes the splash screen out of the start up procedure.
- **AutoCAD product to run:** This is the AutoCAD version and flavor (Map or LDT, etc.) that Carlson is installed for, and will run with.

**Localization Options:**
There are literally hundreds of default settings that can be set with this dialog. The categories that can be selected from are:

```
Annotate Defaults
Area Defaults
Cogo Design
Drawing Setup
DTM and Contour
General
Lin/Curve Table
Minimal Length To Label
Section Profile
Stock Label Arc
Survey Text Defaults
```

The Settings for each Category will display all of the items that can be setup for default values. The Default value is set in the Configuration Default Value box. The corresponding Metric or English default values are set here, allowing for easy switching between the two systems.
Pulldown Menu Location: Settings
Keyboard Command: config_scad
Prerequisite: None
File Names: `\lsp\survini.lsp`, `\lsp\cogoini.lsp`, `\lsp\dtmini.lsp`, `\lsp\mineini.lsp`, `\lsp\hydroini.lsp`, `\lsp\sctini.lsp`, `\lsp\cfg_scad.lsp`, `\lsp\cfg_scad.dcl`

# Mouse Click Settings

This command can be used to make custom mouse click preferences. It allows you to set the preferred functionality of your mouse wheel and mouse buttons.

The Middle Button Click options apply to a 2-button wheel mouse (with the wheel acting as the middle button) or a 3-button mouse. Choose between using the middle mouse wheel for real-time pan, or to show an Object Snap pop-up menu. The mouse wheel can also be clicked and depressed for panning, and it can be used for zooming in and out by scrolling with the wheel.

In the lower section of the dialog, you can determine how the right mouse button will operate. For the right button, there are different levels of pop-up menus that can be activated. With all these menus off, the right button will be used like Enter on the keyboard.

Pulldown Menu Location: Settings
**Keyboard Command:** clickset  
**Prerequisite:** None

### Toolbars

This command allows you to display and hide toolbars. Click on a toolbar name and press the Show or Hide button.

![Toolbars](image.jpg)

- **Show:** Turns on the selected toolbar. If the toolbar is already visible, then this does nothing.
- **Hide:** Turns off the selected toolbar. If the toolbars is already hidden, then this does nothing. If the toolbar is floating, you can also turn it off by clicking the x in the upper right corner.
- **Exit:** Exits this command

**Pulldown Menu Location:** Settings  
**Keyboard Command:** TBARCFG  
**Prerequisite:** None

### Edit Symbol Library

**Function**

This command allows you to customize the symbol library.

Categories are a way for grouping symbols by type for your own convenience in symbol selection. A new category is added by clicking on the "Add Category" button. An edit field then appears in the tree view on the left and waits for you to enter the category name. The input is finished by pressing the Enter key.

The category may be populated by creating a new symbol from selected entities in the drawing, by specifying drawing (.DWG) files, or by moving existing symbols from one category to another.

To create a new symbol, open a drawing which has the entities to be used in the symbol. The symbol should be drawn at unit size (scale 1:1) because Carlson will scale the symbol by the current drawing scale when the symbol is used. Highlight the category for the symbol and click on the "Create Symbol" button. A dialog appears for entering the new symbol name. Next, specify the file name for the symbol. The file name has a .DWG extension and would usually reside in the Carlson SUP directory, but you may use another path. Then the program will prompt you to select the entities from the drawing for the symbol. An insertion point for the symbol must also be picked.
The "Import Symbols" button brings up a file selection dialog which allows you to select multiple files to be added to the current category (to select multiple files use Shift or Control keys along with the mouse). If the files you select are not in the Carlson SUP directory, the program will offer an option of copying them there. There are also Import Library and Export Library buttons.

By default, the symbol description is the same as file name. The description for the symbol or category name may be changed by highlighting that name and clicking on "Rename" button, the name being edited is then placed into edit mode. To move a symbol into a different category, select the symbol to be moved on the tree and click an "Up" or "Down" button as many times a needed to reach the desired category. The symbols are sorted alphabetically within each category, while categories are remaining in the order placed to allow the more frequently accessed categories be on top.

Note: The symbol library is stored in an ASCII file named symbols.dta in the Carlson \USER directory.

**Pulldown Menu Location:** Settings

**Keyboard Command:** editptsym

**Prerequisite:** None

**File Names:** \lspl|scadutil.arx, \user\symbols.dta

---

**Title Block**

**Function**

This command draws a border and title block for the selected sheet size. At the top of the dialog, choose your horizontal scale and sheet size. The *other* choice at the bottom of each list will allow you to add your own scale or size if yours is not listed. Anything added to these lists will be retained for future use. Next, choose either "landscape" or "portrait" format. A blue rectangle next to this choice shows you the difference. Below this, you can choose what layer to draw the border and title block on. The margins to use are specified next at the bottom of the
dialog. On the right hand side of the dialog, you can choose from several title blocks. As you choose each one, a preview will be shown below this list. This routine looks for all drawings named "tblock" in the \SUP directory. If you want to add your own title block, simply create a new drawing (or copy an existing one) in the \SUP directory and give it a name that starts with tblock. Example: tblock22.dwg and tblock-Jones.dwg are both valid names for this routine, but "MyTitleblk.dwg" is not. After you have made all your decisions in the dialog box, press OK. Depending on your current zoom level, your drawing may be zoomed out to allow you to see the entire area that will be covered by the drawing border. At this point, you have the border attached to your cursor and it is waiting for you to pick a point for insertion. As soon as you do this, a secondary dialog will appear for you to fill out the attributes associated with the particular title block you selected.
**Pulldown Menu Location:** Settings  
**Keyboard Command:** tblock  
**Prerequisite:** Set horizontal scale in Drawing Setup
Mortgage Block

This command draws a personalized title block for a mortgage survey. You may select an 8½” x 11” sheet, an 8½” x 14” sheet, or define your own sheet size. The dialog box allows the user to edit all block information and input unique data for every layout. The mortgage block drawing is called from the mortgage.dwg file located in the \sup directory and can be easily opened and edited within AutoCAD, allowing for the user to alter the size, text, or any other aspect of the drawing to fit the user's particular needs. However, this is usually unnecessary since the original .dwg file places this block for a standard 8 ½ x 11 ratio drawing. In addition to the block, the user can include the inputs and prescribed text for a Flood Note, which is placed in the bottom left hand corner of the drawing. You may also select a custom drawing file for your flood note. All inputs are saved and recalled from a mortgage.ini file located in the \User directory.

The LIMITS of the drawing can be set to the lower left and upper right corners of the border. After the title block is drawn, the contents can be edited using the Attribute Edit command under the Edit menu.

Pulldown Menu Location: Settings
Keyboard Command: mortgage
Prerequisite: Set horizontal scale in Drawing Setup
File Names: \lsp\mortgage.lsp, \sup\mortgage.dwg

Rescale Drawing

This command globally resizes selected text, symbol and block entities within the drawing by comparing the existing drawing scale factor to a new scale factor. Entities are scaled from their individual insertion points. Lines and polylines are not scaled.
Prompts

Old Horizontal Scale: 20
New Horizontal Scale: 30
Select text, symbols, dimensions and blocks to scale.
Select objects: select objects by window, crossing or by typing "all" at the command prompt, and press Enter
41 found
Select objects: press Enter
Number of symbols and blocks changed > 7
Testing Entity > 41
Number of text entities changed > 20

Set/Reset X-Hairs

Set X-Hairs sets the crosshairs either to align with the selected line or polyline or to a user-specified slope. Reset X-Hairs restores the crosshairs alignment to horizontal.

Pulldown Menu Location: Settings
Keyboard Command: scaledwg
Prerequisite: Drawing entities to be scaled

Tablet Calibrate

This command executes the routine to perform calibration of the digitizer tablet to the drawing. There are two methods of calibration: Known Reference Points, and Drawing Scale with New Reference Points, which are explained in detail below. The Calibrate routine must be used prior to using the Digitize Contours command.
Before proceeding, please refer to the Settings menu, then go to Configure and General Settings. Then look at the Digitizer Puck Layout section for the selection of the correct puck layout.

**Tablet Calibration**

**Known Reference Points** uses two known coordinates for reference points on the drawing. When this option is selected, the fields for coordinate info activate. Enter the known northing and easting values for the reference points from the info on the drawings in the appropriate fields and pick the Pick button. Pick the points from the drawing on the tablet. Furthermore, Carlson saves the coordinates of the two reference points for future calibrations and displays them on the **Tablet Calibration Dialog** the next time it is accessed, so if you are working in the same drawing, you can use the **Known Reference Points** method with the saved coordinates to digitize back to your previous coordinates. For greater calibration accuracy, choose two points that are farther apart rather than closer together.

![Tablet Calibration Dialog](image)

**Drawing Scale with New Reference Points** is very convenient when you don't know the precise coordinates of the entities on your drawing. The user must specify the drawing scale from the plan. This method establishes a coordinate system relative to the position of the plan on the digitizer board. In addition to the drawing scale, you are required to enter a random coordinate for the first reference point, the default coordinate is (1000,1000). You then pick the Pick button and pick the point on the drawing to assign the specified coordinate to. The program will compute the coordinate of the second reference point that you pick based on the first point. The coordinates of these two reference points would be saved and will be display in the **Tablet Calibration Dialog** as **Known Reference Points** the next time you calibrate the tablet, so you can digitize back to the previous coordinates if you are working on the same drawing, even though you may have moved or rotated your drawing on the digitize board.
**Prompts**

**Tablet Calibration Dialog**
Specify the Calibration Methods. If you select Drawing Scale method, enter the drawing scale and the coordinate of the first reference point. Otherwise enter the exact coordinates of the first and second reference points.

**Pick first reference point**: pick a point

**Pick second reference point**: pick another point

**Pulldown Menu Locations**: Settings > Tablet Calibration
**Keyboard Command**: digsetup

**Prerequisite**: Affix a drawing to your digitizer tablet. Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Select the puck layout in Configure.

**File Name**: \lsp\digsetup.lsp

**Save/Load Tablet Calibration**

A common problem with calibrating maps on a large format digitizer is that if you leave the current drawing session, AutoCAD forgets the tablet calibration. Tablet save can be used to save the calibration when a drawing is taped down properly. This calibration file can be restored at any time later and be accurate so long as the drawing did not move on the tablet.

**Save Configuration Procedure**:
1) Command: TABSAVE
2) Designate filename (*.TCF) to save configuration into.

**Restore Configuration Procedure**:
1) Command: TABREST
2) Select filename (*.TCF) to restore configuration from.

**Pulldown Menu Location**: Settings > Tablet Calibration
**Keyboard Commands**: tablet1, tablet2
**Set UCS to World**

**Function**

This command sets the UCS (user coordinate system) to the world coordinate system (WCS). Carlson TakeOff works exclusively in the world coordinate system and there is no way to change this setting. In AutoCAD, it is possible to change the coordinate system from WCS. If you receive a drawing in which the coordinate system is not set to world, use this command to restore the UCS.

**Prerequisite:** None

**Keyboard Command:** UCS_WORLD

**Units Control**

**Function**

The Drawing Units dialog box controls coordinate and angle display formats and determines precision.

1 Under Length, you specify the current unit of measurement and the precision for the current units.
   - **Type:** This field sets the current format for units of measure. The values include Architectural, Decimal, Engineering, Fractional, and Scientific. The Engineering and Architectural formats produce feet-and-inches displays and assume that each drawing unit represents one inch. The other formats can represent any real-world unit.
   - **Precision:** This field sets the number of decimal places for the current units display.

2 Under Angle you specify the current angle format and the precision for the current angle display.
   - **Type:** This field sets the current angle format.
   - **Precision:** This field sets the precision for the current angle display.
TakeOff uses the following conventions for the various angle measures: decimal degrees appear as decimal numbers, grads appear with a lowercase g suffix, and radians appear with a lowercase r suffix. The degrees/minutes/seconds format uses d for degrees, ' for minutes, and '' for seconds, for example:

123d45'56.7''

Surveyor’s units show angles as bearings, using N or S for north or south, degrees/minutes/seconds for how far east or west the angle is from direct north or south, and E or W for east or west, for example:

N 45d0'0'' E

The angle is always less than 90 degrees and is displayed in the degrees/minutes/seconds format. If the angle is precisely north, south, east, or west, only the single letter representing the compass point is displayed.

- **Clockwise**: This option calculates positive angles in the clockwise direction. The default direction for positive angles is counterclockwise.

When the program prompts for an angle, you can point in the desired direction or enter an angle regardless of the setting specified for Clockwise.

3 Under Drawing Units for TakeOff DesignCenter blocks, you can control the unit of measurement used for block insertions. A block created in units that differ from the units specified in this option is scaled and inserted in the specified units. Select Unitless to insert the block as is and not scale the block to match the specified units. Source content units and Target drawing units settings in the User Preferences tab of the Options dialog box under the Settings menu are used when Insert Units are not defined.

4 Sample Output displays an example of the current settings for units and angles.

Direction displays the Direction Control dialog box described below.

A The Base Angle determines where 0 degrees is located when the program calculates angles. The base angle sets the direction of the base angle. These options affect the entry of angles, object rotation angles, the display format, and the entry of polar, cylindrical, and spherical coordinates. Choose East, North, West, or South, or choose Other to indicate an alternative direction. The default direction for the zero angle is East. In TakeOff, the base angle is relative to the orientation of the user coordinate system.

- **East**: Sets the base angle to east (default is zero degrees).
- **North**: Sets the base angle to 90 degrees north.
- **West**: Sets the base angle to 180 degrees west.
- **South**: Sets the base angle to 270 degrees south.
- **Other**: Sets a direction different from the points of the compass.
• **Angle:** Sets the angle. Available only when Other is selected.

• **Pick an Angle:** Uses the pointing device to define the angle based on the angle of an imaginary line connecting any two points you specify. Available only when Other is selected.

**Prerequisite:** None

**Keyboard Command:** UNITS

---

**Point Object Snap**

When this toggle is turned on, you can move your cursor near a Carlson point and snap to the actual coordinates of the point without having to use the AutoCAD NODE snap. Point Object Snap can be used alone to display the point information or it can be turned on and used during other commands. In the example illustration, the **2DP** command (2D polyline) has been started and the first point picked was point number 2074. As the cursor nears point number 2067, the point snap marker appears and the point information is displayed, click the mouse and the next polyline vertex will snap to the coordinates of point 2067.

---

**Pulldown Menu Location:** Settings

**Keyboard Command:** `pointsnap`

**Prerequisite:** None

**File Name:** `\lsp\scadutil.arx`

---

**Aperture Object Snap**

**Function**

The Drafting Settings dialog box sets object snap modes.
1 Under Object Snap, you set object snaps.

- **Object Snap On**: This option turns running object snaps on and off. The object snaps selected under Object Snap Modes are active while object snap is on. This setting is also controlled by the OSMODE system variable.

- **Object Snap Tracking On**: This option turns object snap tracking on and off. With object snap tracking the cursor can track along alignment paths based on other object snap points when specifying points in a command. To use object snap tracking, you must turn on one or more object snaps.

2 Under Object Snap Modes, you turn on running object snaps.

- **Endpoint**: Snaps to the closest endpoint of an arc, elliptical arc, line, multilines, polyline segment, spline, region, or ray or to the closest corner of a trace, solid, or 3D face.

- **Midpoint**: Snaps to the midpoint of an arc, ellipse, elliptical arc, line, multilines, polyline segment, solid, spline, or xline.

- **Center**: Snaps to the center of an arc, circle, ellipse, or elliptical arc.

- **Node**: Snaps to a point object.

- **Quadrant**: Snaps to a quadrant point of an arc, circle, ellipse, or elliptical arc.
• **Intersection:** Snaps to the intersection of an arc, circle, ellipse, elliptical arc, line, multil ine, polyline, ray, spline, or xline. Intersection snaps to the edges of regions and curves, but does not snap to the edges or corners of 3D solids. Extended Intersection snaps to the imaginary intersection of two objects that would intersect if the objects were extended along their natural paths. Carlson Survey automatically turns on Extended Intersection when you select the Intersection object snap mode. You might get varying results if you have both the Intersection and Apparent Intersection running object snaps turned on at the same time. Intersection and Extended Intersection work with edges of regions and curves, but not with edges or corners of 3D solids.

• **Extension:** Causes a temporary extension line to display when you pass the cursor over the endpoint of objects, so you can draw objects to and from points on the extension line.

• **Insertion:** Snaps to the insertion point of an attribute, a block, a shape, or text.

• **Perpendicular:** Snaps to a point perpendicular to an arc, circle, ellipse, elliptical arc, line, multil ine, polyline, ray, solid, spline, or xline. Carlson Survey automatically turns on Deferred Perpendicular snap mode when the object you are drawing requires you to complete more than one perpendicular snap. You can use a line, arc, circle, polyline, ray, xline, multil ine, or 3D solid edge as an object from which to draw a perpendicular line. You can use Deferred Perpendicular to draw perpendicular lines between such objects. When the aperture box passes over a Deferred Perpendicular snap point, the program displays a Snaptip and marker.

• **Tangent:** Snaps to the tangent of an arc, circle, ellipse, or elliptical arc. Carlson Survey automatically turns on Deferred Tangent snap mode when the object you are drawing requires you to complete more than one tangent snap. For example, you can use Deferred Tangent to draw a line that is tangent to two arcs, polyline arcs, or circles. When the aperture box passes over a Deferred Tangent snap point, the program displays a marker and Snaptip. If you use the From option in conjunction with the Tangent snap mode to draw objects other than lines from arcs or circles, the first point drawn is tangent to the arc or circle in relation to the last point selected in the drawing area.

• **Nearest:** Snaps to the nearest point on an arc, circle, ellipse, elliptical arc, line, multil ine, point, polyline, spline, or xline.

• **Apparent Intersection:** Apparent Intersection includes two separate snap modes: Apparent Intersection and Extended Apparent Intersection. You can also locate Intersection and Extended Intersection snap points while running Apparent Intersection object snap mode is on. Apparent Intersection snaps to the apparent intersection of two objects (arc, circle, ellipse, elliptical arc, line, multil ine, polyline, ray, spline, or xline) that do not intersect in 3D space but may appear to intersect in the drawing display. Extended Apparent Intersection snaps to the imaginary intersection of two objects that would appear to intersect if the objects were extended along their natural paths. You might get varying results if you have both the Intersection and Apparent Intersection running object snaps turned on at the same time. Apparent and Extended Apparent Intersection work with edges of regions and curves but not with
edges or corners of 3D solids.

- **Parallel**: Draws a vector parallel to another object whenever Carlson Survey prompts you for the second point of a vector. After specifying the first point of a vector, if you move the cursor over a straight line segment of another object, the program acquires the point. When the path of the object you create is parallel to the line segment, the program displays an alignment path, which you can use to create the parallel object.

- **Clear All**: This option turns off all object snap modes.

- **Select All**: This option turns on all object snap modes.

**Menu Location**: Settings  
**Keyboard Command**: OSNAP  
**Prerequisite**: None

## System Variable Editor

The AutoCAD engine stores the values for its operating environment and some of its commands in system variables. Each system variable has an associated type: integer, real, point, switch, or text string. This command allows you to list or change the values of system variables.

![Variable Editor](image)

- **List Box**: Contains a list of the variables associated with the currently running version of AutoCAD. There are more items than will display on the list box, use the scroll bar to move up and down through the list. Picking on an item in the list box makes it the current item, causing the information about the item to be displayed, and can be affected by most of the edit commands explained below.

- **Edit Field**: When an item on the list box is picked, its current setting is displayed in the edit field. If you intend to make changes in an item, use standard editing procedures including the use of arrow keys and/or pointer movements.
to make changes. Once changes have been made, you must use the CHANGE options explained below to effect changes. Pressing enter at the edit field will have no effect on the item in the list. If the item selected is a read-only variable, the edit field will be grayed-out and will not allow input.

- **Description**: When an item on the list box is picked, its definition is referenced and displayed in this field. This can be a benefit in learning the uses of the assorted system variables. This is a display only field, so you can't change the description given.

Under Type Group, the type of variable will be displayed indicated by one of the radio buttons. Each of these types are explained below for your benefit. For additional information on variable types used by AutoCAD, obtain and consult a source of AutoCAD documentation.

- **Integer**: Defined as a whole number in the range from -32767 to +32768, no decimal value accepted.
- **Real**: Defined as a real number in the range from -1.797E+308 to +1.797E+308, with extreme decimal accuracy maintained. Some real variables have a smaller range than previously stated.
- **String**: Defined as a sequential array of characters in the range from 0 to 65535 characters, with a range of ASCII (0-255). Numbers can be included in strings, even though they have no mathematical significance.
- **2D Point**: Defined as a list of two real numbers in the range from -1.797E+308 to +1.797E+308 separated by a comma, having extreme decimal accuracy maintained. Always maintain the X,Y format, one (and only one) comma must be used, separating the X and Y.
- **3D Point**: Defined as a list of three real numbers in the range from -1.797E+308 to +1.797E+308 separated by commas. While editing a 3D point, you must always maintain the X,Y,Z format, two (no less or no more), commas must used, separating the X and Y and Z values.

Under Range Group, the variable displayed will usually have a range displayed. The FROM value indicating the minimum, and the TO value being the maximum value accepted.

Under the Store Group, depending on the type of variable, AutoCAD may store the value in the drawing or the configuration file, or it may not be stored. Each of these types are explained below for your benefit.

- **Not Stored**: Some variables, such as PLATFORM and CDATE, are not stored because they are system interdependent.
- **In Drawing**: Most variables are stored in the drawing, making the drawing format more personal than just a database of objects. This allows you to open a drawing and have it behave just as though you had never left it.
- **In Config**: These are variables that remain the same regardless of the drawing opened. APERTURE and PICK-BOX are just two examples of variables stored in the configuration file.

Under Access Group, depending on the type of variable, AutoCAD may not allow you to make changes to it. Each of these types are explained below.

- **Read Only**: Some variables, such as PLATFORM and CDATE, are read-only and therefore cannot be changed. Read-Only variables are marked and the edit field will be grayed indicating that you can't change the variable.
- **Read/Write**: Most variables are read/write and can be changed. These variables are marked and the edit field will be active so you can change the variable.

Under Binary Group, depending on the type of variable, the value may be off or on, yes or no. If the variable type is not binary, this group will be grayed out entirely.

- **Off (0)**: Indicate an off condition. Some variables, such as ATTREQ, are simply on or off toggles. You may change a binary item by clicking in this group to change the variable, or changing the value in the edit field.
- **On (1)**: Indicate an on condition. Binary variables are simply on or off toggles. Their range is from 0 to 1. You may change a binary item by clicking to change the variable, or changing the value in the edit field.
Control Buttons - These buttons are the main controls in the use of the Variable Editor. Each button's purpose is explained below.

- **OK**: Used to accept the changes made during the variable editing process, returning you to the command prompt with changes in effect.

- **Cancel**: Used to cancel the changes made during the variable editing process, returning you to the command prompt without the changes in effect.

- **Load**: Used to load a saved set of system variables. This allows you to create a drawing, save the system variables, open a second drawing, and load those variables into that drawing. Read-only variables are skipped.

- **Save**: Used to save the current system variables to a disk file. All system variables are stored to the file, even those that are marked as read-only.

- **Print**: Used to print the current system variables. After choosing this option, you will be prompted for an output filename, then the program will proceed to write the system variables to the file. This file can be loaded into any editor or word processor, edited and printed.

Variable Buttons - These buttons are used to control the changes in variables, while using the Variable Editor. Each button's purpose is explained below.

- **Change**: Used to execute the changes typed into the edit field. You must use this button, simply pressing enter will not make the change.

- **Restore**: Used to cancel the changes typed into the edit field. If you make a mistake or change your mind while making changes in the edit field, press this button to restore the edit field to the value before editing.

- **Status**: Used to determine if the program will echo the status of changes being made to the command area. If this toggle is on, any changes made from the dialog will echo the change. Also, if a stream of change commands is being read from a file, and the toggle is on, the changes taking place will be displayed.

Note: This command displays many more system variables than are found in the Systems Variable Chapter, which contains a list of supported system variables. Modification of any system variable other than the supported ones found in the Systems Variable Chapter is done at your own risk, and may result in program errors requiring a re-installation of Carlson.

**Pulldown Menu Location**: Settings  
**Keyboard Command**: VAREDIT  
**Prerequisite**: None
All of the routines in this menu operate on points in a Carlson coordinate (.CRD) file. Coordinate (.CRD) files are binary files that contain point numbers, northings, eastings, elevations and descriptions. Alternately, C&G CRD & CGC files, LandDesktop MDB files or Simplicity Systems ZAK files can be used in place of the Carlson CRD file. All routines in this menu will read from, and write to, these types of point data files. At any given time, there can only be one (1) coordinate (.CRD) file set current. If a command is initiated that requires a coordinate (.CRD) file, and there is not one set, Carlson will prompt for a coordinate (.CRD) file name. From that point on, this is the current coordinate (.CRD) file. Another coordinate file can be used by choosing Set Coordinate File, or Open CRD File in Coordinate File Utilities.

Whenever asked for point numbers you can enter any combination with commas and dashes or All to use all points. For example 1-3,7,20-23 would use 1,2,3,7,20,21,22,23. Coordinate files have either numeric or alphanumeric point numbers. Alphanumeric point numbers consist of nine or less digits and letters (i.e. point# 7A). The type of point number format is set when the coordinate file is created. This setting is found under General Settings in Configure. This setting only affects new coordinate files.

Each point is drawn by three entities: point block, point node and symbol. The point block is an AutoCAD INSERT entity with PNTNO, PNTELEV and PNTDESC attributes. These attributes represent the point number, elevation and description respectively. The point node is an AutoCAD POINT entity and is used for picking the point with the NODE snap. The point node is also used as the X, Y, Z coordinate in surface modeling in the Civil Design module.
The symbol can be any symbol defined in the Symbol Library. (Use SPT0 for no symbol). Since points use Carlson point symbols, the AutoCAD system variables PDMODE and PDSIZE should usually be set to 0.

**Point Links**

The points in the drawing can be linked to their coordinates in the coordinate file. The link updates the coordinate file when a point is modified in the drawing. For example, when points are moved with the AutoCAD Rotate command, their coordinates will be automatically updated in the coordinate file. To update the coordinate file without this automatic link, you can run the command Update CRD File from Drawing in Coordinate File Utilities. This option is called Link Points with Coordinate File and can be set in Configure under General Settings. This setting does not affect points currently in your drawing, only points drawn after you change this setting.

**Point Notes**

Each point in the coordinate file has room for a 32 character description. To have a longer description, an associated point note file can be used. The note file has the same file name as the coordinate file with a .NOT extension and is stored in the same directory. For example, survey.not would be the note file for survey.crd. The note file is a text file that stores a point number together with the additional description for the point. There is no limit to the length of the note. Notes can be added to points using the command Input-Edit Point found in Coordinate File Utilities. The List Points command can be used to print out the notes.

**Point Entity Grouping**

For each point, the point attribute block, node, and symbol can be bound together. This means that if you choose to use the Move command (or other AutoCAD tools) the entire collection moves together. This is done using the grouping functionality in AutoCAD.

To disable this system altogether, go to Configure, choose General Settings, and turn off the toggle for Group Point Entities. If you need to temporarily disable grouping in a drawing, you can use the AutoCAD toggle for grouping, which is Ctrl-A. Holding down the Ctrl key and pressing the letter A on the keyboard activates this two way toggle, with the current status echoed to the command prompt area.

**Extended Point Information**

Carlson points include additional information on each element that makes up the point collection (attribute block, node and symbol). This information allows Carlson to know such things as which coordinate (.CRD) the point came from. Commands like Drawing Inspector can then display the point information for the point entities. This also makes it easier for Carlson to identify which AutoCAD objects belong to a point, making commands like Edit Point Attributes a single pick instead of a selection set.
Point Defaults

This command sets Carlson point options.

**Descriptions:** Specify whether you are prompted for a point description when creating points and whether the point descriptions are labeled in the point block.

**Elevations:** Specify whether you are prompted for a point elevations when creating points and whether the point elevations are labeled in the point block.

**Locate on Real Z Axis:** When checked, points are located at their actual elevation, otherwise points will be located zero elevation.

**Attribute Layout ID:** Controls the location of the point number, elevation and description. These attribute layouts are defined in AutoCAD drawings that are stored in the Carlson SUP directory with the file name of SRVPNO plus the ID number (i.e. SRVPNO1.DWG, SRVPNO2.DWG, etc.). If you want to change the attribute positions for a layout ID, then open and edit the associated SRVPNO drawing.

**Symbol Name:** Enter the default symbol name to use. You may also pick the Select Symbol button to select a symbol from the symbol library.

**Prompt for Symbol Names:** When checked, you will be prompted for each symbol name instead of using the default symbol.

**Point Numbers:** When this toggle is OFF, no point number will be created and no points will be stored in the coordinate (.CRD) file.

**Automatic Point Numbers:** When this toggle is OFF, commands that locate a point will prompt for a point number. Otherwise, point numbers are numbered sequentially. If the Start Point Number field is set to 0, no point will be plotted. An exception to this is when you use the *Draw-Locate Points* command and use the Range option, then a point entity is plotted.
The following table illustrates the effects of elevation settings:

<table>
<thead>
<tr>
<th>Elevation settings</th>
<th>Real Z settings</th>
<th>Picked point labels</th>
<th>Point number labels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elevation Yes, Real Z No</td>
<td>Picked point labels: point, Prompts for elevation, uses 0 for z coordinate</td>
<td>Point number labels: point, No Prompt, uses 0 for z coordinate</td>
<td></td>
</tr>
<tr>
<td>Elevation Yes, Real Z Yes</td>
<td>Picked point labels: point, Prompts for elevation for z coordinate</td>
<td>Point number labels: point, No Prompt, uses z coordinate from file</td>
<td></td>
</tr>
<tr>
<td>Elevation No, Real Z No</td>
<td>Picked point labels: point, No Prompt, uses 0 for z coordinate</td>
<td>Point number labels: point, No Prompt, uses 0 for z coordinate</td>
<td></td>
</tr>
<tr>
<td>Elevation No, Real Z Yes</td>
<td>Picked point labels: point, No Prompt, uses z coordinate of picked point</td>
<td>Point number labels: point, No Prompt, uses z coordinate from file</td>
<td></td>
</tr>
</tbody>
</table>

**Start Point Number:** Specify the next point number to use.

**Vertical Angle Mode:** Specify how Carlson should prompt you for vertical angles. None means no prompt. Applies to creating points with commands such as Traverse. The vertical angle is used to calculate the point elevation.

**Separate Layers:** Specify settings for point attribute layers.

- **None:** The point symbol, point number, elevation and description use the layer names PNTMARK, PNTNO, PNTELEV and PNTDESC.
- **Points:** The point number, elevation and description layers are composed by concatenating the point layer and the string NO, ELEV, and DESC respectively. For example, if the point layer is UTIL then the attribute layers will be UTILNO, UTILELEV and UTILDESC.
- **Symbols:** The point symbol layer is composed by concatenating the point layer and the string MARK. For example, if the point layer is UTIL then the symbol layer will be UTILMARK.
- **Both:** The point symbol, point number, elevation and description layers are composed by concatenating the point layer and the string MARK, NO, ELEV, and DESC respectively. For example, if the point layer is UTIL then the symbol/attribute layers will be UTILMARK, UTILNO, UTILELEV and UTILDESC.

**Layer for Points:** Specify the layer name for Carlson points.

**Auto Zoom:** When checked, AutoCAD will perform a Zoom—Center around new points to keep the display centered around current working area. This only applies during commands such as Traverse. This setting is also available in *Configure* under General Settings where it is called Auto Zoom Center for New Points.

**Use Field to Finish For:** Allows you to use the code definitions from Field to Finish for the Point Symbols, Layers, Descriptions, Attribute Layout IDs and whether to locate the point on the "Real Z" and whether to Separate Attribute Layers when creating new points. For example, when creating a point with description "EP", Carlson would look up "EP" in the Field to Finish table and will use the field code definitions to establish the point instead of the definitions defined in Point Defaults.

**GIS File:** This option lets you specify a GIS file to be used when creating new points. The GIS file contains a list of fields to prompt for. For each point that is created, the program will prompt for these fields and store the results.
Draw-Locate Points

The Draw-Locate Points dialog box allows you to insert either new or existing points into the drawing. You can create new points either by picking points on the screen, or by entering northing and easting coordinates. You can also place existing points by entering point numbers which reference the current coordinate file. You are prompted to choose a coordinate file if no coordinate file is current.

The name of the symbol file is displayed in **Symbol Name**. You can choose a different symbol by clicking Select. The selected point symbol is displayed on the right.

**Symbol Rotation Azimuth** is the rotation angle that is used for the point symbols. This angle is used in a counterclockwise direction relative to the current twist screen.

**Layer by Desc** inserts the points in the layer named by the point description. Using Layer by Desc organizes the points by description and allows for layer management. For example, you can use the Isolate Layers command to show only points on a certain layer. If you include an invalid layer character in the description, the layer name stops at the bad character. A point description of "UP / 105" would use layer "UP", for example. The Layer Prefix is added to the beginning of the layer name. For example, a Layer Prefix of "PT_" and a point with the description "EP" would use the layer "PT_EP". Layer Prefix is optional. It allows all the point layers to be grouped.
**Draw Nodes Only** inserts only a point entity (the node) and not the point block and symbol. This option is most useful when you have a lot of points to insert, because inserting only the nodes is faster than inserting nodes with the point block and symbol. Commands such as Triangulate & Contour and Make 3D Grid File can use these points, and do not need the point block and symbol.

Selecting **Elev Text Only** draws text of the point elevation without the point block, symbol, or node. The decimal place of elevation text is placed at the northing and easting point location.

**Locate within Polyline** inserts only the points that are inside a closed polyline. The command prompts you to select a closed polyline. All the points in the current coordinate file are checked. Any points that are located within the closed polyline are drawn.

**Locate within Distance** inserts only the points that are within a specified distance from a reference point. The command asks you for the reference point and the search distance. All the points in the current coordinate file are checked. Any points that are located within the search distance of the reference point are drawn.

**Locate within Window/Coord Range** inserts only the points that are within the specified window or range of northing, easting, and elevation. The command prompts for the minimum and maximum northing, easting, and elevations. These values default to the actual minimum and maximum in the coordinate file. Then the command prompts for the point number range of points to check. The points that fall in both the point number range and the coordinate range are drawn.

Under **Point Prompt-Label Settings**, you determine attributes for which you will be prompted.

**Descriptions** determines whether you are prompted for descriptions for each point when creating new points. When you are placing both new and existing points, Descriptions determine whether this attribute is labeled with the point inserts.

**Notes** works with the note file (.not) associated with the current coordinate file. The note file contains unlimited point descriptions in addition to the fixed 32-character point descriptions in the coordinate file. When you create points with Notes on, the command will prompt for point notes to be stored with the point. When you draw existing points with Notes on, any notes for the points are drawn as text entities below the point description.

**Elevations** determines whether you are prompted for elevations for each point when creating new points. When you are placing both new and existing points, Elevations determine whether this attribute is labeled with the point inserts.

Use ‘+’ labels the positive elevations with a leading ‘+’. For example, ”+159.43”.

Use ‘-’ labels the negative elevations with a leading ‘-‘.

**Locate on Real Z Axis** determines if the points are placed at their elevations or at zero elevation.

**Label Zeros** will label points with zero elevation when the Elevations option is on. Otherwise only points with nonzero elevation will be labeled.

**Elevation Prefix/Suffix** set the prefix and suffix labels to apply for the elevation labels.

**Elevation Integers** controls the number of digits to display to the left of the decimal point for the elevation label. The All setting will show the full elevation digits. The other settings allow you to limit the number of digits to display for the purpose of reducing the amount of space the elevation labels take up in the drawing. For example, if a site is in the 4000 foot elevation range, then this setting could be set to three digits (000) and an elevation of 4321 would be labeled as 321.

**Elevation Decimals** sets the number of decimals to the right of the decimal places for the elevation labels.

Under **Point Number Settings**, you determine how points will be numbered.
**Point Numbers** determines whether the complete point block is drawn or just the symbol and node. When you create new points with Point Numbers off, no points are stored in the current coordinate file, and only the point symbol and node are drawn. When you draw existing points with Point Numbers off, the point attribute block is not drawn and only the point symbol and node are drawn.

**Automatic Point Numbering** applies to creating new points. With this option active, the command will use the **Starting Point Number** for the first new point. The next point number is automatically incremented. Before storing the point, the command checks whether the point number is used. If the point number is used and point protect is on (set in the Coordinate File Utilities command), then the command will prompt for another point number or to overwrite the point. With Automatic Point Numbering off, the command will prompt for the point numbers.

Determine how the points are to be displayed and in what layer.

With **Wildcard match of pt description**, you can display only points with specific descriptions. This can be thought of as a filter. For example, entering IP would display only points that are labeled with the description IP, or Iron Pin. The default is the asterisk (*). This will display all points regardless of description.

**Layer Name** allows you to designate a layer for the points to be displayed. You can enter a new name or choose an existing layer by clicking **Select Layer**. A Carlson Survey point consists of a block insert with attributes, a point symbol, and a point entity. The point entity is used for picking the point by OSNAP Node in other commands. The block insert includes a point number, elevation, and description. These attributes are in the PNMARK, PNTNO, PNTELEV, and PNTEDESC layers. The points are also in an overall layer as specified in this dialog box. This layer setup allows you to freeze a group of points by the main layer name or freeze point attributes for all the points in the drawing. For example, freezing layer "PNNS" would freeze all the points in this layer. Freezing layer "PNTELEV" would freeze the point elevation attribute for all the points.

The **Erase Duplicates** option will erase existing point entities that match the point numbers currently being drawn.

**Fix Overlapping Point Attributes** will detect point number, elevation and description attributes that overlap with other points. Rules can be applied to rearrange the point attributes to avoid the overlaps. A point overlap manager then steps through each overlap for review or manually moving the attributes.

**Draw Range** will draw existing points from the current coordinate file. The Draw Range button will prompt for the point numbers to draw.

**Draw All** will draw all the points in the coordinate file, and then zoom the extents of the display to show the points.

**Draw Point Group** will draw a point group with settings that are established in the Point Group Manager.

**Enter and Assign** can be used to create new points using the point northing and easting.

**Screen Pick** allows you to create points by picking the point coordinate on the screen. For example, you could set the Object Snap toEndPoint and pick the end point of a building polyline to create a point at the building corner.

**Prompts**

To create a new point:

**Draw-Locate dialog** choose **Screen Pick**

**Pick point to create:** pick a point

Select/<Enter Point Elevation <0.00>: Enter elevation Press S to select text to set elevation.

Enter Point Description <*>: Enter

N: 5106.57 E: 4901.96 Z: 0.00

Enter/<Select text of elevation>: Select text entity that defines elevation of point.
To locate a point in the coordinate file (point number 3 in this example):

**Draw-Locate Point dialog** choose **Draw Range**

**Point numbers to draw:** 3

**Points Drawn:** 1
Locates point 3.

**Point numbers to draw:** 1-2

**Points Drawn:** 2
Locates a range of points. From 1 to 2.

**Point numbers to draw:** `Enter`

**Keyboard Commands:** `lpoint`

**Prerequisite:** A CRD file and you may want to execute **Drawing Setup** (see the Setting menu) to set the scale and size.

**File Names:** `\lsp\lp.lsp, \lsp\crdutil.arx`

### List Points

This command generates a report of point numbers, northings, eastings, elevations and descriptions.

**Selection Method-Range** allows you to specify the points to list by point number range

**Selection Method-Area** allows you to select a closed polyline to list all of the points inside of that polyline.

**Selection Method-Selection Set** allows you to specify the points to list by selecting them from the drawing.

**Range of Points:** If you are using the Range method, specify the range of points to list here. To quickly specify all points, click the **All** button.
**Point Group** allows for the selection of a specified group or multiple groups for listing. Standard windows selection tools, ctrl and shift keys, can be utilized for selecting groups.

![Select Point Group(s) window](image)

- **Description Match**: Can be used to filter the point list. For example, entering "EP" for the Description Match would only list those points with a description of "EP". An asterisk (*) is the default setting, it matches any character sequence, meaning no filtering occurs.

- **Report Coordinate Range**: When checked, the point list will include the minimum and maximum northing, easting and elevation.

- **List Point Notes**: When checked, any additional point notes assigned to the points will be included in the point list. Point notes can be entered using the *Input-Edit Point* command found in *Coordinate File Utilities*.

- **Use Report Formatter**: When checked, you may customize the fields and layout of the point report using the Report Formatter. The Report Formatter can also be used to export the point report to Excel or Access.

- **Double Space Between Points**: When checked, the report will be double spaced.

The point list report is displayed in the Standard Report Viewer which can print, draw and save the report file. This report viewer cannot be used to edit the coordinate file. Instead use the *Edit Points* command in the Points menu.

**Example of List Points Report**:

```
List Points Report
File> C:\Carlson2008\DATA\POINTS.CRD
Job Description>
Job Number> 0.000 Job Date> 06/01/2002
PointNo. Northing(Y) Easting(X) Elev(Z) Description
1  5355.240  5000.000  91.8  CP2
2  5000.000  5000.000  90.0  CP2
1000  5355.236  5000.000  91.8  CK
1001  4941.911  4622.029  91.4  FPC
1002  4952.629  4642.818  90.6  FH
1003  4959.931  4634.440  89.8  TOE1
```
**Pulldown Menu Location:** Points  
**Keyboard Command:** listpt  
**Prerequisite:** Points in a coordinate file or on the screen  
**File Name:** \lsp\crdutil.arx

## Import Text/ASCII File

This command converts point data from an ASCII text file into the current Carlson coordinate (.CRD) file. Each line of the text file can contain any combination of point number, northing, easting, elevation and description. All point information should be on one line with the values separated by a comma, space or other delimiter. Under the Source File Format setting you can choose from some specific formats or User-Defined. For User-Defined, the format of the text file is specified in the Coordinate Order field where the value identifiers are listed with the appropriate delimiters. For example:

For a text file with northing, easting, elevation and comma delimiters:

- 5100.0,5150.5,485.1  
- 5127.1,5190.3,487.3

The Coordinate Order would be: Y X Z

For a text file with point number, easting, northing, elevation, description and space delimiters:

- 1 5000.0 5000.0 490.3 TRAV  
- 2 5030.4 4930.5 495.5 TRAV

The Coordinate Order would be: P X Y Z D

Common formats can be selected from the Common Format List. All the lines in the text file should contain only point data and any header lines should be removed. To read the text file, pick the Select Text/ASCII File button and choose the file to read. Then the selected file is displayed in the Preview Window to help with filling out the Coordinate Order. When the Coordinate Order is set, click OK to read the text file. The Wild Card Descriptions Match allows for only point with matching descriptions to be imported. With Point Protect active, the program will check if a point number already exists in the CRD before importing the point. If a point conflict is found, you can either assign a new point number or overwrite the old point. The Value to Add to Point Numbers allows you to renumber the points as they are imported. The Header Lines to Skip value is the number of lines not to be processed at the start of the text file. The Point Group To Assign option will create a point group with the specified name for the coordinate file containing the point numbers imported with Import Text/ASCII File.

Multiple files can be imported at once. To do this toggle on the Enable Process Multiple Files option. After selecting the Text/ASCII Files button, you can select multiple files by using the Shift or Ctrl keys while picking files. You can also run Select Text/ASCII Files multiple times allowing for selection of files located in different locations. The files to import are listed in the top scroll display window. The point data from all the import files can be stored to the current CRD file or to separate files for each import file. The separate file option will name the resulting CRD files with the same name as the import file with a .CRD file extension. For example, the import file job125.txt would create job125.crd. The CRD file will be created in the same location as that of the selected text file to import.

The special formats of Leica .gsi files, TDS .cr5 files, Geodimeter .obs/.raw files, Laser Atlanta .txt files, Trimble .pos files, Zeiss .txt files, Traverse PC .trv files, Maptech, Benchmark .dat files and Cadvantage .cog files can be directly imported by choosing that File Format at the top of the dialog.
Pulldown Menu Location: Points
Keyboard Command: readpt
Prerequisite: A text file to read
File Name: \lsp\crdutil.arx

Export Text/ASCII File

This command outputs point data from the current Carlson coordinate file to an ASCII text file. Specify the type of file to write with the Coordinate Order radio buttons. There are several variations on point number, northing, easting, elevation and descriptions as well as specific formats for Leica, Geodimeter, Zeiss, Maptech, D45, Cadvantage, Multiplane and SDMS CTL formats. In addition there is an option, User-Defined Format, to define the order of
the fields output. When using the User-Defined format, after selecting OK, the User-Define Export Format dialog will appear. On this dialog, specify the order of the fields by defining a number sequence in each field. You can skip fields and omit data in the output file by leaving None in the sequence field for this data.

Specify the Delimiter of the export file as either Comma or Space in the Delimiter field. There are three Selection Methods provided for the data to export. Specify either Range, Screen Points or Screen Entities in the Selection Field. A Range selection is a user specified range such as 1-10,30-50. A Screen Points selection is made by selecting points from the screen area. The Screen Entities option allows for selection of polylines, lines, arcs, points, faces, inserts and text to export point data from. When the Screen Entities option is selected, the following dialog box will display allowing for the specification of the type of entity to export data from.
A description filter is also available for exporting only points from the range or selection set with certain descriptions. After selecting the OK button, another dialog appears that allows you to specify a new text?ASCII file or to append data into an existing file. The standard file selection dialog allows you to specify the export file name.

**Pulldown Menu Location:** Points  
**Keyboard Command:** writept  
**Prerequisite:** A Coordinate File (.CRD)  
**File Name:** \lsp\crdutil.arx

Set Coordinate File

This command allows the user to set the name of the active coordinate file. This file is used by different commands that compute, store and recall point coordinates. Carlson coordinate (.CRD) files are binary files that contain point numbers, northing, easting, elevations and descriptions. Alternately, C&G CRD & CGC files, LandDesktop MDB files or Simplicity Systems ZAK files can be used in place of the Carlson CRD file. These files are stored by default in the configured data subdirectory. When prompted for the name, if you type in a path name the file will be stored in the specified path. If you don't specify a path then the default path that is configured in the Configure command, found under Settings, will be used.

When executed, the command defaults to the Existing tab for selection of an existing file. You may select a file from the list of Recent Folders, or choose the Browse button to go to a specific location on your computer. To create a new file, select the New tab and enter the name of the file in the file name field provided. Use the Browse button to specify the desired location to save the file.
**CooRDinate File Utilities**

This command allows you to manipulate the coordinates stored in a coordinate (.CRD) file. One of the most important commands is the Update CRD File from Drawing which allows you to update the file after editing the drawing with commands such as *Erase, Move, Rotate* or *Change Elevations*. Another handy option is the *Draw Entities by Point Number* which allows the user to input point number ranges and plot Lines, Arcs, Polylines or 3D polylines. Coordinate files have either numeric or alphanumeric point numbers. Alphanumeric point numbers consist of nine or less digits and letters (i.e. point number 7A). The type of point number format is displayed at the top title bar of the main dialog.
Open CRD File: Allows the user to switch to another file. When you exit Coordinate File Utilities this will be the current file that you work with in Carlson.

Copy/Merge CRD File: This command allows for the copying of entire CRD files, or parts of CRD files, to a new or existing files. This can be used to make a backup of your coordinate file, and it can also be very valuable in coordinate file manipulation. For example, if a certain range of points from one CRD file was also required in the active CRD file, this command would be used to simply copy the required range into the active CRD file. There are two options when first executing the command. These options are whether to import points from another file to the current (active) CRD file, or to export the current (active) coordinate file to another file.

Once this option has been decided, a prompt for the file to copy From or TO, will be displayed. Here simply specify the correct file.
Next there's a dialog to specify the range of points to transfer and some options. Here specify the points to copy. Point numbers and ranges can be entered together, for example, 1-3,10,15 would result in points 1 through 3 and points 10 and 15 being copied. The Description Match can be used to filter the points to transfer only the points with matching description. The default of * will transfer all the points in the range. The Store Non-Conflicting Point Automatically will set the transfer action as Store for all transfer points that don't have a point protect conflict. The Skip Merge Dialog If No Conflicts will skip the next dialog when there are no point protect conflicts.

Next there's the Merge Points Manager dialog that shows the Source Coordinate File on the left (where the point data is being copied from) and the Target Coordinate File on the right (where the point data is being written to). Conflict cases are when the same point number exists in both files with different coordinates. The action choices for conflicts are to Overwrite, Skip or Renumber. For renumber, you can either renumber with the next available point number in the target file or to the highest point number in the target file plus one. Non-conflict cases are when the source point number does not exist in the target file. The action choices for non-conflicts are to Store or Skip. You can assign actions by picking on the Action field in the spreadsheet or by entering in a Point Range to apply and picking an action button. The Show Matching Points toggle will show points with matching point data in both files. Otherwise only point with differences are shown. The Next Conflict button will highlight the spreadsheet and set the Point Range to the next point that needs an action assigned. Similarly, the Previous Conflict sets focus to a lower point number that needs an action. The History button shows the point history for the selected point. The
Report button creates a list points report. The Current Merge Status reports the number of unresolved and resolved points. When all the unresolved points are resolved by assigning actions, you can pick OK.

**Convert CRD File Format:** This allows you to convert the current CRD file from numeric format to alphanumeric format or visa versa. This routine will also change crd files to and from different software formats. These formats include C&G, AutoDesk Land Desktop, and Simplicity. The current format of the active coordinate file will be displayed as well as the options for the new file format. This command only changes the format of the active coordinate file.

![Convert CRD File Format](image)

**Map Points from 2nd File:** This routine adds point to the current CRD file from points stored in a second CRD file. The points to copy are specified by numbers one at a time. Prompts for the destination point number (number to create in current crd file) and source point number (point number to be copied from second crd file) will be displayed.

**Import Text/ASCII File:** This routine converts point data from a text file into the current coordinate (.CRD) file. See the Import Text/ASCII File command in this chapter for more information.

**Export Text/ASCII Text File:** This routine outputs point data from the current coordinate (.CRD) file to a ASCII Text file. See the Export Text/ASCII File command in this chapter for more information.

**Edit Header:** Enter or edit the job information associated with the coordinate file. The fields include Job Description, Job Number and Job Date. This information will appear on the List Point report. Non-digit characters are not allowed in the Job Number field.

![Edit Header](image)

**Compress CRD File:** Removes unused point numbers by renumbering high point numbers into the unused spaces. For example, for an original file with points 1,2,105,107,108,109 would be compressed to 1,2,3,4,5,6.
Coordinate Transformation: Transforms coordinates between local, state plane 27, state plane 83, latitude/longitude, and Universal Transverse Mercator (UTM). Works on individually entered coordinates, by range of point numbers and with on-screen entities. For converting between state plane 27 and 83, Carlson calls upon NADCON from the National Geodetic Survey to apply the latitude/longitude adjustment. The NADCON program, ndcon210.exe, is stored in the Carlson EXEC directory.

The Transformation Type is used to define the Source Coordinate and Destination Coordinate formats. Settings for Lat/Long Datum, Lat/Long formats (dd.mmss or dd.dddd), Projections, State Plane Zones and coordinate units are defined in the Transformation Type dialog. The format of this dialog will change depending upon the type of transformation requested.
For all Transformation types, there are three options for inputting the data to be transformed. Data can be selected from the screen by using the **Screen Entities**. If a range of points or a particular point is desired, the **Point Numbers** option would be used. Manual entry of coordinates to transform one at a time is accomplished with the **Enter Coordinates** option. The coordinates can be typed in or use the Input Point Number option. **Output Point Number** is an option to store the results in the coordinate file.

For all transformations there are two output options when using point numbers as the input data. **Overwrite Existing Coords** replaces the original coordinate values with the new coordinate values after transformation. **New Point Numbers** will retain the original coordinate data and point numbers and create new point numbers with the revised coordinate data after transformation.

When transforming a **Local Coordinate System**, there are two options for defining the transformation as shown in the next dialog.

The **Align by Two Pairs of Points** option uses two pairs of source and destination coordinates. The first pair defines the translation as the difference between the source and destination northing and easting.
This destination point is also the pivot point for rotation. Rotation can be entered directly or defined by a second pair of points where the bearing between the first and second source points is rotated to align with the bearing from the first and second destination points. There is an option to also apply scaling. The scaling holds the angle between points and adjusts the distances by the scale factor. The scale factor is calculated for each point as the elevation factor at the first source point times the grid factor at the first destination point averaged with the elevation factor at the transform point times the grid factor at the transform point.

The **Least-Squares Best-Fit** option is used when there are more than two pairs for translation points. Since two pairs of points are sufficient to define the translation and rotation, more than two pairs of points provides more than enough information.
Over **Determination by Plane Similarity** is used to find the least squares best fit transformation for all the given source and destination points. Besides doing a translation and rotation, this option will also scales the points during the transformation. The **Rigid Body Transformation** also does a best fit least squares transformation, but applies only translation and rotation with no scale. The **Helmert 7-Parameter** method can also be used for local transformations. The **7-Parameter Values** can be calculated from control points or entered by the user.

The **Add** button is used to define the source and destination coordinates for the points that define the transformation. Pressing this button brings up the following dialog box.

The **Edit** button is used to edit existing data.

The **Delete** button removes the source and destination pairing from the transformation setup.
The **Process On/Off** button allows source and destination pairings to be turned on and off. This is useful when wanting to inspect different results using different pairings.

The **Optimize** option chooses which point pairings would yield the best transformation results by turning off the processing of pairings with higher residuals. This minimizes the average residual for the control points.

The **Report** option displays a report of the transformation point pairings, their residuals, processing status, transformation scale and avg. residual.

The **Load** and **Save** options allow for saving and recalling local coordinate transformation pairings and settings.

**Draw Entities by Point ID:** Draw Lines, Arcs, 3DLines, Polylines or 3DPolys by defining a range of point numbers.

**Prompts**

**Plot Entities by Point Number**
Type of entity, Arc/Polyline/3dpoly/2dline/Exit/<>Line>: P This response causes the program to plot polylines. Example: ‘1*4-7-10*12-5-8’ would draw lines from point number’s 1 through 4 then to 7, to 10 through 12, then to 5 to 8. (limit 132 characters)

Undo/<>Enter point numbers or ranges>: 1*10-20*30
The program draws a polyline from point number 1 through 10 to point number 20 through 30.

**New Last Point Number:** This option sets the highest point number in the CRD file. All points above this number are erased.

**Swap Northing-Easting:** This option allows you to swap northing and easting coordinates for any selected range of points. What was the northing of an existing coordinate point, or range of points, becomes the easting. And the easting(s) becomes the northing(s).

**Point Entry CRD File Links Manager:** When points are created in the drawing, the program records the source coordinate file for the points. The coordinate file names assigned to the point entities links the point entities back to the coordinate file. These links are used by routines that process the point entities and then need to reference the coordinate file such as Move Point which selects a point entity and updates the coordinate file. This routine checks all the point entities in the drawing and lists all the linked coordinate files. You can use the Assign button to set the
coordinate file assigned to point entities which is useful when the coordinate file has been moved after the points were drawn. Use the Unlink button to remove the link.

**Update Drawing from CRD File:** This function updates the position of Carlson points in the drawing to match the position stored in the coordinate file. This command also has options to erase and draw points. For the erase option, points are erased from the drawing if the point number does not exist in the coordinate file. For the draw option, if a point number in the CRD file does not exist in the drawing, then this point is drawn using the settings from the dialog. The number of points modified, erased and drawn is reported at the end of the command.

**Update CRD File from Drawing:** This function allows you to select all or some of the points in the drawing and add or update them to the .CRD file. The points can be filtered with AutoCAD’s Select Objects: selection mechanism and/or wild card matching of the point descriptions. The Update Point Descriptions option determines whether the point descriptions from the drawing will be stored to the CRD file. Use this command to update the file after a global edit such as *Move, Rotate, Renumber Points, Change Elevations, Erase*, etc. This routine directly reads Leica.
List Points: List the points stored in the .CRD file. See the List Points command in this chapter for more information.

Delete Points: Deletes points in the coordinate (crd) file by point number or description.

Screen Pick Point: Pick a point on the graphics screen and it's coordinate values are added to the coordinate (crd) file. Prompts for point number, elevation and description will be displayed. This command does not plot a point, point attributes or point symbol. Use the command Draw-Locate Points command to do this.

Scale Points: This option multiplies the point northing, easting, and elevation by the scale conversion factor. You can use this routine for metric-English conversion. See the Scale Points command in this chapter for more information.

Translate Points: This option translates a range of points based on entered delta x and delta y, entered coordinates or translation point numbers. See the Translate Points command in this chapter for more information.

Rotate Points: This option rotates a range of points based on entered degrees or rotation, entered azimuths, entered bearings or rotation point numbers. See the Rotate Points command in this chapter for more information.

Align Points: This option does a translate based on a source point and destination point and then rotates to align the first source point and a second source point with the first destination point and a second destination point. See the Align Points command in this chapter for more information.

Description for Points: This option sets the point description field with the user-specified text for a range of point numbers.

Elevation for Points: This option sets the elevation of a specified point or range of points.
**Point Number Report:** This routine lists the used and the unused point numbers in the CRD file.

**Duplicate Points:** This function searches the CRD file for points with the same northing, easting and elevation. The tolerances for considering points to have the same coordinate are set in the dialog separately for northing/easting and elevation. To be counted the same coordinate, both the northing/easting and elevation must be within the tolerance distance. The duplicate points can be erased or only reported. For the erase option, the first point number is kept and any higher point numbers with duplicate coordinates are erased from the CRD file.

**Compare Points:** This function compares the coordinates in the .CRD file with either the coordinates for the matching point numbers in the drawing file, with matching point numbers from another CRD file or with different point numbers from the same CRD file. A report is created for any differences that shows the point numbers and the differences. The difference can be reported as a bearing and distance between the two points, as distance North/South and East/West or as the delta-X and delta-Y. There is an option whether to include the point coordinates in the report.
Example Bearing-Distance format Compare Points Report

**Renumber Points:** This option renumbers points in the user-specified range starting from a new point number. The old point numbers are erased. The condense points will renumber such that there are no unused point numbers in the renumbered range. Otherwise the spaces between the points is maintained. In the example shown, renumbering 1-25 with points 1,2,24,25 to starting point number 101 will result in points 101,102,103,104 if condense is on or 101,102,124,125 if condense is off.

**Input-Edit Point:** Enter or edit the coordinate values or the description of a point. The Notes section is for adding optional point notes which are additional point descriptions. The standard description field is limited to 32 characters. Under notes, any number of lines of text can be assigned to the point. A list box shows the lines of notes. To add a note line, pick a blank line in the list box and then type in the note in the edit box belong the list box and press Enter. To edit a note, highlight the line in the list box and edit the text in the edit box.
Point History: All changes to the coordinate file will record the commands performed on this coordinate file and the status of the points themselves. This makes up the coordinate file history. The history can then be reported by point number or by command. All of the changes can be rolled back. It is important to note that if maintaining such a history file is your objective, in the Settings > Configure > General Settings dialog you must make sure that Maintain CRD History File is checked.
The **Disable History Feature** button at the top of the dialog shown above is a toggle device. It should be clicked if you prefer not to build the point history file. Clicking it a second time changes it back to saying **Enable History Feature**. You can also choose **Delete History File** to delete the file altogether. By clicking any point from the list, as shown in the Points tab example above, and then selecting **History**, you will be given the history for that specific point. Double-clicking on any command shows the details. Clicking on **Details** also shows the selected command’s details. **Undo thru Selected** will undo the effect of all of the commands up through and including the selected command. The changes from the undo command are themselves then added to the command list and can be undone in the future.

**Point Protect Toggle:** This option, located at the bottom-left of the main *Coordinate File Utilities* dialog, toggles point protection on and off. With this option on, when attempting to store a point with a point identifier (point number) that already exists in the current coordinate file, the following dialog will be displayed.
Overwrite with new coordinates will update the existing point number with the new location of the point.

The Use Another Number field displays the point number that will be used if the Use Another Number option is selected. This number will depend upon the option chosen from the Another Number From settings. If Next Available is chosen, the next available number will be displayed in the Use Another Number Field. If there are number gaps in the coordinate file this number will not be the next highest number in the file. For example if points 1-10 and 20-30 exist in the crd file leaving a gap from 11-19, the Next Available number would be 11. If the desired point number, in this example, is 31, then the option of End of File would be selected.

The Overwrite All and Renumber All options apply when more than one point with the same number exists in the coordinate file. These options are helpful when importing points into existing CRD files.

Pulldown Menu Location: Points
Keyboard Command: cfu
Prerequisite: None
File Names: \lsp\crdutil.lsp, \lsp\crdutil.arx, \lsp\scadcfu.dcl, \lsp\scadfile.dcl

**Point Group Manager**

This command is used to create point groups based on inclusion and exclusion filters. The manager can perform various functions on these point groups. Also point groups can be referenced by group name in other commands such as Field to Finish and Data Collection.

![Point Group Manager](image)

**Groups Pulldown**

Create Point Group: This option creates point groups. When selected, the New Point Group dialog box is displayed.
**Group Name** is the name of Point Group to create.

**Description** is the description of Point Group to create.

Use the **Include Tab** to define the filters to be applied when creating the point group. Inclusion rules are applied before the exclusion rules.

When **Include All** is toggled on, all points in the coordinate file will be included in the selection.

When **Point List** is toggled on, an option of defining the point list must be selected.

**DWG: Select** allows for manual selection of the points to include from the drawing. The points must be drawn on the screen prior to using this option. All standard AutoCAD selection tools, are available for selection of the points.

**DWG: Add Within Circle** allows for selection of the points to include by a user defined circle. The circle is defined by specifying the center and radius of the circle. The radius can be defined by entering in a numeric value or by picking on the screen. Points must be drawn to the screen prior to using this option.

**DWG: Add Within Polyline** allows for the selection of points to include by referencing a closed polyline. All points located within the closed polyline will be included in the selection. Prompts for the inclusion polyline and the exclusion polyline will display. The inclusion polyline limits of the selection area. The exclusion polyline defines the area to exclude within the inclusion polyline. Points must be drawn to the screen prior to using this option.

**CRD: Select** allows for manual selection of the points to include from a point list. Standard window selection tools are available for selecting the points to include.
**CRD: Add Within Circle** allows for selection of the points to include by a user defined circle. The circle is defined by specifying the center and radius of the circle. The radius can be defined by entering in a numeric value or by picking on the screen. The points do NOT have to be drawn to the screen prior to selection.

**CRD: Add Within Polyline** allows for the selection of points to include by referencing a closed polyline. All points located within the closed polyline will be included in the selection. Prompts for the inclusion polyline and the exclusion polyline will display. The inclusion polyline limits of the selection area. The exclusion polyline defines the area to exclude within the inclusion polyline. The points do NOT have to be drawn to the screen prior to selection.

**Elevation Range** allows for the selection of points within a specified elevation range to be included in the group. The minimum and maximum elevations can be entered manually in their respective data fields. The minimum and maximum values can also be specified by the Set By Selection and Set From List options.

**Set By Selection** allows for selection of points to include in the group from the drawing. The points must be drawn to the screen prior to using this selection method. Standard AutoCAD selection methods are available.

**Set From List** allows for selection of points to include in the group from a point list. Standard Windows selection tools are available with this option.
The **Description** option allows for a selection of points to include based upon the description of the point. The description to filter for can be entered in the data field or by using the Set By Selection and/or the Set From List options described above.
The **Exclude Tab** allows for defining rules that pertain to the points to be excluded from the Inclusion selection. After defining the inclusion rules for the group, the options on the Exclude tab can be used to filter for points to exclude from the group. For example, if the inclusion rules call for all points within the elevation range of 8 to 12, an exclusion rule can be set to exclude the points on elevation 9 or with the description tree. The options on this tab work exactly like the options on the Include tab. Please refer to the Include tab definitions for further instruction.

**Save Changes** saves the point group to the group name specified based upon the Inclusion and Exclusion rules specified.

**Cancel Changes** discards specified rules and changes and goes back to the Point Group Manager dialog.

**Edit Point Group** allows for editing of existing point groups. From the list of available groups, highlight the group or groups to edit. When complete with the first group, if more than one is selected, selecting the Save Changes option will save the changes to the active group and switch to the next group in the selection set.

From the Groups pulldown, select Edit Groups, the Edit Group dialog box will now appear.
See Create Point Groups for further definitions of the available options.

**Delete Point Groups** deletes specified groups for the existing group list. One or more groups can be deleted at one time.

**Import Point Groups** allows for importing filters from point group manager settings of other coordinate files. This is a useful option when coordinate files are going to contain same point group names with the same filters. This option only brings in the filters into the point group manager, it does not import actual points into the coordinate file by group name. Existing points in the active coordinate file that meet the filter definitions of the imported point groups will automatically be added to the corresponding group.
The **Insert into Drawing** option draws the points in the group in the drawing. Individual points or point ranges can be selected from the group to be erased from the drawing. For example, points 264-275 and point 298 contained in group Wet Lands are tagged to be erased from the drawing in the following figure.

The symbol to be used and the attribute layout are determined by the Point Default Settings. The symbol size and the point attribute size are determined by the settings in the Drawing Setup routine.

**Erase from Drawing** erases specified point group/groups or specified points from within the group from the drawing.

**Erase from Coordinate File and Drawing** erases the points in the specified group/groups or specified points from within the group from the drawing and will also permanently delete the points from the CRD file. You will be prompted with a warning as follows:
Selecting **Yes** will complete the command and erase the points from the screen and also the coordinate file. Selecting **No** will cancel the command leaving the drawing and the coordinate file unchanged.

The **Report** option will generate a point list of the points contained in the selected group/groups or specified points from within the group.

The **Highlight** option highlights the specified objects in the drawing. This makes them distinguishable from the other points on the screen.

The **Draw 2D Line** option draws a 2d polyline between the points contained in the group/groups or between specified points in a group.

The **Export** command exports the selected group/groups or the specified point(s) or range of points from within the group to various formats. The available formats are ASCII/Text, Carlson Software CRD and C&G CRD files.

When **ASCII/Text** is selected, the Export Text/ASCII File dialog box will be displayed. Please refer to the Export Text/ASCII File section of the manual for more information.
The **CRD-Carlson software** command writes the selected group/groups or the specified point(s) or range of points within the group to a new Carlson formatted CRD file.

Specify the file name of the CRD file to create and press save.

**CRD-C&G** writes the selected group/groups or the specified point(s) or range of points within the group to a new C&G formatted CRD file.

Specify the file name of the CRD file to create and press save.
Edit Points

This command edits point data in the current coordinate file or within a point range. The current coordinate file can be set with the Set Coordinate File command. Edit Points shows all the points in the coordinate file. New points can be added and points can be deleted by using the Insert and Delete keys.

This tool also lets you edit notes associated with each point. While the standard point description is limited to 32 characters, the drawing notes are not. When you click on a given point, you can add numerous lines of notes about that point in the bottom of the dialog. Keep in mind that these notes are stored in a separate file with the extension ".not" having the same name as the CRD and residing in the same folder.
Erase Points

This command erases Carlson points inserts from the drawing. The points to erase can either be selected from the screen or specified by point number, point number range or by point group. Erasing a Carlson point will erase the point symbol, point attributes, and point node. The points may optionally be erased from the coordinate file. As long as the points are not deleted from the coordinate file, they can be redrawn with Draw-Locate Points.

Prompts

Select points from screen, group or by point number [Screen/Group/\<Number\>]? press Enter
Point numbers to erase: 1-5
Delete points from coordinate file (Yes/\<No\>)? press Enter
Erasing Carlson Points ....
Number of points erased > 5

Pulldown Menu Location: Points
Keyboard Command: DELPT
Prerequisite: Carlson points to be erased
File Name: \lsp\delpt.lsp

Freeze Points

This command freezes Carlson points to hide them from view without erasing them. Use the Thaw Points command to show the points again. This command works similar on points as Freeze Layers works on layers. The points to freeze can be selected by point number range, point group, inclusion/exclusion perimeter polyline areas, or screen selection. There is a dialog to choose the method and specify a description match filter.

Pulldown Menu Location: Points
Keyboard Command: freezepnt
Prerequisite: Carlson points to freeze
File Name: \lsp\crdutil.arx
Thaw Points

This command thaws Carlson points that were frozen with the Freeze Points command to show the points in the drawing again. This command works similar on points as Thaw Layers works on layers.

Pull down Menu Location: Points
Keyboard Command: thawpt
Prerequisite: Frozen Carlson points
File Name: \lsp\crdutil.arx

Translate Points

This command translates points in a coordinate file from one coordinate position to another. The delta X, Y, and Z can be entered directly or calculated from original and destination coordinates. The original and destination coordinates can be entered directly, specified by point number, selecting the point number from a point list by selecting the list icon, or selected from the screen by selecting the pick icon. Once these points have been specified, the Delta X,Y,Z, if Process Elevations is checked ON, fields will be filled in with their calculated values. Any points in the drawing will be updated automatically in addition to updating the coordinate file.

Define Translation By Angle/Distance requires a specified direction, Northeast (NE), Southeast (SE), Southwest (SW), Northwest (NW) or Azimuth (AZ) along with a specified distance in order to perform a translation. Once the
direction and distance are entered, the Delta X,Y,Z will be calculated. This is a useful command when you know that the job needs to shift, for example, to the Northeast 25 degrees for a distance of 100 feet. Here you would simply type in 25 in the Angle (dd.mmss) field, choose NE in the Type field and then enter the distance of 100 in the Distance field.

With Process Elevations checked, all elevations will be translated by the specified or calculated Delta Z value. This option is very useful in correcting point elevations after performing a survey with assumed elevations and then later surveying into a benchmark with known true elevation. In this case only the Delta Z value, use (-) to indicate a lower correction, and the range of points to translate would be required for a translation. For example if the entire job needed to be lowered by 5', the Delta Z would be defined as -5 and the Range of Points defined as ALL.

Ignore Zero Elevations is only available when Process Elevations has been chosen. With this option checked ON, all points with an elevation of 0 will be ignored resulting in no translation taking place on these points.

With Translate Screen Entities checked ON, after specifying the point range or group to translate and selecting OK on the dialog box the following command line prompt is displayed:
Select objects to rotate (points excluded):
At this prompt select the objects on the screen, polylines, lines, arc, etc., to also translate and press enter. The translation of the points and screen entities will be completed.
Various Output Options for the translated points are available.

Overwrite Existing Coordinates will overwrite the existing coordinate points with the new translation coordinates thus changing the coordinate values in the existing crd file.

New Point Numbers will assign new point numbers to the translated coordinate points and leave the original coordinate points unchanged and present in the coordinate file. When using this option, on the Range of Points to Translate dialog, there is a Value to add to point numbers field. In this field, enter the value to add to the point numbers. For example if the existing point numbers are 1-20, and the value to add is 100, the resulting new point numbers will begin at 101 and end at 120.

New CRD File will place the translated coordinates in a new crd file. After selecting OK to the range of points to translate dialog, the Coordinate File to Create dialog will appear. On this dialog enter the name of the new crd file and select save. The original crd file will remain unchanged and the new file will contain the points with the translated coordinates.

Specifying the points to be translated is accomplished either by specifying a Range of Points (1-20,33,36-40,...) or by Point Groups. If using the Point Group option, the Select Point Group(s) dialog box will be displayed allowing for the selection of the Group(s) to rotate.

The Description Match option only translates points with the description(s) specified in this field.

Undo Last Translation restores the points to their previous location before translation. It is important to note that if Translate Screen Entities has been checked to restore the translated objects to their previous location will require the use of the undo command located in the Edit pulldown.

The AutoCAD command MOVE can be used to translate points on the screen but this does not update the coordinate file unless you have the option Link Points with CRD File turned ON in Configure . (Note: This toggle must have been turned ON prior to locating the points). If you do use the MOVE command and the CRD file needs updating, run the command Update CRD file From Drawing found in Coordinate File Utilities.
Rotate Points

This command rotates points in a coordinate file. The degrees of rotation can be entered directly or calculated from original and destination bearings or azimuths.

The Rotation Point will remain unchanged while the points specified for rotation rotate around it. This point can be specified by using the List button to pick from a list of points contained in the coordinate file, or from the screen by using the Pick button. The rotation point can also be defined by a coordinate value by manually entering in the X and Y values of the point. This point must be defined before the rotation will take place.

The Original Bearings/Azimuths and Destination Bearings/Azimuths can be entered directly or specified by point numbers. If using a pair of points to define the original bearing and then specifying the destination bearing by entering in the desired Bearing/Azimuth, the From and To Pt# fields should be left blank in the destination bearing/azimuth settings. Use the From and To Pt# fields in the Destination Bearing/Azimuth when you want to make a direction or Bearing/Azimuth between two existing points match the Bearing/Azimuth between two other existing points within the file. For example, to make the bearing between points 10-12 match the bearing between points 25-26, the Original Bearing/Azimuth could be defined as From Pt#10 To Pt#12 with the Destination Bearing/Azimuth defined as From Pt#25 To Pt#26.

With Rotate Screen Entities checked ON, after specifying the point range or group to rotate and selecting OK on the dialog box the following command line prompt is displayed:
Select objects to rotate (points excluded):.
At this prompt select the objects on the screen, polylines, lines, arc, etc., to also rotate and press enter. The rotation
of the points and screen entities will be completed.

Various **Output** options for the rotated points are available.

**Overwrite Existing Coordinates** will overwrite the existing coordinate points with the new translation coordinates thus changing the coordinate values in the existing crd file.

**New Point Numbers** will assign new point numbers to the translated coordinate points and leave the original coordinate points unchanged and present in the coordinate file. When using this option, on the Range of Points to Translate dialog, there is a Value to add to point numbers field. In this field, enter the value to add to the point numbers. For example if the existing point numbers are 1-20, and the value to add is 100, the resulting new point numbers will begin at 101 and end at 120.

Specifying the points to be rotated is accomplished either by specifying a Range of Points (1-20,33,36-40,...) or by Point Groups. If using the Point Group option, the Select Point Group(s) dialog box will be displayed allowing for the selection of the Group(s) to rotate.

The **Description Match** option only rotates points with the description(s) specified in this field.

The points that have been specified for rotation that are present in the drawing will be graphically updated to their new location in addition to an automatic update of the coordinate file.

**Undo Last Rotate** restores the points to their previous location before rotation. It is important to note that if Rotate Screen Entities has been checked to restore the rotated objects to their previous location will require the use of the undo command located in the Edit pulldown.

**Pulldown Menu Location:** Points

**Keyboard Command:** rotatept

**Prerequisite:** points in a coordinate file

**File Name:** \lsp\crdutil.arx
Align Points

This command translates a specified Range of Points or Points Group(s) based on a source point and destination point and then rotates to align the first source point and a second source point with the first destination point and a second destination point. The command basically combines the Translate and Rotate Point commands. To specify a Range of Points to align, enter the range to align or select a point group(s) by selecting the Point Group button. Each of the Translation and Rotation points, both Source and Destination points, can be entered manually or picked from the point list by selecting the List button.

When Align Screen Entities is checked, after specifying the point range or group to align and selecting OK on the dialog box the following command line prompt is displayed:

Select objects to rotate (points excluded): At this prompt select the objects on the screen, polylines, lines, arc etc., to also align and press Enter. The alignment of the points and screen entities will be completed.

When Ignore Zero Elevations is checked, all points with an elevation of 0 will be ignored in the alignment.

Undo Last Align restores the points to their previous location before alignment. It is important to note that if Align Screen Entities has been checked to restore the aligned objects to their previous location will require the use of the undo command located in the Edit pulldown.

Pulldown Menu Location: Points
Keyboard Command: alignpt
Prerequisite: Points in a coordinate file
File Name: \lsp\crdutil.arx
Scale Points

This command scales points in a coordinate file. The northing, easting and optionally the elevation are multiplied by the specified scale factor. You can use this routine for Metric-English conversion or a specific conversion by choosing the Use Customized Scale Factor option and specifying the desired Scale Factor in the edit box.

Specify the **Range of Points** to scale by entering in a range or group to scale. You can access the group dialog box by typing "group" in the range of points field.

The **Description Match** option only scales points with the description(s) specified in this field.

The **Scale Factor** is to be entered in manually when using a customized scale factor. If converting from standard measurement units, feet to meters, meters to feet, US Feet to International Feet, etc., the scale factor will be calculated and entered automatically. If a combined scale factor is required for converting from ground to grid and grid to ground coordinates, this value can be calculated by using the **Calculate Combined Factor** option. This calculation process begins with the Calculate Scale Factor dialog shown below.
The **Projection Type** must be specified as either State Plane 83 or State Plane 27 as well as what state plane **Zone** is required.

The available **Coordinate Units** are Metric, US Feet and International (Intl) Feet. The correct unit must be specified before calculating the combined scale factor.

The **Range of Numbers** to Process should be used to select the points to be used in order to calculate the combined scale factor. This does not specify what points are going to be scaled by the resulting scale factor. These points can be selected from a list by selecting the **List** button.

**Scale Direction** determines which way the scale factor will be calculated. A scale for **Ground to Grid** or **Grid to Ground** can be calculated and applied.

Pressing the **Calculate** button will calculate and then display the combined scale factor on the dialog box. To accept this value as the customized scale factor to use to scale the points in the coordinate file, press the **OK** button.

The **Report** option displays a report showing specified information. This information is specified by using the report formatter found throughout the program. Simply choose the information you wish to display and the order to be displayed. For further instruction and information on the Report Formatter please refer to the Report Formatter section of this manual.
With **Align Scale Entities** checked ON, after specifying the point range or group to scale and selecting OK on the dialog box the following command line prompt is displayed:

Select objects to scale (points excluded):

At this prompt select the objects on the screen, polylines, lines, arc, etc., to also scale and press enter. The points and screen entities will be now be scaled and updated graphically and in the active coordinate file.

With **Use Customized Scale Factor** Off, various conversions can be performed by specifying the Source Coordinate units and the Destination Coordinate units. This is a quick and easy way to perform Metric/English conversions.

**Pulldown Menu Location:** Points  
**Keyboard Command:** scalept  
**Prerequisite:** points in a coordinate file  
**File Name:** \lsp\crdutil.arx

### Move Points

This command allows you to move Carlson points, one at a time by selecting any part of the point. Each Carlson point is made of three entities: an AutoCAD POINT entity, a symbol, and a point block with the point number, elevation and description. All these parts of the point are moved together with this routine. Any point moved using this command will result with the original source coordinate file (which is not necessarily the current coordinate file) updated with the new position of the point.

**Pulldown Menu Location:** Points  
**Keyboard Command:** mpnt
**Edit Point Attributes**

This command will edit the attributes of a Carlson point, such as the symbol type, point number, elevation and description. When this command is invoked, the command line will prompt the user: **Select point to edit (Enter to end)**. At this point, you can select any part of the point including the symbol, elevation, point number or the description. Next, a dialog will appear as shown.

To change the symbol, either type in a new symbol name in the edit box, or choose the "Select Symbol" button where you can choose from a list of symbols. To change any of the other properties of the point, simply change or replace the contents of the edit box with the new information. Both Drawing Description and CRD File Descriptions are displayed. When a change to the Drawing description is made, this change will not be reflected in he coordinate file. This allows the change of a description that is defined in the Field to Finish (fld) table for a particular code. If a change is made in the CRD File description, it will be reflected in the coordinate file. Take note that if the CRD file description is changed, running Field to Finish will change the definitions for the point(s) changed. If you change the point number to a number that already exists in the current CRD file, and point protect is ON, you will be prompted **[O]verwrite w/new coordinates, overwrite [A]ll, or use number <1000>:**. You can choose to use the next available point number in the CRD file (this is the default), or overwrite the point number. The properties that you modify, with the exception of Drawing Description, will update the current CRD file. All modifications will update screen entities. Selecting the History button will bring up another dialog box that displays the point history of the point chosen. A history of the point will be listed, but only if, under General Setting, the Maintain CRD History File had been set to ON (selected) for the coordinate file that you are working with. With the CRD History feature of Carlson, all point changes can be rolled back.
You may also choose to use the AutoCAD DDATTE command to change the attributes of a point. If you do this, then the CRD file will not be updated and if you change the elevation attribute, the point will not change its current Z location.

**Pulldown Menu Location:** Points  
**Keyboard Command:** editpnt  
**Prerequisite:** Carlson points  
**File Name:** \lsp\editpnt.lsp

## Edit Multiple Pt Attributes

This function allows you to modify the properties of multiple point attributes at the same time. This command gives you complete control over the Carlson point attributes that are present in the drawing. Changes can be made to each attribute – the point number, elevation, description or symbol – all in one motion. For example, you could rotate the elevation text of some points to 45 degrees, change the height of the description text for all the points in the drawing, or change the layer for a particular attribute. Once this command is chosen, the entry Edit Multiple Points dialog, a smaller box, appears. Here you can determine your point selection method. There is also an option for description matching.

![Edit Multiple Points dialog](image)

After the selection of the points to change, click OK, and the subsequent, larger Edit Multiple Points dialog boxes will appear. The number of points selected will be shown at the top of the dialog boxes.

**Edit Multiple Points dialog**

For each attribute, you can change any number of the properties, including the layer, height and rotation. These dialogs will reflect the current status of each attributes properties. If, for example, you select 10 points, and 5 of them have the elevation rotation set at 45 degrees, and the other 5 are set at 0 (zero) degrees, then the rotation edit field will say *varies* to let you know that the properties of the points you selected are not the same. Here is an example of the dialog box.
The **X location** refers to the distance in the X direction from the center (or insertion point) of the point symbol. The **Y location** refers to the distance in the Y direction from the center (or insertion point) of the point symbol.

The **Layer** refers to the layer of the individual attribute, not the entire attribute block. To change the layer of the entire attribute block, use the **Attribute Block Layer** option. The **Height** is expressed in real units (generally feet or meters), not plotted size. The **Rotation angle** is expressed in absolute decimal degrees. The **Point Entity Layer** refers to the layer that the node of the point resides. The required layers can either be typed in manually, or the Select button can be used to pick from the existing layers in the drawing. If a new layer is desired, simply type in the name of the new layer and it will be created automatically. Use the layer property manager to edit the properties of this new layer, if required.

To change a point symbol, check on the **Symbol** option and use the select button to choose the desired symbol. The **Attribute Layout ID** refers to the attribute layout style defined in Point Defaults or Field to Finish code definitions. This option allows you to change the particular layout with one of the other available styles or to a customized style if defined. The Pick buttons allow you to pick two points to define a distance (or angle in the case of Rotation). If you want to select a line to define a distance or angle, select two points on the line with the appropriate OSNAP.

Each change to an attribute is defined separately. Select the attribute to edit, make the necessary changes to this attribute and then move on to the next attribute if required. Changes made to the attributes are remember individually, which allows for switching back and forth though the attributes until the command is completed. After completion the new settings for the point attributes will be retained until changed or redrawn on the screen.

**Edit Multiple Points dialog**

Again, the number of points selected will be shown in the dialog title. Let’s now define the changes for each attribute individually. In the following example, suppose we want to rotate the elevation text to a 45 degree angle, move the description to the right and change the symbol. First, click on the Elevation for the Attribute to Edit. Now, select the Rotation option and type in 45. The dialog box should be as below.
Now, select the Description option for the Attribute to Edit. Select the X location from the Items to Change. Enter 1.50 in the box. This value makes the description line up better with the rotated elevation. The dialog should be as below:

Now, for the final change, select the Symbol for the Attribute to Edit. We want to actually change the point symbol. To do this, toggle on the option to change the symbol by clicking in the box beside the word Symbol. Next, press the Select button and select symbol SPT5. The dialog should be as below:
At this point we are ready to select the OK button to perform the changes. The following image shows the points before and after the changes.

**Pulldown Menu Location:** Points  
**Keyboard Command:** modpnts  
**Prerequisite:** Points drawn on the screen  
**File Name:** \lsp\crdutil.arx

**Move Point Attributes Single**

This command allows the user to move Carlson point attributes (including the point number, elevation or description) one at a time.

**Prompts**
Select Point Number, Elevation, or Description to Move: select point attribute

Pick new location: pick point

Pick new angle: pick new angle or press Enter

Pulldown Menu Location: Points
Keyboard Command: movepnt
Prerequisite: Carlson points
File Name: \lsp\surv1.lsp

Move Point Attributes with Leader

This command allows the user to move Carlson point attribute (including the point number, elevation or description) and to draw a dynamic leader to the point node. Leaders and arrowheads may be customized by selecting Options at the command line. The attributes are always justified left or right depending on which side the leader starts.

Prompts

Select Point Label to Move (O for Options): select point attribute
Pick label position: pick point
Select another Point Label to Move (O for Options, Enter to End): O

Minimum Leader Length Scaler: Specifies the minimum length, in terms of multiples of the attribute block's height, that the leader must be.

Draw Arrowhead: Specifies whether or not to draw an arrowhead at the end of the leader that points to the point entity.

Minimum Leader for Arrow Scaler: Specifies the minimum length of the leader, in terms of multiples of the attribute block's height, that the leader must be before an arrowhead is placed on it.

Pulldown Menu Location: Points
Keyboard Command: movepntleader
Prerequisite: Carlson points
File Name: \lsp\n
Scale Point Attributes

This command will scale point attribute text (number, elevation and descriptions) and point symbols up or down in size. The routine prompts for a scale multiplier and a selection set of objects. If you want to enlarge, enter a value
greater than one. If you want to reduce, enter a decimal fraction such as .5. This would reduce the text size by 50%. This command is very useful if you have set up your drawing for one plotting scale and decide to change to a new plotting scale. This command has the added benefit that it will adjust the point attributes and symbols to a new screen twist angle.

**Prompts**

Scaling Multiplier `<0.500>`: 2.5 This response would enlarge the point attributes and symbols by 250 percent.
Scale symbols only, point labels only or both [Symbols/Labels/`<Both>`]? press Enter
Select points from screen, group or by point number [`<Screen>/Group/Number>`]? press Enter
Select Carlson Software points. pick a point
Select objects: Specify opposite corner: pick a point
Scaling Carlson Software Point Attributes ....
Number of entities changed> 174

Pulldown Menu Location: Points
Keyboard Command: ptenl
Prerequisite: Carlson points
File Name: `\lsp\ptendl.lsp`

### Erase Point Attributes

This command allows you to erase point attributes like the number, elevation or description individually by picking on the attribute to erase.

**Prompts**

Select Point No., Elev, or Desc to Erase: `select point attribute`

Pulldown Menu Location: Points
Keyboard Command: erasepnt
Prerequisite: Carlson points
File Name: `\lsp\surv1.lsp`

### Twist Point Attributes

This command will rotate the orientation of the text of Carlson point attributes (point #, elevation, description) and point symbols. The Twist Screen option aligns the point attributes to appear horizontal in the current twist screen. The Azimuth option allows you to enter an azimuth or pick two points to align the point attributes. The Entity Segment option aligns the point attributes by the selected line or polyline segment in the direction the entity is drawn. The Follow Polyline option aligns the point attributes by the polyline segment that is closest to the point.

**Prompts**

Twist by [`<Twist screen>/Azimuth/Entity segment/Follow polyline`]? F
Select reference polylines to follow. pick a polyline
Select objects: 1 found
Select objects:
Select points from screen, group or by point number [`<Screen>/Group/Number`]? `select Enter`
Select Carlson Software points.
Select objects: *pick the Carlson point inserts*

Point attributes aligned by Follow Polyline option of Twist Point

**Pulldown Menu Location:** Points  
**Keyboard Command:** twistpts  
**Prerequisite:** None  
**File Name:** \lsp\twist\_pt.lsp

## Resize Point Attributes

This command sets the size of the selected point attributes (point number, elevation, description) and point symbols. This command is similar to Scale Point Attributes, but instead of scaling the size by a factor, all the select points are set to the same specified size. Points can also be chosen based upon Point Groups.

### Prompts

- **Enter point attribute and symbol size <4.0>: press Enter**
- **Scale symbols only, point labels only or both [Symbols/Labels/<Both>]? press Enter**
- **Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter**
- **Select Carlson Software points.**
- **Select objects: *pick the point entities***
- **Finding Carlson Software Point Attributes ....**
- **Number of entities changed > 10**

**Pulldown Menu Location:** Points  
**Keyboard Command:** sizepnt  
**Prerequisite:** Carlson points  
**File Name:** \lsp\sizepnt.lsp

## Fix Point Attribute Overlaps

This command is to be used to adjust point attribute labels to avoid overlapping labels. It applies adjustment methods based upon user-specified ordering and tolerances. The command steps you through any remaining overlaps in an Overlap Manager, which includes the capability to manually move labels. This point overlap feature is also available within the Draw-Locate Point and Field To Finish commands.

---

*Chapter 10. Points Menu*
Methods: There are different methods of automatically solving a point attribute overlap. The methods will be applied in order from top to bottom on the Used Methods list. Unused methods appear on the Available Methods list. The methods are:

Alternate Layout ID 0-9
These methods will simply apply the specified attribute layout ID and then check to see if the attributes of the point in question still overlap. The different attribute layout IDs can be seen in the Point Defaults command on the Points menu.

Flip Individual Attributes
This method tests each attribute (point #, description, and elevation) by flipping it or mirroring it the other side of the point. The mirror is the vertical axis of the text that goes through the point entity. This method is not applied to points that have a leader.

Slide Individual Attributes
This method tests each attribute (point #, description, and elevation) by sliding it back and forth. The maximum distance the attribute will be moved is the horizontal length of the text. This method is not applied to points that have a leader.

Rotate (If Only One Attribute)
This method is applied if there is only one point attribute, either point #, description, or elevation. The one attribute is rotated around the point entity to see if the point overlap can be fixed.

Offset Attribute Block
This method is arguably the most powerful method and can solve any overlap by moving the attribute block far enough. See Offset Options below for a description of the options that can be used with this method.
Offset Options: These are the options that apply to the Offset Attribute Block method of automatically solving point attribute overlaps.

Maximum Offset Scaler: This specifies the maximum distance, in terms of multiples of the whole attribute block's height, that the attribute block may be offset from the point entity.

Use Leader: Specifies whether or not a leader should be drawn when offsetting the attribute block.

Minimum Leader Length Scaler: Specifies the minimum length, in terms of multiples of the height of an attribute's text, that the leader must be.

Draw Arrowhead: Specifies whether or not to draw an arrowhead at the end of the leader that points to the point entity.

Minimum Leader for Arrow Scaler: Specifies the minimum length of the leader, in terms of multiples of the height of an attribute's text, that the leader must be before an arrowhead is placed on it.

Use Selection Set for Points: Check this checkbox to be given the option of selecting which points in drawing to fix overlaps with. If not checked, then all the points in the drawing are used.

Avoid Linework Conflicts: Check this checkbox to prevent point attributes from overlapping linework in addition to other point attributes.

Review Remaining Overlaps: Check this checkbox to have the Overlap Reviewer dockable dialog come up after the automated process finishes. The Overlap Reviewer allows for reviewing the automated fixes as well as tools for manually fixing any remaining overlaps. See Overlap Reviewer below for more information.

Skip Resolved Overlaps: Check this checkbox to skip overlaps that were automatically resolved and to only review unresolved overlaps. If not checked, then both resolved overlaps and unresolved overlaps will be available for review. This option only applies if Review Remaining Overlaps is on.

Overlap Reviewer

The Overlap Reviewer will come up after automatic overlap fixing if the Review Remaining Overlaps checkbox was checked. This tool displays how many points were found, how many overlaps were fixed, which overlap is currently being viewed, how many overlaps there were total, and the point # of the current overlap. Use the First, Last, Back, and Next buttons to navigate forwards and backwards through the list of overlaps. Use the Move Block and Move Attrs buttons to manually move either the entire attribute block or individual attributes.
Pan and Zoom Controls: Use the buttons on the top to help zoom in and out and pan the drawing around. You can also use the standard mouse controls for panning and zooming.

First, Last, Back, and Next: These buttons allow you to step through each overlap or to jump to the first or the last.

Status: This drop-down list indicates the status of the current overlap. open means that the overlap has not been fixed yet. resolved means that the overlap has been fixed. ignore can be chosen by you to remove the overlap from the list.

Restore: Restores the attributes of the current point to their original location and rotation from before the Fix Point Attribute Overlaps command was run.

Move Block: Allows you to move one or more attribute blocks in the drawing. See the documentation for Move Point Attributes with Leader command in the Points menu.

Move Attrs: Allows you to move and rotate one or more individual attributes in the drawing. See the documentation for Move Point Attributes command in the Points menu.

Auto-Zoom: Check this checkbox to automatically zoom and pan the view as each overlap is viewed.

Prompts

The following prompt will be displayed if the Use Selection Set for Points checkbox is on and OK is pressed. Select the points to fix overlaps with: pick the Carlson point inserts
Trim by Point Symbol

This command will trim lines and polylines that pass through the selected point symbols such that the lines do not appear within the symbol. This should be a last step because this routine explodes the points and modifies the lines and polylines by trimming which makes these entities unusable by some of the other COGO routines.

Prompts

Select Carlson Software point symbols to trim against.
Select objects: select the point symbols

Change Point Layer Color

This command changes the layer and optionally the color of Carlson points. The points are initially put in the layer set in Point Defaults. The symbol, point number, elevation and description are in the layers PNTMARK, PNTNO, PNTELEV, and PNTDESC. To change the point attribute colors, this routine creates new attribute layers based on the new layer name. For example if the new layer name was TRAV, then the resulting layers would be TRAVMARK,
TRA VNO, TRAVELEV and TRAVDESC. These new layers can be given different colors. To select an attribute color, pick on the color button. To permanently change attribute colors, edit the drawing SRVPO1.DWG in the Carlson SUP directory. To permanently change a symbol color, edit the symbol drawing itself.

The selection of the points to change can be accomplished in three ways. A number range selection would require the input of the range of points to change. An example would be 1-20,25,30, 32-36. Points groups can also be used as a selection method. Simply specify the point group name to change, when prompted, and all the points included in that group will be changed. The final selection method is that of Pick Points. Using this method a prompt to select objects is displayed. When prompted select the points to change from the screen.

Pulldown Menu Location: Points
Keyboard Command: pntchg
Prerequisite: Carlson points displayed in the graphic drawing window
File Name: \lsp\pntchg.lsp

Renumber Points

This command will edit the point number attributes of a group of Carlson points. The command prompts for the user to enter the point number difference. Enter the positive or negative amount you would like to have added/subtracted from the current value. After selecting the point to change, a prompt to delete the old point number is displayed. If yes is chosen the old point number is deleted from the CRD file, if no is selected the old and new point numbers are retained in the file. This results in one coordinate position represented by two point numbers.

The following illustrates number changes from point 4, 5 and 6 to 104, 105 and 106. This prompt sequence retains both numbers in the CRD file. If the intent is to renumber and delete the original points 4, 5 and 6, then Yes would be selected when prompted to Delete old point numbers.

Prompts

Positive number increases, negative number decreases Point number.
Point Number difference <1>: 100 This response would add 100 to the current point number value.
Select Carlson Software Points for Point Number change.
Select objects: select a point number or a group of points by window or crossing
Delete old point numbers from file [Yes]/No? Choose correct response. In this example the response was N, leading to the following.
PT#: 6 changed to PT#: 106..
PT#: 5 changed to PT#: 105..
PT#: 4 changed to PT#: 104..
Number of entities changed: 3

Pulldown Menu Location: Points
Keyboard Command: renumpt
Prerequisite: Carlson points
File Name: \lsp\renumpnt.lsp

Explode Carlson Points

This command can be useful if you need to send your drawing to another firm who does not have AutoCAD/Carlson. Drawing transfer problems occur when the recipient does not have the same block/inserts defined or available. This command explodes all blocks and replaces the Carlson point attributes with TEXT entities of the same value. After the points have been selected, a prompt for the layer name for each point attribute will be displayed. Point Numbers, Point Elevations and Point Descriptions can be put on user specified layers, or the default for each prompt can be selected. Caution: After using this command, the link between the points and the coordinate file are destroyed and you can no longer extract the attributes from the drawing. If you want to use this command but retain your point information, follow these steps:
1. Save your drawing
2. Run this command to explode the points
3. Execute the SAVEAS command and save the drawing as a different name (you can also choose DXF format if you wish).
4. Exit the drawing without saving.

Prompts

This command will explode selected Carlson Software point blocks and replot the attributes as Text entities! The resulting points will NOT be useable by most Carlson Software commands!!!!
Select Carlson Software Points to Explode, select points
Layer Name for Point Numbers <PNTNO>: press Enter
Layer Name for Point Elevations <PNTELEV>: press Enter
Layer Name for Point Descriptions <PNTDESC>: press Enter
Number of entities changed> 345

Pulldown Menu Location: Points
Keyboard Command: explode_scad
Prerequisite: Carlson points
File Name: \lsp\scexp.lsp
Convert Surveyor1 to CRD

This command will convert a Surveyor1 coordinate file to the current Carlson format.

**Pulldown Menu Location:** Points > Convert Point Format
**Keyboard Command:** SURVEYOR2CRD
**Prerequisite:** A Surveyor1 coordinate file

Convert CRD to TDS CR5/Convert TDS CR5 to CRD

These commands convert coordinate file formats between a Carlson CRD file and a TDS CR5 file. Both of these file formats are binary which require these special routines. These commands will prompt for the file names to process.

**Pulldown Menu Location:** Points
**Keyboard Commands:** crd_cr5, cr5_crd
**Prerequisite:** A CRD or CR5 file
**File Name:** \lsp\cogoutil.arx

Convert CRD to Land Desktop MDB

This command converts a Carlson CRD file into an Autodesk Land Development Desktop (LDD) point database file in Access MDB format. The LDD point database always has the file name of POINTS.MDB. So, to specify the LDD file to create, you only need to specify the directory/path and not the file name. This path corresponds to the LDD project directory. The conversion program has point protect, so that if a point number from the CRD file already exists in the LDD file, you then will be prompted to skip or replace the point. Once the command is executed, the following dialog is displayed. On this dialog, specify the Carlson CRD file to convert as well as the LDD (MDB) file to append, if existing, or create if creating a new LDD (MDB) file.

**Pulldown Menu Location:** Points > Convert Point Format
**Keyboard Command:** crd_ldd
**Prerequisite:** A .CRD file
**File Name:** \lsp\gisutil.arx

Convert Land Desktop MDB to Carlson Points

This command converts an Autodesk Land Development Desktop (LDD, also referred to as LDT) point database file into a Carlson CRD file. The LDD point database always has the file name of POINTS.MDB and is stored in...
the LDD project directory. Once the command is executed, the following dialog is displayed. On this dialog, specify the LDD file to convert as well as the Carlson CRD file to append, if existing, or create if creating a new CRD file.

**Pulldown Menu Location:** Points > Convert Point Format

**Keyboard Command:** LDD_crd

**Prerequisite:** An LDD point database file

**File Name:** \lsp\gisutil.arx

### Convert Civil 3D to Carlson Points

This command converts an Autodesk Land Development Desktop (LDD) point database file into a Carlson CRD file. The LDD point database always has the file name of POINTS.MDB and is stored in the LDD project directory. Once the command is executed, the following dialog is displayed. On this dialog specify the LDD file to convert as well as the Carlson CRD file to append, if existing, or create if creating a new CRD file.
Convert Carlson Points to Land Desktop

Function

This command converts a Carlson CRD file into a Land Desktop point file. To do this, you must specify the existing Carlson CRD points to convert. You have the option of selecting all points, or selecting on-screen the specific points you'd like to convert.

Prompts

Convert all or selected points [All/<Selected>]? press Enter
Select Carlson Software Points to convert:
Select objects: pick first point for window selection method
Select objects: pick second point
Processing Carlson Software point...

Convert Softdesk to Carlson Points

This command converts Softdesk point blocks in the drawing to Carlson point blocks. These point block formats are similar and converting only requires reordering and renaming the attributes. Softdesk points can also be read into the current CRD file by using the command Update CRD File from Drawing in Coordinate File Utilities, this updates the CRD file without modifying the screen entities.

Convert Carlson Points to C&G

This command converts a Carlson CRD file into a C&G Point file.
Specify the existing Carlson CRD to convert by selecting the Open Carlson CRD File button. Specify the existing C&G CRD file to write to, or the new C&G CRD file to create, by selecting either Open C&G CRD file or Create C&G CRD file. Press OK and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** crd2cg  
**Prerequisite:** A Carlson CRD file

### Convert C&G to Carlson Points

This command converts C&G Points into a Carlson CRD file.

Specify the existing C&G File to convert by selecting the Open C&G CRD File button. Specify the existing Carlson CRD file to write to, or the new Carlson CRD file to create, by selecting either Open Carlson CRD file or Create Carlson CRD file. Press OK and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** cg2crd  
**Prerequisite:** A C&G point file

### Convert Carlson Points to Simplicity

**Function**
This command will convert Carlson points to Simplicity.

Select Carlson CRD file to convert by selecting the Open CRD file button.
Specify the existing Simplicity file to write to, or the new Simplicity file to create, by selecting either Open Simplicity File or Create Simplicity File. Press Export and the conversion is completed.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: crd, zak
Prerequisite: A Simplicity point file

Convert Simplicity to Carlson Points
This command converts Simplicity Points into a Carlson CRD file.

Specify the existing Simplicity File to convert by selecting the Open Simplicity File button. Specify the existing Carlson CRD file to write to, or the new Carlson CRD file to create, by selecting either Open CRD File or Create CRD File. Press OK and the conversion is completed.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: zak, crd
Prerequisite: A Simplicity point file
Convert Leica to Carlson Points

This command converts LisCad or Leica point blocks in the drawing to Carlson point blocks. These point block formats are similar and converting only requires reordering and renaming the attributes. Leica points can also be read into the current CRD file by using the command Update CRD File from Drawing in Coordinate File Utilities. This updates the CRD file without modifying the screen entities.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: 2surv3
Prerequisite: Leica points

Convert Geodimeter to Carlson Points

This command converts Geodimeter point blocks in the drawing to Carlson point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes. Geodimeter points can also be read into the current CRD file by using the command Update CRD File from Drawing in Coordinate File Utilities. This updates the CRD file without modifying the screen entities.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: 2surv4
Prerequisite: Geodimeter points

Convert Carlson Points to Ashtech GIS

This command converts Carlson point blocks in the drawing to Ashtech GIS point blocks. After executing the command, you will be prompted to select the points to convert. When using this command, the setting "Group Point Entities", found under General Settings of the Configure command (Settings menu) should be unchecked (turned off).

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: 2ashtech
Prerequisite: Carlson Points

Convert Carlson Points to Softdesk

This command converts Carlson point blocks in the drawing to Softdesk point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: 2soft
Prerequisite: Carlson points
File Name: \lsp\2soft.lsp

Convert PacSoft CRD to Carlson CRD

This command converts a PacSoft CRD file to a Carlson CRD file. PacSoft stores the point descriptions to a separate coordinate descriptor file having an extension of PTD. This file should be present in the same directory as the CRD file to convert. Prompts for the PacSoft CRD file to convert, and the Carlson CRD file to create, will be
displayed. Once both files have been specified, the following dialog box will be displayed.

The No Coordinate Conversion option converts the file format while leaving the coordinate values unchanged.
Convert From Meters to Feet will assume the coordinates in the selected PacSoft crd file are metric, and will convert the coordinate values to US Feet.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: pacsoft2crd
Prerequisite: PacSoft crd file

**Convert Carlson Points to Eagle Point**

This command converts Carlson point blocks in the drawing to Eagle Point point blocks. A prompt for the Eagle Point version to convert to will be displayed.

Specify the appropriate version and then select the OK button. You will then be prompted to select the Carlson points to convert. These point block formats are similar, and converting only requires reordering and renaming the attributes.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: 2eds
Prerequisite: Carlson points

**Convert Eagle Point to Carlson Points**

This command converts Eagle Point point blocks in the drawing to Carlson point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes. Eagle Point points can also be read
into the current CRD file by using the command *Update CRD File from Drawing*, found in *Coordinate File Utilities*. This updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format

**Keyboard Command:** 2surv2

**Prerequisite:** Eagle Point points

**File Name:** \lsp\2surv2.lsp
The Profile menu shown below has commands for creating, drawing and reporting profiles.

<table>
<thead>
<tr>
<th>Profiles Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Profile Defaults</td>
</tr>
<tr>
<td>Quick Profile</td>
</tr>
<tr>
<td>Create Profile From...</td>
</tr>
<tr>
<td>Design Elevation Profile</td>
</tr>
<tr>
<td>Design Dewater/Pipe Profile</td>
</tr>
<tr>
<td>Input/Export File</td>
</tr>
<tr>
<td>Draw Profile</td>
</tr>
<tr>
<td>Profile Grid</td>
</tr>
<tr>
<td>Label Horizontal Axis</td>
</tr>
<tr>
<td>Profile to 3D Polyline</td>
</tr>
<tr>
<td>Profile to Points</td>
</tr>
<tr>
<td>Profile Report</td>
</tr>
<tr>
<td>Polyline Slope Label/Report</td>
</tr>
<tr>
<td>Station-Elev-Slope Label/Report</td>
</tr>
<tr>
<td>Sag &amp; Crest Report</td>
</tr>
<tr>
<td>Pipe Depth Summary</td>
</tr>
<tr>
<td>Profile Utilities</td>
</tr>
<tr>
<td>Profile Conversions</td>
</tr>
</tbody>
</table>
Profile Defaults

This command allows you to specify the default parameters for working with profiles.

**Profile Defaults**

**Horizontal Scale:** Specify the horizontal scale.
**Vertical Scale:** Specify the vertical scale.
**Text Size Scaler:** Specify the text size scaler. This value is multiplied by the horizontal scale to obtain the final text height.
**Symbols Size Scaler:** Specify the symbol size scaler. This value is multiplied by the horizontal scale to obtain the final symbol size.
**Profile Annotations Layer:** Specify the layer that the profile text will be plotted on.
**Object Height for Sight Distance Calcs:** Specify the object height value used when a sight distance is calculated.
**Eye Height for Sight Distance Calcs:** Specify the eye height value used when a sight distance is calculated. The sight distance defaults are set to the AASHTO standards but can be changed as conditions dictate such as for an accident study or for metric values.
**Vertical Curve Drawing Resolution:** Specify the length for line segments that are generated to represent vertical curves. Default value is 10.0
**Vertical Curve PC & PT Points Layer:** Specify the layer that the endpoint nodes of the vertical curve will be plotted on.
**Station Type:** Specify the format for the station labels: 1+00 is the default, 1+000 is for metric, NO.0 is the Korean format.

**Keyboard Command:** PRD
**Prerequisite:** None
**File Name:** \lsp\scadprof.dcl, \lsp\prd.lsp

---

**Chapter 11. Profiles Menu** 318
Quick Profile

This command allows you to create a profile in one step. The alignment for the profile can be defined using picked points, a centerline file or a polyline. The surface for the profile can be defined by 3D screen entities or surface files (grid or triangulation). Since picked points are the default for the horizontal alignment, the command is as quick as select surface type (screen or file), then Pick, Pick, Enter and view. The resulting profile is displayed in a graphic dialog box with real time data reporting. As the crosshairs are moved across the profile in the window, the station, elevation and slope data corresponding to the current crosshair location appear in the lower right of the window. A second crosshair on the plan view corresponds to crosshair movement along the profile so the user knows exactly where the current profile point is on the plan view. Also the Adjust Alignment function allows you to drag a horizontal alignment point and update the profile in real-time.

**Vertical Exaggeration:** Determines the amount of vertical exaggeration for the profile in the window.

**Drag Action:** Determines whether the right mouse button functions as "Zoom" or "Pan" in the profile window.

**Grid Ticks Only:** Instead of the full graph as shown above, Grid Ticks only plots only ticks along the horizontal and vertical axis near the station and elevation text.

**Adjust Alignment:** Allows you to pick a horizontal alignment point and while moving it, the profiles are updated in real-time. You can also select a horizontal alignment segment and move the whole alignment position. The Adjust Alignment function is only available when surface files are used as the source of the surface model.

**Save:** Writes the current profile data to a .PRO file.

**Draw:** This draws the profile with grid in the drawing. The user has options for horizontal and vertical scales and the layer of the profile. The Draw Profile command includes more options for drawing the profile. In order to use this command, you must first create a .PRO file using the Save command described above.

**Exit:** Exits this command.

**Help:** Opens on-line help.
Note that the Draw option will exit the Quick Profile command after the drawing is complete. A typical completed drawing, in this case with two surfaces, is shown below. Note also that the horizontal stationing text offset follows the setting in the Draw Profile command itself.

![Graph showing profile with two surfaces]

**Prompts**

**Pick starting point (CL-Centerline, P-Polyline):** screen pick alignment points for profile  
**Pick second point:** pick next point  
**Pick next point (Enter to end):** press enter to end  
**Tested 58 of 58 Entities Intersects found > 33**  
**Dialog Box**  
Opening file c:\Carlson2008\DATA\quickpro.pro for write. Note that the 2nd surface profile, if used, is named QUICKPRO2.PRO.  
**Keyboard Command:** quickpro  
**Prerequisite:** 3D screen entities and a grid (.GRD) or triangulation (.FLT) file  
**File Name:** \lsp\quickpro.lsp

**Profile from Surface Entities**

Profile from Surface Entities creates a profile from contours, triangular mesh, and other 3D drawing entities. The method is to draw a polyline as the profile centerline. Then the profile is derived from the intersections of this polyline with the 3D entities. For added accuracy in pulling the profile, include the triangular mesh as well as the contours.
File: Displays the name of profile to be created.
Beginning Station: Specify the beginning station for the profile.
Interpolate Endpoint Elevations from Beyond Profile Extents: When checked, the program will look past the ends of the centerline for additional intersections with 3D entities. These additional intersections will then be used to interpolate the elevation at the starting and ending station of the centerline.
Extrapolate Endpoint Elevations to Extents of Profile: This option uses the slope of the last two elevation points of the profile and calculates the elevation of the endpoint from this slope.
Station by another reference centerline: When checked, the program will prompt you to pick another centerline polyline. The intersection points along the first centerline are then projected onto the second centerline. The profile then stores the elevation of the intersection with the station along the second centerline.
Breakpoint Descriptions from Layers: When checked, breakpoint descriptions are assigned based on layer name of surface entities. These descriptions are used in routines such as Input-Edit Profile and Profile Report.
Ignore Zero Elevation Lines in Surface Model: When checked, any zero elevations selected in the surface model are ignored.
Profile Offsets: Specify optional offset profiles. Enter offsets separated by a space. Example: 30 -30 (to create 30' left and 30' right offset profiles). After entering the offset values, press TAB to select file options described below.
Offset Profiles to: Specify whether offsets profiles should be created as separate profile (.PRO) files, or included in a single profile (.PRO) file. Only available if you specify Profile Offsets above. Offset profiles are automatically named by combining the profile name and the offset. For example, if the profile is named NATGRD.PRO and you create a 30' right offset profile, it will be named NATGRD30.PRO.

Prompts
Profile File to Write dialog Specify a new profile file (.PRO) name to create.
Profile from Surface Model dialog Make choices, click OK.
Polyline should be drawn in direction of increasing stations.
CL File/<select polyline which represents the profile centerline>: pick the centerline (Do not press Enter.)
Select Lines, PLines, and/or 3DFaces that define the surface for profiling.
Select objects: C (for crossing and window everything the centerline crosses) or All (to select all objects on the drawing)
Keyboard Command: prosm
Prerequisite: A polyline centerline and surface lines and polylines.
File Names: \lsp\scadprof.dcl, \lsp\proflap.lsp, \lsp\plinsct.arx

Profile from Grid or Triangulation Surface

This command creates a profile (.PRO file) from a centerline polyline and a surface model stored in a 3D grid file (.GRD) or triangulation file (.FLT). The polyline defines the alignment of the profile and the grid defines the surface.

Prompts

Choose Grid or Triangulation file to process  Select existing .GRD, .TIN, or .FLT file.
Complete the Profile Options dialog.

If you choose to station by another reference centerline, it is necessary that the reference centerline extend beyond the range of the picked polyline in order to project correctly and capture offsets along the entire length of the picked centerline.

Choose PROfile file to Write dialog  Enter a profile file (.PRO) name to write.
Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>: select a polyline
Polyline should have been drawn in direction of increasing stations.
CL File/<Select Reference centerline polyline>: select a polyline
CL File/<Select Reference centerline polyline>: press Enter
Reference CL starting station <0.0>: press enter

Pulldown Menu Location: Profiles > Profile from ...
Keyboard Command: progrid
Prerequisite: A .GRD grid file, .TIN, or .FLT tmesh file
File Names: \lsp\progrid.lsp, \lsp\profedit.arx

Profile from 3D Polyline

To create a .PRO file, Profile from 3D Polyline uses X-Y distances between the points of a 3D polyline for sequential stations and the Z values at these points for profile elevations.

Prompts
Profile from Points on Centerline

This command creates a .PRO file from points and a centerline that is represented by a polyline or centerline file. The elevations of the profile are derived from the elevation of the points and the stationing for these profile points is calculated from the distance along the centerline. The points must be within the offset distance from the polyline in order to be included in the profile. The profile is created by projecting the points perpendicular onto the alignment to determine the station and the elevation comes from the point elevation. The polyline or centerline should be drawn (or defined) in the direction of increasing stations. The points can be selected from point entities in the drawing (Screen), by point numbers from the current coordinate file (Numbers), or by point group as defined by the Point Group Manager (Group).

Prompts

PROfile file to Write dialog box: Enter a new profile file name to write.
CL File/<Select polyline that represents centerline>: pick a polyline or choose C for Centerline
Select Centerline file if Centerline option is used. If the desired points are further from the centerline, enter a larger maximum offset tolerance.
Note: for all selected points, the points should be located on the real Z axis.
Select the Carlson points along the centerline.
Select objects: Select the point entities.

Keyboard Command: profpts
Prerequisite: A polyline centerline and points
File Names: \lsp\profpts.lsp, \lsp\regrade.arx

Profile from Pipe Polylines

This command creates a profile that contains the station, elevation and pipe width of pipes that cross the centerline. This type of profile is called a Crossing profile and Draw Profile treats it differently. Instead of connecting the station-elevation points with a polyline, Draw Profile draws each station-elevation as a circle with a radius of the pipe width. When there is vertical exaggeration in the drawn profile, the pipe circles are drawn as ellipses.

This routine uses a polyline that represents the centerline. The pipe polylines are 3D polylines with an assigned pipe width. One way to create them is to use the command Draw Pipe 3D Polyline in the Profile Utilities sub-menu. To attach the pipe width value to a polyline, use the Assign Pipe Width to Pline command also in the Profile Utilities sub-menu. The program then finds the intersections of the polyline centerline with the pipe polylines and stores the station of the intersection along the centerline with the elevation and pipe width of the pipe polyline. There is also a prompt to whether the pipe position is at the top, bottom or middle of the 3D pipe polylines.

Prompts

Profile File to Write Dialog Enter new .PRO file name.
Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>: pick a polyline
Enter the starting station <0.0>: press Enter
Select the pipe polylines crossing the centerline.
Select objects: pick pipe polylines
Position of pipe polylines on pipe [Top/Center/<Bottom>]? press Enter
Found 2 crossing pipe polylines.
The command Draw Profile would then interpret this profile as a pipe profile, and plot it as needed.

Pulldown Menu Location: Profiles > Profile from ...
Keyboard Command: propipe
Prerequisite: A polyline centerline and pipe polylines
File Name: \lsp\profedit.arx

Enter Profile On-Screen

This command allows you to create profile files and is similar to Design Road Profile. The only difference is that Enter Existing Profile does not ask for vertical curves. The procedure is to first specify the on-screen grid and then enter or pick the stations and elevations. The profile is drawn as it is entered.

Notice that the station, elevation, and slope at the current position of your cursor crosshairs is displayed at the bottom of the side-bar menu. These values will update whenever the crosshairs move except after selecting either the side-bar or top menu.
Prompts

Profile Settings dialog
Profile File to Write dialog Specify a profile file (.PRO) to create.
Station of first PVI or pick a point: 0
Elevation of PVI: 565
Second station or pick a point (U, E, D, Help): 200 'U' is undo, 'E' ends the routine, 'D' is incremental distance to
the next station, 'H' brings up an explanation of these items on-screen.
Percent grade entry/Ratio/<Elevation of PVI>: 575
Station of next PVI or pick a point ('U' to Undo, Enter to End): pick a point
Snap PVI dialog
This dialog box appears when you pick a point and the Prompt for Snap option in the Profile Settings dialog is
selected. The station and slope may be changed to the nearest snap value. The elevation is the free variable and it
will change to compensate for any snap. To change the elevation, select the elevation edit box and enter the new
value.
Station of next PVI or pick a point ('U' to Undo, Enter to End): press Enter

Pulldown Menu Location: Profiles
Keyboard Command: makeprof
Prerequisite: A profile grid drawn on-screen
File Names: \lsp\makeprof.lsp, \lsp\profile.dcl
Input/Edit Road Profile

This command opens the Input/Edit Road Profile dialog, showing the profile graph and a spreadsheet table containing the profile data. With this dialog, you can enter and edit road profile files (.PRO), not only by specifying the values in the spreadsheet, but also by editing the PVI points on the profile graph directly. The updates in the spreadsheet and the graphic box are synchronized.

From the Profile menu in the Civil Design Module, choose Input/Edit Road Profile. The program reads a road profile file (.PRO), a road centerline file (.CL) and a surface file (.TIN or .FLT). If you design a new road profile, just enter the new road profile file name. If you open an existing profile to edit, the profile graph is shown in the graphic box on the top, and the spreadsheet is filled with profile data. The buttons and lists between the graphic box and the spreadsheet provides the abilities to input and edit the road profile in graphic.

1. Functions Editing Profile in Graphic:

- **Switch to pan mode button**: Switch the cursor to PAN mode
- **Switch to dynamic zoom mode button**: Switch the cursor to ZOOM mode
- **Zoom Extents button**: Zoom the graphic window to show the complete graph
- **Add PVI button**: Allow you to add a new PVI point by picking at any locations inside the graphic box. The program will extract the station and elevation of the point and display them in the New PVI dialog, from where you can modify the station and elevation directly in the Station and Elevation boxes, or by modifying the Slope In and Slope Out values. You can also specify the vertical curve radius and the resolution snap for the station and slope. Click on OK button to save the new PVI data. Below is an example of the dialog.
New PVI dialog

**Edit PVI button:** Pick an existing PVI point on the profile graph and drag it around to change the station and elevation.

**PVI Edit Mode list:** This list has five options: Free, Hold Slope In, Hold Slope Out, Hold Station and Hold Elevation, which controls the movement of the PVI that is being edited by the Edit PVI button command.

**Vertical list:** This list determines the vertical exaggeration of the profile graph.

2. Spreadsheet Editor:

The spreadsheet editor allows you to enter and modify data cell by cell. The profile graph will be updated automatically after any changes of the profile data. **Insert PVI** button inserts a row in front of the highlighted row to create a new PVI, **Delete PVI** button deletes the highlighted row as while as the corresponding PVI. In the **Sag-Crest Points** list, the coordinates of all Sag and Crest Points are listed.

3. Settings Dialog

Click on the Settings button, the settings dialog displays.

**Hold Current Elevation:** When you change a PVI's station or elevation, if this toggle is on, its slope out will be changed and the elevation of the next PVI is held, otherwise its slope out is held and the elevation of the next PVI will be changed.

**User K-Value:** Toggles between displaying K-Value and Sight Distance in the fifth column of the spreadsheet.

**Grid Ticks Only:** Toggles between displaying the grid and grid ticks in the graphic box.

**Show Reference Surface:** An option to show the reference surface profile along with the road profile in the graphic box.

**Show Centerline Special Stations:** When this toggle is on, the points at centerline special stations such as PC, SC, ST, TS and SP are shown in the graphic box.

**Show Vertical Lines for Intersections:** When this toggle is on, vertical lines represent intersections of two road profiles are shown.

**Show Sag-Crest Points:** An option to draw the sag and crest points in the graphic box.

**Output Reference Surface Profile:** An option to output the surface profile to a file whose name has a suffix of the current road profile file name.

**Set button:** Set the current Reference Surface file to another one.
4. Show Sections

This function applies the design template at the road profile to get the road section file, computes the outslopes and earthworks relative to the reference surface section file, and displays both road and surface sections in a graphic dialog box. Click on the Show Sections button, the Road Design Templates dialog displays. The last 4 input items are strictly optional design files.

**Design Template:** Specify a template file (.TPL) or template series file (.TSF) that defines the final grade offsets and elevations and the cut/fill slopes.

**Template Transition:** Specify a .TPT file, which allows modified template files to be applied at different ranges of stations on a project.

**Template Point Profile:** This option lets you have separate profiles for template points that are independent of the centerline file.

**Template Point Centerline:** This option lets you have separate centerlines for template points that are independent of the main centerline.

**Super Elevation:** This option is used to specify a super elevation file (.SUP) that defines the super elevation transition stations on a project.

After specifying the design template file(s), click on OK button to display the section graph. In the section dialog, the graph is automatically updated when you move your cursor along the road profile graph to change stations.
5. Vertical Speed Tables

The Vertical Speed Table function provides a few of speed tables, which utilize AASHTO's speed table data and offer the recommendations for design speeds and curve parameters. Please refer to AASHTO A Policy on Geometric Design of Highways and Streets 2004 (pp 265-280) for details.

Click on the Vertical Speed Tables button to open the speed table dialog shown as below. The Table Name list contains the names of all speed tables that have been defined. There are five default speed tables: AASHTO - Crest Curve Based On Passing Sight, AASHTO - Crest Curve Based On Stopping Sight, AASHTO - Sag Curve Based On Stopping Sight, METRIC- AASHTO - Crest Curve Based On Passing Sight, METRIC- AASHTO - Crest Curve Based On Stopping Sight and METRIC- AASHTO - Sag Curve Based On Stopping Sight. You can add, edit and delete any speed tables. All speed table files are in the ...\USER folder and are available for all projects.
Vertical Speed Table

Click on the Add button, the New Vertical Speed Data dialog displays. Enter values in the Design Speed, Sight Distance and K boxes. Click on OK button to commit the new speed entry. Edit button allows you to modify design speed, sight distance and K values of the highlighted speed entry, and Delete button deletes the highlighted entry from current table. New Table button creates a new speed table, Edit Table button is used to modify the name of current table, Duplicate Table button makes a new speed table that contains the same data as current table, and Delete Table button removes current table completely.

New Speed Entry

New Vertical Speed Table
Prompts

Input-Edit Road Profile dialog: Fill in values.

Pull-down Menu Location: Profiles > Input-Edit Road Profile

Keyboard Command: roadpro

Prerequisite: a road profile file (.PRO), a road centerline file (.CL), a surface file (.TIN, .FLT)

File Name: \lsp\eworks.arx

Design Road Profile

This command is for simultaneously creating a .pro file and drawing the road profile. It is typically used when designing a road profile on top of a plotted existing grade profile, where the goal is to minimize cut and fill and keep to a minimum the number for vertical curves and avoid excessively steep grades. It is often necessary to match the starting and ending elevations of existing roads or features. For example, a side road will contact the main road at a fixed, given elevation. One concept to remember is that it may be best to favor a little more fill than cut in the design profile, because if your design template for the road involves ditches, a little bit of cut can lead to significant extra cut volumes due to the ditch placements. The Design Road Profile command works fine when overlaying on profile plots with either matching horizontal and vertical scales or exaggerated vertical scales (e.g. 50 H and 5 V). Just be sure to specify the correct scale settings in the Profile Settings dialog. The procedure is to first specify the on-screen grid and then enter or pick the stations and elevations.

Once two segments have been entered, you will be prompted for the vertical curve length. The vertical curve is a parabola, the typical form used in the United States. If you don't want a vertical curve, enter 0. Otherwise you can directly enter the vertical curve, or enter the sight distance or the K-value from which the vertical curve is calculated. The vertical curve can also be specified to pass through a point or do a best fit through multiple points. This through point option would be useful for hitting an existing feature such as a driveway on the vertical curve. Unequal vertical curves is another option where the vertical curve length going into the PVI differs from the length leaving the PVI. Before using your entry, the vertical curve, sight distance, and K-value are displayed. Object height and eye height are two variables that effect the vertical curve. Their values can be set using the command Profile Defaults.

Notice that the station, elevation and slope at the current position of your cursor crosshairs are displayed in real-time in a small dialog.
Prompts

Profile Settings dialog
Profile to Write Dialog: Note that you can choose to append to an existing road profile, which allows you to continue design work in different work sessions. If Append is selected, the cursor will default to the end point of the selected profile, which will be treated as a 'PVI' point, so that you will be prompted for a vertical curve length after your very next picked point.

Pick Lower Left Grid Corner <5000.08,3211.24>[endp on]: Pick a lower left corner for the plotted grid on the screen. If you have just finished plotting the existing profile, the program will remember your lower left coordinates, and you just hit Enter to accept the default values.

Enter station or pick a point (Enter to End): 0
Elevation of PVI: 932.5
Station of second PVI or pick a point (U,E,D,Help): 175
Percent grade entry/Ratio/<Elevation of PVI>: 942
Station of next PVI or pick a point ('U' to Undo, Enter to End): pick a point

Snap PVI dialog

The Snap PVI dialog box appears when you pick a point (if the Prompt for Snap option in the Profile Settings dialog is selected). The station and slope may be changed to the nearest snap value. The elevation is the free variable and it will change to compensate for any snap. To change the elevation, select the elevation edit box and enter the new value. In this example, you might choose a slope snap of 0.1 and if the station was flexible (not fixed, such as the end of the road), you could choose a station snap of 10.

View Table/Unequal/Through pt/Sight Distance/K-value/<Length of Vertical Curve>: 100
For Crest with Sight Distance>VC and Vertical Curve => 100.00
Sight Distance => 124.43, K-value => 11.2
Use these values (<Y>/N)? press Enter
Station of next PVI or pick a point ('U' to Undo, Enter to End): press Enter
Vertical Curve Text Options dialog box
Pick vertical position for VC text: Pick a position above the profile grid. The final plot is shown below:
Pulldown Menu Location: Profiles
Keyboard Command: road
Prerequisite: A profile grid
File Names: \lsp\makeprof.lsp, \lsp\vcplot.lsp, \lsp\profedit.arx, \lsp\profile.dcl

**Design Sewer/Pipe Profile**

This command creates a sewer profile (.PRO) file with manholes, or will create a pipe profile (no manholes, no manhole width), and draws it on the screen. It requires that a grid is already drawn. It begins with the Design Sewer Settings dialog box.
Bottom Manhole Width: Specify the size for the bottom of manholes. Not available when Profile Type is set to pipe.
Max Pipe Length: Specify the maximum limit for the distance between manholes.
Min Percent Slope: Specify the minimum slope (absolute value) between manholes.
Layer name for text: Specify the layer name for annotation. If you enter a layer that does not exist, it will be created.
Profile Layer: Specify the layer name for pipes and manholes. If you enter a layer that does not exist, it will be
created.

**Drop Across Manhole:** Specify the amount the elevation drop across the manhole in the direction of the profile. Will accept a negative a value. Not available when Profile Type is set to pipe.

**Snap Prompt:** Activates the PVI Snap dialog box. See below for description.

**Pick Plan View Polyline:** Allows you to select a polyline from plan view that represents the sewer centerline. This leads to the plotting of manhole symbols on the plan view and also creates default manhole-to-manhole stations.

**Manhole Bottom At Pipe Slopes:** When checked, the manhole bottom will be drawn level with the pipe slope.

**Profile Type:** Choose between Sewer profile or Pipe profile. Pipe profile do not include manholes.

**Grid Dimensions:** Specify the grid dimensions on which the sewer will be designed.

**Design Method:** Choose whether distances specified are center or manhole to center of manhole or actual pipe length. Not available when Profile Type is set to pipe.

**New/Append:** Choose between creating a new profile (.PRO) file or appending an existing file.

**Depth to Use:** Choose between specifying pipe top or pipe bottom elevations. Not available when Profile Type is set to sewer.

### Prompts

**File Selection dialog**
Choose a new profile file name to create.

**Pick Lower Left Grid Corner <5000.0,5000.0>[endp on]:** *pick the corner*

**Select existing ground polyline or ENTER for none:** You may optionally pick a polyline to use for calculating the depth from the surface as the sewer stations are entered.

**Enter station or pick a point (Enter to End):** *0*

**Depth from Surface/<Elevation of manhole>:** 935.7

**Enter the step up/down in feet <0.00>:** press Enter

**Station of second MH or pick point (U,E,D,Help):** *pick a point*

If the Pick Plan View Polyline option has been chosen, the program will default to the station of the next vertex in the selected polyline. If the Prompt for Snap option was selected in the main dialog, then the Snap Profile Point dialog appears here. The station and slope may be changed to the nearest snap value. The elevation is the free variable and it will change to compensate for any snap. To change the elevation, select the elevation edit box and enter the new value.
Enter the step up/down in feet <0.00>: press Enter Enter 0.1 if pipe drops one tenth into manhole and you are designing in upstream direction.

If you enter a station for the next manhole rather than picking a point on the screen, then you will be prompted as follows:

**Depth/Percent grade/Min grade/<Elevation of manhole>:** 939.79

**Size of pipe in inches <10.0>:** 8.0

**Station of next manhole or pick a point (U,E,D,Help):** press Enter

If you picked a plan view polyline, you will be asked:

**Draw manholes on centerline [Yes/<No>]?** Y Then you will be prompted for the default manhole symbol to use.

**Profile Sewer Settings dialog**

**Sewer Label Options dialog** (Displayed by pressing the Annotation Options button.)

**Select existing ground polyline:** pick a polyline or press Enter to be prompted for each manhole surface elevation

This prompt only appears if no ground polyline was selected above.

**Manhole No. 1 label [MH #1]:** press Enter

**Manhole No. 2 label [MH #2]:** press Enter
Chapter 11. Profiles Menu

Draw Sewer Options

[Options interface shown in the image]

- General: Options related to general settings.
- Manhole: Options related to manhole settings.
- Pipe: Options related to pipe settings.

**General Tab Options**
- Manhole Name: Options for naming manholes.
- Manhole Style: Options for manhole styles.
- Manhole Size: Options for manhole size adjustments.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
- Manhole Material: Options for manhole material.
- Manhole Type: Options for manhole type.
- Manhole Size: Options for manhole size.
- Manhole Style: Options for manhole style.
- Manhole Color: Options for manhole color.
Pipe/Center Combo Labeling Method calculates the slope as the elevation difference from the edge of the pipe, divided by the distance between the manhole centers.

\[
\text{Slope} = \frac{Y_{\text{pt3}} - Y_{\text{pt2}}}{X_{\text{pt4}} - X_{\text{pt1}}}
\]
Example of sewer profile and surface profile

Example of sewer profile using Horizontal Axis Text Orientation as Vertical and Pipe Label Position as Horizontal Dimension

Detail of manhole bottom at pipe slope
Detail of drop across manhole of 0.2

Detail of step up

Top=2, Bottom=4, Offset=100

Top=4, Bottom=4

Top=2, Bottom=4, Offset=4, Fixed=0
Top=2, Bottom=4, Offset=4, Fixed=2

Detail of Draw Manhole Base and Label Invert Elevation with Vertical Line

Detail of Label Rim Elevation at Manhole

Manhole with the Draw Sump option

Label Pipe Flow Values option shows flow rate, travel time, depth and velocity

Chapter 11. Profiles Menu
**Pulldown Menu Location:** Profiles  
**Keyboard Command:** sewer  
**Prerequisite:** A profile grid  
**File Names:** \lsp\mksewer.lsp, \lsp\profedit.arx, \lsp\profile.dcl

**Input-Edit Profile File**

This command is a spreadsheet type editor for profile (.PRO) files. Besides editing a profile, this routine can be used to just view the contents of a profile. Also, a new profile can be entered by editing a previously empty or non-existing file.

The command starts by prompting for the profile file to edit. Alternately, you can run Input-Edit Profile by double-clicking on a profile polyline that is drawn on a profile grid.

The opening dialog below shows the layout of this editor. At the top of the dialog, you can dynamically see the profile and vary its appearance by using zoom and pan. You can change the look of the profile more by using the vertical exaggeration multipliers. The station, elevation and slopes are also shown at the lower left of the dialog, fluctuating with the movement of the cursor. Then there are between five and nine columns for the possible fields in a profile. Which columns are active depends on the type of profile: generic, road, sewer, pipe, crossing or circular. Six rows are visible at a time. To view different rows, use the scroll bar on the right. When a greater amount of columns are in use, use the scroll bar at the bottom. The Profile Name edit box is an optional identification name used by multiple profiles in Draw Profile. The Add Row and Remove Row buttons, when used, will dynamically and immediately make changes to the profile image at the top.

On the right is a column for Check Stations which report the elevation at the specified stations. The Check Stations are not stored in the profile. This is a design tool for viewing the elevations at certain stations while adjusting the profile data. The last line has eight action buttons.
Add Row: Adds a new row into the profile after the current row.

Remove Row: Removes the current row.

Type of Profile: Choose. Column titles and the amount of columns will change accordingly.

Hold Next Slopes: A toggle that may applied or left blank.

Use K-Value: Toggles between displaying K-Value and Sight Distance in the fifth column for road profiles.

Select Reference profile: An option to show a second profile as reference. When a reference profile is active, the Check Stations and graphic window report the cut/fill with the current profile and the elevation of the reference profile. Also with a reference profile active, the spreadsheet adds a column for depth.

Vertical Speed Tables: This button is enabled only when you edit a road profile. Please refer to the documentation on Input-Edit Road Profile for the information on Vertical Speed Tables.

Next: Used for navigation when editing a .PRO file containing multiple profiles, loads the next profile.

Previous: Used for navigation when editing a .PRO file containing multiple profiles, loads the previous profile.

Transform: Allows you to either Translate or Scale the profile. Translate globally adds or subtracts value to stations and/or elevations within the specified range of stations, while Scale will apply the specified scale factor to stations and/or elevations within the specified range of stations.

Load: Used for loading another, existing .PRO file for editing.

Save: Saves the profile using the current profile file name. The current profile file name is displayed in the top title bar of the dialog box.

SaveAs: Allows you to save the profile under a different profile file name.
Keyboard Command: profedit
Prerequisite: None
File Names: \lsp\profile.dcl, \lsp\profedit.arx

**Draw Profile**

*Draw Profile* is a flexible routine for drawing a profile anywhere in the drawing. The profile may be drawn with or without a grid or with just tick marks. The vertical curve annotations, for a road profile, and manhole annotations, for a sewer profile, may also be drawn. Draw Profile uses the profile information that is stored in .PRO files. Once the profile is drawn using Draw Profile, the design and labeling routines of the Profiles dropdown are applicable to the profile. The first step in Draw Profile is to choose the profile (.PRO) file(s) you want to draw.
The Draw Profile dialog box appears, and contains all of the settings for creating the profile.

**Draw Grid:** This option will draw a grid and axis elevations for the profile. Pick Setup to access Grid Setup dialog.

**Grid Direction:** Profiles can be drawn Left to Right (the default) or Right to Left. Although most profiles are drawn left to right, if you have a road that runs east to west and you wish to draw the profile stationing beneath the actual road stationing, then choosing a Right to Left profile may be appropriate. Unavailable when Draw Sheet is checked.
**Vertical Grid Adder to Top:** This adds the specified amount of grid to the top of the profile.

**Vertical Grid Adder to Bottom:** This adds the specified amount of grid to the bottom of the profile.

**Draw Elevation Bar:** Click on this option if you desire to have a vertical barscale displayed. It will run up and along the left-most vertical grid line of the profile.

**Label Scale:** Click on this option and you obtain a scale drawn at the lower left corner of the profile.

**Draw Elevation Labels Only On Left Side:** This option eliminates elevation labels on the right side of the profile.

**Offset Elevation Text:** This option offsets the left-side vertical axis text using the specified Offset Scale.

**Offset Station Text:** This option offsets the horizontal axis Station text by the specified Offset Scale, allowing the insertion of elevation or other information above the stationing. It is often used in conjunction with the Label Horizontal Axis options.

**Grid Type:** This selects the type of Grid to generate. The choices are Grid Lines, Ticks Only, Ticks and Dots, Ticks and Checks.

**Station Text Orientation:** This option allows you to specify the orientation of the station text shown along the bottom of the profile. The example below shows both options:

![Station Text Orientation](image)

**Draw Sheet:** When checked, the profiles will be drawn in paper space. Plan Only, Profile Only, or Plan and Profile sheets can be created. Each plan and profile sheet is created in it's own layout tab. When the plan and profile is drawn, you are placed in tilemode=0 and paper space. Click the "model" space tab (shown below) to return to model space to edit the plan view features, for example. The options within Sheet Setup become available when this toggle is checked on. Pick Setup to access the Sheet Setup dialog:
Layout Name: Enter a name for the paper space "tabs" to be assigned to each layout for each sheet. The program will automatically divide the plan view and the profile view into sheet layouts, and if the length of the profile extends beyond a single sheet, then multiple layouts are created, with the layout name ID incremented by 1. If you enter "ms" to go to model space within a layout tab, you can pan to alter the plan view position. Its best to zoom in/out and edit within the Model tab. The Layout tabs appear at the bottom of the screen, along with the "Model space" tab to go back to standard plan view:

Block Name: This is the drawing name for the plan and profile sheet to be inserted. Carlson provides a standard plan and profile drawing in the form of Profile.dwg located in the Support subdirectory. You may wish to revise Profile.dwg, add your company logo, and re-save it as Profile1.dwg or you could add your own complete version of a Plan and Profile sheet. If you choose the latter, you should examine the scale, dimensions and the lower left corner of Profile.dwg, and try to duplicate those dimensions and corner coordinates in your own drawing. It is also important to store all your standard profile sheets in the Support subdirectory. You cannot draw Right to Left in Sheet mode. Note that the Sheet mode will re-orient the centerline left to right, which may cause text (such as the stationing) to plot upside down, until you use the Flip Text command under the Edit menu.

Sheet Width: This is the profile width, in inches, on the sheet. Even though the sheet is a fixed size, you can limit the length of the plot to 32 inches or less with this entry. If we used an entry of 16 for the example profile above, two plan and profile sheets would be created, because the first sheet would go from station 0+00 to 3+20 (16 inches at a 20 scale) and the second sheet would finish from 3+20 to 4+51.91. In English units, a typical entry here would be 30 for 30 inches.

Overlap Station: In multiple plan and profile sheet plotting, after the first sheet, all subsequent sheets will have the first 2 stations in common with the last 2 stations on the previous sheet, if the Overlap Station option is turned on. For example, if the last 2 stations are 3+10 and 3+20 on sheet 1, then sheet 2 will start with 3+10, then 3+20, with this option turned on. With this option turned off, if the first sheet ends with 3+20, then the second sheet would begin with 3+20.

Sheet Contains: This drop list allows the selection of which type of sheet to generate. The choices are Plan and Profile, Plan Only or Profile Only.
**Plan View Lower Y:** This sets the lower position of the paper space window for the plan view. With Lower Y set to 9 (inches above the base of the sheet) and Top Y set to 21, there is a 12 inch vertical window, running the full Sheet Width (typically 30 to 32). This window for the plan view can be expanded or reduced with these settings.

**Top Y:** This sets the top vertical limit for the plan view window, measured in inches from the bottom of the plan and profile sheet.

**Draw North Arrow in Plan View:** This draws a North Arrow in plan view.

**Draw Layout Plan View Borders in Model Space:** This draws the borders in Model Space.

**Plot at 1:1:** With this clicked on, the sheet will be paper size, designed to be plotted at 1:1. A 30-inch profile sheet will measure 30 units, even though the centerline and profile may be 1500 feet in length. If the Scale 1:1 option is turned on, then you cannot check the distances of features using commands such as Bearing and Distance on the Inquiry menu, because the distances will be scaled down by a factor equal to the drawing scale (for example, at 1"=50', the reduction in scale factor is 1/50 or 0.02). You can set the absolute starting coordinate for the 1:1 scaled plot by setting the Sheet Lower X and Sheet Lower Y. With this clicked off, the profile will drawn full size, with a 1500-foot profile measuring 1500 feet.

**Fit Each Vertical:** With this option turned on, the command will recognize the lower and upper vertical elevations of the profile and set the vertical axis elevation range to enclose the actual elevation limits of the profile. With this option turned off, you can enter the lower vertical elevation range, dropping it down further to increase the lower margin. Whether or not the Fit Each Vertical option is turned on or off, you are always prompted for the top elevation range.

**Tile Sheets:** If clicked on, only one Layout is created in paper space, and all sheets appear in this single Layout as tiles of individual sheets, much like the tiles mode of viewing files within Windows Explorer.

**Label Match Line:** When clicked on and multiple sheets are plotted with plan view option on, a match line will plot in the plan view.
Prompts (Draw Sheet option)

You are first asked to select the polyline that represents the centerline, and the program best fits the centerline in the plan view portion of the plan and profile sheet, then captures all of the associated drawing that will fit in that paper space window. If the length of the polyline divided by the scale exceeds the Sheet Width entry (for example, 5000 feet of road divided by 50 Horiz. Scale is 100, which exceeds the sheet width), then multiple plan and profile sheets will be automatically created. A 5000 foot road at 50 scale with a 30-inch sheet width, would lead to 3 full sheets of 1500 feet each and a "leftover" fourth sheet showing the last 500 feet.

Bottom Vertical Spacing <0.0>? press Enter

The program places the profile plot flush against the bottom of the vertical grid, by default. This prompt allows for an offset, moving the profile plot up off the bottom of the grid. If the lowest elevation of the profile is 940 by default, entering 10 would start vertical axis labeling at 930, and if the vertical scale was 5 units, this would push the vertical plot up 10 units or 2 standard grid intervals.

Top Elevation of Profile Grid <945.0>: press Enter

Cl File/Select polyline that represents centerline: Select the centerline polyline (if Draw Plan has been clicked on).

Beginning Station <0.0>: press Enter

The items below refer again to the profile options that are independent of the Draw Sheet option:

Draw Horiz Axis Elev: This option creates elevation labels along the horizontal axis. Pick Setup to access the Horizontal Axis Elevations settings dialog.
Draw Horiz Label Box: This option draws a boxed area underneath the profile. It is best used in standard Draw Grid mode, with Draw Sheets clicked off. Pick Setup to access the Horizontal Label Box Setup dialog. An example of the resulting plot is shown here:
**Draw Break Point Sta:** Will label these values along the profile line above each break point in the profile. Pick Setup to access the Break Point Station Setup dialog.

![Break Point Station Setup](image)

**Draw Break Point Elev:** Will label these values along the profile line above each break point in the profile. Pick Setup to access the Break Point Elevation Setup dialog.

<table>
<thead>
<tr>
<th>Station</th>
<th>0+00.00</th>
<th>0+13.45</th>
<th>0+24.43</th>
<th>0+50</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elevation</td>
<td>140.09</td>
<td>139.95</td>
<td>140.66</td>
<td></td>
</tr>
</tbody>
</table>
Draw Break Point Desc: Will label these values along the profile line above each break point in the profile. Pick Setup to access the Break Point Description Setup dialog.

Starting Station: This field defaults to the starting station in the selected profile(s). If changed, the starting station can move forward, clipping out the first part of the profile. When you are not plotting sheets, you must set the starting station to the end of the previous sheet's ending station to force a multiple sheet layout.

Ending Station: This field defaults to the ending station in the selected profile(s). A profile that is 3000 feet in length could be plotted in 2 parts, first station 0 to 1500, then station 1500 to 3000, using the Starting Station and Ending Station options.

Label Text Scaler: This sets the size of text used for vertical curve annotation to the horizontal scale times the scaler, when you are working in English units. In metric units the text height would be 0.01*horizontal scale*scaler.

Link To Files: This setting controls the linkage of the plotted profile(s) to the actual profile file(s) (.PRO), determining how changes to the file affect the plotted profile(s). If set to Off, there is no linkage, Prompt will
ask whether to update the plotted profile(s) when the file changes, and Auto will automatically update the plotted profile(s) when the file changes.

**Match Line Elevations:** For high relief profiles that might otherwise extend up and into the plan view portion of the drawing, the Match Line Elevations option can be used to break the profile and redraw the remaining portion with its own vertical scale, as seen above.

**Elevation Range:** This is the range of elevations that is used in conjunction with the Match Line Elevation option. If the range is exceeded (that is, if the range above is 20), the program will break the profile and draw the remainder with a separate vertical axis range.

**Grid Scale and Interval Settings**

**Horizontal Scale:** This scale applies primarily to text size. If the text scaler is 0.1 and the horizontal scale is 50, then text size will be $0.1 \times 50 = 5$.

**Horizontal Grid Interval:** This sets the spacing of the grids that run vertically from the horizontal scale.

**Horizontal Text Interval:** This sets the spacing of the stationing text that appears along the horizontal axis. When using a large "Axis Text Scaler", the horizontal axis text can become too large, and it often necessary to space the horizontal text interval at twice the horizontal scale.

**Vertical Scale:** This scale sets the vertical exaggeration of the profile. If the horizontal scale and vertical scale are the same, then the vertical is not exaggerated. Profiles are often plotted with a 5 or 10 vertical exaggeration. For example, the horizontal scale may be 50, but the vertical scale may be 5.

**Vertical Grid Interval:** This sets the spacing of the grids that run horizontally between the vertical axes on the left and right side of the profile.

**Vertical Text Interval:** This sets the spacing of the elevation text that appears along the vertical axes.

**Label Settings:** These 4 buttons are where you gain access to control over specific label settings for different profile types.

Layers, Colors, Text Styles and Linetypes buttons provide access to settings for each of these features of the profiles.
### Chapter 11. Profiles Menu

#### Draw Profile Layers

<table>
<thead>
<tr>
<th>Layer Type</th>
<th>Layer Name</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st Profile GSR</td>
<td>PROFILE</td>
<td></td>
</tr>
<tr>
<td>2nd Profile GSREG</td>
<td>PROFILE</td>
<td></td>
</tr>
<tr>
<td>Generic Label Layer</td>
<td>PROTEXT</td>
<td></td>
</tr>
<tr>
<td>Grid Text Layer</td>
<td>GRIDTEXT</td>
<td></td>
</tr>
<tr>
<td>Main Index Grid Line Layer</td>
<td>GRID</td>
<td></td>
</tr>
<tr>
<td>Intermediate Grid Line Layer</td>
<td>GRID</td>
<td></td>
</tr>
<tr>
<td>Profile Label Layers</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Road Label Layer</td>
<td>ROAD_PROTXT</td>
<td></td>
</tr>
<tr>
<td>Sewer Label Layer</td>
<td>SEWER_PROTXT</td>
<td></td>
</tr>
<tr>
<td>Pipe Label Layer</td>
<td>PIPE_PROTXT</td>
<td></td>
</tr>
<tr>
<td>Pipe Crossing Label Layer</td>
<td>CROSS_PROTXT</td>
<td></td>
</tr>
</tbody>
</table>

- Prefix Profile Layer Names With Profile Name

#### Draw Profile Colors

<table>
<thead>
<tr>
<th>Layer Type</th>
<th>Color</th>
<th>Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st Profile GSR</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>2nd Profile GSREG</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Grid Text</td>
<td>ByLayer</td>
<td></td>
</tr>
<tr>
<td>Grid Line Main Index</td>
<td>ByLayer</td>
<td></td>
</tr>
<tr>
<td>Grid Line Intermediate</td>
<td>ByLayer</td>
<td></td>
</tr>
<tr>
<td>Generic Labels</td>
<td>ByLayer</td>
<td></td>
</tr>
<tr>
<td>Profile Labels</td>
<td>ByLayer</td>
<td></td>
</tr>
<tr>
<td>Road Profile Labels</td>
<td>ByLayer</td>
<td></td>
</tr>
<tr>
<td>Sewer Profile Labels</td>
<td>ByLayer</td>
<td></td>
</tr>
<tr>
<td>Pipe Profile Labels</td>
<td>ByLayer</td>
<td></td>
</tr>
<tr>
<td>Pipe Crossing Profile Labels</td>
<td>ByLayer</td>
<td></td>
</tr>
</tbody>
</table>

- OK  Cancel  Help
Load Settings: Loads a saved collection of Draw Profile settings, saved in a (.PFS) file.
Save Settings: Saves all Draw Profile settings in a (.PFS) file.

When OK is clicked at the base of the dialog box, the prompting at the command line continues. In this example, assume that a road profile has been selected, since more prompts will occur with road profiles than with generic profiles.

Prompts (Road profile example)

Erase existing profile from drawing [Yes/No]? N This prompt appears only if you have previously drawn the profile.
Next a dialog appears to set the Profile Grid Elevation Range by specifying the Top and Bottom Elevations. Adjust as desired, pick OK.

Pick Starting Point for Grid <8779.55, 5716.36>: pick a point for the lower left corner of the grid

Assuming a road profile has been selected, the following dialog box appears:

Include K-value: This option is a function of the change in slopes on either side of the point of vertical intersection. Include Sight Distance: This option is computed by the delta slope and is a function of whether the vertical curve is a sag or a crest. Include Grade: This option draws slopes along the tangent portion of the vertical curves, with slope direction arrows. Draw Vertical PVC and PVT Lines: This option draws vertical lines emanating from the PVC and PVT of all vertical curves. Position Text Below Line: This option draws the PVC, PVI, and PVT information under the picked location for the vertical curve labeling.
**Pick Each Label Position:** If there were more than one vertical curve in the profile, this option allows you to pick a vertical position for each of the vertical curve's annotation.

**Draw Slope Direction Arrow:** Draws an arrow to indicate slope direction.

**Number of Decimal Places:** Choose the decimal precision used in the elevation and stationing annotation for vertical curves.

Next, select a point vertically that corresponds to the position of the left-right lines under which is written percent grade and above which is written the vertical curve length, sight distance, and K-factor, if requested. The PVC, PVI, and PVT stations and elevations are written above or below this picked point depending on dialog box settings.

Sewer Options:
Additional Prompting for Multiple Profiles

Detected multiple profiles within C:\CARLSON PROJECTS\2006-0124\DATA\PRO\EXAMPLE.PRO

Note that the Profile from Surface Entities command can store additional profiles into the same profile file.

**Draw profiles on same or different grids (Same/<Different>)? press Enter** This determines whether the multiple profiles will be drawn together on the same grid or drawn on separate grids.

**Uniform or variable grid size (Uniform/<Variable>)? press Enter** This selects between one-size-fits all grids or
individually sized grids for each profile.

**Keyboard Command:** drawprof  
**Prerequisite:** A .PRO file  
**File Names:** \lsp\drawprof.lsp, \lsp\profile.dcl, \lsp\vcplot.lsp, \lsp\endsewer.lsp

## Draw Profile Grid

This command plots a grid and labels the grid lines with stations and elevations. Profile grids can also be plotted along with the profile when using the command *Draw Profile*. Use this command to draw only the grid. The following dialog box appears:

![Draw Grid Dialog Box](image)

**Direction:** Choose grid direction, either left to right or right to left.  
**Station Text Orientation:** Specify whether the station text should be plotted horizontal or vertical.  
**Axis Text Only:** When checked, grid lines are not drawn.  
**Ticks and Axis Text:** When checked, one horizontal and vertical grid line as well as the annotations will be drawn.  
**Offset Horizontal Axis Annotation:** When checked, additional space is added between the bottom horizontal grid line and the station labels in order to leave room for Horizontal Axis Elevations and sewer profile annotations.  
**Text Size Scaler:** This sets the size of text used for annotation. This value is multiplied by the horizontal scale to obtain actual text size.  
**Index Grid Line Layer:** Specify the layer name for index grid lines.  
**Grid Text Layer:** Specify the layer name for text annotation along the horizontal and vertical axis.  
**Intermediate Grid Layer:** Specify the layer name for intermediate grid lines.  
**Horizontal Scale:** This sets the horizontal scale for the profile grid.  
**Vertical Scale:** This scale sets the vertical exaggeration of the profile grid.  
**Horiz. Text Interval:** This sets the spacing of the stationing text that appears along the horizontal axis. If you use a large Text Size Scaler such as 0.2 in English units, it is best to set the horizontal text interval to twice the horizontal scale, so that the larger text will not overlap along the horizontal axis.  
**Vert. Text Interval:** This sets the spacing of the elevation text that appears along the vertical axes.  
**Horiz. Grid Interval:** This sets the spacing of the grids that run vertically from the horizontal scale.  
**Vert. Grid Interval:** This sets the spacing of the grids that run horizontally between the vertical axes on the left and right side of the profile.  
**Scan File to Set:** Prompts to select a profile (.PRO) file which it reads to set the values for starting and ending
stations and elevations.

Draw Grid with Station Text Vertical and no Offset Horizontal Axis

Prompts

Draw Grid dialog box
Pick Starting Point for Grid <0.0, 500.0>: pick a point

Pulldown Menu Location: Profiles > Profile Grid
Keyboard Command: drawgrid
Prerequisite: None
File Names: \lsp\drawgrid.lsp, \lsp\profile.dcl

Add Grid Ticks and Dots

This routine draws ticks on the axis and/or interval dots on an existing grid.

Prompts
Add Grid Ticks & Dots dialog
Specify whether to draw the ticks and/or dots, and choose their resolutions (.1 or .2). Also, make sure the grid parameters match the grid that you're working on.

Pick Lower Left Corner of Grid: pick the corner (endpoint snap is on)
Pick Upper Right Corner of Grid: pick the corner (endpoint snap is on)

Grid ticks and dots with metric stationing (no ‘+’) as set in Profile Defaults

Pulldown Menu Location: Profiles > Profile Grid
Keyboard Command: tickdot
Prerequisite: A profile grid
File Name: \lsp\profile.dcl

Add Grid Lines
This routine draws grid lines at the specified scale and interval between the picked lower left and upper right grid corners.

Prompts

Add Grid Lines dialog
Make sure the grid parameters match the grid that you're working on.

Pick Lower Left Corner of Grid: pick the corner (endpoint snap is on)
Pick Upper Right Corner of Grid: pick the corner (endpoint snap is on)

Pulldown Menu Location: Profiles > Profile Grid
Keyboard Command: gridline
Prerequisite: A profile grid
File Names: \lsp\profile.dcl, \lsp\gridline.lsp

**Horizontal Axis Elevations**

This command labels the elevations of a profile along the bottom horizontal axis at a user-specified interval. It requires an existing grid and profile. The profile can be read from either a .PRO file or from a profile polyline on the grid. This polyline must be drawn in the direction of the grid. There are more labeling options when using the screen polyline method.

In the dialog, you can set the layer name, style, size and decimal places for the labels. Two profiles can be labeled at once to handle existing and final profiles in one step (see graphic). When labeling two profiles with the "File" method (recalling a profile), use the "L" justification for the first set of horizontal axis elevations, and use the "R" justification for the second set. One convention is to label the existing profile to one decimal place and the final profile to two decimal places. When labeling only one profile, use the center justification. When using two profiles from the “Screen” selection method, there is an option to also label the elevation difference between the profiles. The Label Between Elevations option chooses between labeling the values in the order of existing elevation, cut/fill and final elevation or in the order of existing elevation, final elevation then cut/fill. The Skip Elevation Labels option will label only the cut/fill and not the elevations.
Prompts

Read Profile from a File or from the Screen (File/<Screen>): press Enter

Plot Elevations on Horiz Axis dialog
Make sure the grid starting station and elevation match the grid that you're working on.

Pick the existing grade (Enter for none): pick a profile polyline on the grid

Pick the final grade (Enter for none): press Enter

Alignment of text (<Left>/Center/Right)? C This prompt occurs only in the "File" selection method.

Pick Lower Left Grid Corner: pick the corner (endpoint snap is on)

Pulldown Menu Location: Profiles > Label Horizontal Axis

Keyboard Command: horelev

Prerequisite: Profile grid with a profile polyline

File Name: \lsp\horelev.lsp

Horizontal Axis Crossings

This purpose of this command is to draw ticks on the horizontal axis of the profile at station locations where the centerline intersects selected plan view polylines. It requires a grid, profile and an existing CL file, as well as user-specified values entered into the dialog. The profile can be read from either a .PRO file or from a profile polyline on the grid. This polyline must be drawn in the direction of the grid. In the dialog, you can set the direction of the grid, the horizontal scale and the starting station of the grid. You can also determine the Text Size Scaler, Text Layer
name and the Marker Size Scaler. The command line offers the option to choose the existing centerline (.CL) file. You enter "C" and a dialog appears where you may select the file.

![Horizontal Axis Crossings dialog](image)

Prompts

**Horizontal Axis Crossings dialog** Fill in values.
Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>: pick polyline

![Plan view showing crossing](image)
Profile to 3D Polyline

This command converts a 2D polyline centerline into a 3D polyline that follows the elevations of the profile. Horizontal and vertical curves are represented as a series of polyline segments since 3D polylines cannot contain arcs. Profile to 3D Polyline can be combined with other commands for plan-view road design as follows:

1. Draw 2D polyline centerline.
2. Profile from Surface Model - to create existing surface profile.
3. Design Road Profile - to design the final profile with vertical curves.
4. Profile to 3D Polyline - create a 3D polyline of the road centerline.
5. Offset 3D Polyline - offset the 3D polyline centerline left and right by the horizontal and vertical distances.
6. Design Pad Template - run twice for left and right polylines of road to tie into surface at specified cut and fill slopes. This creates the limits of the disturbed area. Or use Join Nearest, Direct Connect Endpoints, to create a closed loop pad with one run of Design Pad Template for simple ramps, driveways and access roads.
7. Triangulate & Contour - draw final contours using road 3D polylines.
8. Volumes - use any of the volumes commands to calculate cut and fill volumes.

Prompts

Layer Name for 3D Polyline <3DPROF>: press Enter
Select profile centerline polyline: pick a polyline
Station by another reference centerline [Yes/<No>]? N for no. This option will prompt for a second centerline to use for stationing.
Enter the starting station <0.0>: press Enter
Select Profile File
Starting station of centerline <0.0>: press Enter
Erase centerline (Yes/<No>)? Y This option will erase the original 2D polyline centerline.

![Profile To Points Diagram]

Example of road design in plan-view with Profile to 3D Polyline

**Keyboard Command:** proto3dp  
**Prerequisite:** A .PRO file and a centerline polyline  
**File Name:** \lsp\profedit.arx

### Profile To Points

This command creates Carlson points along a horizontal alignment polyline using a profile file to compute the point elevations. The created points are stored in a coordinate (.CRD) file and can also be drawn on screen in the layer specified by the user. Station text, profile name, and special points (vertical and horizontal PC's and PT's) can be stored in the point description depending on user settings.
Create points at Profile special points: Includes vertical PC and PT points.
Create points at Centerline special points: Includes horizontal PC and PT points.
Create points at Station Intervals: Allows you to specify intervals for point creation.
Interval On Line Segments: Specify station interval for line segments.
Interval On Curve Segments: Specify station interval for curve segments.
Station to Begin Intervals: Specify station to start intervals.
Prompt For Additional Odd Stations: Any station can be entered to create additional points with elevations derived from the profile.
Create Points on Centerline: When checked, points will be created on the centerline.
Create Left Offset Points: When checked, left offset points will be created. Specify the offset in the edit box.
Create Right Offset Points: When checked, right offset points will be created. Specify the offset in the edit box.
Vertical Offset Of Profile: Specify the vertical offset. Enter zero for no vertical offset.
Plot Points: When checked, points will be plotted in the drawing, otherwise points are only added to the current coordinate (.CRD) file.
Include profile name in point descriptions: When checked, the profile name will be used as the prefix on the point description. For example, if the profile name is DESIGN.PRO, then the point description might be DESIGN 0+63.37.
Decimal Places: Specify the display precision for points that are plotted in the drawing. This setting does not affect the coordinates stored in the CRD file.
Centerline by: Click either Polyline or CL File.
Type of Centerline: Click either Roadway or Railroad.
OK: Specify files.

Prompts

Select Coordinate File to Process
If the current coordinate is set, it is used automatically without this prompt.
Select profile centerline polyline: *pick a polyline*
Station by another reference centerline [Yes/No]? *N for no.* This option will prompt for a second centerline
to use for stationing.

**Starting station of centerline <0.0>:** press Enter

**Choose Profile to Process dialog** Specify a profile name.

**Starting point number <1>:** press Enter This defaults to the point number after the highest one currently in the CRD file.

**Station for additional point (ENTER to end):** press Enter This option will create a point at the specified station. Prompt occurs only if option is specified in dialog.

Points created along profile centerline using elevations from the above road profile

**Keyboard Command:** pro2pts

**Prerequisite:** A .PRO file and a centerline polyline

**File Name:** \lsp\profedit.arx

### Profile Report

This command creates a summary report of generic, road, crossing, pipe and sewer profiles using a profile file (.PRO file). The report is generated in the standard report viewer which can print the report, save it to a file or draw it on the screen. The different types of profiles have different report options.

For roadway profiles, Report Sag and Crest Stations will calculate and report sag and crest stations and elevations. Report Stations at Centerline Points will prompt the user for a centerline file (.cl file) and report stations and elevations at horizontal PC and PT points. Report Cut/Fill from Second Profile will compute and report the elevation difference between the subject profile and a second reference profile. Report Station/Elevation at Interval will calculate and report stations at the specified interval in addition to other points. Report Elevation to Vertical Offset creates and additional elevation column in the report. The differential amount for this column is specified by the user in the Vertical Offset window. The Use Report Formatter option runs the report through the report formatter where you can choose which fields to report and the report order as well as output to Excel or databases.
Prompts

Specify a Profile File dialog Choose the .PRO file.
Profile Report dialog Make selections, click OK.
If a vertical offset is entered, a second column of elevations is reported.

Sample Profile Report:

<table>
<thead>
<tr>
<th>Station</th>
<th>Elevation</th>
<th>Type</th>
<th>VertCurve</th>
<th>Distance</th>
<th>Slope</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>0+00.00</td>
<td>88.08</td>
<td></td>
<td></td>
<td>0.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1+00.00</td>
<td>94.39</td>
<td></td>
<td></td>
<td></td>
<td>6.45%</td>
<td></td>
</tr>
<tr>
<td>2+00.00</td>
<td>100.84</td>
<td></td>
<td></td>
<td></td>
<td>6.45%</td>
<td></td>
</tr>
<tr>
<td>3+00.00</td>
<td>107.29</td>
<td></td>
<td></td>
<td></td>
<td>6.45%</td>
<td></td>
</tr>
<tr>
<td>3+73.78</td>
<td>112.05</td>
<td>PVC</td>
<td></td>
<td>371.48</td>
<td>6.45%</td>
<td></td>
</tr>
<tr>
<td>4+00.00</td>
<td>113.68</td>
<td></td>
<td></td>
<td></td>
<td>6.00%</td>
<td></td>
</tr>
<tr>
<td>5+00.00</td>
<td>118.82</td>
<td></td>
<td></td>
<td></td>
<td>4.27%</td>
<td></td>
</tr>
<tr>
<td>6+00.00</td>
<td>122.22</td>
<td></td>
<td></td>
<td></td>
<td>2.54%</td>
<td></td>
</tr>
<tr>
<td>6+23.78</td>
<td>128.18</td>
<td>PI</td>
<td>350.00</td>
<td>250.00</td>
<td>6.45%</td>
<td></td>
</tr>
<tr>
<td>7+00.00</td>
<td>121.26</td>
<td></td>
<td></td>
<td></td>
<td>-6.10%</td>
<td></td>
</tr>
<tr>
<td>7+23.78</td>
<td>119.50</td>
<td>PVT</td>
<td>100.00</td>
<td>51.93</td>
<td>-8.67%</td>
<td></td>
</tr>
<tr>
<td>7+75.71</td>
<td>115.00</td>
<td></td>
<td></td>
<td></td>
<td>-8.67%</td>
<td></td>
</tr>
</tbody>
</table>

Pulldown Menu Location: Profiles
Keyboard Command: preport
Prerequisite: A .PRO file
File Names: \lsp\proreprt.lsp, \lsp\profedit.arx

Chapter 11. Profiles Menu 369
Polyline Slope Report

This command calculates and labels the slope of a line, polyline segment, an entire polyline, or pair of points, as drawn on a profile. The command starts with the Slope Report Options dialog.

Horizontal Scale: Specify the horizontal scale of the profile.
Vertical Scale: Specify the vertical scale of the profile.
Text Size Scaler: Specify the text size scaler.
Decimals: Specify the display precision for the slope labels.
Label Symbol: When checked, the degree symbol or percent sign will be used in the label.
Label Arrow: When checked, a slope direction arrow will be included.
Label Minus Sign: Will label a minus sign on negative slopes.
Label Format: Specify how to label the profile slopes. The automatic settings means to use a percent label for any slope less than 10%. and a ratio for any slope greater that 10%.
Label Method: Choose to label the entire profile at once or to pick individual segments.
Reduce Profile Points: When checked, the number of labels created on the profile will be reduced based on the Offset Distance value. Applies only to the Entire Polyline selection option.
Offset Distance: Specify maximum offset between profile vertices. Only available when Reduce Profile Points toggle is checked on.

Prompts

Slope Report Options dialog box
Points/<Select line or polyline to list-label>: pick a polyline
Slope Distance> 600.33 Horizontal Distance> 600.00
Elevation Difference: 20.00 Slope Ratio: 30.00:1 Slope Percent: 3.33
Starting point of label ([Enter] for none): pick a point
Points/<Select line or polyline to list-label>: press Enter If you choose P for points, you go into the Points mode and can label the slope of any pair of screen picks on the profile.
Keyboard Command: llg
Prerequisite: A profile grid and profile polyline
File Name: \lsp\llg.lsp

Station-Elevation-Slope Report

This command calculates the elevation and slope along a profile at user specified stations or intervals. The routine allows three types of profile input options: Profile File (an existing .PRO file), Screen Profile (existing grid and polyline profile), or None (allows you to specify station-elevation points without referencing a profile). If the Screen Profile option is used, the profile polyline direction must match that of the stationing on the grid.

There are two Output options: Report and Label Profile. The Report option will send the output data to the standard report viewer, which can then be printed, saved to a file or plotted in the drawing. The Label Profile option will create text on the existing grid and polyline profile. With either option, the user will be prompted to enter or pick the station to report unless the Report at Interval option is checked on. In this case, the reporting will be done automatically at the interval specified. With the Label Profile option, the user has the additional options for defining the data to be labeled (Station, Elevation, Both or None), the slope format and the vertical position of the text on the grid.

This command can also be used as a profile inspector. As you move the cursor around, the station, elevation and profile grade are displayed in a real-time window, unless you specify the more automatic "report at interval" method. If Prompt for snap is set on (available in non-interval mode), then when a point on the profile is picked, you have the opportunity to snap to an even 1, 5 or 10 stations.
Prompts

Station-Elevation-Slope Report Options dialog
Profile Settings dialog Check that these parameters match the grid.
Pick polyline segment of the grade: pick the profile polyline
Pick the Lower Left corner of the grid: pick the corner (endpoint snap is on)
Range of Stations: <0.0 - 451.913>
Enter a Station or Pick a point (Enter to end): 100 (non-interval method)
Station 1+00.00, Elevation 958.75
Pick the vertical position for the text: pick a point to place the text
Enter a Station or Pick a point (Enter to end): press Enter

Picked method with Slope set to None
Interval method with Slope in Percent

**Pulldown Menu Location:** Profiles  
**Keyboard Command:** staelv  
**Prerequisite:** Profile grid with profile polyline or .PRO file  
**File Name:** \lsp\ewoks.arx

## Sag & Crest Report

This command will calculate the high and low point (sag and crest) on the vertical curves defined in the specified road (.PRO) profile file. Plotting the calculations in the drawing is optional. A profile grid must already be drawn to use the plotting option. The sag and crest are only labeled if the respective low and high points occur on a vertical curve.

![Profile Settings dialog](image)

### Prompts

- **Report only/Plot calculations**: press Enter
- **Profile Settings dialog** If you're using the plot option, make sure these parameters match your grid.  
  - [end on]**Pick Lower Left Grid Corner <0.00,0.00>**: pick this point  
  - **Number of decimal Places <2>**: press Enter

---

*Chapter 11. Profiles Menu*
Pipe Depth Summary

This command reports the horizontal distances for the range of depths comparing a surface profile to a trench, pipe or sewer profile. There is an option to use two surface profiles and the program will use the minimum of the two depths. In addition to the report, the depth ranges can be labeled along the profile in the drawing.

The simplest of applications of this command, comparing a sewer profile to a surface profile and reporting the depth summary according to the specified Depth Zones, is shown below.

Use Trench Template for Volumes: Trench templates are made using the command Input-Edit Trench Template within the Profile Utilities "flyout". Trench earthwork volumes are then computed.

Report Backfill Volumes: Available if trench templates is clicked on.

Use Rock Strata Profile: If clicked on, the Rock Profile can be entered in the lower portion of the dialog, and if the pipe invert is below rock surfaces along any segment, rock linear feet will be reported, in the same depth categories as used for trench depths. In the example shown below, if rock depth is uniformly 5 feet below surface elevation, in the form of a rock profile, rock quantities are 348 feet of 0-2 feet depth of rock trenching.

Use 2nd Surface Profile to Minimize Cut: If the final grade is below existing grade, in those areas, it saves trenching work to first do the cut to final grade, prior to filling over existing grade in areas of fill. Then trench depths

Chapter 11. Profiles Menu
are minimized. This option, if clicked on, computes trench depths to the minimum of the two specified surfaces, and activates the 2nd Surface Profile option in the lower portion of the dialog.

**Extend Shorter Profile to Longer Profile:** This option will extrapolate the starting and ending stations of the shorter profile to match the longer profile.

**Draw Zone Dimensions on Profile:** The depth zones will be annotated along the horizontal axis of a profile drawing with this option.

**Report Manhole Depth Summary:** This leads to the depth summary report.

**Depth Zones:** These zones are for reporting the pipe range of depth. The depths should be entered in lowest to highest order. Use the Next and Back buttons to move between the 20 possible depth values.

**Prompts**

**Pipe Depth Options dialog**

- Pick lower left grid corner \[\text{int on}\]: *pick the profile grid corner*
- Pick vertical position for dimensions: *pick a point below the profile grid*

---

**Pipe Depth Summary**

<table>
<thead>
<tr>
<th>Depth</th>
<th>Manholes</th>
<th>Linear Ft</th>
<th>% of Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-2.0</td>
<td>0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>2.0-4.0</td>
<td>1</td>
<td>34.2</td>
<td>7.9</td>
</tr>
<tr>
<td>4.0-6.0</td>
<td>0</td>
<td>299.6</td>
<td>65.3</td>
</tr>
<tr>
<td>6.0-8.0</td>
<td>2</td>
<td>115.2</td>
<td>26.8</td>
</tr>
<tr>
<td>8.0-10.0</td>
<td>0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td>&gt;10.0</td>
<td>0</td>
<td>0.0</td>
<td>0.0</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>3</strong></td>
<td><strong>330.8</strong></td>
<td><strong>100.0</strong></td>
</tr>
</tbody>
</table>

**Manhole Depth**

- MH#3: 6.10
- MH#2: 6.21
- MH#1: 3.20
- **Total:** 15.54
**Profile ID**

This command reports the profile file name, horizontal scale and vertical scale that was used to draw the selected drawing entity. Simply pick a profile entity in the drawing and the profile file name is reported in the command text window. The profile must be drawn in Carlson by completing the Draw Profile command (without aborting the command by pressing Esc).

**Prompts**

- **Select profile entity to identify**: *pick an entity*
- **Horizontal Scale**: 50.0  **Vertical Scale**: 10.0
- **Profile Name**: sewer.pro
- **Select profile entity to identify**: *press Enter to end*

**Review Profile Links**

This command shows a list of all the profile links that the program knows about in the current drawing. These links are between the profile files and the drawn profiles in the drawing. You can use the Remove button to remove links for any obsolete profiles or if you don't want to link a certain profile.

**Merge Profiles**

This command combines a range of stations of one profile and a range of stations of a second profile. The stations and elevations in these two ranges can be stored in a new file or overwrite an existing profile. Both profiles must be the same type: generic, road, pipe, or sewer.

**Prompts**

- **First Profile to Merge** Select a profile.
- **Second Profile to Merge** Select a profile.
- **Range of first profile stations to use** `<0.0 - 400.0>`: *press Enter*
- **Range of second profile stations to use** `<400.0 - 800.0>`: *press Enter*
Profile file to Save dialog box

Ranges can overlap, as shown below:
Range of first profile stations to use <0.000 - 471.214>:
Range of second profile stations to use <450.000 - 480.000>:
In the case of overlap, all non-matching stations and elevations in the two sets of profile ranges will be used in the final profile. If matching stations are found, the elevations of the first and second profiles will be averaged.

Pulldown Menu Location: Profiles > Profile Utilities
Keyboard Command: mergepro
Prerequisite: Two profiles
File Name: \lsp\profedit.arx

Average Profiles

This command averages up to four profiles and stores the resulting profile into a user-specified file name. Profiles that don't share the exact profile range will be projected to match the low and high stations in the selected profiles, after which the averaging will be computed.

Prompts

1st Profile file to Average dialog Specify a profile file.
2nd Profile file to Average dialog Specify a profile file.
3rd Profile file to Average dialog Hit Cancel to stop selecting profiles.
Choose Profile to Write Specify a profile file.

Pulldown Menu Location: Profiles > Profile Utilities
Keyboard Command: avgpro
Prerequisite: Two or more profile files
File Name: \lsp\profedit.arx

Draw Pipe 3D Polyline

This command creates a 3D polyline that represents a pipe. The points can be either picked on screen or specified by point number in the current coordinate file. This command is a convenient way to make 3D polylines that can become "pipe polylines" used for capturing their profile positions, leading to circular or elliptical or even square plots of the pipes or culverts within Draw Profile. However, this command is not required nor sufficient to make a pipe polyline useful in the Draw Profile command. Pipe polylines are made only by converting 3D polylines into pipe polylines using the adjacent command, Assign Pipe Width to Pline.

Prompts

Layer Name for 3DPoly <PIPE>: press Enter
Prompt for elevations (.XY filter) (Yes/<No>)? Y for yes
Undo/<Pick point or point numbers>: pick a point
Elevation <0.0>: 554.12
Undo/<Pick point or point numbers>: pick a point
Percent slope/Ratio slope/Elevation <0.0>: 553.72
Undo/Close/<Pick point or point numbers>: press Enter
Draw another 3D polyline (Yes/<No>?): press Enter

Pulldown Menu Location: Profile->Profile Utilities
Keyboard Command: drwpipe
Prerequisite: None
File Name: \lsp\3dpline.lsp

Assign Pipe Width to Polyline

This command attaches a pipe width to one or more polylines. Any polyline can be used, but it should be a 3D polyline that represents the elevations of the pipe. Pipe width is used in commands such as Profile from Pipe Polylines and Section Points from Pipes commands.

Prompts

Select polyline: pick a polyline
Enter pipe width (in): 18
Set pipe width for 1 polylines.
Select polyline (Enter to End): press Enter

Pulldown Menu Location: Profile->Profile Utilities
Keyboard Command: plwidth
Prerequisite: A polyline
File Name: \lsp\plwidth.lsp

Profile Offset Text

This command draws station/offset and description text for points along a centerline polyline at a picked vertical position on the screen. It works well when used on combined Plan and Profile sheets, where the offset text can be plotted in the profile portion. The text is drawn vertically and is positioned horizontally at the station of the centerline. The station and offset of the point can optionally be included in the text. The points can either be picked or specified by point number. After picking the point, a text editor allows you to type in additional text for the label. For centerlines that are not roughly East-West, use Twist Screen under the View pulldown to re-orient the centerline.
to a near horizontal position on the screen. Only the "pick point or point number" option will display the edit box for the description.

**Include station-offset in label:** When clicked on, the calculated station and offset text is plotted. **Full or Abbreviated:** The abbreviated form leaves off the even 100 feet in front of the stationing, and saves some space. Station 14+50.23 would plot as +50.23. **Label Left and Right Offsets (Together or Separately):** The "Separately" option will ask for a horizontal alignment point for left and another for right offsets. Otherwise offsets will be labeled along one horizontal alignment based on one pick. **Text justification (Left or Right):** Left plots down the screen and right will plot up the screen. **Label Prefix:** Will place this prefix in front of the station and offset or entered text for the picked position. For example, the word "Sta." could be added as a prefix, leading to a plot such as Sta. 14+50.23. **Label Suffix:** Will append this suffix to all text for each picked position.

**Prompts**

Profile Offset Text Dialog *make choices, click OK*
Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>: *pick the centerline*
Starting station of centerline <0.0>: *press Enter*
Pick horizontal alignment for text: *pick a point*
Pick point or point number (SS for Selection Set, Enter to End): *pick a point*
Profile Offset Text dialog
Pick point or point number (Enter to End): *press Enter*
Profile Offset Text along a centerline

**Pulldown Menu Location:** Profiles > Profile Utilities

**Keyboard Command:** protext

**Prerequisite:** A centerline polyline

**File Name:** \lsp\profedit.arx

## Label Profile Differentials

This command labels the elevation difference between two profiles at specified stations. The text label is drawn along the polyline centerline in plan view. Cut is labeled as negative and fill as positive.

### Prompts

**Existing Ground Profile dialog** Specify a profile file to read.

**Final Surface Profile dialog** Specify an existing profile file to read.

**Select centerline polyline:** Pick a polyline. This represents the centerline and should be drawn in the direction of increasing stations.

**Starting station of polyline <0.0>:** press Enter

**Label all polyline vertices (<Yes>/No)?** press Enter This option will label the elevation difference at the stations of each point on the polyline centerline.

**Pick points to label (Yes/<No>)?** press Enter This option allows you to pick points along the centerline to label.

**Prompt for text position (Yes/<No>)?** press Enter This option allows you to pick the position of each elevation difference label. Otherwise the text is automatically centered at the point on the polyline.

**Text size <4.00>:** press Enter

---

**Pulldown Menu Location:** Profiles > Profile Utilities

**Keyboard Command:** prodiff
Prerequisite: Two profile files
File Name: \lsp\profedit.arx

Label Sewer Laterals

This is a command to label, in plan view, the sewer laterals in linear feet. This includes a station distance from a known starting station on the main line, as well as the length of the lateral itself from the main sewer line to the property. You may optionally include a prefix and/or suffix for both the station and lateral labels.

Prompts

**Label Sewer Lateral** dialog Specify your preferred values.
**Pick centerline/polyline that represents a sewer:** pick an entity
**Starting Station of the sewer** <0.0>: press Enter
**Pick a lateral intersection point (Enter to end):** pick an intersection point
**Pick a lateral to label:** pick entity
**Pulldown Menu Location:** Profiles > Profile Utilities  
**Keyboard Command:** label_sewer_lateral  
**Prerequisite:** Sewer line with lateral(s)  
**File Name:** \lsp\profedit.arx

### Profile Conversions

There are eleven Profile Conversion commands, all of which are listed below. The first nine in the list are Import Profile commands. These commands allow you to convert a single profile file from their respective program to the Carlson profile (.PRO) format. For each, you are prompted to select the file to be imported, then provide a Carlson profile file name. Underneath each of the nine brief descriptions shown are, in bold, the prompts that you see in dialog box form and/or on the command line.

The last two commands listed below are Export Profile commands. They allow you to convert a single Carlson profile (.PRO) file to Softdesk (.TXT) format, or a single Carlson profile (.PRO) file to Leica (.GSI) format. You are prompted to select the Carlson profile file, then provide a name for the Softdesk or Leica file.

#### Import Columnar Text

Allows you to Import a comma or space delimited text file to create a profile (.PRO) file.
Import CAiCE Profile

Allows you to convert a single CAiCE (.KCP) profile file to the Carlson profile (.PRO) format. You are prompted to select the CAiCE file, then provide a Carlson profile file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: caice2pro
File Name: \lsp\profedit.arx

Import Leica Profile

Allows you to convert a single Leica profile (.GSI) file to the Carlson profile (.PRO) format. You are prompted to select the Leica file then provide a Carlson profile file name.

Choose Leica/Wild File to Readdialog Select existing file.
Choose Profile to Writedialog Select file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: wildpro2
File Name: \lsp\profedit.arx

Import MOSS Profile

Allows you to convert a single MOSS profile (.INP) file to the Carlson profile (.PRO) format. You are prompted to select the MOSS file then provide a Carlson profile file name.

Choose MOSS Profile File to Readdialog Select existing file.
Choose Profile to Writedialog Select file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: moss2pro
File Name: \lsp\profedit.arx

Import Softdesk Profile
Allows you to convert a single Softdesk profile (.TXT) file to the Carlson profile (.PRO) format. You are prompted to select the Softdesk file then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** dcapro2  
**File Name:** \lsp\profedit.arx

**Import Sokkia/SDR Profile**

Allows you to convert a single Sokkia/SDR (.SDR or .RAW) profile file to the Carlson profile (.PRO) format. You are prompted to select the Sokkia/SDR file, then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** sdr2pro  
**File Name:** \lsp\gisutil.arx

**Import Spanish ALZ Profile**

Allows you to convert a single Spanish ALZ profile (.INP) file to the Carlson profile (.PRO) format. You are prompted to select the Spanish ALZ file and then provide a Carlson profile file name.

**Choose CLIP File to Read** dialog: Select existing .ALZ file.  
**Choose Profile to Write** dialog: Select file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** alz_to_pro  
**File Name:** \lsp\eworks.arx

**Import Spanish RAS Profile**

Allows you to convert a single Spanish RAS profile (.RAS) file to the Carlson profile (.PRO) format. You are prompted to select the Spanish RAS file and then provide a Carlson profile file name.

**ISPOL File to Read** dialog: Select existing .RAS file.  
**Choose Profile to Write** dialog: Select file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** ras_to_pro  
**File Name:** \lsp\eworks.arx

**Import Terramodel Profile**

Allows you to convert a single Terramodel (.RLN) profile file to the Carlson profile (.PRO) format. You are prompted to select the Terramodel file, then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** tm2pro  
**File Name:** \lsp\gisutil.arx

**Export Softdesk Profile**
Choose Profile File to Read dialog Select existing .PRO file.
Choose Softdesk File to Write dialog Enter new Softdesk file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: dcapro1
File Name: \lsp\profedit.arx

Export Leica Profile

Choose Profile File to Read dialog Select existing .PRO file.
Choose Wild File to Write dialog Enter new .GSI file name.
GSI file format [<8>/16]? press Enter

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Commands: wildpro1
File Names: \lsp\cogoutil.arx
Sections Menu

The Sections menu shown below has commands for creating, drawing and reporting sections. All commands are described in this section except for Polyline Slope Label/Report which is described under the Profiles section.
Section Defaults

Allows you to specify certain default values for working with sections. The dialog below appears when you select this command.

Horizontal Scale: Specify the horizontal scale.
Vertical Scale: Specify the vertical scale.
Text Size: Specify the text size scaler. This number is multiplied by the horizontal scale to determine actual text height.
Limit of Break Points per Section: Specify the maximum number of break points per section.
Station Type: 1+00 usually applies to English units, while 1+000 is for metric, and No.0 is for Korean.

Pulldown Menu Location: Sections
Keyboard Command: sctdef
Prerequisite: None
File Name: \lsp\regrade.arx

Input-Edit Section Alignment

This command will create or append to a section alignment file which is stored as a Multiple Cross Sections (.MXS) file. This file contains the coordinates that define the center and endpoints of section lines and is a requirement of many section commands such as Sections from Surface Entities and Sections to 3D Polyline. The section alignment defines the stations along a centerline and how far left and right to create cross sections. This routine starts by asking for a new or existing .MXS file name. Then the centerline is specified by either by choosing a centerline file (.CL file) or selecting a polyline that represents the centerline. Next, the program prompts for the starting station of the centerline. If this is a new section alignment, the Make MXS File Settings dialog appears.

The Input-Edit Section Alignment dialog lists all the section stations and offsets in the alignment of an existing .MXS file.
Dialog if using an existing .MXS file

**Edit:** Allows you to edit the currently highlighted row.

**Add:** Allows you to add more sections by displaying the Make MXS File Settings dialog (shown below).

**Delete:** Deletes the currently highlighted row.

**Save:** Saves the MXS file, exits this dialog and draws the section alignment on the screen using temporary vectors (yellow for left offsets, magenta for right offsets). Any viewport change such as Redraw or Zoom will cause these vectors to disappear. The draw the section lines with Line entities, use the Draw Section Alignment command.

**SaveAs:** Saves a new MXS file with a user-specified name.

---

**Station Interval:** Enter the station interval for sections.

**Right Offset:** Enter the width for the sections, right of the centerline. Not available if Pick Offset Distances is checked.

**Left Offset:** Enter the width for the sections, left of the centerline. Not available if Pick Offset Distances is checked.

**Type of Curve:** Specify either Roadway or Railroad curve.

**Prompt for Starting and Ending Stations:** Click or do not click.

**Pick Offset Distances:** Allows you to specify the offsets by using the distance between two picked points in the drawing.
Use Perimeter Polyline: Allows you to specify a closed polyline that will be used as the limit of the cross sections. The offsets will be contained within this closed polyline.

Station Options: There are five methods for locating the stations:
Stations at Interval: Creates cross sections at the specified interval such as every 25 feet. If the Prompt for Starting and Ending Stations is on, then the program will apply the station interval to the user-specified range of stations. Otherwise the station interval is used along the entire centerline.
Stations at Centerline Points: Creates cross sections at every transition point in the centerline such as the PC, PT, spiral points and end points.
Stations at Crossing Polylines: Allows you to select polylines that cross the centerline and creates cross sections at the intersections of these polylines with the centerline.
Odd Stations with Specified Endpoints: Creates cross sections at stations that are entered or at picked points along the centerline. This option also allows you to pick the left and right offset points which do not have to be perpendicular to the centerline.
Additional Odd Stations: Creates cross sections at the specified stations but the offsets are always perpendicular to the centerline with the user-defined default offset distances.

Prompts

Specify an MXS file dialog Choose new or existing.
Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>: pick centerline
Enter Beginning Station of Alignment <0.00>: press Enter

Keyboard Command: editmxs
Prerequisite: A polyline centerline or a centerline .CL file
File Name: \lsp\profedit.arx

Draw Section Alignment

This command will draw the location of the cross sections contained in an existing .MXS file. The cross sections stations can also be labeled Perpendicular or Parallel. The main purpose of this routine is to allow you to graphically view the location of the cross sections.
Quick Sections

This command creates section files in one step. The horizontal alignment for the sections can be defined by using picked points, a centerline file or a polyline. A section alignment (.MXS) file is not required for this routine. 3D screen entities or surface files (.GRD, .FLT, or .TIN) are used to define the vertical alignment.

There are two options under Quick Section Methods. The Station Series method creates sections perpendicular from the horizontal alignment at a station interval. In this case, the horizontal alignment represents the centerline. The Single Station method creates one section along the horizontal alignment appends this section to the output section file. In this case, the horizontal alignment represents the alignment of the section.

For the Station Series method, there are settings for the Start Station of the horizontal alignment, the End Station to stop creating sections, the Interval for the stations, and the Left and Right Offsets to define the section width. There are also options to control the section stations to create. The Stations At Interval option will create sections at the specified station interval. The Stations At Centerline Points option will create sections at the special stations of the centerline for the centerline transitions such as PC, PT points.

For the Single Station method, the Station value is assigned to this section. The Zero Offset Point chooses between using the starting point of the horizontal alignment as the zero offset or selecting a point along the alignment as the zero offset.

With the Source Of Surface Model set to Surface Files, the program prompts for up to two surface files so that up to two section files can be generated at a time. When the Surface Model is set to Screen Entities, only one section file is created from the screen entities. With Screen Entities, there are a few more options. The Descriptions By Layer option will use the layers of the screen entities as the descriptions for the section points. The Interpolate From Data Beyond Section Limit will check for intersections with the section line and the screen entities beyond the left/right offsets to interpolate the elevations at the left/right offset extents. The Ignore Zero Elevations will filter out screen entities that are at zero elevation. The Interpolate Zero Offset Elevation Of Sections will create a section point at offset zero by interpolating between the nearest section points.
The program requires an output section file to store the results. There is an output option to draw the sections which calls the Draw Section File command. Finally, the option to Draw Plan View Polyline will draw the horizontal alignment as a polyline which is especially useful is the method to define the alignment by picked points was used.

Prompts

Pick starting point (CL-Centerline,P-Polyline): select a point
Pick second point: select second point
Pick next point (Enter to end): press Enter
Quick Section Options dialog
Choose Source of Surface Model, Screen Entities or Surface File, and make other selections. Click OK.

Keyboard Command: quicksct
Prerequisite: 3D Screen entities or surface files
File Name: \lsp\profedit.arx

Sections from Surface Entities

This command allows you to create cross sections from a surface model. The stations for the sections, and the left and right offset distances, are defined in the MXS file. This file must be created before running this routine by using the Input-Edit Section Alignment command. The surface model is defined by lines or polylines with elevation. The polylines with elevation could be a contour drawing file from a photogrammetry firm, or it can be created from survey points with the Triangulate & Contour command. When using Triangulate & Contour it is useful to use the Draw Triangulation Lines option because the 3D triangulation lines represent all the breaklines in the surface which increases the accuracy of the cross section verses just using the contours. Breaklines or 3D polylines can also be
used to represent ridges and valleys. The program samples the selected lines, polylines and 3DFace entities and calculates the intersections of these segments with any of the cross sections. The station, offset and elevation of these intersections make up the data in the section file. This section (.SCT) file can be reviewed or edited with the *Input-Edit Section File* command. Also, the section file can be plotted with the *Draw Section File* command or used in the by the *Process Road Design* command to calculate volumes.

![Section Menu](image)

**Interpolate 0 Offset Elevation of Sections:** When checked, this option will add a data point at offset zero for every station with an elevation that is interpolated from existing offsets.

**Make Profile from 0 Offsets of Sections:** Allows you to specify a .PRO file name to create from the 0 offsets of the sections.

**Section End Point Treatment:** The section end points are the left and right furthest offsets such as left and right 100 feet. When calculating sections based on the intersections with surface entities, there usually isn't an intersection exactly at the end points. For example, there could be contours at offsets right 87.31 and 105.43 but no intersection exactly at 100. There are four methods for determining the elevation for these end points.

- **Extrapolate Endpoint Elevation from Last Slope:** This option calculates the slope from the last two offset-elevation points and calculates the elevation at the endpoint from this slope. For example, given offsets at 80 with elevation 100, and 90 with elevation 101, the elevation at offset 100 would be 102.

- **Extend at Flat Grade to Right and Left MXS Limit:** This option uses the last offset elevation as the end point elevation. For example, if the last offset were 85 with elevation 102, the program would add an offset at 100 with elevation 102.

- **Cut-off at the End of Surface Data:** This option does not add offsets at the end points. The sections will end at the last offset found in the surface model.
**Interpolate from Surface Data Beyond MXS Limit:** This option looks beyond the offset limit for more intersections with surface entities. The endpoint elevation is then interpolated between the offsets above and below the endpoint. For example, given offsets at 90 with elevation 101, and at 110 with elevation 103, the endpoint offset at 100 would have elevation 102. If this option is selected, the Distance to Add to MXS Limit for Interpolation field becomes available.

**Distance to Add to MXS Limit for Interpolation:** Enter distance.

**Ignore Zero Elevation Lines in Surface Model:** When checked, all zero elevations will be ignored.

**Breakpoint Descriptions from Layer:** When checked, this option will store the layer name of the surface entity as the description for the offset-elevation point in the section file.

**Limit of Break Points Per Section:** Specify the maximum number of break points per section. Default value can be set using the *Section Defaults* command.

### Prompts

- **MXS File to Process** Select the section alignment .MXS file
- **Section File to Write** Specify the .SCT file
- **New or Append** Choose whether to create a new .SCT section file, or add to an existing .SCT section file
- **Sections from Surface Model dialog** Make selections
- **Select Lines, PLines, and/or 3DFaces that define the surface.**
- **Select objects:** Pick the surface entities

- **Pulldown Menu Location:** Sections
- **Keyboard Command:** sctsm
- **Prerequisite:** Constructed surface model (.MXS file) to be sampled
- **File Name:** \lsp\sctflap.lsp, \lsp\plinsct.arx

### Sections from Grid or Triangulation Surface

**Function**

This command creates a cross section file (.SCT file) from a surface model that is defined by a 3D rectangular grid file (.GRD file) or a triangulation file (.FLT, .TIN). The grid file can be created in the Civil Design module with the *Make 3D Grid File* routine. The triangulation file can be created with the Write Triangulation File option in the *Triangulate & Contour* command. This command also requires an .MXS file to define the alignment and stations of the sections. The number of section points created is displayed at the end of the routine.

### Prompts

- **Choose Grid or Triangulation File to process** choose existing .GRD, .FLT, or .TIN file
- **Choose MXS File to Process** choose existing .MXS
- **Choose Section file to write** enter new file name
- **Found 1410 section points.**

- **Pulldown Menu Location:** Sections
- **Keyboard Command:** sctgrid
Prerequisite: Grid (.GRD) or triangulation (.FLT or .TIN) file, and a cross sections .MXS alignment file
File Names: \lsp\sctgrid.lsp, \lsp\profedit.arx

Sections from Polylines

This command allows the user to select a polyline that represents a section in cross section view and writes it to a .SCT file. This can be useful for revising sections or for defining a new one. For example, let's say you have extracted sections from a surface model of the existing ground on a site, and have plotted them using the Draw Section File command. Next, the Polyline by Slope Ratio command is used to draw the proposed or final grade sections. Now use this command to send the sections to a Section file and compute the earthworks using the Calculate Sections Volume command. After selecting the command, the Polyline to Section File dialog appears.

The first time this command is selected, the output Section file is set to the same name as the current drawing. Select the Specify Section File Name button to specify a different name. The Station Interval edit box allows you to specify the amount that the default station number will be incremented as the station prompt shown below appears. The Interpolate Zero Offset toggle, if on, causes the program to output the elevation of the zero offset to the output .SCT file. A second and a third section file can be specified to process three sections at a time for each station. This allows you to handle both existing and final grades at once. After selecting the OK button, the prompts below appear.

Prompts

Exit/Pick text/<Station <0.00>>: press Enter
Exit/Pick text/<Starting elevation of grid <100.00>> 440 This supplies the AutoCAD coordinate to translate the grid from.
[int on] Pick point at starting elevation and zero offset of section ([Enter] for none): press Enter
Select station 0.00 1st section polyline: select a polyline
Select station 0.00 2nd section polyline: select another polyline
Exit/Pick text/<Station <0.00>>: E

Pulldown Menu Location: Sections

Chapter 12. Sections Menu 394
Keyboard Command: sctfpl
Prerequisite: Plot the section or profile to write to the .SCT file.
File Name: \lsp\plinsct.lsp, \lsp\plinsct.arx

Sections from Points

This command creates an .SCT file from Carlson points in the drawing. An .MXS file is needed to define the centerline and the stations of the cross sections. The offsets for the cross section points are derived from the perpendicular distance between the centerline and the Carlson points. The cross section elevations come directly from the elevations of the points. In order to be included in a cross section, a Carlson point must be within the offset tolerance distance of the cross section line.

Prompts

Choose MXS File to Process select file
Choose SCT file to Append/Write select file
Enter the maximum offset tolerance <1.0>: press Enter
Ignore Zero Elevations (<Yes>/No)? press Enter This option filters out all Carlson points that have a zero elevation.
Select points along the sections.
Select objects: pick the Carlson points

Carlson points for use in creating Section file

Pulldown Menu Location: Sections
Keyboard Command: scpts
Prerequisite: Carlson points and an .MXS file
File Names: \lsp\sctpoint.lsp, \lsp\profedit.arx
Tablet Calibrate

This command executes the routine to perform calibration of the digitizer tablet to the drawing. There are two methods of calibration: Known Reference Points, and Drawing Scale with New Reference Points, which are explained in detail below. The Calibrate routine must be used prior to using the Digitize Contours command.

Please refer to Configure, General Settings and Digitizer Puck Layout for selection of the correct puck layout before proceeding.

Tablet Calibration

Known Reference Points uses two known coordinates for reference points on the drawing. When this option is selected, the fields for coordinate info activate. Enter the known northing and easting values for the reference points from the info on the drawings in the appropriate fields and press ok. The command line will prompt for the selection of each point from the drawing on the tablet. Furthermore, Carlson saves the coordinates of the two reference points for future calibrations and displays them on the Tablet Calibration Dialog the next time it is accessed, so if you are working in the same drawing, you can use the Known Reference Points method with the saved coordinates to digitize back to your previous coordinates. For greater calibration accuracy, choose two points that are farther apart rather than closer together.

Drawing Scale with New Reference Points is very convenient when you don't know the precise coordinates of the entities on your drawing. The user must specify the drawing scale from your plan, this method can establish a coordinate system relative to the position of the plan on the digitizer board. In addition to the drawing scale, you are required to enter a random coordinate for the first reference point, the default coordinate is (1000,1000). Takeoff would computer the coordinate of the second reference point that you pick based on the first point. The coordinates of these two reference points would be saved and will be display on the Tablet Calibration Dialog next time when you calibrate the tablet, so you can digitize back to the previous coordinates using Known Reference Points method if you are working on the same drawing, though you might have moved or rotated your drawing on the digitize board option allows the user to specify the drawing scale of the plans be digitized and to assign an assumed northing and easting for a base point. When selected, Drawing Scale and Northing and Easting for Point 1 activate. Press ok. The command line will prompt for a pick of the first point.
Tablet Calibration Dialog
Specify the Calibration Methods. If you select Drawing Scale method, enter the drawing scale and the coordinate of the first reference point. Otherwise enter the exact coordinates of the first and second reference points.

Pick first reference point: pick a point
Pick second reference point: pick another point

Pulldown Menu Locations: Contour in Civil Design, Sections in Civil Design, Digitize in Takeoff
Keyboard Command: digsetup
Prerequisite: Affix a drawing to your digitizer tablet. Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Select the puck layout in Configure.

File Name: \lsp\digsetup.lsp

Digitize Sections
This command creates a section file (.sct) by digitizing a section drawing. The command starts with the dialog shown below where you specify the section file name to create. The station interval is used to automatically default to the next station value when digitizing a series of stations. The Interpolate Zero Offset option will interpolate an elevation at the exact zero offset.

After the dialog, the program will prompt to pick three reference points on the section. These points should have known offsets and elevations. Additional sections can be aligned by a single point. Corners on the section grid can be used for these reference points. The reference points and the user-entered offset and elevations for them sets up the program for the section. Now you can start picking the section grade points.

You can also digitize existing and final surfaces back to back, and there is an undo function that will allow undo while digitizing points. As the section is digitized, it is shown in a real-time graphics window. Holding down the right mouse button acts as a zoom function, while holding down the mouse scroll button acts as a pan. The puck keys can be used to enter all the input data.
Prompts

Digitize Section dialog

Calibrate section sheet:
Pick First section sheet reference point: *pick a point on the section grid*
Enter offset <0.0>: -50
Enter elevation: 200
Pick Second section reference point: *pick another point on the section grid*
Enter offset: 50
Enter elevation: 210

Pick Third section reference point:
Enter offset: 50
Enter elevation: 230
Section station to digitize <0.000>: 133.63
Digitize break point for SAMPLE GRID section 133.630 (Enter to end): *pick a point* on the section starting at the left and working right
Digitize break point for SAMPLE GRID section 133.630 (Enter to end): *pick a point* on the section
Digitize break point for SAMPLE GRID section 133.630 (Enter to end): *pick a point* on the section
Save changes to SAMPLE GRID section 133.630 [<Yes>/No]? press Enter
Digitize break point for SAMPLE GRID FINAL section 133.630 (Enter to end): *pick a point* on the section starting at the left and working right
Digitize break point for SAMPLE GRID FINAL section 133.630 (Enter to end): *pick a point* on the section
Digitize break point for SAMPLE GRID FINAL section 133.630 (Enter to end): *pick a point* on the section
Save changes to SAMPLE GRID FINAL section 133.630 [<Yes>/No]? press Enter
Digitize another station [<Yes>/No]? press Enter
Calibrate next section:
Pick section reference point: pick a point on the section grid
Enter offset <50.00>: 0
Enter elevation <200.00>: 200
Section station to digitize <233.630>: 200
Digitize break point for SAMPLE GRID section 200.000 (Enter to end): pick a point on the section
Digitize break point for SAMPLE GRID section 200.000 (Enter to end): pick a point on the section
Save changes to SAMPLE GRID section 200.000 [<Yes>/No]? press Enter
Digitize break point for SAMPLE GRID FINAL section 200.000 (Enter to end): pick a point on the section starting at the left and working right
Digitize break point for SAMPLE GRID FINAL section 200.000 (Enter to end): pick a point on the section
Digitize break point for SAMPLE GRID FINAL section 200.000 (Enter to end): pick a point on the section
Save changes to SAMPLE GRID FINAL section 200.000 [<Yes>/No]? press Enter
Digitize another station [<Yes>/No]? N

Digitize End Areas

This command writes an earthwork (.EW) file that can be used by the Print Earthwork File Report command and print an earthworks and volumes report. It is the users responsibility to record the sections in the proper consecutive sequence. The earthwork (.EW) file written by this command can be edited in any ASCII text editor.

Prompts

Datum elevation <0.0>: 100 Enter the datum elevation that you calibrated the tablet with.
Horizontal Scale <20.0>: press Enter
Vertical Scale <20.0>: 10
Digitize cut area (Enter to end): pick a point Starting at either end of the section, digitize break points of cut area.
Digitize cut area (Enter to end): pick a point
Digitize cut area (Enter to end): pick a point .......
Digitize cut area (Enter to end): press Enter Press Enter to end prompting of break points. The end area is then displayed.
More cut areas (Y/N) <N>: [Enter]
Section Conversions

All Import commands in this submenu are designed to convert other section file formats to the Carlson section (.SCT) file format. The Import Columnar Text has some options to make the program match the import data. This routine can be used for section text files that have station, offset, elevation and optionally description separated by spaces or commas. All the other Import routines read specific formats from other software. The Export commands are designed to convert the Carlson section (.SCT) file format to other section file formats. You will be prompted to specify the file name to convert, then specify a section (.SCT) file name.

Note: The Import/Export LandXML Files routine in the File menu supports section data as well as other survey and civil data types.

Another Note: The Section Report routine can be used to Export section data from Carlson and this command includes an option to use the Report Formatter which allows you to select the fields to export and their order. Plus the Section Report report formatter has functions to export to Excel and databases.

Prompts

Prompts and commands vary for importing and exporting section file data.

Importing:

Import Columnar Text

Type of delimiter [Space]/Comma]? C for comma. Choose the type of separator between fields in the import file.

Section data contains description field [Yes/No]? N for no. This option specifies whether the import file contains descriptions for the section points.

Add description to section data [Yes/No]? Y for yes. This option will assign a specified description to the section points.

Description for section data: TOPO

Import Agtek Reads .ROG and .RDS format section files (ASCII only).

Import Arkansas DOT Imports Level Note File

Import Ceal Reads CEAL section files.

Import GEOPAK Reads .XRS, .XSR, and .TXT format section files (ASCII only).
Import Georgia DOT Reads .END files.
Import IGRDS Reads .LIS, .RDS, and .TXT files.
Import Moss Reads MOSS section files.
Import NC DOT Reads .ORI and .TXT files.
Import Pizer Reads .TXT files.
Import RoadCalc Reads RoadCalc (Eagle Point) sections files.
Import SMI Reads .CUT format section files (ASCII only).
Import Softdesk Reads .SEC format section files (ASCII only).
Import Spanish SC1 Reads ISPOL .SC1 section files.
Import Spanish TRV Reads CLIP .TRV section files.
Import Terramodel Reads .XSC files.

Exporting:
Export GEOPAK Converts Carlson .SCT files to .TXT format.
Export IGRDS Converts Carlson .SCT files to .RDS format. Prompts for section surface type - original ground or final surface.
Export RoadCalc Converts Carlson .SCT files to RoadCalc (Eagle Point) format.

Pull-down Menu Location: Sections > Section Conversion

Keyboard Commands: xsecread, agtek, level, ceal, geopak2sct, gadot2sct, igrds2sct, moss, ncdot2sct, pizer2sct, inroadcalc, smisct, softsct, sc1_to_sct, trv_to_sct, tm2sct, sct2geopak, sc2igrds, outroadcalc

Prerequisite: Sections files; formats vary by command
File Name: \lsp\drawsct.arx

Sections to 3D Polylines

This command creates 3D polylines from a section (.SCT) file. Besides the section file, a centerline polyline, centerline file or section alignment (.MXS) file must be specified to define the plan view location of the 3D polylines. The elevations for the 3D polylines come from the section file. These 3D polylines can then be used by other Carlson routines to create surface models.

Typically, the 3D polylines are drawn as cross-sections perpendicular to the centerline at each station. When using a polyline centerline instead of the .MXS file, there is an option to draw by connecting similar descriptions to make 3D polylines parallel to the centerline. For example, if the section file has descriptions for each section point then you can draw 3D polylines for EP, SHD, TIE, etc.

Prompts

Layer Name for 3D Polylines <3DXSEC>: press Enter
Align sections by MXS file, centerline file or polyline [MXS/Centerline/<Polyline>]? press Enter
Choose Section File to Process Select the .sct file
Range of stations: 1.14 to 1605.25
Enter the starting station to process <1.14>: press Enter
Enter the ending station to process <1605.25>: press Enter
Draw sections or offset polylines by description [Section]/<Offset>? press Enter
Type of centerline [Roadway]/Railroad]? press Enter. This option chooses between roadway and railroad methods for stationing along curves.
Select centerline polyline: pick the polyline
Enter the centerline starting station <0.0>: press Enter
Draw perimeter of sections [Yes]<No]? Y This option will connect all the left most offsets and right most offsets together with a 3D polyline.
Use reference profile to interpolate between sections [<Yes>/No]? N for no. This option will prompt for a profile to use for interpolating elevations along the 3D polylines between the section stations. This improves the accuracy when the profile goes through vertical curves. Without the profile, the 3D polyline elevations will be straightline interpolated between the sections.

Draw all template ids or specific ids and offsets [All/<Specific>]? press Enter for Specific

Enter Offset or Description to draw: EP

Keyboard Command: scto3dp
Prerequisite: A section (.SCT) file
File Name: \lsp\scto3dp.lsp, \lsp\plinsct.arx, \lsp\profedit.arx

Sections to Points

This command creates Carlson points using a section (.SCT) file to define the point elevations. The x,y position of the points are calculated based on the station and offset along a centerline polyline. These points are stored in the current coordinate (.CRD) file and can also be plotted in the drawing. Points can be created at each station in the section file or at a set station interval. The range of stations to process can also be set. The Description Match field can be used to filter the offsets and only create points with matching descriptions (e.g. only "EOP" offsets). The Create points at fixed offsets option can be used to make points at user-specified offset distances. The program will interpolate the elevations for these points by interpolating from the neighboring offsets. The is both a Centerline by Polyline or by CL File option. The CL File option will prompt for an existing centerline (.CL) file. The Reduce Points option will skip creating points for the same offset between stations if the x,y position and elevation change is less than the offset tolerance. Essentially, when a series of offsets are on a straight line (no vertical and no horizontal curve) then only the starting and ending points are needed and all the intermediate points can be skipped. For example, the Reduce Points routine will look at the left side EOP offset points at stations 1+00, 1+05 and 1+10 and if these three points make a straight line then the point for station 1+05 can be reduced. The Offset Distance is the tolerance that Reduce Points using for testing whether the middle point (offset point at station 1+05) can be reduced. The distance for the middle point is calculated as the perpendicular distance from the middle point to the line between the two end points. Both the horizontal and vertical distances are checked.
Prompts

Sections to Points Settings dialog

Coordinate File to Process Choose a .CRD or other coordinate file to add the points to. This prompt only occurs if no coordinate file is current.

Choose SCT file to read *pick the cross section file*

Range of stations: 3.34 to 750.00

Enter the starting station to process <3.34>: press Enter

Enter the ending station to process <750.00>: press Enter

Select centerline polyline: *pick the polyline that defines the stations*

Type of centerline [<ROADWAY>/RAILROAD]? *RO*

Enter the centerline starting station <0.0>: press Enter

Created 65 points.

Keyboard Command: stcopt

Prerequisite: A .sct file and polyline centerline

File Name: \sp\plinsct.lsp

Slope Zone Section Analysis

This command reports the cut/fill areas and volumes within given ranges of slopes. There is an option to use another section for cut/fill reference.

Prompts

Select Section to Process *Select .SCT file*
Select Slope Zone dialog Select No
Report slope or horizontal area [<Horizontal>/Slope]? s
Slope format [<Percent>/Ratio]? Enter
Greatest slope % of zone 1: 3
Greatest slope % of zone 2: Enter
Starting station to process <0.000>: 
Ending station to process <0.000>: 1000
The Standard Report Viewer creates a report called Section Slope Zone Analysis Report.

Keyboard Command: setzone
Prerequisite: .SCT file
File Name: \lsp\regrade.arx

**Draw Pipe 3D Polyline**

This command creates a 3D polyline that represents a pipe. The points can be either picked on screen or specified by point number in the current coordinate file. This command is a convenient way to make 3D polylines that can become "pipe polylines" used for capturing their profile positions, leading to circular or elliptical or even square plots of the pipes or culverts within Draw Profile. However, this command is not required nor sufficient to make a pipe polyline useful in the Draw Profile command. Pipe polylines are made only by converting 3D polylines into pipe polylines using the adjacent command, Assign Pipe Width to Pline.

**Prompts**

Layer Name for 3DPoly <PIPE>: press Enter
Prompt for elevations (.XY filter) (Yes/<No>)? Y for yes
Undo/<Pick point or point numbers>: pick a point
Elevation <0.0>: 554.12
Undo/<Pick point or point numbers>: pick a point
Percent slope/Ratio slope/Elevation <0.0>: 553.72
Undo/Close/<Pick point or point numbers>: press Enter
Draw another 3D polyline (Yes/<No>)? press Enter

Pulldown Menu Location: Sections
Keyboard Command: drwpipe
Prerequisite: None
File Name: \lsp\3dpline.lsp

**Assign Pipe Width to Polyline**

This command is described in the Profiles Menu section of Help, under Profile Utilities.

---

_Chapter 12. Sections Menu_
Extend Sections to Offset Limits

This command extends the offsets to the left and right limits for each station in a section file. The left and right offset limits are defined in the section alignment (.MXS) file. The elevations for the extended offsets can be extrapolated from the last slope from the existing offsets or the elevations can be carried flat from the last offset elevation. For example, consider section station with a left most offset of -192.5 and a right most offset of 197.3. If the MXS file had offset limits of 200 for left and right, then this routine would assign offsets with elevations at offsets -200 and 200. The resulting section file can be saved to a separate section (.SCT) file or overwrite the original SCT file.

Prompts

Select Section Alignment File select .MXS file
Section File to Read select .SCT file
Extend last slope or use last elevation [<Slope>/Flat]? press Enter
Choose SCT file to Write specify new .SCT file name

Pulldown Menu Location: Sections > Section Utilities
Keyboard Command: extendsct
Prerequisite: .SCT file and .MXS file
File Name: \lsp\regrade.arx

Overlay Section File

This command will create a section file at given cross slopes and minimum overlay from a reference section file. An existing and a proposed .SCT file must be selected, along with additional section information. A choice between Overlay Value or Proposed Elevation must be made. When the Overlay Value option is chosen, a Minimum Amount of Overlay must be entered. When the Proposed Elevation option is chosen, a Proposed Centerline Elevation value must be entered.
Prompts

Overlay Section Data dialog Select file names and options, click OK
Report viewer creates a proposed section file report.

Pulldown Menu Location: Sections > Section Utilities
Keyboard Command: sct_overlay
Prerequisite: A .SCT file
File Name: \lsp\regrade.arx

Average Section Files

This command will average a section file for a given station range. A source file to process must be selected to get things started. A starting station to average and a last station to average must then be entered. A new .SCT file will be created as a result.

Prompts

Select Source Section File to Process Select a SCT file.
Starting station to average <0.000>: press Enter
Last station to average <1614.160>: press Enter
Section File to Write Select a SCT file name and folder.

Pulldown Menu Location: Sections, Section Utilities >
Keyboard Command: avgsct
Prerequisite: A .SCT file
File Name: \lsp\regrade.arx
**Merge Sections**

This command combines a range of stations of one section and a range of stations of a second section. The stations, offsets and elevations in these two ranges can be stored in a new file or they can overwrite an existing profile. Two .SCT files are required.

**Prompts**

- **First Section File to Merge**: select an existing .SCT section file
- **Starting station to merge** <0.000>: press Enter
- **Last station to merge** <1614.160>: press Enter
- **Second Section File**: select another existing .SCT file
- **Starting station to merge** <0.000>: press Enter
- **Last station to merge** <1310.050>: press Enter
- **Section File to Write**: Enter a new .SCT file name and choose folder

**Update Sections from Polylines**

This command is used to update section (.SCT) files from manual changes made to polylines originally created by Draw Section.

**Prompts**

**Pulldown Menu Location**: Sections > Section Utilities
**Keyboard Command**: update_sct_from_dwg
**Prerequisite**: Drawn Sections
**File Name**:

**Section ID**

This command is used to pick a section drawing entity and then report the source section file name.

**Prompts**

**Select section entity to identify**: select entity

**Pulldown Menu Location**: Sections > Section Utilities
**Keyboard Command**: sctid
**Prerequisite**: A .SCT file
**File Name**: lsp\sctpro1.lsp

**Sections Points from Surface Entities**

This command creates a section .SCT file in a similar way as *Sections from Surface Entities*. The difference is that these section points are not connected by a polyline as a surface in *Draw Section File*. Instead, a point symbol is drawn for each offset-elevation point. First this command prompts for the symbol to use. Next the program asks for
the section alignment (.MXS) file to use, then the section (.SCT) file to make or append. Then you select polylines to create the section points from. The intersections of these polylines with the cross sections are calculated and the resulting station-offset-elevations are stored in the section file. The description field for these section points identify them as individual points instead of a surface. The description starts with POINT- followed by the symbol name (e.g. POINT-SPT5).

Prompts

Select Symbol dialog
MXS File to Process Select an existing section alignment .MXS file
Section File to Write dialog
New or Append Choose between creating a new .SCT file or add to an existing section file
Select surface polylines.
Select objects: pick the polylines
Added 21 points to section file.
Writing section file > C:\scad2006\data\horn.sct

Pulldown Menu Location: Sections > Points on Section
Keyboard Command: sctpts2
Prerequisite: Surface polylines and an MXS file
File Names: \lsp\regrade.arx, \lsp\sctrow.lsp

Sections Points from Right of Way

This command is the same as Sections Points from Surface Entities except that the symbol for the right of way is automatically drawn as a downward pointing arrow. The description field for these section points identify them as right of way points. The description is POINT-ROW. A new .SCT file is created or an existing one appended to.

Prompts

MXS File to Process Select a section alignment file
Section File to Write dialog
New or Append Choose between creating a new .SCT file or add to an existing file.
Select right of way polylines.
Select objects: pick the polylines
Added 21 right of way points to section file.
Writing section file > C:\scad2006\data\horn.sct

Pulldown Menu Location: Sections > Points on Section
Keyboard Command: sctrow
Prerequisite: Right of way polylines and an MXS file
File Names: \lsp\regrade.arx, \lsp\sctrow.lsp

Sections Points from Pipes

This command is the same as Section Points from Surface Entities, except that the symbols for the pipes are automatically drawn as a circles with a radius set to the pipe width. The profile equivalent of this command is Profile from Pipe Polylines. When Draw Section File has vertical exaggeration, the pipe is drawn as an ellipse. The description field for these section points identify them as pipe points. The description is POINT-PIPE followed by the pipe size.
in feet (e.g. POINT-PIPE-1.500). The pipe polylines used to derive the pipe section points can be created with the
Draw Pipe 3D Polyline and Assign Pipe Width to Pline commands in the Sections->Section Utilities menu. Also,
the position of the pipe polylines on the pipe can be selected. The choices are Top, Center and Bottom.

Prompts

MXS File to Process Select a section alignment file
Section File to Write
New or Append Choose between creating a new .SCT file or add to an existing file.
Select pipe polylines.
Select objects: pick the polylines
Position of pipe polylines on pipe [Top/Center/<Bottom>]? Enter
Added 46 pipe points to section file.
Writing section file > C:\scad2006\data\pipe.sct

Pulldown Menu Location: Sections > Points on Section
Keyboard Command: sctpipe
Prerequisite: Right of way polylines and an .MXS file
File Names: \lsp\regrade.arx, \lsp\sctrow.lsp

Input-Edit Section File

Function

This program can be used to enter or edit data stored in a section file (.SCT file), including a real-time graphic
window in the Edit mode. The section data consists of stations, offsets, elevations and descriptions. This command
also has utilities for translating the offsets and elevations, deleting stations from the file, intersecting the outslopes
of one section file with another, combining multiple occurrences of the same station and sorting the stations, offsets
and elevations. While editing the section file, a second section file can be used as reference. To choose this file, pick
the 2nd button. For example, when editing the proposed section file, you can reference and view the ground section
file as the 2nd file.

The program begins by prompting for a New or Existing section .SCT file to process. The Section file to process
dialog appears, allowing you to specify the file that you want to operate on. Use the New option to create a new
file. Use the Existing option to edit the offsets and elevations for station/sections that you have already created,
or append new stations to a file. The program defaults to a section file with the same name as the drawing or a
name that you specified using another section command. You also can choose a 2nd existing .SCT file to reference.
After specifying the file name(s), the program displays any stations currently in the file, in the Stations List of the
Input-Edit Section File dialog box.

Alternately, when sections are drawn in the drawing, you can double-click on a section polyline to launch Input-Edit
Section File for the .SCT file associated with the section polyline.

If you specified a new file, the Stations List box will be blank. To edit and display the offset and elevation data at a
station, you can double click on the station in the Stations List box, or input the station in the Station to Edit edit box
at the bottom of the dialog. To add a station to a new file or existing file, you must enter the station in the Station to
Edit edit box. Stations will present in accordance with the Section-Profile settings in Configure under the Settings
pulldown menu (eg. 10+00, 1+000, 1000).
Edit: Opens the Edit Station dialog which shows a graphic of the section on top, a list of the offset-elevation points in the middle, and the function buttons on the bottom. To add an offset point, type in the offset, elevation and optional description in the spreadsheet. Left offsets are entered as negative numbers. You can enter the slope or ratio from the last point and the program will calculate the elevation. To edit an offset point, highlight the point from the list and then edit the values in the Offset, Elev and Desc columns. The highlighted point will be marked by an X in the graphic screen. The Sort button will sort the list of offsets from lowest to highest, left to right. It is recommended that you Sort offsets before doing the Tie command, so that the left-most and right-most offsets appear first and last in the offset list. The Up button will move the highlighted offset point up in the list. Likewise the Down button moves the highlighted offset point down in the list. Prev (F2) and Next (F3) buttons move through the stations and allow you to review and edit stations in forward or reverse order. The scroll bar can also be used to quickly move through stations and then zero in with Prev (F2) or Next (F3).
The Add Row button inserts an offset line above the currently highlighted row. The Remove Row button erases the highlighted offset and elevation from the list. After inputting or editing press the OK button to return to the Stations List dialog and keep any changes you have made. Select the Cancel button if you want to cancel changes made to the current station. Extend Pavement/Subgrade will allow you move a surface point and shift, in parallel, the associated subgrades and tie points. One application, shown below, is to extend a shoulder point and re-compute the TIE point, all in one clean operation:

Another application of Extend Pavement/Subgrade is to move the curb position and all associated subgrades. The "inside" curb point is at 12.00 units from centerline. If the pavement is extended from 12 to 15 at this station, use of this feature will extend the subgrades, maintain all slopes and re-compute the TIE point, as shown below:
A real-time report of offset-elevation-slope now displays in the top of the graphic as you move the cursor across the section in the graphic window. The screen defaults to zoom mode where holding down the right-mouse button zooms in and out. You can also switch to pan mode. There are buttons for zoom extents, zoom in and zoom out. If your mouse has a scroll button, you can hold it down to pan and scroll it to zoom in and out. You can also set the Vertical Exaggeration ranging from 1X to 10X and including "Fit". Show subgrades has the ability to tie a subgrade into the surface. Grid Ticks Only just shows the left and bottom axis lines of the grid with grid tick marks along the axes. With Auto Zoom All turned off, you can hold the same view position as you click Next and Previous and move through the list of stations. The Check Offset field calculates an elevation based on an entered offset.

Drive (Edit Station): This function scrolls through the sections at the rate of speed specified by the user in the Speed window. The Drive View options determine whether the sections are displayed using the full width of the graphic window or centered in the window. The combination of Full Grid Range and Auto Zoom All allows the sections to rise and fall with the centerline elevations, as if you were driving an actual road. With Auto Zoom All off, and Full Grid Range on, the grid itself moves up and down at the current position of the first section, as you drive. Focus View On Offset Range allows the user to set the left and right viewing limits of the sections. Section data beyond the specified limits is not displayed.
Elevation Field (Edit Station): Equations (+, -, *, /) can be entered to calculate or adjust an elevation. For instance, to subtract 1.25' from elevation 1926.18, simply enter 1926.18-1.25 and press enter. The new elevation will be calculated and displayed in the viewer window.

Tie (Edit Station): The Tie button allows you to tie the left and right surface points of the 1st section file into the 2nd section file. It is used for classic outslope intersects from final grade to existing grade. The dialog layout includes an option to tie the section to a specified elevation, in addition to a surface (second section file). A left or right tie direction can also be selected. If a point has been tied in from SH for shoulder at offset -20 at 3:1, a new offset with the description "TIE" is created. If you try another outslope such as 4:1 from the same SH shoulder point, a new "TIE" point is created and the old TIE point is removed automatically.

Translate: Allows you to add or subtract a distance from the offsets to adjust or shift the centerline. You can also adjust the elevations up or down. When using this option, you can choose the range of stations to operate on (starting and ending stations) and the values to adjust the offsets and elevations. If, for example, you want to shift the centerline, but not the elevations, enter the plus or minus amount you want to translate, and when prompted for...
the elevation enter zero.

**Scale:** Allows you to scale the station, offsets and/or elevations by the specified scale factor. This function can be used to convert between English and metric units.

**Delete Stations:** Allows you to remove a station or range of stations from the in memory Stations List. Click "Delete Range of Stations" on to delete a range, a click it off to delete an individual station. Since the station editor data is stored in virtual memory, if you accidentally delete a range, Quit the editor with out saving the stations to disk. Then recall the original file.

**Reduce:** Allows you to remove offsets from a range of stations by removing vertices in the offsets that are virtually in a straight line. Using an offset cutoff, meaning no offset and elevation moves more than the entered amount (e.g. 0.01), excessive numbers of vertices can be eliminated. The command is similar to Reduce Vertices when applied to the plan view.
**Sort:** Allows you to sort the station numbers into ascending order, and sort the offsets and elevations in the individual station records (offsets are sorted from left to right). When sections are derived from the *Sections from Surface Entities* command they are already sorted, but when sections are digitized or input manually they occur in the order that you digitized them. So, for proper plotting and earthworks, you may want to run the Sort option before processing.

**Combine Stations:** Used to bring together in one record slot multiple occurrences of the same station number. This can occur when using the Digitize Sections (XSec) command and the section that you are digitizing has match/break lines which forces you to digitize the station in two or more parts.

**Interpolate:** Allows you to add or overwrite a station between two stations or projecting forward from two stations. You can choose to interpolate a single station or an interval of stations. Specify the two known stations in the Start Station and End Station edit boxes, as well as the interval if using the interval method. The program will do straight line, mathematical interpolations, adding offsets to the interpolated stations to match the totality of offsets in the starting and ending stations. However, if the offsets have descriptions, you can choose to interpolate by description and the program will interpolate by description (eg. EP at 12 on Station 1100 and EP at 15 at station 1150 would lead to EP at 12.6 at 1110). There is also an option to reference a profile, so if station 1100 and 1150 were on either side of a high point at 1125, the interpolated offsets would respect the profile as well as the starting and ending station. Use of this command is often critical to creating accurate digital terrain models of sites for machine control. Select the OK button to execute the function with the current settings or select the Cancel button to abort the process.
Copy Station: Allows you to copy a station that already exists to a new or existing station number. Choose the existing From Station using the edit pulldown box, then enter the new station number in the To Station edit box. Select the OK button to execute the function with the current settings, or select the Cancel button to abort the process.

Tie Station: Allows you to tie the outslopes into the reference second section file. This routine first brings up a dialog to specify the range of stations to process. It includes a line to set the slope to tie with. The program will start from the left most offset and use this slope to find the intersection with the reference section file. Then the intersection from the right most offset is calculated with this slope. These intersection points are the tie points. The slope can be defined by percent, ratio, continue the last slope, and vertical.

Save: Saves the currently loaded section file.

SaveAs: Allows you to save the currently loaded section file as a different file.

Exit: Allows you to exit from the section editor and return to the drawing editor. The program will warn you to save to a file if you have made changes.

Keyboard Command: scted

Prerequisite: None

File Name: \lsp\regrade.arx
Draw Section File

This command will plot the section data from up to six section (.SCT) files at once. The section file can be created by several methods including Input-Edit Section File, Sections from Surface Entities, Digitize Sections or Process Road Design command. A range of sections can be plotted in a vertical stack, on section sheets, or by selecting a point that corresponds to the grid bottom elevation.

When drawing sheets format in metric mode, be sure to set metric On (clicked) in the Drawing Setup command. Then in the Sheet Parameters dialog, set the Block Name to SCTSHT2 and set your metric sizes.

In the initial dialog, specify up to six section (.SCT) files to plot, the layer for each, and the layer names and text styles for the overall grid text, grid lines, and subgrade. There is also a toggle to Prefix Layer Names with Section Name, so that all layers created for the sections begin with the section name. At the bottom of the dialog is a button to Load Settings, loading a set of previously saved settings, and buttons to set the Colors and Linetypes for the section components.
The second dialog box presents the next level of settings for the generation of sections.

**Horizontal Scale:** Specify the horizontal scale.

**Vertical Scale:** Specify the vertical scale.

**Link Sections To Files:** This setting controls the linkage of the plotted sections to the actual section file(s) (.SCT), determining how changes to the file affect the plotted sections. If set to Off, there is no linkage, Prompt will ask whether to update the plotted sections when the file changes, and Auto will automatically update the plotted sections when the file changes.

**Type of Plot:** Specify how the sections will be plotted, either as a Vertical Stack, Pick Location, selecting the datum point of each section, or Sheets, which will plot the sections on a block section sheet.

**Fit Each Vertical Grid:** When checked, the grid bottom elevation and grid height are set automatically, and you may specify values to add to the top and bottom of each grid. See Vertical Grid Adder to Top and Vertical Grid Adder to Bottom. When not checked, the Vertical Grid Adder to Top and Vertical Grid Adder to Bottom options change to Grid Bottom Elevation and Grid Vertical Height.

**Scan File to Set Defaults:** This button allows the program to set the minimum and maximum parameters. If you choose this option the program will automatically set the range of stations, vertical spacing distance, right and left grid distances and starting/datum elevation. This option writes a file called "sectsort.tmp" that is read and used to set the defaults the next time you use the program. Therefore, if you are selecting a different .SCT file to plot you should use this option to update the .TMP file.

**Range of Stations to Draw:** Specify the range of stations from the file which will be drawn.

**Interval of Stations to Draw:** Specify the interval of stations to draw. For example, perhaps you sampled every 25 feet with the Sections from Surface Model command for more accurate quantities but only want to plot 50 foot stations. ALL is the default value for this field.

**Vertical Grid Adder to Top:** Specify the distance that will be added to the highest elevation of the section for the sheets and pick location options. Only available when Fit Each Vertical Grid is checked ON.

**Vertical Grid Adder to Bottom:** Specify the distance that will be subtracted from the lowest elevation of the section for the sheets and pick location options. Only available when Fit Each Vertical Grid is checked ON.

**Grid Bottom Elevation:** Specify actual bottom elevation for each section grid. Only available when Fit Each
Vertical Grid is checked OFF.

**Vertical Grid Height**: Specify actual grid height for each section grid. Only available when Fit Each Vertical Grid is checked OFF.

**Vertical Space Between Grids**: Specify the distance the sections are stacked above the last one plotted when drawing multiple sections.

**Maximum Sections Per Column**: Sets the maximum number of sections allowed per column.

**Label Elevation at Zero Offset**: Will label the section elevation at offset zero. The label is drawn on the section grid just above the section line. Press the Set button to the right of this toggle to set the display precision, text size scaler and layer for these labels. There is also an option to draw the elevation on a 45 degree diagonal, otherwise the elevation label is draw vertically.

```
Elevation At Zero Offset

Decimals For 1st Section File: 0.00
Decimals For 2nd Section File: 0.00
Text Size Scaler: 0.080
Layer: GRIDTEXT
Style: STANDARD
Color: ByLayer
Label on Diagonal Leader
[ ] Draw Section 1 [x] Draw Section 2
[ ] Draw Section 3 [ ] Draw Section 4
[ ] Draw Section 5 [ ] Draw Section 6
```

**Label Break Pt Offsets**: Will label these values along the section line above each point in the section. Press the Set button to the right of this toggle to set the display precision, text size scaler and layer for these labels.
**Label Break Pt Elevations:** Will label these values along the section line above each point in the section. Press the Set button to the right of this toggle to set the display precision, text size scaler and layer for these labels.

**Label Break Pt Descriptions:** Will label these values along the section line above each point in the section. Press the Set button to the right of this toggle to set the text size scaler, layer, and description match for these labels.
**Label Slopes**: Will draw in the slopes.

**Label End Areas**: Will label cut and fill quantities on each section.  
**Use Table**: Puts end areas cut/fill values in table.
Grid Line/Text Drawing Controls

**Plot Grid:** Uncheck this toggle if you do not want the grid to plot.

**Text Only:** Check this toggle if you only want to plot the cross section polyline and the grid text. This can be useful for plotting on a section sheet that has pre-plotted grid lines and you want to plot only the section and text.

**Circle Stations:** Will draw the station number with a circle around it on the left and right sides of the section grid.

**Label Scale:** Will label the horizontal and vertical scale on each section.

**Left Grid Offset Limit:** Specify the length the grid lines are plotted to the left from the centerline or zero offset.

**Right Grid Offset Limit:** Specify the length the grid lines are plotted to the right from the centerline or zero offset.

**Station Text Size Scaler:** Specify the text size scaler for the station text. This value is multiplied by the horizontal scale to obtain the final text height. For example, if you set Station Text Size to 0.10 and the horizontal scale is 100.0, then the text height will be (0.10 X 100) or 10.0.

**Grid Text Size Scaler:** Specify the text size scaler for the axis text. This value is multiplied by the horizontal scale to obtain the final text height. For example, if you set Axis Text Size to 0.08 and the horizontal scale is 50.0, then the text height will be (0.08 X 50) or 4.0.

**Horiz Grid Spacing:** Specify the distance the vertical lines of the grid will be spaced.

**Horiz Text Spacing:** Specify the interval that text will be plotted below the grid lines.

**Vert Grid Spacing:** Specify the distance the horizontal lines of the grid will be spaced.

**Vert Text Spacing:** Specify the interval that text will be plotted to the left and right of the grid lines.

Select the OK button at the bottom of the dialog to begin plotting. For the Vertical Stack and Pick Location options, you are prompted to specify a starting point for the sections. If Sheet option was selected, another dialog appears to specify all the settings for sheet plotting, see details below.

**Prompts**

*Select Starting Point for Row of Sections* pick a point
The Pick Location type of plotting has the following prompts:

**Station > 4000.000 Min Elev > 462.849 Max Elev > 472.091**  
Change datum elev/<Select point that represents 0 offset elev 460.0>: C

Starting-Datum Elevation: 450

The program scans the station data and determines the minimum and maximum elevations, and proposes a datum elevation. If you have pre-plotted a grid sheet and want to reference another local grid coordinate, then change the datum elevation appropriately.

**Change datum elev/<Select point that represents 0 offset elev 460.0>: pick a point**

**Station > 4025.000 Min Elev > 463.332 Max Elev > 472.385**  
Change datum elev/<Select point that represents 0 offset elev 460.0>: pick a point

The program continues to prompt until the last station in the range specified is drawn. You can use the Cancel function ([Ctrl] + [C]) to stop plotting, if necessary. If you chose the Vertical Stack option you will be prompted for the starting point for the row of sections. If you selected the Sheets option, and press the OK button, the Section File Sheet Drafting Parameters dialog appears, allowing you to set up how you want the section sheets plotted.

Sheet Parameters

**Block Name:** Specify the AutoCAD drawing name that will be inserted for each sheet. The default is SCTSHT1 which is included with Carlson 2008, and is stored in the \SUP directory. You can use this or use a sheet block of your own design. The block should be drawn at a 1 = 1 scale since the program inserts it at the horizontal scale setting from the previous dialog.

**Distance Between:** Controls the distance from the bottom of one sheet and the bottom of the next.

Rows of Sections

**Per Sheet:** Controls how many sections will be stacked on top of each other on a sheet.  
**Distance Between:** Controls how much space will be placed between the top of the last section plotted and the
bottom of the next section. The distance between and other values in this dialog are in AutoCAD units. In our above example we are set to 20 horizontal scale so 20 would equal 1 inch when plotted. It is recommended that you set the horizontal and vertical scales in the previous dialog before accessing the sheet parameters dialog so that reasonable defaults will be set automatically.

Columns of Sections
**Per Sheet:** Controls how many rows of sections will be plotted on each sheet.
**Distance Between:** Controls the distance that the rows of section will have between the centerline of the one section row and the next centerline of rows. This edit box can only be accessed if you have a number of columns greater than one. For example, if you want 15 inches between the columns, specify 300 (15 x 20).

1st Section Offset from
**Lower Left of Sheet to CL:** X and Y edit boxes allows you to specify where the first section of the first row will be placed relative to the lower left of the section sheet. In our example we specified 160 (8 inches at 20 scale) and 15 (1.5 inches at 20 scale). The Block SCTSHT1 has a half inch border before the 1st grid line and we want to plot starting at the second grid line, which is another inch from the bottom of the sheet. We want the centerline of the first section to be slightly left of the center of the sheet which is 33.5 inches wide so we specify 15 inches (300 at 20 scale).

**Previous:** This button allows you to return focus to the main dialog and make changes to settings or cancel the program. One thing to remember when plotting sheets with grid lines on them is to switch on the Text Only toggle on so you don't get duplicate grid lines.

**Label Grid Zero Offset:**
**Save Settings:** This button allows you to save all the parameters settings to a file so you can easily recall them for another project.
**Load Settings:** This button allows you to recall the settings saved with the option explained above.

When you select the Layers button this dialog appears allowing you to specify the layer that the files are plotted on. If you are specifying a new layer to create, type the name into the edit box. If you want to select a layer that already exists from the layer list, then click on the Select... button to the right of the edit box. When you select the OK button the program prompts for the starting point for the row of sheets. The default is coordinate 0, 0 though you can select any point you like. With the settings shown in the example dialogs the sections would be plotted as shown below.

**Drawing Metric Section Sheets**
First, be sure that you are set to metric mode in *Drawing Setup* under the Settings menu. Then set the scales and spacing as shown in the dialog below. This example is 1:1000 scale. When the first dialog is set, click OK to reach the second dialog. There is a different block name for metric sections called schsht2.dwg. This file is located in the Carlson 2008 SUP directory. Choose the parameters for the second dialog as shown. In this case the sheets will have two rows and two columns of sections.
Drawing Setup dialog with metric 1m=?m setting from Settings menu
First dialog with metric settings

Second dialog with metric settings

Keyboard Command: drawsct
Prerequisite: An .SCT file
File Names: \lsp\drawset.lsp, \lsp\scadprof.dcl, \lsp\drawsct.arx
Section Report

This command generates a report of a section file for the specified stations. The information contained in the report is determined by the settings in the Section Report Options dialog box.

Decimal Places: Specify the display precision for stations and elevations.

Use Row-Column Report Layout: When checked, offsets are reported in columns. Example reports showing the difference are shown below.

Use Report Formatter: Report output is directed to the Report Formatter which allows for custom reports, as well as being able to export the report to Microsoft Excel or Access.

Report Descriptions: Controls whether the descriptions for each section point are reported.

Specify User-Entered Offsets To Report: After choosing OK from this dialog, the program will prompt for additional offsets to report with interpolated elevations. These are for offsets that don't already exist as section points in the section file.

Report Slopes: Will report the slope between section points. Specify how to report the slopes, either none, percent, ratio, or auto format. Auto format means that slopes less than 10% are reported in percent, while greater slopes are reported as ratios.

Stations to Report: Specify either a range and interval of stations to report or enter each station one at a time.

Grades to Report: This applies to section files that contain subgrades. For these section files, you can...
choose which grades to report (top surface or subgrades). All is also an option.

**Description Match:** This field can be used to filter the section points by their description.

**Report Elevation Difference:** Reports section elevations by Reference Grade Point, Section File or choose none.

**Reference Grade Point:** Specify the reference grade ID. Only available if Grade Point option is selected, as mentioned above.

**Select Reference Section File:** Specify a reference file. Only available if Section File is chosen, as mentioned above.

**Elevation Difference at Offset Interval:** Used if there is an elevation difference. The next three options only available if Elevation Difference at Offset Interval is clicked.

**Offset Interval:** Value required.

**Left Limit/Right Limit:** Values required.

**Prompts**

*Section Report Options dialog* choose options
*Section File to Report dialog* choose existing file
*Starting station for report* $<0.000>$: press Enter
*Ending station for report* $<1147.478>$: press Enter
*Station interval (A for All)* $<100.0>$: press Enter
Sample Report

Keyboard Command: sctrprt
Prerequisite: A section file (.sct)
File Names: \lsp\sctrprt.lsp, \lsp\profedit.arx, \lsp\scadewrk.dcl

Offset & Elevation Label/Report

This command calculates the offset and elevation at points along a polyline on a section grid. The results can be drawn on the grid or just displayed on the text screen. The offset and elevation are either calculated for each vertex of the polyline or at user specified points. This command can also be used as a section inspector. As you move the cursor across the section, the offset, elevation and slope are reported in real-time in a pop-up window.

The Prompt for snap toggle controls whether the command will present the snap dialog as you pick points to figure the offset and elevation at. The Grid Starting Elevation edit box allows you to input the beginning elevation of the local grid that you are designing in. Use the Scale edit boxes to set the proper horizontal and vertical scales for your design environment. The Label each vertex of grade polyline option will draw the offset-elevation label above each point in the selected polyline.
Prompts

Section Offset-Elevation Settings dialog Choose the scales and base elevation that match your section grid.
Pick center grid point [int on]: Pick the grid point at the zero offset and base elevation. The intersection osnap mode is on.
Pick grade polyline: select polyline
Pick vertical alignment for text: pick point above the polyline

Offset & elevation at each polyline vertex

Pulldown Menu Location: Sections
Keyboard Command: offelev
Prerequisite: Must plot the polyline that represents the grade
File Names: \lsp\sct_elev.lsp, \lsp\regrade.dcl

Calculate Section Volumes

This command will read two section files and compute the cut and fill end areas and volumes. It computes the sections volume in the order they appear in the file. If you need to sort the stations in sequential order use the Input-Edit Section File command. Begin by selecting the base section file then the final section file. After specifying
the input files the Calculate Section Volumes dialog appears. The settings can then chosen and customized to match your reporting needs. There is an option to apply topsoil removal/replacement adjustments, as well as support for processing sections with subgrades.

**Range of Stations to Process:** Specify the range of stations to process. Separate stations with a hyphen as shown.

**Cut/Fill Starting/Ending Sta.:** Volumes are calculated using end areas between the range of stations. Instead of cutting off the volumes exactly at this range, the Ending and Starting Stations for Cut and Fill can be used to have the volume taper from zero at the specified Starting Station to the volume at the first station in the range. Likewise, the Ending Stations can be used to taper the volume from the last station in the range to zero at the specified Ending Station.

**Fill Shrink/Cut Swell Factor:** Allows you to specify a value that the volume calculated will be multiplied by.

**Report Precision:** Specify the display precision for the report.

**Calculate Centroids Using Centerline:** When checked, the program will calculate the centroids using a centerline (.CL) file. you will be prompted to select the centerline file.

**Report Centroids:** Specify whether or not to report centroids.

**Use Rock Section for Rock Volumes:** When checked, you will be prompted to select a third section (.SCT) file that will be used to calculate rock quantities.

**Report Cut/Fill Text:** Specify whether or not to report cut/fill text.

**Extend Shorter Sections to Longer:** If checked, shorter sections are lengthened to the same left and right offset extents as the corresponding longer sections.

**Interpolate Missing Section Stations:** If checked, the missing stations are accounted for in the calculations.

**Select Topsoil Adjustment File:** Specify an optional profile (.PRO) file for haul data output.

**Select Mass Diagram Output File:** Specify an optional profile (.PRO) file for haul data output.

**Prompts**

Section File (Existing Ground) to Read choose existing .SCT file
Section File (Final Ground) to Read choose the other existing .SCT file
Calculate Sections Volume dialog Make selections.
Keyboard Command: calcsct
Prerequisite: Two section (.SCT) files
File Names: \lsp\calcsct.lsp, \lsp\scadewrk.dcl, \lsp\eworks.arx

Calculate End Area

This command allows the user to select two polylines representing an existing grade section and a final grade section, and calculate the end area. Or you can also specify and define cut/fill end areas by picking interior points. The area calculated can be drawn at a user specified point. Optionally, the command writes the stations cut and fill to an earthwork (.EW) file that can be printed/displayed by the Print Earthwork File Report command. This command starts with the Calculate End Area dialog.

![Calculate End Area Dialog]

**Horizontal Scale:** Specify the horizontal scale of the existing cross section.
**Vertical Scale:** Specify the vertical scale of the existing cross section.
**Text Scale:** Specify the text size scaler, this value is multiplied by the horizontal scale to determine the final text height.
**Station Interval:** Only available if Write Results to EW File is toggled on. Allows you to specify the station interval that the station prompting will default to as you select the polyline/sections for computation.
**Extend Shorter Ends to Longer:** Click or leave blank.
**Write Results to EW File:** When checked, the results will be written to an earthwork (.EW) file. You may create a new file or choose to append/revise an existing file.

**Prompts**

**Calculate End Area dialog** make choices
**Specify Earthworks File (ew) dialog** specify new or existing file This box appears if Write Results to EW File is clicked.
Select existing grade polyline (ENTER to end): select polyline
Select final grade polyline: select polyline
Calculating End Area...
Cut: 12002.965 Fill: 660.272
Pick Point for Label (Enter for none): pick point
Enter the station <0.00> press Enter Pressing Enter selects the default station 0+00. If the station does not exist in the file it will be added. If it does it will be revised.

Select existing polyline: press Enter
Continue moving along automatically to the next station interval and select polylines. Or enter the station values randomly. The command sorts the .EW file regardless. As a result of this sort feature, the user can select stations in any order and they will be arranged in ascending order for proper volume computation.

Keyboard Command: endarea
Prerequisite: Plot the existing grade and final grade polyline/section
File Names: \lsp\parea.lsp, \lsp\scadprof.dcl, \lsp\profedit.arx

Input-Edit End Area File

This command allows you to enter in Stations, Cut (SF), Fill (SF) data to calculate a project’s Mass Haul (CF).

You can set the Station Interval and Delete or Insert a Row at your discretion. The Report button will show you the
Cut/Fill at each station as well as the Total Cut/Fill.

Make Mass Haul Diagram

Use the Make Mass Haul Diagram to create a .pro file of your data. Then run the command Report Profile to create a report of your mass haul data or run Draw Profile to create a diagram like the one below.

Prerequisite: End Area Data
Keyboard Command: ewedit

Print EW File Report

This command is used to display/print an earthworks (.EW) file. This file can be generated by several commands such as Calculate End Area or Digitize End Areas. A standard file selection dialog prompts you for the .EW file, then the volumes report is displayed in the Standard Report Viewer.

Prompts

Earthworks File (ew) dialog select existing file
Standard Report Viewer screen appears with volumes.

Volumes From File main.ew

<table>
<thead>
<tr>
<th>Station</th>
<th>Fill(sf)</th>
<th>Cut(sf)</th>
<th>Interval</th>
<th>Fill(cy)</th>
<th>Cut(cy)</th>
</tr>
</thead>
<tbody>
<tr>
<td>34+00.00</td>
<td>0.0000</td>
<td>24.7082</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
</tr>
<tr>
<td>35+00.00</td>
<td>0.0000</td>
<td>75.0246</td>
<td>100.0000</td>
<td>0.0000</td>
<td>184.6904</td>
</tr>
<tr>
<td>36+00.00</td>
<td>0.0000</td>
<td>29.1810</td>
<td>100.0000</td>
<td>0.0000</td>
<td>192.9733</td>
</tr>
<tr>
<td>37+00.00</td>
<td>0.3867</td>
<td>2.4916</td>
<td>100.0000</td>
<td>0.7161</td>
<td>56.8011</td>
</tr>
<tr>
<td>38+00.00</td>
<td>31.1798</td>
<td>0.0000</td>
<td>100.0000</td>
<td>58.4565</td>
<td>2.7622</td>
</tr>
<tr>
<td>39+00.00</td>
<td>57.6465</td>
<td>0.0000</td>
<td>100.0000</td>
<td>164.4931</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

Total FILL from Station 34+00.00 to 39+00.00 = 223.6657 (cy)
Total CUT from Station 34+00.00 to 39+00.00 = 437.2270 (cy)

S

Keyboard Command: ewreport
Prerequisite: .EW file
File Names: \lsp\eworks.arx
Roads Menu

The Centerline menu provides commands for designing and editing centerlines and centerline files. Tools for stationing, labeling and offsetting centerlines, along with Right of Way features, are also provided in this menu. Additionally, there are many import and export conversion options to select from when you pick Centerline Conversion.
Design Centerline

This command draws a centerline polyline and writes the centerline data in a centerline file. The first step is to specify a centerline (.CL) file name. Next in the Design Centerline dialog you can specify several options. Centerline Layer is the layer name for the polyline. Tangents Layer is the layer name for the tangent lines drawn from the centerline to the curve center. Max superelevation is used for determining the minimum recommended radius. Setting the Prompting mode to Existing skips design questions such as design speed.

After the Design Centerline dialog, the program cycles through curve prompting until End is selected. There are PC and PI modes for curve entry. In PC mode the arc's PC points are entered followed by the curve data. The PC points can be specified by either picking the point, entering a distance or entering a station. In PI mode, the arc's PI points are entered. Once the PI points determine two tangents, the program prompts for curve data for the previous PI. Spirals can only be entered in PI mode. You can switch between arc and PI mode between curves on the polyline. The arc curvature can be specified by degree of curve or radius. The minimum recommend radius is based on AASHTO. The arc length can be specified by PT station, tangent length or arc length.

The Store Points in CRD File will create points in the current coordinate file for each design point on the centerline. This option is also used for creating the SMI chain file within Centerline Utilities, since the SMI chain file requires point numbers. To specify the coordinate file, choose Set Coordinate File in the Points menu.

Prompts

Centerline file to design Enter the .CL file name to create.
Design Centerline Dialog Choose your options and click OK.
Pick Point or Point number: pick a starting point or enter the starting point coordinates
For PC mode design:
Bearing/PI/End/Undo/<Pick Point or Point number>: pick the PC point
Bearing/PC/PI/End/Undo/<Pick Point or Point number>: PC
Enter Design Speed for curve <55.00>: 40
Minimum Recommended Radius = 426.67
View/Point/Degree of Curve/<Radius>: 500
Curve direction (Left/<Right>)? press Enter for right
Length to use (Station/Tangent/<Arc>): press Enter for arc
Point/Station/Tangent/<Arc Length>: 200
Reverse/Compound Curve (Yes/<No>): press Enter
PI/Distance/Station/<Pick PC or Point number>: D for distance
Point/Enter Distance: 180
Bearing/Line/Undo/End/<Continue PC>: press Enter
Enter Design Speed for curve <40.00>: press Enter
Minimum Recommended Radius = 426.67

Example of PC mode centerline design

View/Point/Degree of Curve/<Radius>: 500
Curve direction (Left/<Right>)? press Enter
Point/Station/Tangent/<Arc length>? 300
Reverse/Compound Curve (Yes/<No>)? press Enter
PI/Distance/Station/<Pick point or Point number>: D for distance
Point/Enter Distance: 140
Bearing/Line/Undo/End/<Continue PC>: E to end
For PI mode design:
Bearing/PI/End/Undo/<Pick Point or Point number>: pi
Pick Point or Point number (PI)<5098.50,3509.11>: pick the first PI point
Type of curve [Spiral/<Circular>]? S for spiral
Enter Design Speed for curve <55.00>: 40
Minimum Recommended Radius = 426.67
View/Point/Degree of Curve/<Radius>: 500
Enter Number of Lanes <2>: 
View/Enter Spiral Length In <204.8000>: 210
View/Enter Spiral Length Out <210.0000>: press Enter
Bearing/Pick next Point or Point number (PI): pick the next PI point
TS: 1+33.280
SC: 3+43.280
CS: 6+39.364
ST: 8+49.364
Bearing/Line/PC/Undo/End/<Continue PI>: press Enter
Type of curve [Spiral/<Circular>]? press Enter for circular
Enter Design Speed for curve <40.00>: press Enter
Example of PI mode centerline design

Minimum Recommended Radius = 426.67
View/Point/Degree of Curve/<Radius>: 500
Bearing/Pick next Point or Point number (PI): pick the last PI
PC : 9+35.900
PT : 16+34.283
Reverse/Compound Curve [Yes/<No>]? press Enter
Bearing/Line/PC/Undo/End/<Continue PI>: E to end
EndPoint : 18+37.121

Stations are printed for every PC, PT and end point in the design process.

Pulldown Menu Location: Centerline
Keyboard Command: centerln
Prerequisite: None
File Name: \lsp\eworks.arx

Input-Edit Centerline File

This command can be used to input a new centerline or edit an existing centerline (.CL) file. It is a dialog-based alternative to Design Centerline and has the advantage of accepting whatever information you have on your centerlines (coordinates, stationing, length of tangents and arcs, etc.). For creating a new centerline, it is ideal for entering data straight from highway design plans. For editing, this command allows you to change any of the geometric properties of any of the elements of the centerline (lines, curves, spiral-only and symmetrical spiral-curve-spiral elements), including the starting coordinates and station.

Starting this command launches the Centerline Input-Edit main dialog box. To edit an existing Centerline, you can either pick the Load button and pick the .CL file, or pick the Screen Pick button and pick the polyline in the drawing that represents the Centerline. The Centerline is then displayed in the graphics window of the dialog box. The highlighted segment in the text window is also highlighted in the graphics window.
Up/Down: Moves elements in the table Up and Down in the list. For example, if this centerline ended with a tangential line from the last curve, then was followed by a non-tangential line at 45 degrees NE, moving the last element up would create a line at 45 degrees after the curve (non-tangential), and the formerly tangential line will remain tangential and therefore continue at NE 45 degrees.

Draw: This button draws the centerline in the drawing on the specified layer.

Drag Action (Zoom and Pan): In the graphics window, hold the left mouse button down and move mouse to Pan, roll the wheel to Zoom.

Load: Loads an existing centerline (.CL) file for review or editing. After loading a centerline, the listbox in the dialog shows a list of all the elements in the centerline, identifying them as either a line, curve, spiral only or full spiral-curve-spiral element and reporting the ending station, northing and easting of the element.

Add: Adds a new element after the highlighted element. Prompts you for the type of the element to be added, Line, Curve, Spiral-Only or Spiral-Curve-Spiral.

Edit: Allows you to edit the highlighted segment.

Remove: Removes the highlighted element from the centerline.

Assign Point Numbers: This will create Carlson points along the elements of the centerline and store them to the current CRD file. The new points will be numbered in sequence beginning with the first available point number in the CRD file.

Reverse: Reverses direction of Centerline.

Save: Saves the currently loaded centerline to a file, or will prompt you for a name if no name has been set.

SaveAs: Prompts you for a file name for the saved file.

Exit: Exits this routine, prompting to save changes if necessary.

Help: Goes to the Help screen for the Input-Edit Centerline command.

Station Equations: At any number of locations on a centerline, you can set the back station and forward station for the re-stationing of the centerline. The station equation dialog appears below:
If the Station Back is lower than the Station Ahead, then a "gap" is inserted in the centerline, where the stations jump forward. If the Station Ahead is less than the Station Back, then an overlap occurs, where the common station range is repeated.

The dialog for every type of element shows the point ID, the northing, easting and station of the start point of the element. It then allows the user to modify or define the parameters specific to the type of element. The following are some of the things to remember about data entry in the centerline editor. These are valid for lines, curves and spirals.

• Wherever length of the element is to be entered, entering an expression of the type 123.5 - 93.7 would evaluate the difference of the values. This is particularly convenient where only the stations of the start and end points of the element are known.

• When the station is specified, the program takes the length of the element as the difference between the station of the start point of the element and the station specified.

• All bearings should be specified by entering the angle between 0 and 90 degree (in dd.mmss format) and selecting the quadrant.

• When entering the delta angle of a curve, only the absolute value (between 0 and 360 degree) is to be entered. The direction of the curve is to be explicitly set as right or left, the default being left. All angles are entered in (dd.mmss) format.

• Point numbers, when used, access their coordinates in the current .CRD file. If the point number specified has no coordinates stored in the coordinate file, the point number is remembered for that particular location (say the radius point of a curve or the SC point of a spiral). Then, when the .CL file is saved, the program creates points for that location and stores them to the .CRD file with the specified point number.

The dialog for a Line allows the user to specify the line primarily by its length or station and its bearing. The line can also be defined by its end point number or its coordinates. The bearing of a line can be changed if the Tangential to the Previous Element toggle is not checked. By default, any line which follows a curve element is defaulted to be tangential to it. To use a bearing different than that of the previous element, uncheck this toggle and enter the bearing.

The dialog for the Curve allows the user to define the curve primarily by its radius and delta angle or arc length. The other parameters of the curve that can be edited are the bearing of tangent-out and the "Station to", which also defines the arc length. The curve can also be specified by entering the coordinates or point numbers of its end point (PT) and the radius point. Another way to specify the curve would be to enter the chord length or PT point station and chord bearing. If the central PI point and a point on the forward tangent are known, then the curve can be defined by entering both of these points and at least one other property of the curve (like radius, arc length, delta angle). The point on the forward tangent can be any point that defines the tangent out direction including the next PI point. If only the central PI point is known, then the tangent-out can be entered by bearing instead of by forward tangent point. Central PI and forward tangent points are not displayed from the .CL file. They have to be entered by the user and are valid only for that particular edit session; that is, they are not remembered the next time the
file is loaded. Curves are assumed to be tangent to the last element unless the Tangential to the Previous Element checkbox is cleared.

The Curve Edit Mode option defines how the curve is accepted in the centerline. If the Hold PC point is checked on, the radius is taken as fixed and the delta angle of the curve is calculated based on some additional parameter. Hence, the extent of the curve is unlimited. However, if the Hold PI points option is checked on, the bearing of tangent-out of the curve is taken as fixed and the radius is calculated based on some other parameter. In this case, the curve is completely restricted within the central PI point and the bearing of tangent out. Hence, when the Hold PI points option is checked on, the above parameters should also be defined to carry out the calculations.

The dialog for the Spiral-Curve-Spiral element allows the user to define the spiral by entering either the various parameters of the spiral (like the angles and lengths) or the coordinates or point numbers of its defining points: the TS (Tangent-to-Spiral), SC (Spiral-to-Curve), Radius point, CS (Curve-to-Spiral), ST (Spiral-to-Tangent) and end point (optional). While defining the spiral by its geometric properties, the program will accept the data even if the information for the simple curve is given with zero spiral lengths. In this method, however, the central PI point of the spiral MUST be specified (that is, it is always in Hold PI Points mode). The tangent out can be defined by entering bearing or by specifying a point on the forward tangent. This forward tangent point can be the next PI coordinates. The direction of the spiral-in and spiral-out elements would be the same as the direction of the simple curve (left or right).

The spiral can be defined by several different parameters and the order that you enter data into the spiral dialog can be important. There are two main sequences for entering data. The method to use depends on the spiral data that you have. The first method is to enter the radius of the simple curve, the spiral in and out lengths, the tangent bearing out and the PI station. The second method is to make a Line segment coming up to the TS (tangent to spiral) point. This Line segment should be added before creating the Spiral element. Then with the Spiral In point set to the TS point, enter the radius of the simple curve, the spiral in and out lengths, the curve direction (left or right) and the arc length of the simple curve. Then the rest of the spiral points will be calculated. The Spiral Only element allows for flexible transitions from curve to spiral to curve or line to spiral to curve or between any combination of curve and line elements. The Spiral-Curve-Spiral element, for example, can be entered as Line, Spiral Only, Curve, Spiral Only and Line, producing the same results.

Once all the elements of the centerline are defined, the file can be saved and then plotted using the Draw Centerline File command.

Example
Here is an example of a highway interchange ramp that involves a starting tangent and a spiral curve that goes abruptly into a simple curve and then a final tangent. Here is the starting dialog.

You start by entering a starting Northing and Easting and starting Station. The Start Point# is optional. Then the concept is that you click Add to add each subsequent element (line, curve, spiral-curve-spiral or spiral only).
Line (Tangent) Segment: We want to enter the tangent segment length up to the TS (tangent to spiral). Enter in the length (200.0), bearing (88.0732) and then the bearing quadrant (NW). Since the next spiral-curve-spiral element can be based on a PI station, it is not necessary for this line segment to go up to the TS point. The purpose of this line segment is to establish the tangent-in direction.

When OK is clicked, the routine will add the Line element as the first in the list of complete centerline elements. Next up is Curve-Spiral-Curve. Click Add.
**Spiral Segment:** Though the dialog is complex (for total flexibility), the key on a typical symmetrical spiral curve is to enter four things: (1) the radius of the simple curve, (2) the spiral in and out lengths, (3) the tangent-out bearing and (4) the PI station (1835.67). Everything else will calculate when you press Enter for the PI station.

**Curve Segment:** Add the next element and select curve. The Curve dialog appears. The key is to enter the Radius Length (255), the Arc Length (150) and the Curve Direction. Everything else will calculate.

**Final Line Segment:** All you need to enter in the final dialog for the line (tangent) segment is its length. All other
items will calculate when you press Enter.

The completed centerline will appear as shown in the dialog and each element can be edited. Pick the Save button to store this centerline data to a .CL file.
**Polyline to Centerline File**

This command writes a centerline (.CL) file from a polyline. The northing and easting for each vertex of the polyline is written to the centerline file and each arc in the polyline becomes a circular curve.

**Prompts**

- **Centerline file to Write dialog** Enter the .CL file name to create.
- **Beginning station <0+00>:** press Enter Or, type in the beginning station then press Enter.
- **Select polyline that represents centerline:** pick the polyline that represents your centerline

**Draw Centerline File**

This command reads a centerline (.CL) file and plots it as a 2D polyline in the drawing at the proper coordinates. First you are prompted for the layer name for the polyline to be created. There is also an Options choice that allows you to specify whether to draw PI lines, and specify the length of same.

Next you are prompted for the file name of the centerline to plot.
The .CL file can be made with the following commands on the Design menu: *Polyline to CL File, Input-Edit Centerline* or *Design Centerline*. Drawing the centerline file is a way to check the .CL file data graphically for correctness. If a spiral exists in the .CL file, the spiral will be represented by polyline segments.

**Prompts**

*Options/Layer Name for Centerline* <CLINE>: press Enter
Enter the layer name to plot the polyline on.

*Centerline File to Plot file selection dialog*
Select the .CL file name to read and plot.

**Keyboard Command:** clpline
**Prerequisite:** a centerline file
**File Name:** \lsp\clpline.lsp

**Centerline Report**

This command reads a centerline file and creates a report in the standard report viewer which can be written to a file, a printer, or to your drawing. If the centerline file contains point numbers, then the report will include these point numbers. If station equations are found, they are noted at the top of the report. Here is an example report:

![Centerline Report Example](image)

**Keyboard Command:** clreport
**Prerequisite:** A centerline (.CL) file
**File Name:** \lsp\eworks.arx
**Centerline ID**

Centerline ID reports the centerline file name and location that is associated with an alignment polyline. The subject polyline must have been created with either Design Centerline, Input/Edit Centerline, or Polyline to Centerline File. When the routine is initiated and an alignment polyline is selected, the file associated with that polyline is reported at the command line. Additional alignment polylines may be selected without re-entering the command, or Enter may be pressed to exit the command.

**Prompts**

Select centerline polyline to identify: *pick the polyline
Centerline Name: D:\SAMPLE.CL
Select centerline polyline to identify (Enter to end): *press Enter

Pulldown Menu Location: Centerline
Keyboard Command: CL_ID
Prerequisite: A polyline created from a Design Centerline, Input/Edit Centerline, Polyline to Centerline File, or Centerline File to Polyline.
File Name: \lsp\surv1.lsp

**Centerline Conversions**

There are twelve Import options available in Carlson Civil to convert other applications' centerline files to Carlson Civil centerline files (.CL), and five Export options to convert Carlson Civil centerline files (.CL) to other applications' formats. Each Import option prompts for the file to convert and the name of the new .CL file to create, each Export option prompts for .CL file to convert and a file name for the new file.

Pulldown Menu Location: Centerline > Centerline Conversion
Keyboard Commands:
File Names: \lsp\cogoutil.arx

**Enter Right of Way**

**Function**

This command adds right of way information to a centerline file which must be created before running this command. The right of way is created by entering station-offset points or picking points. A right of way polyline is drawn through the points and each point is labeled with the station and offset. Besides drawing the right of way, this data can also be used in *Process Road Design* to limit the cut/fill slopes.

**Prompts**

Choose Centerline to Process Specify a centerline file.
Layer name for labels <ROW>: *press Enter
Number of decimal places for labels <2>: *press Enter
Side for right of way (Left/<Right>)? *press Enter
Starting station of centerline: 0.000
Enter station or pick a point ('U' to Undo, Enter to End): 0
Enter offset: 35
Enter station or pick a point ('U' to Undo, Enter to End): 200
Enter offset: 35
Enter station or pick a point ('U' to Undo, Enter to End): 250
Enter offset: 50
Enter station or pick a point ('U' to Undo, Enter to End): 300
Enter offset: 50
Enter station or pick a point ('U' to Undo, Enter to End): *pick a point*
Enter station or pick a point ('U' to Undo, Enter to End): *press Enter*

The end result is a new polyline and a fully annotated ROW line plot. The Enter ROW command can be used to create new polylines that can be applied to templates using the command Template Point Centerline.

**Polyline to Right of Way**

**Function**

This command adds right of way information to a centerline file which must be created before running this command. The right of way is created by selecting a polyline that represents the right of way. The station and offset for each point relative to the centerline is stored as the right of way data in the centerline file. There are two applications for this data. The Draw/Label Right of Way command can be used to label each point with the station and offset. Also this data can also be used in Process Road Design to limit the cut/fill slopes.

**Prompts**

Choose Centerline to Process Specify a centerline file.
Polyline should have been drawn in direction of increasing stations.
Select polyline that represents right of way: *pick a polyline*
Side to apply right of way (*Left*/Right)? *press Enter*

**Pulldown Menu Location:** Design

**Keyboard Command:** rowpl

**Prerequisite:** A polyline and centerline file

**File Name:** \lsp\eworks.arx

---

**Label/Draw Right of Way**

**Function**

This command draws and labels right of way polylines from data stored in a centerline (.CL) file. The right of way data consists of station and offset points for the left and right sides of the centerline. This data can be created with the *Enter Right of Way* or *Polyline to Right of Way* commands. Each right of way point is labeled with a leader that has the station on top and the offset on bottom. The station label is partial which only shows the number after the '+'.

**Prompts**

- **Choose Centerline to Read** Specify a centerline file.
- **Layer name for labels** *ROW*: *press Enter*
- **Draw right of way polylines (Yes/<No>)?** *press Enter*
- **Number of decimal places** *2*: *press Enter*

---

**Station Polyline/Centerline**

This command will station a polyline or centerline file at a given interval distance. The options for this command are set in the dialog shown below. After setting the options, click OK on the dialog and then pick the polyline or select the centerline file. All settings can be saved as (.STA) files and loaded for reuse, and for storing multiple stationing schemes. Polyline/Centerline station labels are also dynamic, and so will update when changes are made.
in the geometry.

**Distance for Stations** is the primary interval for stationing.

**Distance for Intermediate Stations** is the intermediate interval for stationing.

**Beginning Station** is the beginning station of the centerline for stationing.

**Locate Even Stations** labels the stations at the distance interval (i.e. 2+00, 3+00, etc.).

**Locate Odd Stations** labels the non-interval stations at the polyline/centerline end points and PC and PT points.

**Locate User-Entered** prompts you for individual stations to label.

Without the **Increment Station Labels from Beginning Station** option, the program increments the station labels from zero. For example, if the station interval is 100 and the polyline starting station is 145, then the program will label 2+00, 3+00, etc. With this option active, the station labels are incremented from the starting station. In this example, the program would then label 2+45, 3+45, etc.

**Label Deflection Angles** adds this annotation to the stationing. Settings for this are specified in the **Label Deflections Setup**, accessed by the **Deflections Setup** button.
When **Specify Start/End Stations** is checked, only the stations between and including the specified starting and ending stations will be labeled. If locate centerline points and offset points are toggled on, only points within the specified stations will be located.

When **Erase Previous Station Labels** is checked, previous station labels are erased when new ones are generated.

The **Setup PC Lines** button accesses the **PC Lines Setup** dialog, where settings are controlled for lines and/or symbols and/or labels at the starting and ending (PC and PT) stations of an arc of the polyline/centerline.

**Draw PC Lines** controls whether lines are drawn from the PC and PT points.

When **Label PC On Centerline** is checked, the station of the PC and PT will be labeled on the centerline as well as the PC and PT lines. When not checked only the PC and PT lines will be labeled.

**Draw PC Symbols** controls whether symbols are placed at these locations. If checked, the desired symbol is selected by picking on the box to the right.

**Label PC Radius** controls whether this point is labeled.
Max Length controls the maximum length for the PC lines to be drawn described above.

Back in the main Station Polyline/Centerline dialog box:

Draw PI Lines draws a 2 segment polyline in both tangent directions from the PI as a marker for the PI.

When Label PI Stations is checked, the PI station is labeled at the PI point.

When Locate PI Points is checked a point will be created at the PI of a horizontal curve graphically and written to the active coordinate file.

When Label Station Text is checked, this command places station text along the polyline at the angle of the corresponding segment. After toggling this option on, the Label Setup button will become available for selection. Select it to configure the label settings as desired. Select the Marker Setup options to modify the size of the markers for certain types of stations. See definitions following the dialog box.

Label Setup

- **Text Layer** is the user-specified layer for text labels to be drawn on.
- **Text Style** is the user-specified text style for labels.

- **Decimals** determines the number of decimal places of the stationing labels to be drawn for the odd stations and user entered stations only.

- **Text Size Scaler** determines the size of the station labels. This value multiplied by the horizontal scale setting in Drawing Setup results in the size of the label. For example, if the horizontal scale is set to 100 and the text size scaler is set to 0.10, the station labels will be 10 units.

- **Text Offset Scaler** works like text size scaler above controlling the distance the text labels will be offset from the centerline.
• If the **Flip Text For Twist Screen** setting is checked and the drawing has been twisted using the twist screen command, the label text will be flipped to read in the proper direction of the stationing.

• **Label Intermediate Stations**: If the intermediate distance is the same as the station distance then no intermediate station ticks or labels will be drawn. For example, with the above entries and 0+00 for the first station the stations will be labeled with descriptions as follows: 0+00 0+50 1+00 1+50, etc.

• **Station + at Tick Mark** labels the station text along the polyline with the ‘+’ of the station text at the station's location on the polyline. See Marker Set up for marker size manipulation settings.

• **Label Northing/Easting of Starting Point** adds this label information, including prefixes and/or suffixes as specified.

• Use **Label Stations** to specify whether to label the stations perpendicular or parallel to the centerline.

• Specify the **Position** of the station labels, either above or below the centerline. This is only available when labeling stations using the parallel option.

• **Align** determines the alignment of the station label, either left or centerline, centered along the centerline or to the right of the centerline. This option is only available when using the perpendicular option for station labels.

The **Marker Setup** options control the size of markers for different station types as well as the layer the markers will be drawn on.

![Marker Setup](image)

Specify whether to define the **Centerline By** picking a 2D polyline or 3D polyline in the drawing or selecting a centerline (.CL) file.

• Using a **2D Polyline** will result in horizontal distance stationing along the polyline.

• Using a **3D Polyline** will result in the slope distance stationing along the polyline.

• Using a **CL File** will result in horizontal distance stations as with the 2D Polyline option only a prompt for the centerline to use will display.

Use **Station Type** to specify the stationing format to use.
Use **Type of Curves** to specify whether you are labeling a roadway curve (arc definition) or railroad curve (chord definition).

**Locate Centerline Points** will locate points and store them in the current CoorDinate file.

**Locate Radius Points** will locate the radius points of any arc segments.

**Starting Point Number** determines the starting point number for the points to be located.

There are two ways to **Set Elevations** for the centerline points and offset points to be created.

- The **3D Polyline** option gets the elevation of the point from a specified 3D Polyline within the drawing.
- The **Profile** option will determine the elevation of the point based upon the same station in the profile file. You will be prompted for the profile file to read for the elevation reference.
- With the **None** option selected, no elevations will be determined for the points.

When **Include Station in Description** is checked, the station along the centerline will be included in the resulting offset point.

**Description Prefix** is an optional user-specified prefix to be added to the point description.

**Description Suffix** is an optional user-specified suffix to be added to the point description.

When **Label Sta Equations** is checked on any station equation, contained in a centerline (*.cl) file will be labeled. This option is only available when stationing a centerline file (*.cl).

**Locate Offset Points** will create points at the specified left and right offset distances from the centerline. Options for setting the elevations and descriptions of the points are available from the Offset Setup dialog.

- When **Use Slopes** is on, it makes available the Percent Slopes fields for defining the slope from centerline both right and left for determining the elevations of the offset points.
• Enter the desired **Offsets** left and right.
• Enter the desired **Percent Slopes** from centerline to the left and right offset points.

**Prompts**

**Station Polyline Dialog**
Polyline should have been drawn in direction of increasing stations.
Select polyline that represents centerline: *select a polyline*

![Station Polyline Dialog](image)

Closeup of Station + at Tick Mark option

Labels with Label PC on Centerline checked on

![Labels with Label PC on Centerline](image)

Labels set to perpendicular and Max Length of PC lines set to 75.0

![Labels set to perpendicular and Max Length of PC lines set to 75.0](image)
Keyboard Command: stapl

**Prerequisite:** A polyline or CL file

**File Name:** \lsp\staent.lsp

### Label Station-Offset

This command will label the station and offset of a point relative to a centerline. A polyline that represents the centerline or a centerline (CL) file is required before using this command. The points to label can either be picked on screen or specified by point number. As the crosshairs are moved, the station and offset of the current position are displayed in real-time in a small window (see example). This command starts with the Label Station-Offset Settings dialog.
Label Options: Specify whether to label the text only or add the label to the existing point description.

Label Position: Specify if the program should automatically position the label with a leader, let the user pick the location, or use no leader.

Label Alignment: Specify whether the labels should be Horizontal on the screen, Parallel to the Centerline, Perpendicular to the Centerline, or user-specified by Picking.

Type of Curve: Specify whether the centerline is for a roadway or railroad.

Layer Name: Specify the layer name for the labels.

Text Size Scaler: Determines the size of the labels. This value multiplied by the horizontal scale setting in Drawing Setup results in the size of the label. For example, if the horizontal scale is set to 100 and the text size scaler is set to 0.10, the labels will be 10 units.

Text Offset Scaler: Determines the text offset. This value works the same way as the Text Size Scaler.

Beginning Station: Specify the beginning station of the centerline. The polyline should be drawn in the order of increasing stations. Not available when you use a centerline (.CL) file to define the centerline.

Max Offset to Calc: Specify the maximum offset to calculate.

Station Decimals: Specify the display precision for the station text.

Offset Decimals: Specify the display precision for the offset text.

Station Prefix: Specify an optional prefix for the station text.

Station Suffix: Specify an optional suffix for the station text.

Offset Prefix/Suffix: Specify an optional prefix and/or suffix for each offset.
Station Label: Choose between Full label (1+35.42), Partial label (+35.42) or no station label.

Offset Label: Choose between Fill label (L15.35), partial label (15.35) or no offset label.

Flip Text for Twist Screen: With this option checked, the text will be flipped as necessary to adjust for the use of Twist Screen.

Label Both Station-Offset On Same Line: With this option checked, the station and offset label will be drawn on the same line.

Station Type: Specify the stationing format to use.

Centerline By: Specify whether to define the centerline by picking a polyline in the drawing or selecting a centerline (.CL) file.

Prompts

Label Station-Offset dialog
Polyline should have been drawn in direction of increasing stations.
Select Polyline Centerline: pick the polyline centerline
Pick point or point number (SS for Selection Set, G for Group, Enter to End): pick a point
Station on Line > + 2+10.91 Offset > 57.36 Right
Select point number to add station description to: pick point number This prompt will not appear if the L option, label only was selected.
Pick point or point number (Enter to End): press Enter

Real time display of station offset as you move the cursor
Keyboard Command: offsta
Prerequisite: A polyline centerline
File Names: \lsp\inqoff.lsp, \lsp\scadcogo.dcl

Calculate Offsets

This command calculates the station and offsets of point coordinates relative to a centerline. The points to calculate can be stored in a coordinate (.CRD) file or picked on the screen. As the crosshairs are moved, the station and offset of the current position are displayed in real-time in a small window (see example).

Beginning Station: Specify the beginning station of the centerline. The polyline should be drawn in the order of increasing stations. Not available when you use a centerline (.CL) file to define the centerline.
Maximum Offset to Calc: This is the maximum distance from the Centerline for which offsets are calculated.

Report Offsets Ahead/Behind Centerline: When checked, this option shows offsets for points or picked points located before the beginning station and after the ending station of the centerline.

Label Station and Offsets: When checked, the station offsets will be labeled in the drawing.

Sort Report by Stations: When checked, this option will report the station-offsets in station order no matter what order the points were calculated.

Report Point Coordinates: When checked, this option will include the point northing and easting in the report.

Report Point Notes: When checked point notes will be included on the calculate offset report.

Create Point Notes: When checked, the station and offset of the offset point will be created as notes and written to a note file (*.not). This note file will have the same name as the crd file.

Use Report Formatter: When checked, the output of this command is directed to the Report Formatter which allows you to customize the layout of the report fields and can be used to output the data to Microsoft® Excel or Microsoft® Access. You must check this option on in order to use the Report Grade Elevation From option.

Round Stations: When checked, this option will round the stations for the selected points on the report to the Rounding Interval specified. For example if an offset point is located at station 1+01, and the rounding interval is set to 10, then the report will show the offset point at station 1+00.

Store Station Text to CRD File: When checked, the station offset text is appended to point numbers that are selected.

Report Grade Elevation From: When checked, this option will calculate an elevation for each point from a 3D polyline, grid file (.grd) or triangulation (.flt) file. To Use this option, the Report Formatter must be toggled on. The grade elevation is reported and compared with the point elevation to report the cut/fill. For the 3D polyline option, the grade elevation is calculated by finding the elevation at the point on the 3D polyline that is the nearest perpendicular position from the offset point. The 3D polyline that is used for elevations does not need to be the same polyline that is used as the centerline for the station-offset calculations.

Define Centerline by: Specify whether to define the centerline by picking a polyline in the drawing, selecting a centerline (.CL) file, or using 2 points.

Station Type: Specify the stationing format to use.

Decimals: Specify the display precision for the stations and offsets.

Type of Curve: Specify whether the curves are for a roadway or railroad.

Prompts

Calculate Offset Settings Dialog
Polyline should have been drawn in direction of increasing stations.
Select Polyline near endpoint which defines first station.
[nea on] Select Polyline Centerline: select polyline centerline
(5309.0 4845.0) Station: 0.00
(5526.0 4917.0) Station: 228.63
### Design Template

This command creates a template definition file (.TPL file). The template file can then be applied in the *Process Road Design, Draw Typical Template, Locate Template Points* or *Design Pad Template* commands. The template is designed using the dialog shown below. The top portion shows the template as you create it. In the middle is a row of icons which are the building blocks of the template. They can be chosen in any order by picking on the icon. In the bottom of the dialog are four list boxes that list the elements of the template. The surface elements are listed in order starting from the center. The subgrades are listed from top to bottom order. To add a template element, highlight the position in the list above where to insert the element. Then pick one of the element icons. To change the order of an element, highlight the element and pick the Move Up or Move Down buttons. The Edit button edits the dimensions of the highlighted element. The Remove button erases the highlighted element from the list. There is no limit to the number of surface or subgrade elements. Note that there is a Right Side Same as Left option. When active this option only requires template design for the left side and will automatically mirror the design for the right side.
The template surface can be composed of three types of elements: medians, grades and curbs. The median is a flexible closed figure defined in a clockwise direction. Each median point consists of an X and Y offset. The median must be closed and the program will automatically create the closing segment. In the Median Design dialog, the median is shown in the top display and bottom has a list of median points. The display shows the median in magenta and the grade lines in and out in green. For the display the grade in comes from the left and the grade out goes to the right. The median must define the Grade In point which is the point that ties into the incoming surface grade. Also the Grade Out point must be specified for where the surface grade continues out from the median. These Grade In and Grade Out points emanate from the starting or "from" position in the coordinate dialog where they are specified. Since a single median must be placed on the left or right side (and is typically not used symmetrically with right side same as left), you will need to offset the template centerline one-half the median width within the command Process Road Design in order to center the median. You will also have to move the "C/L" designation, to obtain centering, when using Draw Typical Template.
You can design a median for "mirroring" to create a centered effect, as shown below. The only negative to this method is the appearance of a vertical line in the median plot. Medians can be saved and loaded for re-use in other templates.
Surface grades can be entered by selecting the Grades icon which brings up the dialog shown. Downhill slopes are negative and the Distance is the horizontal distance. The text ID serves 4 purposes: (1) The ID will be applied as a description to all final template points generated in the form of a coordinate (.CRD) file, (2) The ID can be used as a design point, as in EP+5 indicating 5 feet or meters right of edge of pavement, (3) Points of common ID may be connected by 3D polylines as an output option of Process Road Design and (4) Quantities can be generated with reference to the ID and material (gravel, concrete, etc.) entered elsewhere within this command.

To add a curb, select the Curb icon. The dialog box below appears where you can fill in the curb dimensions. There are three curb types to choose from. The curb dimensions can be specified in feet, inches or meters in metric mode. The Rounding option will smooth the surface of the curb which only shows when the template is applied in commands such as Process Road Design. The Integral/Separate option determines whether to draw the front line of the curb to separate the curb from the subgrade. For example, fully concrete pavements that contain a curb would be drawn with the "integral" curb option. The slope of the curb can either be flat, set to the slope of the incoming grade or set to a user-specified slope. The material name is used in the Process Road Design report.

Straight & rounded curbs

Integral and separate curbs

Chapter 13. Roads Menu 466
To specify cut treatment, pick the Cut icon. There is room to specify up to five cut slopes which can be slopes in series or slopes to use at different depths. In a simple case of one cut slope, you can just enter the one slope value and leave the depth and other slope boxes blank. For Slopes in Series, each slope is used up to the specified depth until an intersection with the ground. If the intersection is not reached by the first slope, then the next slope continues from where the first ended. If you have more than five slopes, pick the Repeat Slopes option which will repeat the sequence of entered slopes until the ground is reached. The Bench Between Cuts option allows you to enter a bench width and percent slope to be inserted between each cut slope. Besides running the cut slopes to specific depths, the
Cut To Section option can be used to have each cut slope intersect a surface from a section (.sct) file. With Cut To Section on, the Process Road Design command will prompt for these cut slope section files. For example, this Cut To Section option could be used when you have a cut bench that occurs at a set elevation but different cut depths as the road profile changes. In this case, you could create a section (.sct) file at this set bench elevation.

With Slopes in Series off, just one of the slopes is used depending on the depth. For example, set the dialog as shown to use 4 to 1 slopes at depths up to 4 feet, 3:1 up to 10 and 2:1 if deeper. The effect is 4:1 if shallow and, by contrast, 2:1 if the fill is deep. The Smooth Transitions option will gradually transition the slopes from one range to the next. In this example, if the depth is 5 feet the slope will be between 4:1 and 3:1. The graphic in the Design Template dialog will explicitly show slopes in series versus individual slope depending on setting (shown below are individual slopes, with slopes in series off):

The Pivot at Subgrade option will position the cut pivot point where the bottom subgrade intersects the template grade. The ditch or upslope conditions will then occur from this special subgrade "daylight" pivot point, instead of from the outer shoulder surface pivot point. The Tie to Existing Point will draw the cut slope from the cut pivot point to either the outside offset-elevation or an offset-elevation point with a specified description from the existing section file. This method is used when survey crews take sections and designate the specific slope tie points.

The Slope to Rock applies in Process Road Design when using a Rock Section File. There are two slope order modes for rock slopes: Slope TO Rock and Slope FROM Rock. For the Slope TO Rock mode, the cut slope will be the Slope To Rock up to the rock surface. After reaching the rock surface, the regular cut slopes apply. For the Slope FROM Rock mode, the regular cut slopes apply up to the rock surface. Then from the Slope From Rock applies from the rock surface to the ground surface.

Ditch Grades can be inserted prior to the application of the cut upslope. For curb and gutter roads, there is typically no ditch. But for roads with drainage downhill to the outside and no curbs, ditches are typically used in cut conditions. The Ditch Grades list contains each ditch grade in order from the regular template. Any number of ditch grades can be added by picking the Add Ditch button. To create a V ditch, add just one ditch grade such as slope ratio -1, distance 1. This makes one side of the V. The pivot point for the cut slopes will be the bottom of the V.
and the other side of the V will be made by the cut upslopes. For a ditch with a flat bottom, you could have two ditch grades such as slope ratio -2, distance 4 and then slope percent 0, distance 2. If a minimum depth for ditch is entered, no ditch will be applied unless the cut exceeds that depth. The Force Berm will apply the Berm (defined using the Fill icon) in cut instead of a ditch up to a certain depth of cut.

Fill treatment is similar to cut. Up to five slopes for different depths can be specified. Slopes in Series and Smooth Transitions work the same way as cut. Berm Grades are the fill equivalent to Ditch Grades. Fill treatment does have some extra options. Guardrail Expansion will extend the last template surface grade the specified Shoulder Distance when the fill is greater than the Min Depth. The Force Ditch option has two different methods to apply the Ditch Grades from the cut definition. With "At Base Of Fill" on, Force Ditch creates the ditch where the fill slope hits existing ground. With "At Base of Fill" off, the Force Ditch method applies the ditch grades from the template pivot point. The Minimum Depth for Berm Grades will only draw the Berm Grades when the fill depth is greater than the specified value.

The Right of Way icon brings up the dialog shown which allows you to specify whether to use a retaining wall to keep the cut/fill slopes from crossing the right of way. The right of way data is stored in a centerline file (.cl file) as stations and offsets for the left and right sides of a centerline. When the retaining wall option is active, the cut or fill slope will go at the design slope up to the right of way and then the slope will tie into the ground by going
straight up or down. Without the retaining wall option, the cut or fill slope will become steeper in order to tie into the ground at the right of way. For example, if the cut slope is 50% but this slope ties into the ground past the right of way, then the slope will be modified to something steeper such as 65%. The Offset ROW options will force the tie in the offset distance before the right of way.

The Shoulder Super Elevation icon specifies where on the template the slopes will transition between super elevation slopes and normal slopes. The transition point is identified under Pivot Point by the template id for the grade, curb or median. Note that the pivot point can be specified as an ID plus a distance as in "EP+2". Starting from the center, the template grades will be in super up through this template segment. For example, based on the template shown in the first dialog of this command, the EOP Pivot Point the Super Elevation Settings dialog will create the first EOP grade in super while the curb and grade S will be at normal grade. The High and Low Pivot Point options allow for different transition points depending on which side is raised by the super elevation. The Max Percent Slope Difference is the maximum difference between the super elevation grade and the normal grade at the pivot point. For example with a Max Percent Slope Difference of 7%, if the super elevation grade is 6%, then the slope after the pivot on the high side will be -1% even if the normal design slope is steeper than -1%. If the grades do not start from the center in super, then the Divided Roads option can be used. With this option, the grades start from the center as normal and then transition to super at the Normal to Super Pivot Point.
Example of super elevation of 4% to the right for a divided road with a Max Difference of 7%. The normal template is shown above. The Normal to Super Pivot Point is MED and the Super to Normal Pivot Point is EP. The result is that the EP segment is in super and the SH and MED segments are at normal slope. On the left, the SH segment is at the normal -10%, the EP segment is at the super elevation slope of -4% and the MED segment wants to be at 4% but ends up at 3% because this meets the Max Difference requirement. On the right side, the MED segment starts at the normal -4%, then the EP segment transitions into the super -4% and then the SH transitions back to normal which results in a 3% slope because of the Max Difference requirement.

To add subgrades click the SubGrades icon which brings up the dialog shown. The subgrades are areas below the template surface. There can be any number of subgrades stacked one below another or side by side.

The subgrade starts from the surface at the distance from the center set under Horizontal Offset. To start from the centerline, enter 0 in Horizontal Offset. First the subgrade moves straight down from this Horizontal Offset. The depth down is specified in Vertical Offset in feet units or meters in metric mode. The Vertical Offset normally should be set as a negative number. The bottom of the subgrade then either moves away from or towards the center depending in the Direction In or Out setting. The distance to move is specified under Distance. The Slope Type for

Chapter 13. Roads Menu
the subgrade bottom can be either set to a specified slope or set to match the grades of the surface. After moving the specified distance, the subgrade will tie back into the template surface either by going straight up, by continuing at the subgrade slope until intersecting the surface or by wrapping around. The commonly used "continue slope" approach will extend the slope until it hits something (like a curb or another surface segment). It will not trim. So if the pavement segment is 12 feet to a curb, it is better to enter 10 and "continue slope" than to enter 12 exactly, as a "tilted" curb may place the curb edge at 11.98' from the start of the subgrade, causing the subgrade to go past face of curb and intersect back of curb. Also, for angled tie-ins of subgrade from base of curb to the surface, such as the example shown below, be sure the distance entered is less than what would intersect the surface, so that the "extend" effect will create the intersect. In this example, the first subgrade (asphalt) is "continue slope", the second (gravel) is "straight up" and the third (gravel tie in behind curb) is "continue slope".

The Material field is an optional description that is used in the Process Road Design report. Special super elevation pivot points may optionally be specified. The values for Horizontal Offset, Distance and Pivot Offset can be specified by template ID. For example, EP could be used in Distance to have the subgrade have a width of the EP grade. Also expressions can be used such as EP+5 to go the distance of the EP segment plus 5. This is especially useful for template transitions so that if the EP grade varies the subgrade width will automatically adjust.
Example of Wrap Around Subgrade

Keyboard Command: template
Prerequisite: None
File Name: \lsp\tplmake.arx

**Draw Typical Template**

This command draws a template and labels the slopes and distances. The cut and fill treatment can be shown on the left and/or right sides. All the cut/fill slopes are shown for the different depths when multiple slopes are defined. There are options to draw the normal template, super elevation or details of different sections.

You will be prompted to select the template (.TPL) file first, then the Typical Section dialog appears. Specify the parameters and press the Draw button.
Prompts

Template File to Read Specify a template file.
Typical Section dialog Set your options then click Draw.
Pick Starting Position: *pick a point*

Curb Detail

Normal Typical Template
Keyboard Command: typical
Prerequisite: A template file (.TPL file)
File Name: \lsp\eworks.arx

Template Transition

This command creates a template transition file (.TPT file) that can be used for the commands Locate Template Points and Process Road Design. The template transition is associated with a typical template (.TPL) file. The template transition file defines changes in grade distances or slopes for a specific template ID through a specified range of stations. Lane widths, for example, can be made to expand and contract. You can only modify existing template grades. Template Transition does not allow curbs, medians, subgrades or cut/fill treatment to be modified. Also new template elements cannot be added and existing elements cannot be removed. For this reason, lanes of road that "emerge" and slope distinctly from standard road lanes would need to be entered as small (0.001 in width) segments in the original template, available for expansion using Template Transition. Template Transition offers one of 3 ways to change template widths and slopes. Another way involves use of Template Point Profile and Template Point Centerline, where a particular template ID can be directed to follow a specific profile and centerline of its own. The third method is template-to-template transitions using Input-Edit Template Series, where distinct templates transition one to another. All three methods require that template IDs "pre-exist" in order to be expanded, or to follow profiles and centerlines, or to transition between template files. So the technique of making very short phantom segments for emerging and disappearing "lanes" or roads with distinct grades is universal. If special slopes are not involved, lanes can expand and contract without creation of phantom segments in the original template. Only clever use of Input-Edit Template Series, where templates with no curbs could "end" and templates with curbs can begin at specified stations, can effectively make "new" features like curbs and medians materialize.
Reviewing the below plan view, when you are given stations and offsets that define a template position like edge-of-pavement (above), you can use Template Transition effectively.
The first Template Transition dialog shows a list of the transitions, covering the above right-lane variable width. To add a transition, click the Add button. This brings up the second Template Transition dialog which shows the transition template for the second segment. The middle sections list the template grades that can be changed. To modify a grade, highlight the grade and click the Edit button.

The Begin Transition Station is where the normal template begins to transition to the modified template. The Begin Full Template Station is where the modified template is used entirely. The End Full Template Station is where the template starts to transition back to normal. The End Transition Station is where the template has returned to normal. This method is designed for elements like passing lanes which expand from normal then contract back to normal. But you can also use this method for roads that start off or end expanded or altered. For example, to start off the road at a 40' edge-of-pavement dimension, it is necessary to transition up from 12.5' (normal dimension). If you need to have 40' at station 0, then enter station -0.01 as the "Begin Transition Station", and enter station 0 as the "Begin Full Template Station". Select the EP grade in the dialog, and change it to 40'. Then click "Link to next transition". The Link to Next Transition option joins the current transition to the next transition without returning to the normal template. This takes you to the second dialog, shown above. You sustain the 40' width from Begin Transition Station 125.29 and transition at station 215.08 to a 24.23' dimension. Then quickly end the transition at station 215.081 for the "End Full Template Station". Finally, transition back to normal 12.5' by entering 335.51 for "End Transition Station".

There is another "trick" to using Template Transition with templates that include subgrades. The subgrades will not automatically extend and follow the expanded grade IDs such as EP for "edge-of-pavement", unless the subgrades are defined in terms of the IDs themselves within Design Template. Subgrades that expand "at slope" to intersect a curb, for example, can expand naturally as the curb position moves outward on the right side. But subgrades that go "straight up" at back of curb at offset 14.5' in this example will stay at 14.5', unless defined as shown below by referencing the "EP ID:

<table>
<thead>
<tr>
<th>Sub-Grade Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slope Type</td>
</tr>
<tr>
<td>✓ Match Surface</td>
</tr>
<tr>
<td>✓ Special</td>
</tr>
<tr>
<td>Slope [%]: 0.000</td>
</tr>
<tr>
<td>Direction</td>
</tr>
<tr>
<td>✓ Cut</td>
</tr>
<tr>
<td>✓ In</td>
</tr>
<tr>
<td>Intersect surface:</td>
</tr>
<tr>
<td>Straight Up</td>
</tr>
<tr>
<td>Wrap Height: 0.000</td>
</tr>
<tr>
<td>Tie Slope [%]: 0.000</td>
</tr>
<tr>
<td>Horizontal Offset:</td>
</tr>
<tr>
<td>0</td>
</tr>
<tr>
<td>Vertical Offset:</td>
</tr>
<tr>
<td>12.00</td>
</tr>
<tr>
<td>Distance: EP=2</td>
</tr>
<tr>
<td>Material: stone</td>
</tr>
</tbody>
</table>

Cut and Fill slopes can also be transitioned by picking the Cut and Fill buttons. Ditch and Berm grades can also be modified here.
Transitions can also be applied to the left, right or both sides. This allows you to have separate overlapping transitions for the left and right sides.

**Prompts**

**Template Transition to Edit/Create** Choose New to create a transition file or Edit to modify a transition file

**Template File to Edit:** Specify a transition file

**Template Transition dialog**

**Keyboard Command:** tpltrans

**Prerequisite:** A template .TPT file

**File Name:** `\lsp\tplmake.arx`

**Input-Edit Super Elevation**

This command is an editor for super elevation stationing. The super elevation data is stored in new or existing super elevation (.SUP) files. When creating a new super elevation file, there is an option to read a centerline file and build the super elevation stationing based on the curves and spirals in the centerline using AASHTO-based stationing or optionally, the Virginia DOT method. The AASHTO calculations are based on the equations in chapter 3 of the 2004 Green Book titled Geometric Design of Highway and Streets. The length of the transition from normal crown to superelevation will be automatically computed by the program using either method based on the design speed and other settings, but the user can control what percentage of this transition to and from superelevation occurs in the tangent leading up to the curve or in the curve itself.
The main superelevation dialog displays a list of each super elevation transition. These entries should be sequentially entered from lowest to highest stations. To edit the super elevation stationing, highlight the entry line and click Edit. The Add button creates a new entry below the current highlighted row or at the top of the list if no row is highlighted. The Delete button removes the highlighted row from the list. The Save button saves the super elevation file. To exit the program without saving, click the Cancel button.

The super elevation stationing is entered in the Input/Edit Superelevation dialog. The View Table button shows a table of the super elevation slope for the delta angle and radius at different design speeds. The Calc Super button calculates the slope of full super given the design speed. The station entries are defined as follows:

- **Method**
  - AASHTO
  - Virginia DOT

- **Normal Crown Percent Slope**: 2.00
- **Number of Lanes**: 2
- **Lane Width**: 12.0
- **Design Speed (mph)**: 35.00
- **Transition Part in Tangent (%)**: 100.0
- **Curve (%)**: 0.0
- **Max superelevation**
  - 4%
  - 6%
  - 8%
  - 10%

The super elevation stationing is entered in the Input/Edit Superelevation dialog. The View Table button shows a table of the super elevation slope for the delta angle and radius at different design speeds. The Calc Super button calculates the slope of full super given the design speed. The station entries are defined as follows:
Station to begin transition: where normal crown rate begins to transition
Station to begin super run-in: where slope becomes flat
Station for super at normal crown rate in: where slope equals negative of normal crown rate
Station to begin full super: where slope reaches full super slope
Station to end full super: where slopes begins to transition from full super back to normal
Station for super at normal crown rate out: where slope equals negative of normal crown rate
Station to end super runoff: where slope becomes flat
Station to end transition: where slope returns to normal crown rate

Given these various Station settings, an unequal rate of change can occur between any two stations. However, the program can calculate the stations to set an even rate of transition, as long as it knows the max superelevation, the normal crown slope and the station to start transition, start full super, end full super and end transition. The Calculate Stations button therefore calculates the stations for begin run-in, normal crown rate in, normal crown rate out and end super run-out. To calculate these stations the values with an "*" must be entered.

The Compound Curve option allows you to specify a second superelevation slope for a compound curve. In addition to specifying the second slope, the starting and ending stations for this slope must also be entered. The Reverse Curve option is similar to the Compound Curve option. A typical Reverse Curve is shown below in plan view and as it would appear in the summary dialog:
Station 399+00 is the "pivot" where superelevation left flattens and turns into superelevation right.

Prompts

New or Existing Super Elevation File dialog
Superelevation File to Process Specify a superelevation file.
Superelevation Editor dialog
Keyboard Command: super
Prerequisite: None
File Names: \lsp\eworks.arx, \lsp\makesup.lsp
Input-Edit Template Series

This is another method of widening lanes or causing templates to change: direct template-to-template transitioning. Using this command, you specify the station where one template "ends" and the station where another template "begins", and the program auto-transitions between templates. For the transition to work optimally, the templates should share the same IDs. If the templates are distinct with separate, unrelated IDs, then by ending template1 at station 500 (for example) and starting template2 at station 500.01, a very abrupt transition can be accomplished. For modifying templates, the Template Series method is an alternative to both the Template Transition method and to a third method of using Template Point Profiles and Template Point Centerlines, where a template ID "follows" a particular centerline and profile. One advantage of the Template Series approach is that it can be used to link different templates together, like non-curb and curb templates, as shown here in plan view:

For the above example, Template 1 applies from station 0+00 to 0+30, then transitions to Template 2 at 1+00, which itself transitions to Template 3 (still no right-side curb), which ends at 1+05. There, Template 4 starts with a curb replacing a standard EOP/Ditch combination on the right side. So Template 4 would be set to begin at 1+05.1, a short distance past 1+05. This template transitions into Template 5 at station 2+05. You do not need to enter start and ending templates at station 0+00 or after station 2+05. Therefore, the dialog for this example might look as follows:
Note that you can run Process Road Design to review the design results in plan view, with entry of only the Design Template/Series, the Profile and the Centerline (items 1, 2 and 4 within Process Road Design). You do not need existing cross sections to use Process Road Design. If you process at an interval such as 10 over any desired station range, you can output the Template Polylines and verify the result in plan view. If no sections are found, the program will process from edge of shoulder left to edge of shoulder right, and omit cut and fill slopes. With the correct templates, this would reproduce the plan view shown above.

Input-Edit Template Series is also an effective way to accomplish superelevation, and even simultaneous superelevation and lane widening. Consider the "stages" of pivoting into superelevation of 3%. The first template might be called "Normal Crown" (the lower template). The second template might be called "Reverse Crown" (+2% cross slope). The third template might be called "Full Super" and would be the +3% template. You need the second template because you need to "restrain" the left-hand side of the road from pivoting until the continuous +2% cross slope is reached. If you only used the "Normal Crown" template, say, at station 4+00 and then the "Full Super" template at station 6+00, then at station 5+00, where 1/2 of the transition occurs, the left side cross slope would be -2.5% (transitioning halfway). In reality, the left side should not pivot until station 5+60. If the rate of pivoting is less from normal crown to flat outside lane, and the rate changes after that point, then you would need a fourth template to direct how the road transitions to full superelevation.

Prompts

**Keyboard Command:** tplseries
**Prerequisite:** Template Files
**File Name:** \lsp\tplmake.arx

**Topsoil Removal/Replacement**

This command creates a topsoil definition (.TOP) file which defines topsoil removal and replacement zones to be used in the Process Road Design command. You can have different topsoil adjustments for different station ranges. These adjustments are applied to the existing ground section in the Process Road Design command and will effect the cut and fill volumes. Process Road Design will also report the amounts of topsoil removal and replacement.

The command starts by displaying a list of the topsoil stations in the dialog shown below. To add a topsoil adjustment, pick the Add button which brings up a second dialog. You can have different amounts of topsoil removal and replacement for areas in cut and areas in fill. Subsoil is another category of removal that will be combined...
with any topsoil removal. The Subsoil removal volume is reported separately from topsoil removal by Process Road Design. Subsoil is automatically removed from the site and not used in fill or as a replacement quantity. Therefore, the subsoil element applies only to unsuitable materials that need to be removed. In the example below, we are only removing topsoil in cut (where cutting must take place in any case), and in the cut, we are removing 2’ of subsoil which will be hauled off site (since subsoil is not re-used). The removed 0.5’ of topsoil in cut will then be replaced in both cut and fill zones of the road within the limits specified by the "Replacement Limit ID". (No topsoil will be replaced on paved surfaces!)

The Replacement Limit ID is an option to limit the replacement to occur only within the template left offset Limit ID and the right offset Limit ID. If this Limit ID is left blank, then the program will apply the replacement between the left catch point and the right catch point. Topsoil removal is always applied between the catch points. The Limit ID corresponds to a template ID as set in the Design Template routine. Typically, you would use an ID like SH for shoulder and replace topsoil only from the far left and right tie/catch points to the SH or shoulder point. If you use a curb and want to replace topsoil to back of curb, keep in mind that the program takes the basic code "CB" and creates 3 curb points typically, so the back of curb would become CB3 in most L-shaped curbs.

If the Topsoil (".TOP") file is selected within Process Road Design, all quantities of topsoil removal and replacement and subsoil removal are reported, as shown below:

Processing 0+00.00 to 4+42.10

Total Topsoil Removed: 5219.22 C.F., 193.30 C.Y.
Total Subsoil Removed: 20876.89 C.F., 773.22 C.Y.
Total Topsoil Replaced: 5309.57 C.F., 196.65 C.Y.
Hauled-In Topsoil: 90.35 C.F., 3.35 C.Y.
Total Cut: 9106.52 C.F., 337.28 C.Y.
Total Fill: 16402.56 C.F., 607.50 C.Y.
Total SUBGRADE1 - asphalt: 2763.36 C.F., 102.35 C.Y.
Total SUBGRADE2 - stone: 9209.44 C.F., 341.09 C.Y.
Total CURB - concrete: 1078.37 C.F., 39.94 C.Y.

The cut reported in Process Road Design would be the remaining cut after topsoil and subsoil removal, and the fill would be the fill necessary to bring the grade to base of topsoil replacement, on top of which the topsoil is added. The removal of topsoil and subsoil usually creates less cut and more fill, as some of the cut is accomplished by the topsoil/subsoil removal, and in terms of fill, the grade must be brought up to replace the "cavity" created by the topsoil and subsoil removal. Topsoil removal depths and replacement depths can have a dramatic impact on cut and fill quantities, particularly on smaller scale projects like subdivision roads. In this example, every extra 0.1' of topsoil removal produces approximately 100 c.y. of net fill.

Prompts

**Topsoil File to Read** Specify a topsoil file.
**Topsoil dialog** Choose your options.

**Keyboard Command:** topsoil

**Prerequisite:** None

**File Name:** \lsp\eworks.arx

### Assign Template Point Profile

This command assigns profile (.PRO) files to template point ID's like EP (edge of pavement), SH (shoulder) or DL (ditch line), storing this information in a template point profile (.TPP) file which can be used by the *Process Road Design* and *Road Network* commands. The purpose of the profile assignments is to allow separate profiles for template points that are independent of the centerline profile. For example, a ditch grade could have a different profile than the centerline. Multiple template point profiles can be assigned so the amount of control is unlimited. The Template Point Description corresponds to the name set in the *Design Template* command.

If you want the template ID point to follow a special slope or vertical alignment, use Assign Template Point Profile. The combination of using template point centerlines and profiles applied to particular template ID points is a design method sometimes referred to as "strings", where template elements string along special horizontal and vertical alignments. The rules of the template in terms of distances and slopes to the next point in the template will resume after the template point centerline and profiles are applied.

**Prompts**

First you are prompted to create a new Template Point Profile (.TPP), or edit an existing one.

Next the Define Template Alignments dialog is presented, showing a list of existing Template ID-Profile assignments. To add a new assignment, first pick the Set button to set the Reference Template file (.TPL), then pick the Add button. This brings up the Template Point Profile Settings dialog. First, pick a Template Point Description from the List, which is derived from the components defined in the Template. Next, pick the Specify Profile File button, to choose the file (.PRO) to assign to the Template Point ID. Enter the Station range to Apply the assignment, select the Station Reference, specify if this assignment is for the Left, Right, or both sides of the main centerline, and
finally specify the method to apply the assignment. Since the template ID profile can change the relative position of the template ID from the centerline, you have two options for how to fit in the template ID profile: Hold Offset or Hold Slope. Hold Offset will keep the same offset for the template ID and adjust the slope to the template ID. The Hold Slope will keep the same slope to the template ID and adjust the offset to reach the template ID profile elevation. Use Hold Offset when Template Point Profile is used in conjunction with Template Point Centerline, where a single template ID is defined to follow both a special and distinct horizontal alignment (centerline) and vertical alignment (profile).

Pick OK. Back in the Define Template Alignments dialog, pick Add to add another assignment, Edit to edit an existing assignment, Delete to delete a defined assignment, or Save to Exit.

Now Process the road design employing the newly defined Template Point Profile assignment. This is the Process Road Design main dialog. Pick the Template Point Profile button to select the new file (.TPP). You could also create a new Template Point Profile file directly from this dialog box.
Viewing the road sections with the *Input-Edit Section File* command on the Section menu shows the effect of the Template Point Profile assignment.

**Keyboard Command:** tppset  
**Prerequisite:** Profile file (.PRO)
Assign Template Point Centerline

In roadway design situations involving varying pavement widths, the only effective way to control the edge of pavement positions is through the use of Assign Template Point Centerline. This command assigns centerline (.CL) files to template ID points, independent of the main centerline, thereby controlling the horizontal location of the edge of pavement. The assignment of Template ID points to centerline files (.CL) is stored in Template Point Centerline files (.TPC). These files are then used by the Process Road Design and Road Network commands. The slope to these template points is based on the parameters defined in Design Template. Subgrades can be made to follow template IDs if their offset distances are defined not by distance but by reference to the template ID.

Prompts

First you are prompted to create a new Template Point Centerline file (.TPC), or edit an existing one.

Next the Define Template Alignments dialog is presented, showing a list of existing Template ID-Centerline assignments. To add a new assignment, first pick the Set button to set the Reference Template file (.TPL), then pick the Add button. This brings up the Template Point Centerline Settings dialog. First, pick a Template Point Description from the List, which is derived from the components defined in the Template. Next, pick the Specify Centerline File button, to choose the file (.CL) to assign to the Template Point ID. Finally, specify if this assignment is for the Left or Right side of the main centerline. Pick OK. Back in the Define Template Alignments dialog, pick Add to add another assignment, Edit to edit an existing assignment, Delete to delete a defined assignment, or Save to Exit.
Now Process the road design employing the newly defined Template Point Centerline assignment. This is the Process Road Design main dialog. Pick the Template Pt Centerline button to select the new file (.TPC). You could also create a new Template Point Centerline file directly from this dialog box.

Pick OK to Process the road design.
Here are two sections along the roadway, illustrating the varying lane widths on the right side of the main centerline. They are viewed with the Input-Edit Section File command on the Section menu.
**Keyboard Command:** tpcsset  
**Prerequisite:** Template file (.TPL), secondary Centerline file(s) (.CL)  
**File Name:** \lsp\eworks.arx

## Process Road Design

The primary function of this command is to assemble all of the components for a road design and process them together. While all of the Input Files can be created prior to accessing the Process Road Design command, all can be edited from the Road Design Files dialog, and many files can actually be created from the Road Design Files dialog itself. The actual processing of the Road Design essentially applies the design template at the design profile elevation along the specified centerline and computing the outslopes and earthworks relative to the existing ground surface. The earthworks report can be shown in the standard report viewer or customized with the Report Formatter option. Secondary functions include creating a final grade section file for plotting with the *Draw Section File* command, creating final grade points in a coordinate file, creating a final surface/contour model, and drawing the road as 3D polylines. You can also output a mass haul diagram profile. The program also has options for applying a superelevation file, template transition file, template point profile, template point centerline, rock section file, an as-built existing section file and a topsoil removal file. *Process Road Design* can be used not just for final road design computations but for levees, channels and any template-based application.

This command begins with the dialog shown below. The top section contains input Files. In a typical implementation of this command, you will have already defined a horizontal centerline for the design to follow, however, you could actually pick the Centerline button, pick the New tab, name the new centerline file (.CL), pick Open, and then back in the main Road Design Files dialog, pick the Edit button and layout the centerline design. The only component that you must have already created before running Process Road Design is #4, an Existing Surface file. As long as there is an Existing Ground Surface, the command will generate the Existing Ground Profile automatically, and the Proposed Finish Grade Profile can be created with the Edit button. Even a Design Template can be created right from here as well. Ultimately, the top 3 Input items (Centerline, Design Profile, and Design Template/Series) are required to Process a Road Design, leading to final sections and full contouring and 3D viewing. The Existing Surface is needed as well to process with earthwork calculations and tie slopes.
Input items 5 through 11 are strictly optional design files. It should be pointed out that items 8 and 9 (Template Point Profile and Template Point Centerline) enable template IDs to follow any defined centerline or profile and provide total flexibility of design. Lane widening, matching existing curb lines, special ditches, etc. can be easily accomplished with these two options. The template IDs simply "string along" or follow these pre-defined alignments, and the rules of the template apply to all other template ID points.

The Output Files section allows you to specify files to store the processing results. The Section File creates a final grade section file that can be drawn with Draw Section File. The Topsoil Section File creates the modified existing ground section file if Topsoil Removal is set in the input. This "post-topsoil removal" section file can be used for earthworks calculations to compare any stage of work, using Calculate Sections Volume under the Section pulldown menu. The Coordinate File creates a coordinate file containing every break point in the final grade. The point descriptions include the station, offset and template ID. Whether to include the subgrade points as well as the final surface points is determined by the Include SubGrade Points in Output CRD File option on the next dialog. To the right of the Output Files is the option to create new output files or append to existing output files. If you extend the road, or revise a portion of the project, you can simply "Append" rather than overwrite. The first time that you run this command for stations 0-1000, you would set Output Files to New. Then you could run this command again, possibly with new inputs, for stations 1000-2000 and set Output Files to Append.

On the next dialog, there is a Save Settings button to store all the settings from the first and second dialogs into a specified Road Design File with an (.RDF) file extension. Recorded (.RDF) files can be recalled later using the Load Settings option.

1> Centerline

Specify the name of the Centerline file with this option. The (.CL) file contains the horizontal alignment geometry for a project. This parameter file must be specified if you want to have earthworks centroid corrections computed, generate final coordinates, Disturbed Area Polyline, and/or use Triangulate & Contour. The centerline file can be
created by the *Design Centerline* or *Polyline to Centerline* commands in the Design pulldown menu.

![Example Centerline](image)

**2> Design Profile**

Specify the design profile (.PRO) file to derive the centerline elevations when the template is applied. This file defines the vertical alignment and is always required. The profile can be created with any of the profile creation routines in the Profile menu, but typically you would use *Design Road Profile* or *Input Edit Profile*.

![Example Design Profile](image)

**3> Design Template/Series**

Specify a template definition (.TPL) file or template series (.TSF) file that defines the final grade offsets and elevations and the cut/fill slopes. The template file is created by the *Design Template* command and the template series file (a set of templates ordered by range of stations) is created using *Input-Edit Template Series*. A single template file or a template series file is required to run *Process Road Design*. 
4 > **Existing Surface**

Specify the surface model which will be treated as the existing ground for cut and fill volumes and to calculate the outslope intersections when the template is applied at the profile elevations. This Existing Surface can be defined by either a section file or triangulation. The section file can be created with commands such as *Sections from Surface Entities*, *Input/Edit Section File*, *Sections from Points* or one of the *Digitize Sections* commands on the Section menu. The triangulation file can be created with the *Triangulate & Contour* command.

![Example Existing Sections](image)

5 > **Rock Section File**

This option specifies an optional rock section file that is used as an additional surface. When in cut, a special cut slope is used up to the intersection of the rock surface. After this intersection, the normal cut slopes apply. The special rock cut slope is specified in Design Template under the cut options. If the "pivot point" in cut is below the rock line, then the special rock cut slope will be applied. Note that rock sections can be derived from borings to rock, as modeled, or can be created quickly by using the "translate" command within *Input-Edit Section File* to translate the existing ground sections by a vertical offset (e.g. -6) to an approximate top of rock.

![Detail of rock cut slope](image)
6 ➤ Template Transition File

Specify a .TPT file with this option. The Template Transition file allows modified template files to be applied at
different ranges of stations on a project. In this way, template IDs can be made to widen (as for passing lanes) and
contract. Use the Template Transition command under the Design menu to create a template transition file.

7 ➤ Super Elevation File

This option is used to specify a super elevation file (.sup file) that defines the super elevation transition stations on a
project. The super elevation file can be created with the Input-Edit Super Elevation command.

8 ➤ Template Point Profile

This option lets you have separate profiles for template points that are independent of the centerline profile. This
design file is created with the Assign Template Point Profile command.

9 ➤ Template Point Centerline

This option lets you have separate centerlines for template points that are independent of the main centerline. This
design file is created with the Assign Template Point Centerline command.

10 ➤ Topsoil Removal

This option applies topsoil removal and/or replacement to the existing ground section file. This design file is create
with the Topsoil Removal/Replacement command.

11 ➤ As-Built File

The As-Built File is a cross section file used to match existing grade and retain as-built portions of a road improve-
ment project. The final cross sections will conform to the as-built cross sections for those template IDs specified in
the second dialog. Beyond the specified set of offsets in the as-built cross section file, the design road files will be
applied.

12 ➤ Output Design Section File

Specify the name of the file to output the final grade sections calculated by applying the template file at profile
elevations and calculating the outslope intersection with the existing ground cross sections. This file can then be
plotted by using the Draw Section File command. After plotting the final sections overlaid on the existing sections,
revisions can be made graphically with commands like PEDIT and Polyline by Slope Ratio. The data output to
the file can also be edited and reviewed with the Input-Edit Section File command. If the final sections are edited
graphically, the revised section data can be updated in the .SCT file with the Polyline to Section File command.
13 Output Existing Section File

This option creates a section file of existing ground. This applies when the existing surface is a triangulation file. The station intervals for the existing section file will match the stations from the design section file.

14 Output Topsoil Section File

This option writes out a modified existing ground section adjusted by the topsoil removal. This option is only valid if a Topsoil Removal file is being used.

15 Output Coordinate File

This option creates a coordinate file containing every break point in the final grade for the range of processed stations. Using the second dialog, there are additional options to output subgrade and ditch/berm points. The point descriptions include the station, offset and template ID. The station interval is set by the stations in the Existing Section File.

16 Output Mass Diagram File

The mass haul diagram can be output as a profile file and shows the cumulative cut and fill along the selected range of stations. Cut and fill is balanced between points on the mass haul profile that cross the Z-axis. Because of the typically large values of cut and fill associated with road and earthwork projects, the vertical scale for the profile may need to be set to 10 times the horizontal scale, or more. The profile preview screen which appears when you select profile for loading will show the elevation range and help suggest an appropriate vertical scale.

Running the Road Design Job

After setting up the files and options in the first dialog click the OK button. The next dialog shown below has processing options.

In the Process Options section, the Range of Stations to Process field sets the range of station that you want to calculate. Each time you use this command, the existing grade (.SCT) file is scanned and the range in the edit box
is set to the minimum and maximum stations in the file. If you change the station range, you can click the Full Range button to restore the default full range of stations. The Settings button will interpolate additional existing cross sections (internally) and create final cross sections at special stations like profile high and low points, profile transition stations for PVC and PVT, key centerline points like PC's and PT's, and superelevation and template transition points and any user-defined special stations. These additional station improve volume calculations.

The Edit Design Sections Before Final Processing does just that. You can review and edit the final sections in the spreadsheet with graphic view editor similar to the Input-Edit Section File command. For example, you can change the tie slope as selected stations. After making these changes, the modified final sections are used for the rest of the road design process including earthworks and drawing output.

The Station Interval and Existing Section Max Offset buttons are ghosted if the existing surface is a set of cross sections. If there is no existing surface, or the existing surface is a grid, TIN or FLT file, then you must enter the Station Interval to generate sections along the centerline. Besides the stations at interval, sections can be created at special stations as specified under the Settings button. The Existing Section Max Offset controls the max left and right offsets for generating the existing sections when the Existing Surface is defined by a triangulation file. This offset needs to be set far enough for the final sections outslopes to tie into existing. On the other hand, keeping this offset fairly close to the tie point will help make processing run faster.

The Calculate Centroid option applies to centerlines containing curves. The centroids of the cuts and fills will be computed, and the radius to these centroids will be calculated. Then the effective interval will be computed between cut and fill centroids. In this way, in a tight curve where fill is concentrated to the outside of the curve and cut is concentrated to the inside of the curve, fill will be increased and cut will be reduced. This also increases the accuracy of volume calculations.

The Template ID for Profile allows the profile grade to be applied to another template ID point other than the centerline. This feature might apply, for example, to a 2-lane road that will eventually be part of a 4-lane road being built in stages. The first-stage, 2-lane road would be fully symmetrical and designed around the crown of the road, but the template profile might be one of the edge of pavements. You can specify the template ID (e.g. EP), and whether the left or right side ID should be used to apply the profile grade.

Volumes are calculated using end areas between the range of stations. Instead of cutting off the volumes exactly at this range, the Ending and Starting Stations for Cut and Fill can be used to have the volume taper from zero at the specified Starting Station to the volume at the first station in the range. Likewise the Ending Stations can be used to taper the volume from the last station in the range to zero at the specified Ending Station.

The Shrink and Swell Factor edit boxes allow you to specify a value that the volume calculated will be multiplied by. If you specify any number other than one an additional report showing accumulated adjusted volumes and differences will be produced.

The Vertical Offset of Profile edit box will place the template at the profile grade as raised or lowered by the entered offset. The Horizontal Offset of Template will shift the template left or right on the centerline by the specified amount. Use a positive value to offset to the right and use a negative value to offset left. This option is useful, for example, when one side of a divided highway is built years before the other side is to be started. In this case, you could define a normal template with a crown in the middle, but would enter a horizontal offset from the crown of the road to the actual centerline of the divided highway.

The Report and File Output Options include settings for reporting final coordinates (if specified in the previous file output dialog), as well as special features.

The Report Precision controls the number of decimal places.
The **Use Report Formatter** option allows you to customize the fields to report and their order. It also can output the report to MS Excel or databases.

The **Report Subgrade Areas** option will include an additional line in the report for the end area of each subgrade material.

The **Report Centroids** toggle controls whether the shift in the cut or fill centroid radius shift will be included in the earthworks report.

The **Report Cut/Fill Text** option greatly expands the size of the report by presenting the cut and fill end areas at each station. A sample of the cut/fill text report is shown below. Volumes by end area method are presented between each line containing station and end areas of cut, fill and optionally rock.

<table>
<thead>
<tr>
<th>Station</th>
<th>Cut(sf)</th>
<th>Fill(sf)</th>
<th>Rock(sf)</th>
<th>Interval</th>
<th>Cut(cy)</th>
<th>Fill(cy)</th>
<th>Rock(cy)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3+00.00</td>
<td>0.00</td>
<td>101.07</td>
<td>0.00</td>
<td>50.00</td>
<td>313.78</td>
<td>93.58</td>
<td>0.00</td>
</tr>
<tr>
<td>3+50.00</td>
<td>338.88</td>
<td>0.00</td>
<td>0.00</td>
<td>6.09</td>
<td>80.93</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3+56.09</td>
<td>379.10</td>
<td>0.00</td>
<td>0.03</td>
<td>43.91</td>
<td>824.60</td>
<td>0.00</td>
<td>31.84</td>
</tr>
<tr>
<td>4+00.00</td>
<td>634.92</td>
<td>0.00</td>
<td>39.12</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The **Report Cut/Fill Differences** option will report the cut/fill ratio and balance at each station.

The **Report Final Station-Offset** option will create a report of the final section offset-elevation data in row-column format. The station and profile grade are shown on the left followed by columns of offset and elevation for each data point. There are options to report the surface points only, the subgrade points only or filter the points by ID.

**Write SMI Chain File** creates a chain (.CH) file that contains the centerline, profile and template data for SMI Construction V.

The **As-Built IDs to Use** option applies only if you have specified an as-built section file as one of the inputs in the previous dialog. Consider a normal road template with 20 feet to edge of pavement (EP) and 10 feet more to shoulder (SH). Going further, assume that when you run this template, it does a fill condition on the right and creates a TIE point. If you wanted to conform the template to match a wider section of road at certain stations, you could edit the output file of a normal run (using Input-Edit Section File) and create new offsets and subgrade points for widening and even force a trapezoidal ditch in cut, as shown in the entries below:

<table>
<thead>
<tr>
<th>Offset</th>
<th>Elevation</th>
<th>Description</th>
<th>Ratio(1)</th>
<th>Slope(%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>21 330</td>
<td>1996.350</td>
<td>EP</td>
<td>-50.00</td>
</tr>
<tr>
<td>13</td>
<td>21 330</td>
<td>1995.320</td>
<td>SUBGRADE1-3</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>31 500</td>
<td>1996.544</td>
<td>SH</td>
<td>-25.00</td>
</tr>
<tr>
<td>15</td>
<td>21 330</td>
<td>1996.350</td>
<td>SUBGRADE1-4</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>39 600</td>
<td>1992.394</td>
<td>DD</td>
<td>-2.00</td>
</tr>
<tr>
<td>17</td>
<td>40 000</td>
<td>1992.394</td>
<td>BD2</td>
<td>Flat</td>
</tr>
<tr>
<td>18</td>
<td>45 000</td>
<td>1995.394</td>
<td>TIE</td>
<td>2.00</td>
</tr>
</tbody>
</table>

Because all the other offsets to the left match by default, this editing will force the template to conform from offsets 21.33 right to the tie at 46 right. As you try different design template or other changes in **Process Road Design**, this as-built information would hold for the specified station. Alternately, you could edit the final cross section directly in Chapter 13. Roads Menu 498.
**Input-Edit Section File.** Note that you can use distinct, new ID points like BD2 which are not found in the template file, and they will be created if part of the as-built cross section file, and if referenced as *As-Built IDs to Use.* This As-Built method works best when inserting controlled section defined from TIE left to TIE right, which get inserted as completed sections in a run of Process Road Design.

The *Output CRD File* options apply when a Output Coordinate File is specified in the first dialog. These options allow you to output any combination of template surface, subgrade, ditch and berm points. The *Output CRD To Use Sta-Off Desc* option sets whether to include the station and offset in the description for each point. Here are example coordinates for station 0+90:

<table>
<thead>
<tr>
<th>PtNo.</th>
<th>North(y)</th>
<th>East(x)</th>
<th>Elev(z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>122</td>
<td>189497.42</td>
<td>611730.32</td>
<td>90.01</td>
<td>TIE 0+90.00L53.65</td>
</tr>
<tr>
<td>123</td>
<td>189461.43</td>
<td>611733.72</td>
<td>108.09</td>
<td>SHD 0+90.00L17.50</td>
</tr>
<tr>
<td>124</td>
<td>189457.45</td>
<td>611734.09</td>
<td>107.93</td>
<td>CURB3 0+90.00L13.50</td>
</tr>
<tr>
<td>125</td>
<td>189456.95</td>
<td>611734.14</td>
<td>107.93</td>
<td>CURB2 0+90.00L13.00</td>
</tr>
<tr>
<td>126</td>
<td>189456.95</td>
<td>611734.14</td>
<td>107.09</td>
<td>CURB1 0+90.00L13.00</td>
</tr>
<tr>
<td>127</td>
<td>189455.96</td>
<td>611734.23</td>
<td>107.09</td>
<td>EP 0+90.00L12.00</td>
</tr>
<tr>
<td>128</td>
<td>189444.01</td>
<td>611735.36</td>
<td>107.33</td>
<td>CENTER 0+90.00R0.00</td>
</tr>
<tr>
<td>129</td>
<td>189432.06</td>
<td>611736.49</td>
<td>107.09</td>
<td>EP 0+90.00R12.00</td>
</tr>
<tr>
<td>130</td>
<td>189431.07</td>
<td>611736.58</td>
<td>107.93</td>
<td>CURB1 0+90.00R13.00</td>
</tr>
<tr>
<td>131</td>
<td>189431.07</td>
<td>611736.58</td>
<td>107.93</td>
<td>CURB2 0+90.00R13.00</td>
</tr>
<tr>
<td>132</td>
<td>189430.57</td>
<td>611736.63</td>
<td>107.93</td>
<td>CURB3 0+90.00R13.50</td>
</tr>
<tr>
<td>133</td>
<td>189426.59</td>
<td>611737.00</td>
<td>108.09</td>
<td>SHD 0+90.00R17.50</td>
</tr>
<tr>
<td>134</td>
<td>189412.18</td>
<td>611738.36</td>
<td>100.85</td>
<td>TIE 0+90.00R31.97</td>
</tr>
</tbody>
</table>

The **Drawing Output Options** bottom section of the Additional Earthworks Parameters dialog contains output options which are only available when a centerline file is specified.

The *Triangulate & Contour* option will automatically run this command after Process Road Design is done to create the final contours. Triangulate & Contour uses the template 3D polylines to model the final surface, and the disturbed area polyline is used as the inclusion perimeter for the contours. With Triangulate & Contour clicked on, the *Setup* button becomes active. Picking Setup brings up the Triangulate & Contour settings including the contour interval and whether to draw 3D Faces. Also under Setup, there are controls for the colors of the 3D Faces for each template break point. With Triangulate & Contour active, Draw Template Polylines and Draw Disturbed Area Polyline are automatically turned on. The *Merge Road With Existing* option combines the road design triangulation with the existing ground surface and stores the resulting triangulation in the file specified with the Set button. This option is available when the Existing Surface is a triangulation file and the Triangulate & Contour option is active.

The *Erase Previous Road Entities* option will erase any entities from the drawing that were created in a previous run of Process Road Design using the same design files. This option allows you to easily re-run Process Road Design and update the drawing entities after changing one of the road design files.

The *Draw Cross Section Polylines* option will create 3D polylines perpendicular to the centerline with each template break point. The interval of these cross section polylines is determined by the station interval of the Existing Sections.

The *Draw Template Polylines* option will create 3D polylines parallel to the centerline by connecting common template point IDs. For example, a template ID could be EP which this option would use to create 3D polylines for EP on the left and right of the centerline. Which template point IDs to connect in set under *Template IDs to Draw.* Setting this to an asterick (*) will plot all the template break points. The *Select* button shows cross sections of the final templates for graphical selection of the ID's to draw.
Likewise, the *Draw Subgrade Polylines* option will create 3D polylines parallel to the centerline for the specified subgrade breakpoints.

The *Draw Disturbed Area Polyline* option will create a polyline perimeter that represents where the cut/fill slopes tie into the existing ground.

The *Draw Slope Direction Arrows* option will draw arrow indicators for cut or fill slope direction. The arrows are drawn in plan view and usually are drawn together with the Draw Disturbed Area and Draw Cross Section Plines options. Cut arrows start from the disturbed area limit and point towards the centerline. Fill arrows start from the base of the fill slope and point away from the centerline. The *Solid Cut Arrows* option chooses between solid fill or wire-frame cut arrows. These arrows, especially when drawn as solid cut arrows, help distinguish cut and fill at a glance, when in plan view. In the example below, fill from a berm is shown at the left and cut down to a ditch is shown at the right. The arrows will only draw if there is enough dimension in the cut and fill to fit the entire arrow. So the cut and fill arrows reveal the deeper cut and fill zones.

![Diagram of arrows indicating cut and fill slopes](image)

**Prompts**

**Road Design Files dialog:** Choose the design files

**Additional Road Design Parameters**

**Road Design Report dialog**

Trim existing contours inside disturbed area (Yes/No)? Y This prompt appears if Triangulate & Contour is on. This option will trim polylines with elevation that cross the disturbed area perimeter for the road.

Join final contours with existing (Yes/No)? Y This prompt appears if Triangulate & Contour is on. This option will join the final contours with the existing contours where they join at the disturbed area perimeter.

Portion of Earthworks Report:

Template File> C:\DATA\simo2.tpl
Profile File> C:\DATA\rd.pro
Existing Section File> C:\DATA\simo2.sct
Centerline File> C:\DATA\simo2.cl

Processing 0+25.000 to 7+51.152
Total Cut : 800563.177 C.F., 29650.488 C.Y.
Total Fill: 1554948.266 C.F., 57590.677 C.Y.

Station Cut(sf) Fill(sf) Interval Cut(cy) Fill(cy)
Portion of Final Station-Offset Report:

<table>
<thead>
<tr>
<th>STATION</th>
<th>P.G.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2+50.000</td>
<td>1013.444 59.619 18.000 12.000 0.000 12.000 992.634 1013.444 1013.204 1013.444 1013.204</td>
</tr>
<tr>
<td>2+75.000</td>
<td>1015.059 65.772 18.000 12.000 0.000 12.000 991.173 1015.059 1014.819 1015.059 1014.819</td>
</tr>
<tr>
<td>3+00.000</td>
<td>1016.499 71.547 18.000 12.000 0.000 12.000 989.725 1016.499 1016.259 1016.499 1016.259</td>
</tr>
<tr>
<td>3+25.000</td>
<td>1017.764 76.733 18.000 12.000 0.000 12.000 988.398 1017.764 1017.524 1017.764 1017.524</td>
</tr>
</tbody>
</table>

Existing Contours and Centerline
3D template polylines, disturbed area perimeter polyline and final contours

3D template polylines and final contours viewed in 3D using Viewpoint 3D command

**Review of 3 Methods of Transitioning Templates using Process Road Design**

The 3 methods of template transitions and super elevation are:

1. Template Transition and/or Super Elevation Files
2. Template Point Profile and Template Point Centerline files
3. Template Series file which transitions between multiple, named templates.

Road widening and lane transitions can be handled by all 3 methods. Special ditches are best handled by method (2), Template Point Profile and Template Point Centerline, especially since Template Transition files only work with
lanes or portions of roads defined by the Grade button in Design Template. Template Transition files do not apply to cut and fill segments, unless they are designed as fixed features using the Grade button. Super elevation can often be handled by method (1) or method (3). Bear in mind that new lanes or template elements that emerge and then disappear need to exist as template ID points in all referenced templates, using all 3 methods. These template ID points can be set to 0.001 units from adjacent template points, then "told" to emerge and widen as new lanes with distinct slopes appear. The program will not transition templates that don't share common template ID points.

This deceptively easy looking example below might be approached by a combination of methods 1 and 2. For method 1 to apply (template transition), the slopes of the pavement lanes must be maintained according to the template definition from centerline to outside lane. The ditch portion will be handled by method 2 (template point centerline).

Assume Spouts Springs Road is a hillside road with a ditch cut on the left side and fill on the right side. The trapezoidal ditch is shown. We will design only from station 4+00 to station 6+94 where the intersection begins. The standard template of 10' left lane and 10' right lane might appear as shown below:

Note that if lanes are designed to expand, it's important that the subgrade (9" of paving, shown above) be defined as following the ID, and should not be set to a fixed distance. The "EP" ID is used in the dialog below (top of subgrade dialog within Design Template) for this example.
The right hand portion of this example would be entered as follows:

When you click "Add" within the Template Transition main dialog, you are presented with the above screen. Template transitions require that you specify the correct side of the road in the lower left, then click the Grade or lane to alter, which is the first lane on the right, which is set to 13.73 according to the plans. To make sure the lane is fully expanded from the standard 12 to the 13.73 at station 400, it is necessary to set the "Begin Transition Station" to something less than 400, as shown. Then if this "expanded" lane width does not transition back to standard 12 width, but changes again, you must click on "Link to next transition" and leave the "End Full Template" and "End Transition" stations blank. Then you click "Add" again for the final segment, which would be entered as shown:
First, you specify "Side to Apply" as "Right", then click the pavement lane and edit it to 30’, as shown above. Referencing the plan view drawing for Spouts Road shown above, you transition from station 451.67 to the new 30’ road lane width at station 556.69 and hold that to the "End Full Template Station", which is 694.00. Then you can enter an "End Transition Station" just past the end of the key station range, which internally would transition the template back to a standard width of 12’ at 694.01 (a moot point as the end of the project is station 694 for this exercise). The key to template transition is that it is designed to transition from normal to expanded or reduced dimension, then transition back to normal. It is ideal for use in passing lanes that appear and then transition back, but requires use of "Link to next transition" to handle a sequence of lane width changes as above. Therefore, where lane widths change often, and don't transition back to the normal template lane width, it is often best to use Template Point Centerline as the method of lane transitioning. We will apply that below to the ditch line.

When the template transition process is repeated for the left driving lane, you obtain a final Template Transition dialog as shown here:

For the left side, the first screen just starts things up by establishing 10.28 as starting left side dimension, then the "Link to next transition" option is used, and the width of 18 is entered, transitioning to 18 at station 554.21 and
holding that to an end station of 764.34, transitioning "back" to 12 at the fictitious 764.35, well beyond the 400 to 694 station range of interest. When this template transition file is run in Process Road Design and Triangulate & Contour is turned on within Process Road Design, the output clearly shows that the lane transitions have followed the lane expansions correctly:

However, it is easy to see that the "design ditch" on the left side of the road, at 2' wide, did not conform to the special ditch which hugs the shoulder at station 7+00 but transitions to further off of the shoulder at 4+00. This special ditch is best handled with Template Point Centerline. To complete the special ditch design, use Polyline to Centerline File on both ditch polylines, calling the inside polyline BD1.CL and the outside polyline BD2.CL, as a reference to the ditch IDs, BD1 and BD2. You can give them a starting station of 0. The stationing of the ditch polyline does not matter, since only the coordinates of the centerline in the command Assign Template Point Centerline are used to determine the template ID position. Within Assign Template Point Centerline, Add each of the ditch sides as shown:

Note that if the ditch always exists on the left side, the ditch grades can be defined using the Grade button in Design Template, rather than using the Ditch feature within the Cut button. For final results, run the Process Road Design command using a combination of the Template Transition File and the Template Point Profile.

The end result is a final drawing that uses the Template Transition file to create the correct edge of pavement and uses the Template Point Centerline file to track along the correct ditch polylines. This is shown below in the final drawing of the 3D polylines generated by Process Road Design:
The actual slope to the ditch on the left is held at the design of 3:1, or whatever exists within the template from shoulder (SH) to base of ditch (BD1) in cut. Shown below in the Input-Edit Section File screen editor is station 6+50, where the ditch is designed very close to the shoulder:

Note that the distance from BD1 to BD2 is irregular, based entirely on the plan view offset of the ditch polylines. Note also that BD1 to SH is 3:1, holding the defined slope. (The cursor position also can be used to verify slope of any portion of the section in "real-time"). Finally, note that the subgrade follows the widening and irregular position of the pavement lane EP for both left and right sides, since the subgrade offset from centerline was defined as EP.

Although superelevation can be handled by use of superelevation files, for most simple applications (2-lane roads in particular), a single curve with superelevation can be handled by a template series file, using only 3 templates: normal crown, reverse crown, full super. This is illustrated below, for a typical 2-lane road template:
The actual Template Series File will consist of 6 entries for one curve: Normal, Reverse, Begin Full Super, End Full Super, Reverse, Normal. You would only need to make one extra template, for simple roads, for every additional curve, for the full super condition, since normal and reverse crown remain the same. Note that the curbs, even on the high side, can be designed to slope downward and catch the shoulder drainage in Design Template by use of "special slope" of -1% in the curb design, or by entering a value for the added "Drop" across the gutter portion. Both methods create a downhill slope to the face of curb. So the above project might be designed as shown below in the Input-Edit Template Series command:

![Input-Edit Template Series File](image)

Note that beginning and ending stations are not necessary. If station 0.00 was omitted, Process Road Design would use the normal template in any case from station 0 to 250. Similarly, Process Road Design will use the normal template going forward from station 900 automatically.

**Review of 2 Methods of Matching Portions of Existing Roads**

There are two main techniques for tying new template designs into existing roads, which may apply to road expansions, urban re-paving, grade improvements and other renovation projects. As more and more roadwork involves road improvement rather than new road development, these techniques become more useful and critical to master.
The two techniques are: (1) Use of Template Point Profile and Template Point Centerline files to match existing conditions on portions of roads that do not change, and (2) Use of the "As-Built" cross section feature as one of the input files. An advantage of the As-Built method is that you can insert section points with special IDs for special features, whereas the Template Point Profile and Template Point Centerline methods must follow template IDs that are found in the original, main template design file. But the Template Point or "string" method allows for calculating sections at any interval, while the As-Built section method will revise final sections only at stations found in the As-Built section file.

Consider this alley-way, which consists of a Belgian block style curb (no gutter) that is already in place. The plans are to remove a crowned asphalt alleyway and put in a bricked alleyway on sand, with a central, "depressed" rock drain of 1’ width, to avoid water draining against buildings that abut the alley. But the design must match an existing "Belgian block" style curb on the right side of the road, which will not be removed.

There is a new profile design involved, and a new template. However, the right side of the template will meet the exact grade and offset of the in-place curb, which has been surveyed as back of curb (CB3). Then the command Offset 3D Polyline was used to create the face of curb at EP=CB1, and to create the inside top of curb (CB2). Because of the symmetry and consistency of the curb, only the back of curb needed to be surveyed to hold the existing curb feature in place within Process Road Design. From that survey, the 3D Polyline for the EP is derived, which will be used for Template Point Centerline and Template Point Profile.

Features such as curbs and medians can be designed once within Design Template and then saved as curb or median files, then re-loaded and used in other templates, and applied to the left or right side of the template as desired. The central rock median of 1’ total width can be constructed as two subgrades, one on the left side of 0.5’ width and one on the right side of 0.5’ width. The brick portion can be designed as a 4” thick subgrade as shown below. On the left side, you would need to use the "Straight Up" method of closing the subgrade surface. On the right side, you can use "Continue Slope". When using Continue Slope, it is best to underestimate the length needed to contact the next surface (the right curb), so continue can do an "extend" and find it. If you make the length too long (e.g. 6’, which catches the curb which itself tilts back -2%), the program will not trim and will draw the subgrade to the back of the curb. Note that the vertical subgrade depth can be entered as 4 or -4. Both are accepted.
Be sure to define the sand subgrade on the right side (lowest subgrade) to have a distance of EP, a flexible distance that follows the precise offset of the EP "ID", which will be assigned to follow the face of curb template point profile defined by CB1 above.

The next step is to set up the face of curb 3D polyline as a template point centerline and template point profile assigned to "EP". First you must do Polyline to Centerline File, pick the inner 3D polyline which is face of curb at proposed road level. Then you must do Profile from 3D Polyline and make a profile for the "EP". Then you assign this centerline and profile to the appropriate ID (EP) to force the curb to contact the correct curb position and elevation. The curb defined in the template matches the pattern of the in-place curb, so by setting EP to the correct template centerline and profile, the curb will "follow" at the correct position. The stationing used for the template point centerline is not critical to the calculation. However, the profile stationing much match and reference the centerline stationing. Therefore, when doing the command Profile from 3D Polyline, answer Yes to the question: "Station by another reference centerline [Yes/<No>]". Making the Template Point Profile is always best accomplished by this method of Profile from 3D Polyline, referencing the design centerline. The Template Point Profile (and Template Point Centerline) would appear as shown here:
The files in Process Road Design would be set up as follows:

Note that no existing surface file is needed to compute final cross sections from as-built (straight wall on left of alley) to as-built (existing curb on right of alley). A final section is plotted below, showing the unique slope and lane distance determined by the as-built centerline and profile files that control the edge of pavement, and by extension, the curb, which continues with fixed dimensions from the edge of pavement.
A second method of doing as-built road design is to use the as-built cross section method. Whenever as-built cross sections are specified as part of the input files in Process Road Design, and then referenced for use on the Additional Road Design Parameters screen within Process Road, those offset IDs that are referenced will be held. Any matching IDs or new IDs found in the as-built cross sections will be substituted for the designed IDs within the final sections. In the example below, it might be proposed to redesign Edgemont Road from a roadside ditch road to one with a curb and gutter as well as sidewalks. However, the designer might want to keep the existing central median, already curb and gutter with plantings.

This example raises the challenging issue of inserting special interior points with new IDs into a set of design cross sections, through a length of about 125 feet of road. If a cross section of the island is taken through station 1+00, it might have the following ID points:
This cross section could then be part of an as-built cross section file (.SCT) which can be recorded at any desired station interval, the smaller the interval, the greater the accuracy. Now if the actual road template is defined as EP for edge of pavement and standard CB for curb, with CENTER for the centerline position, Process Road Design will substitute the As-Built File CENTER ID for the one calculated by the program, and will add in all the unique IDs from the cross section file, from -15.011 left to 15 right. Interestingly enough, this Edgemont Road example would also require a Template Point Centerline for the left and right edge of pavement, to pull the paving edge out to the expanded road dimension, which doesn't taper to normal until station 3+35.51. It would not require a Template Point Profile, so long as the road maintained a consistent design slope from centerline. When using Template Point Centerline, you need to turn the edge of pavement polylines into centerline files. Before doing so, test each polyline with the command Reverse Polyline (within Polyline Utilities under Edit) to verify that the polyline is drawn in the correct direction, as shown by the phantom arrows. The file Template Point Centerline elements might appear as shown:

```
<table>
<thead>
<tr>
<th>Offset</th>
<th>Elevation</th>
<th>Description</th>
<th>Ratio (%)</th>
<th>Sloped (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>-15.011</td>
<td>101.152</td>
<td>CBL1</td>
<td>0.0%</td>
<td></td>
</tr>
<tr>
<td>-13.011</td>
<td>101.152</td>
<td>CBL2</td>
<td>0.0%</td>
<td></td>
</tr>
<tr>
<td>-12.002</td>
<td>101.652</td>
<td>CBL1</td>
<td>0.0%</td>
<td>12600.00</td>
</tr>
<tr>
<td>-14.552</td>
<td>101.652</td>
<td>CBL1</td>
<td>0.0%</td>
<td></td>
</tr>
<tr>
<td>0.000</td>
<td>102.210</td>
<td>CENTER</td>
<td>-7.36</td>
<td>3.06%</td>
</tr>
<tr>
<td>12.420</td>
<td>101.671</td>
<td>ID</td>
<td>-20.23</td>
<td>-3.53%</td>
</tr>
<tr>
<td>12.844</td>
<td>101.679</td>
<td>CBL1</td>
<td>0.0%</td>
<td>12600.00</td>
</tr>
</tbody>
</table>
```

Be aware that a subgrade such as a concrete sidewalk, if it is to be placed behind the curb, must reference the curb or the edge of pavement ID for positioning, whenever the edge of pavement offset is changing based on use of a Template Point Centerline or As-Built cross section file containing duplicated IDs for edge of pavement. You can specify an offset for the sidewalk in the Subgrade option within Design Template, as shown below. The "2.52" offset
was used to move past the tilting edge of the back-of-curb, which slightly exceeds 2.50.

If the Island.sct file is the as-built cross sections, the entire input screen for the Edgemont Road project might appear as follows:

In the next dialog, fill in the descriptions for the section points in the As-Built IDs To Use field.
Here is the resulting output section file showing the combination of the design template with the as-built section points.

Example Divided Highway with Special Super Elevation Treatment
Divided highways such as 4-lane highways with a central depressed, grassy median are among the most challenging roads to define as templates, especially when accurate subgrade elevations and quantities are involved. Rules for
superelevation and subgrade pivot points must be applied. And most divided highways do not use the centerline as the profile and require shifting the profile elevation to a specific template ID, like the inside edge of pavement or crown point for each side of the highway. This shifting occurs within Process Road Design. Furthermore, many highway departments have complicated rules for the profile grade. One such rule is that in superelevation, when the pivot lane reaches reverse crown, the profile moves from the crown of the road to the inside edge of pavement. Whatever the delta Z between the crown profile grade and inside edge of pavement profile grade is at reverse crown, this delta Z is subtracted from the profile grade and determines the profile of the inside edge of pavement from reverse crown through full super and back to reverse crown again. This typically improves drainage within the median portion, since a steep superelevation pivoting from the crown of the road can either reduce the median depth, or force the median too low. This is illustrated in the graphic below. Such challenging highways can be designed using special features within Design Template and Process Road Design.

The divided highway template itself can be quite complex. Let's review the requirements of our template below, first left side, then right side, in superelevation of 4.5%.

The main criteria for the design is that the pavement lanes are 12' wide, with 2% slope from the crown point in the middle (except in superelevation). On the interior high side of superelevation shown above, the grade breaks off at the EP or inside edge of pavement, and the maximum algebraic difference is 7%. So at 4.5% superelevation, the normal 4% downhill shoulder slopes instead at 7%-4.5%=2.5%, as shown. This part of the template behavior is controlled by the Superelevation Shoulder button within Design Template, with entries as shown here:
Note that the Super Elevation Settings dialog treats the "interior" of the road in the upper part, and the exterior of the entire road (like a 2-lane road) in the lower part. So the "Low Side Pivot Point" under the lower "Transition from Super to Normal" is where, walking from the middle of the road towards the left, super ends and normal slopes resume. That is set to OSH, or the outside shoulder position, the goal being to slope the full shoulder with the superelevation on the lower outside shoulder lane, then resume normal (non-super) slope at the 6:1 "recovery zone" slope. The entry of OSH as Low Side Pivot Point for Super to Normal controls that. In the upper part of the dialog, the inside "Transition from Normal to Super" sets the Low Side Pivot Point at EP. So at EP, walking from the template center left towards the left side of the road, normal ends at EP and superelevation begins. So the median upslope of 6:1 is normal, as is the shoulder, the super starts at EP. But because the 7% maximum percent slope difference is active, the shoulder can't remain at 4% but goes to 2.5% leading to the 4.5% superelevation. When super subsides to 3% or less, the shoulder would be normal at 4% as specified in the template design in this case.

Referring to the graphic above showing the left side of the divided highway, the gravel for the shoulder is shown running out to "daylight" on the outside recovery zone and on the inside median slope. However, to reduce quantities of stone, the stone runs at a uniform slope of -2% in normal crown, or matches superelevation, but pivots to 1% downhill at the outside OEP and 4' past the inside EP. This is accomplished through the subgrade entry dialog. First, the outside subgrade:
Note that the normal slope of the stone subgrade does not follow the surface but stays at the "special" slope of -2%, matching the surface always only beneath the asphalt portion within the pavement zone. For divided highways, it is always necessary to do at least 2 subgrades for each material: one from the crown or middle of the road "out" to the outslope (as above), and one from the crown or middle of the paved portion in to the interior. Since the crown of the road on each side of the highway is 32 feet left of the center depressed median position, the horizontal offset for the "out" position is 32. Enter the vertical offset as the entire distance from the horizontal offset down to subgrade bottom. In this way, any other thinner subgrades above are deducted from total subgrade quantities of the grade under consideration. If the goal is to "force" a -1% slope in both normal crown and superelevation, then set the Max Slope After Pivot(%) to -1%, and click "Special". Then set both Standard Slope and Minimum Slope Percent to -1%. This ensure that -1% will be used at the pivot offset of OEP, or as specified. Apply this to both subgrades ("in" and "out" from horizontal offset 32). If you simply entered -1% for the Max Slope After Pivot(%) and clicked Normal, slopes on the low side would break over to -1% but slopes on the higher side of each superelevation lane (beneath inside shoulder on the left, outside shoulder on the right) would continue on at the super slope and not break off. You must use the "Special" setting. The low side shoulder for the inside portion of the left side of the road is specified by the "In" subgrade, in this dialog:
The pivot point for the subgrade on the inside left of the template is ISH+4, or 4 feet from inside shoulder to inside edge of pavement, the +4 being the direction walking out from the middle of the template in all cases. The right side of the template is shown next:

On the right side, the high-side subgrade pivot in the "out" direction, walking from the middle of the road outward, is OEP+4. On the right side, the high-side subgrade pivot in the "in" direction is simply ISH, as shown. So the controls exist to specify critical break points on subgrade and surface grades using Design Template. Whether this is the best design can be debated, but the controls are there to create surface and subgrade slope breaks and grade changes.

Referring to the Super Elevation Settings dialog above, the key to setting the superelevation of the divided highway to the inside edge of pavement at reverse crown (minus the 0.24 delta Z from profile grade to inside edge of pavement grade) is to click on the option, "Pivot Super From Low Edge".

Now you must run Process Road Design, using this template, to produce verifiable final cross sections. Set the Process Road "Additional Parameters" dialog such that "Crown" (or whatever ID is used for the center crown point on each side of the road) controls the profile grade.
The final sections that are produced will shift the profile grade to the inside edge of pavement from reverse crown to reverse crown through superelevation, adjusted -0.24'. A final section is shown plotted below as drawn using Draw Section File:

![Plot of final section](image)

**Pulldown Menu Location:** Roads  
**Keyboard Commands:** eworks  
**Prerequisite:** Profile file and template file  
**File Names:** `\lsp\eworklisp, \lsp\eworks.arx, scadewrk.dcl`

---

**Road Network**

**Function**

This command synthesizes road network design for subdivisions and commercial and industrial sites by enabling interactive 3D design of all road centerlines, profiles and templates, including cul-de-sacs. A docked dialog on the left of the screen identifying the existing DTM surface and all road files combines with an active CAD screen and command line. You can save drawings and run virtually any standard Autocad command while within the docked dialog. Once the user identifies all centerlines involved, the program detects intersections and end segments suitable for cul-de-sacs, and through user input of design parameters for cul-de-sac dimensions and intersection transitions, the program will process the complete 3D design, with output options including cross sections, 3D faces, TIN files and contours. The many roading files involved in a road network design are all saved to an "RDN" file that can be recalled, modified and re-processed.
Procedure

Step 1: Start the Road network command, and either create a new Road Network (.RDN) file, or select an existing one. If you have previously run Road Network with the current drawing the Road Network docked dialog will open with the last Road Network (.RDN) file you worked with. If this happens, but you prefer to create a new Road Network (.RDN) file, or use another existing Road Network (.RDN) file, click the Load/New button at the bottom of the Road Network docked dialog. If you wish to make a copy of the current Road Network (.RDN) file, click the SaveAs button.

If this is a new Road Network (.RDN) file, the first thing to do is to review the Settings, and be sure to have the Existing Surface set. Click the Settings button at the bottom of the docked dialog. The Road Network Settings are divided into four tabs, Process Options, Output Options, Report Options, and Transition Defaults. On the Process Options tab, pick the Existing Surface button to set the target surface for the road network to project side slopes to. Either a TIN or an FLT file are accepted as valid surfaces, both of which can be made within the command Triangulate and Contour. For speed, it is recommended that the binary TIN file format be selected. This tab is also where you set cross section processing options, including station interval through the main part of the centerlines, as well as a different value to be used going through intersections, the maximum offset from CL for existing sections to be sampled, and any special stations that you want processed. Process On Updated Centerline sets how RoadNet responds to changes in the centerline. The Network can be reprocessed Automatically, not at all, or the user can be prompted that the Road Network needs to be reprocessed. Tie to Existing controls whether or not the side slopes specified in the template (.TPL) file are applied or not.
On the Output Options tab, if you want the Road Network to generate a Surface, check Triangulate and Contour and click the Setup button to specify the Surface name and other options.

If the option to Draw Triangulation Faces is selected, the Set Colors/Layers button is selectable. The components of the templates used are shown here and their colors can be controlled. The Color By Cut/Fill Depth option colors the Triangulation Faces with a range of Reds and Blues to show areas and depths of Cut and Fill for the proposed Road Network.
The Output File Defaults button is where all Output File names are set.
The **Merge Road with Existing** option gives the ability to merge the Road Network surface into the target existing surface to create a new surface that essentially depicts the entire site after the Road Network is constructed.

**Write SurvCE Stakeout** creates a SurvCE Stakeout (.RNF) file that contains all of the information for the entire network, including all centerlines and profiles. This file can be directly loaded into Carlson SurvCE data collection software for unlimited field stakeout of the road design.

There are also options to **Draw Template Polylines**, **Subgrade Polylines** and **Cross Section Polylines**. These are typically used to generate additional surfaces for modeling, stakeout or machine control purposes.

**Draw Slope Arrows** creates arrows in the drawing to show the direction of each triangular "plate" in the Road Network TIN. This can be helpful to visualize where water will be flowing.

**Output Coordinates** generates Carlson Points for a wide array of critical locations in the Road Network. The dialog box to make selections of the desired locations for points is accessed through the Setup button.
Elevate Pads adjusts the elevation of closed polylines within a specified proximity of the Road Network, relative to the elevation of a specified point on the Road Template (Reference Template ID). In the dialog below, all closed polylines on layer PAD that are within 100 feet of the road will have their elevations set based on a 2 percent grade up from the PAVE Template ID point, in either Cut or Fill conditions. In future earthwork balancing adjustments, the polyline can be adjusted a maximum of up to a 10 percent grade or down to a 1 percent grade from the Reference Template ID.

Elevate Lots is a similar function to Elevate Pads, but acts on a set of grading rules which are stored in a Grading Rules (.GRR) file. For detailed information on Grading Rules, please refer to this topic in the Help on the 3D Data.
menu.

Review the Report Options and Transition Defaults tabs as well.
Step 2: Back in the main dialog, click "Add" in the upper left "Road Name" portion, and identify all of the main road and secondary (intersecting) road centerlines. Referring to our drawing above, we could do the full design at once or start by identifying North Road and East Road as the main roads and Paris Boulevard as the first secondary road. Note that centerlines may be picked as polylines or loaded as centerline files. All centerlines (horizontal alignments) must have, at minimum, an associated profile (vertical alignment) and an associated template. These must be pre-designed and stored, ready for recall, before executing the Road Network command. In the Road name dialog portion, select a road and click Edit to review the files. Note that by selecting Paris Boulevard and East Road, the program automatically detects the first intersect. As you follow the design below, you will see that we follow the hierarchy of the road precedence as outlined in the graphics. At every intersection, there needs to be a primary controlling road (template cross slopes are held) and secondary adjusting road (centerline profile adjusts to template of primary road at some transition distance).
Step 3: Click Process to compute the design. Based on the settings in the above "Settings" dialog, the program will Triangulate and Contour and create the drawing shown below. If you edit any road feature or dialog entry and click Process again, the program automatically clears the last Triangulate and Contour drawing and creates a new final design drawing. In this way, you can trial-and-error your design for all roads, or build the design in stages.

Viewing the file in the 3D Viewer Window command with a 4.0 vertical exaggeration, you can even see how the curb-and-gutter Paris Boulevard ends abruptly as it transitions to the roadside ditch template of East Road.
Next we can review the effect of adding Front Drive, Loop Road and West Drive into the equation. For the profile design for Loop Road and other intersecting roads, it is a good practice to use Calculate Offsets under the Centerline pulldown to compute the station of the intersection on the main road. For Loop Road, those stations are approximately 21+25 and 25+29. Then use Input-Edit Profile to load the Paris Boulevard profile and enter those stations as "Check Stations" in the lower right of the dialog, to compute the design profile at those points (1174.2 and 1158.6 respectively). These profile points can then guide the design of the Loop Road profile. After roads are added to the list, new intersections are found. When you select a road for analysis, it highlights on the drawing in plan view, as shown below.

If you click Edit after selecting Loop Road as above, you have the option to change any aspect of the centerline,
profile or template file, and you can add optional files such as road width change files and superelevation files. For example, if you choose to edit the profile, the program derives the existing grade from the existing surface triangulation file specified in Settings, and you are able to design graphically and interactively as shown:

Similar editing dialogs are offered for centerline file design and for template design, in which cases you are dropped into the full editors for those commands (Input-Edit Centerline and Design Template).

You can also more closely analyze the intersections of any road. If you select the intersection at ParisBlvd and Start:LoopRd, you obtain the multi-tab dialog:

The profile transition PVI distance takes the primary road (in this case Paris Boulevard) and extends its template crown slope 50 feet, and then connects to the next PVI on the secondary road. It works on the premise that the main road's template slope must govern. It then inserts a vertical curve of specified length at the new PVI. Since 1/2 of the vertical curve is 25 feet, the actual template slope extension from the main road reaches 25 feet from centerline. These values, inherited from the main Settings dialog, can be revised for each individual intersection.
Since we do not have a crossing intersection, we only obtain a "Front-Left" tab and a "Back-Left" tab, left being the left side of the primary road (Paris) and front being the first "curve return" treatment on the outside of the loop and back being the second "curve return" treatment on the inside of the loop. If this was a crossing intersection, you would have 2 more tabs in the dialog: "Front-Right" and "Back-Right". If you click the "Front-Left" tab, you obtain this dialog:

![Edit Intersection dialog](image)

Two edge-of-pavement alignments are intersecting, and the radius of the intersection, as defaulting from the Settings dialog, can be edited here. That covers the plan view aspect. But these edge-of-pavement points have their own profile as projected out from the governing road profile along the template. You can actually specify a vertical curve length to transition these profiles, and you can click Edit Profile to review these "curve returns" further. Clicking Edit Profile brings you to still another dialog:
By selecting Edit Template Transition, you can shorten or lengthen the transition zone by entering new starting and ending transition stations.

And finally, for any portion of the intersection transition, you can choose to output the centerline and profile for the shoulder pivot points, and the existing and final sections as centered on the pivot points.

Completing West Drive, Front Drive and South Drive leads to the following plan view and 3D view. Note that West Drive's profile should pay attention to the existing profile positions where it intersects Paris Boulevard and also North Road, or else excessive transition effects may occur. Using the Calculate Offsets command and just inspecting the intersect, you can note that it is found at station 194 of Paris Blvd and station 1125 of West Drive. At station 194, using Check Stations within Input-Edit Profile, the elevation is 1224.92. So the goal should be to make West Drive hit near 1224.92 at its station 1125. Similarly, Front Drive should closely match the elevation of Paris Boulevard as it starts and goes north, and South Drive is subject to both West and Paris. Clicking Add within the Cul-de-Sac portion of the docked dialog enables you to specify at cul-de-sac at the end of South Drive.

Clicking Process now produces the following:
A close-up view of the cul-de-sac, in 3D, reveals the detail of the design, showing a raised "fold" due to no vertical curve transition at the projected high point at the back of the cul-de-sac:

This dimple effect can easily be eliminated by lowering the elevation of the "PVI" at the projected intersect point in the back of the cul-de-sac, and by adding a vertical curve transition of, say 50'. This is done by highlighting the South Drive Cul-de-Sac and clicking Edit.
Note that now, with so many named roads and intersections, a scroll bar has materialized in the upper portions of the dialog. Clicking Edit on the selected SouthDr at End cul-de-sac leads to this dialog:

![Edit Cul-de-Sac dialog]

The first thing we do is change the Profile Transition VC from 0.0 to 50.0, as shown. Then we need to click Edit Profile to lower the profile at the back of the cul-de-sac. This profile refers to the edge-of-pavement grade.
Now, after clicking Process, the cul-de-sac has a better design:

With Road Network, you can directly input all roads and the program will sort out primary and secondary intersection priorities on its own, while providing you the option to edit these assignments within the Edit options within Intersections. The resulting DTM surfaces can then be studied for water flow using the hydrology features of Carlson Civil, cross sections and profiles can be plotted, and total road-related earthwork calculated.
Pulldown Menu Location: Roads
Keyboard Commands: roadnet
Prerequisite: Profile file and template file
File Names: \lsp\eworkd.lsp, \lsp\eworks.arx, scadewrk.dcl

Road Design Inspector

This routine takes a full suite of road files (existing and final profiles, existing and final cross sections and the centerline) and presents three graphical windows showing the road in plan view, profile view and section view, with a slide bar that lets you "drive" the road or project from start to end. In addition to applying to roads, the command applies to any set of existing and final sections that follow a horizontal alignment (centerline), such as for channels and embankments. As you move the slide bar left and right, your position is shown in profile view, in plan view and in cross section view. The cross section graphics can be scaled to fit the allotted screen space, or can be set to a scale such as 1H:1V or set to exaggerated scales (2H:1V up to 10H:1V).
The current station is displayed as you move the slide bar. You can zoom and pan the cross section view, and you can also enter a specific station to study. Stations that do not exist in the cross section files will be interpolated.

Pulldown Menu Location: Roads
Keyboard Command: rdcheck
Prerequisite: Existing and final Profiles (vertical alignment), Centerline (horizontal alignment), Existing and Final Cross Sections
File Name: \lsp\profedit.arx
Locate Template Points

This command creates Carlson points along a centerline either at picked points, point numbers, entered individual station and offset or at station interval with offset, in all cases using the elevations calculated from the template design files. The first offset prompt is for the location of the point. The second offset prompt is for what elevation to use. For staking template points (e.g. edge of pavement) you usually enter the same offset for the position and for the elevation. But if you are staking back of curb, which might be at offset 14.5, you might enter 16.5 for the position (to stake 2’ back of curb) and 14.5 for the vertical elevation (to use the elevation of back of curb itself). The points are stored in a coordinate (.CRD) file. The station and offset of the point is stored in the point descriptions. If the points method is used and existing Carlson points are selected by number, range or “point group”, then new points at the same position are created with interpolated elevations and new descriptions. The command starts with the dialog shown below. The required design files include the template file, the profile which defines the vertical alignment, the centerline file which contains the horizontal alignment and the coordinate file for storing the resulting points. All these design files must be created before running this command. To specify a design file, pick on the type of file button. The optional files include an existing section file for calculating the cut and fill slopes, a rock section file for special cut slopes in rock, a template transition file and a super elevation file. For example, if an existing section is specified, template points can be calculated further from the centerline, all the way from the shoulder out to the "catch" or tie point in cut and fill.

If you choose the Station/Offset method, you can specify whether to create points at a station interval. Otherwise the program prompts for each station at which to create points. If the Station/Offset method is used, you will be prompted whether to calculate points on the left, right or both sides of the centerline and whether to offset the calculated elevation by a delta Z amount. If you choose the Points method, you can pick points on the screen (using snaps on entities if desired) or you can specify point numbers individually, by selection set, by range or by point group. You can also select whether to calculate elevations from the template surface or from a subgrade and you can add a description prefix to all descriptions.

A classic application of this routine would be for road staking such as setting back of curb points. Many
survey companies prefer to stakeout roads by pre-calculated point numbers rather than calculating from road design files in the field to stakeout road offsets. So if the goal was, for example, to stake 2 feet behind the back of curb, but use the elevation of the top of curb, and the shoulder rose at 4% behind the curb, then the vertical difference to the top of curb would be $-2 \times 0.04 = -0.08$. The program will calculate this automatically by the method of asking for the distinct offset to use for the elevation. Obviously, if you want to stake to the exact surface elevation at the offset specified, then enter the same offset for both position and elevation. The prompting for this back of curb example is shown below.

Prompts

**Template Points dialog:** Specify the required files and optional files.

**Additional Options dialog:** Choose Station/Offset or Points method, as shown below:
Offset for X,Y position: 16.5 In this case, this is the pavement width (12.5) plus curb width (2) plus back-of-curb offset (2). The northing and easting for the points will be calculated with this offset.

Offset for elevation <16.5>: 14.5 The elevations for the points will be calculated at this offset (back of curb in this example).

Apply offset to left, right or both sides (Left/Right/<Both>)? press Enter Note that if you want to have the points number sequentially on the left side and sequentially on the right, then do L for left first and R for right second. If you answer "Both" then the numbering will go sequentially left to right on each station (see below).

Offset to process (Enter to End): press Enter Or, enter an offset to calculate another X,Y position, or the same X,Y position but on a different side of the road if doing L and R distinctly.
Pulldown Menu Location: Roads
Keyboard Command: tpltrans
Prerequisite: A template file, profile file and centerline file
File Name: \lsp\eworks.arx
The Surface menu, shown below, has many commands for triangulation, contouring, volumes, profile design and much more.
Triangulate & Contour

This command provides a complete set of functionality for contouring, labeling, and creating tin surface models. Given data entities that represent the surface, this command creates a final contour map with labeled, smoothed, and highlighted contours and/or a surface model that can be saved to a file (to be used in other areas of the program) or drawn on the screen as triangles or faces. Eligible data entities include points, inserts, lines, 2d polylines, 3d polylines, elevation text, 3d faces, and points from ASCII or coordinate (.CRD) files.

Triangulate & Contour has many options which are defined in the exhibits shown in the following pages. With this command, you can do any combination of drawing the triangulation network lines, drawing the contours, drawing triangulation network 3D Faces or lines, writing a triangulation file and storing a surface file.

In order to force Triangulate & Contour to correctly interpolate elevations between two points that define a grade break in the surface (such as points on a ridge, wall, or road), a breakline must exist between the points. A breakline line can be specified as a 3D polyline or line. In fact, all 3d polylines and lines with elevation are treated as breaklines.

If Triangulate & Contour reports zero points found and fails to do anything when you're using Carlson points, then those points are probably located at zero elevation. To fix this problem, make sure that Carlson Point Inserts is toggled on in the Selection tab. This will enable Triangulate & Contour to read the elevation from the elevation attribute of the point.

Triangulate Tab

When **Draw Triangulation Lines** is turned on, the program will draw the triangulation as simple AutoCAD lines with elevation. Specify the layer for these lines in the box to the right.

When **Draw Triangulation Faces** is turned on, the program will draw each triangle in the triangulation network as a 3D Face. These 3D Faces can then be used in AutoCAD’s modeling routines such as **HIDE** and **SHADE** or in Carlson routines such as **3D Viewer Window, 3D Surface FlyOver and Slope Zone Analysis**. Specify the layer for
these 3DFaces in the box to the right.

**Write Triangulation File** stores the triangulation surface model as an .flt or a .tin file. The .flt file format is a text file depicting the edges in the triangulation network. The .tin file is a new binary file format depicting the triangulation network. The .tin file is much faster and more efficient than the previous .flt file format. The triangulation file(s) can be used by several commands such as Volumes By Triangulation, Spot Elevations, and Profile from FLT File. Either type in the file name to create or press the Browse button to select a file name.

**When Use Inclusion/Exclusion Areas** is activated, the program will prompt you for inclusion and exclusion polylines. These are used to define the area of activity for triangulation and contouring. The inclusion and exclusion polylines must be closed polylines and must be drawn before using Triangulate & Contour. The command line display must be set to show at least two lines to see the prompting for the selection of the Inclusion/Exclusion perimeters.

Only the parts of the contour lines and triangles that are within the inclusion polylines will be drawn. For example, an inclusion could be the perimeter of the site. The parts of contour lines that are inside the exclusion polylines are not drawn. Exclusion polylines can be used for areas where you don't want contours such as within buildings. When **Ignore Zero Elevations** is activated, this setting will filter out all data points at an elevation of zero from the data set.

If you would like to manually set the range over which to contour, select one of the **Specify Input/Output Elevation Range** options, one for source data and one for contour output. The program will automatically contour from the lowest elevation in the data set up to the highest at the increment specified in Contour Interval.

**When Erase Previous Contour Entities** is activated, this setting will erase previously drawn contour entities.

The triangulation network is based on the x,y position of the points. **Pick Reference Plane** allows you to contour an overhang or cliff by changing the reference plane to a side view. The reference plane can be specified by first using the Viewpoint 3D command and then using the View option, or you can specify three data points on the cliff (two along the bottom and one at the top).

**Highlight Breaklines** highlights breaklines in the triangulation network by drawing the triangulation lines along breaklines in yellow.

**Interpolate Ridges and Valleys** creates additional triangulation in a ridge or valley situation to more accurately define the feature during surface modeling operations. This option would commonly be used when creating a surface model from existing contours, since it replaces the need to manually draw 3d polylines along ridges and valleys.

**Interpolate Summits and Pits** creates additional triangulation in a summit or pit situation to more accurately define the feature during surface modeling operations. This option would commonly be used when creating a surface model from existing contours.

**Simplify Surface** is designed to reduce the digital size of a surface, without significantly compromising the integrity or accuracy of the surface. The most common application is for surfaces derived from very large datasets, such as smoothed contours. Its use is less applicable to design surfaces or surfaces based on surveyed points, but it can still be utilized. **Simplify Surface** reduces the size of the surface file by analyzing the difference in elevation between each vertex of the TIN and the vertices directly surrounding it, assigning a numerical weight or value to each vertex. If it is determined that the calculated weight for a particular vertex is less than the **Tolerance** factor, the vertex is a candidate for removal. The number of vertices removed is directly proportional to the **Tolerance** factor, so the higher the **Tolerance** factor, the more vertices are removed, the lower the **Tolerance** factor, the fewer vertices are removed.

If **Simplify Surface** is selected, the **Preserve Breaklines** option is activated. **Preserve Breaklines** further analyzes the TIN by focusing on the edges, calculating the angular difference between adjacent triangular faces. If the angular
difference between edges is greater than the specified **Breakline Angle**, it is considered to be a breakline, and it is preserved. If it's angular difference is determined to be below the **Breakline Angle**, it becomes a candidate for removal. In that case, the **Weight** factor is applied to the corresponding vertex, adjusting it's original value. If the resulting value is still below the **Tolerance**, it is then removed. The number of vertices removed is inversely proportional to the **Weight** factor, so the greater the **Weight** factor, the fewer vertices that are removed, the lower the **Weight** factor, the more vertices that are removed.

A good rule of thumb that can be used when deciding whether or not to use these options is: if the surface contains no man-made features, use **Simplify Surface** only, if it contains man-made features, such as roads, use both **Simplify Surface** and **Preserve Breaklines**.

**Before:** Surface made from an existing contour map. Note the flat spots in the bottom of the valley (bottom center of the image) when Interpolate Ridges and Valleys is disabled.
After: The same surface with Interpolate Ridges and Valleys enabled.  
    Note the smooth flowline at the bottom center of the image.

The Max Triangle Mesh Line Length value limits the length of the triangulation network lines. Any triangulation line that exceeds this limit will not be drawn or included in contouring. This allows you to avoid abnormally long triangulation lines where you have relatively too few data points and on the outskirts of your data points. The Exterior value applies to triangulation lines around the perimeter of the triangulation area and the Interior value applies all the other triangulation lines. Generally you would have the exterior value larger than the interior.

An Error Log is generated if the Triangulate and Contour routine finds a vertical conflict between breaklines or other surface entities, opening the following dialog box. Three types of conflicts are reported; Crossing Breaklines, Vertical Edges, and Breakline T-Intersections. Crossing Breaklines indicates that the intersection of two entities does not have a common elevation. Vertical Edges indicates that two entities or vertexes of differing elevations have the same x-y location, thus forming a vertical plane. Breakline T-Intersections indicates that a 3d entity is abutting another entity, but the second entity doesn't have a vertex at the point of intersection. Each type of conflict is listed in its own category.

Clicking to the "plus" sign beside a category will display the individual conflicts within that category. When a line item error is selected, a highlighted arrow is temporarily placed in the drawing to indicate the exact location of the specific conflict. Zoom functionality allows the user to more closely inspect the specific problem area, and if needed a marker can be drawn or a report generated for an individual conflict or conflicts.
Zoom pans the drawing to move the selected conflict to the center of the screen. The zoom functions are only active when a single line item is selected.

Zoom In zooms in on the highlighted area for closer inspection. Multiple picks on the zoom button will increase the magnification.

Zoom Out zooms out away from the highlighted area.

Report All/One toggles between One and All depending whether a single line item conflict or a category is selected from the error log. An error report is generated listing the x-y position and the elevation difference of the entities in conflict.
Draw All/One toggles between One and All depending whether a single conflict or a category is selected from the list. This option draws an "X" symbol at each selected conflict. The layer and size of the symbol is controlled in the fields below.

Continue closes the Error Log and proceeds with the contouring operation.

Layer Name specifies the layer name for the "X" entities drawn with Draw One/All. This also sets the layer name for the "Draw Lines" option.

Symbol Size specifies the size of the "X" symbol that is drawn to delineate the selected errors. This will determine the actual size of the symbol in the drawing. This value is not multiplied by the horizontal drawing scale.

In the case of crossing polylines, Draw Lines will trace over the polylines responsible for the conflict. The polylines will be created in the layer specified in the layer field.

Contour Tab
When the **Draw Contours** box is checked, the program will draw contour lines after triangulating. Otherwise, only the designated triangulation operations are performed. Specify the layer for contours in the edit box to the right.

**Contour by Interval** or **Contour an Elevation** determines whether to contour by interval (ie: every 10 feet) or to contour a certain elevation. The elevation option allows you to contour specific values. For example, if you want just the 100ft contour, then select elevation and enter 100. The default mode is by interval.

Use **Contour Interval** to specify the interval to contour. **Note:** If the previous option is set to Contour an Elevation, then this field is used to specify the elevation to contour.

Contour lines whose total length is less than the **Min Contour Length** value will not be drawn.

**Reduce Vertices** attempts to remove extra vertices from the contour polylines which has the advantages of a faster drawing and smaller drawing size. Default is **ON**

When the Reduce Vertices option is enabled, the **Offset Distance** value is the maximum tolerance for shifting the original contour line in order to reduce vertices. The reduced contour polyline will shift no more than this value, at any point, away from the original contour line. A lower value will decrease the number of vertices removed and keep the contour line closer to the original. A higher value will remove more vertices and allows the contour line to shift more from the original.

When activated, the **Hatch Zones** option will create hatching between the contours based on elevation zones. The following dialog will open allowing the user to specify the hatch type and color for each elevation zone. The entire elevation range of selected data is displayed under Current Values.
Clear clears the all of the Elevation fields in the dialog.

Load loads previous settings from a saved .pat file.

Save saves the current setting configuration to a .pat file.

Auto opens the following dialog, allowing for automatic configuration of the range of elevations in each zone, assigning of colors and hatch patterns, and the scale.

<table>
<thead>
<tr>
<th>Starting Zone</th>
<th>Starting Value</th>
<th>Value Interval</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zone 1</td>
<td>0.000</td>
<td>1.000</td>
</tr>
<tr>
<td>Zone 2</td>
<td>120.00</td>
<td>1.000</td>
</tr>
<tr>
<td>Zone 3</td>
<td>120.00</td>
<td>1.000</td>
</tr>
<tr>
<td>Zone 4</td>
<td>120.00</td>
<td>1.000</td>
</tr>
<tr>
<td>Zone 5</td>
<td>120.00</td>
<td>1.000</td>
</tr>
<tr>
<td>Zone 6</td>
<td>120.00</td>
<td>1.000</td>
</tr>
<tr>
<td>Zone 7</td>
<td>120.00</td>
<td>1.000</td>
</tr>
<tr>
<td>Zone 8</td>
<td>120.00</td>
<td>1.000</td>
</tr>
<tr>
<td>Zone 9</td>
<td>120.00</td>
<td>1.000</td>
</tr>
<tr>
<td>Zone 10</td>
<td>120.00</td>
<td>1.000</td>
</tr>
<tr>
<td>Zone 11</td>
<td>120.00</td>
<td>1.000</td>
</tr>
<tr>
<td>Zone 12</td>
<td>120.00</td>
<td>1.000</td>
</tr>
<tr>
<td>Zone 13</td>
<td>120.00</td>
<td>1.000</td>
</tr>
<tr>
<td>Zone 14</td>
<td>120.00</td>
<td>1.000</td>
</tr>
</tbody>
</table>

Starting Zone sets the zone with which to begin the application of the setting defined in this dialog. For Instance, if the Starting Zone was set to 10, the settings definitions applied here wouldn't affect Zones 1-9, but would start at Zone 10.

Set Values enables the Starting Value and Value Interval fields, which allow the user to specify the starting elevation for the given zone and set the zone increment.

Starting Value sets the elevation of the beginning zone to define.

Value Interval sets the elevation increment for subsequent zones.
Set Colors enables the Starting Color and Color Increment fields.

Starting Color sets the starting color number, based on the AutoCAD standard color chart.

Color Increment sets the color number to increase for subsequent zones. So if the increment was set to 5, and the starting color was 60, the next color would be 65, 70, and so on.

Set Pattern sets the hatch pattern for the defined zones.

Set Scale enables the Scale option.

Scale sets the scale for the selected hatch pattern.

Draw Index Contours creates highlighted contours at a specified interval. When enabled, the fields for Index Layer, Index Interval and Index Line Width are activated.

Use Contour Smoothing Method to select the type of contour smoothing to be performed. Bezier smoothing holds all the contour points calculated from the triangulation and only smooths between the calculated points. Polynomial smoothing applies a fifth degree polynomial for smooth transition between the triangulation faces. The smoothing factor described below affects the smoothing bulge.

Bezier Smoothing Factor The contour preview window shows you an example of how much smoothing can be expected at each setting. Sliding the bar to the left results in a lower setting which have less looping or less freedom to curve between contour line points. Likewise, moving the slider to the right results in a setting that increases the looping effect. Note that too much smoothing applied in some situations can result in crossing contours.

Subdivisional Surfaces / Subdivisions Generation causes each triangle in the triangulation surface model to be subdivided into an average of three smaller triangles per subdivision generation, with the new temporary vertices raised or lowered to provide smoother contours. More generations increases the smoothness of the algorithm at a cost of increased processing time. If Straight Lines are chosen as the contouring drawing method, then the contours are guaranteed never to cross. The original points of the surface model are always preserved. These modifications to the surface model are only for contouring purposes and are not written to the triangulation (.FLT) file or inserted into the drawing. If some contour movement is too small for appearance’s sake, consider enabling Reduce Vertices.

Labels Tab
When **Label Contours** is activated, contours will be labeled based on the settings below.

**Label Layer** specifies layer name for intermediate contour labels.

**Index Label Layer** specifies layer name for index contour labels.

**Label Style** specifies the text style that will be used for the contour label text.

**Label Text Size Scaler** specifies the size of the contour labels based on a multiplier of the horizontal scale.

Contours whose length is less than the **Min Length to Label** value will not be labeled.

When **Break Contours at Label** is checked, contour lines will be broken and trimmed at the label location for label visibility. When enabled, the Offset box to the right activates. The Offset determines the gap between the end of the trimmed contour line and the beginning or ending of the text.

When **Draw Broken Segments** is checked, segments of contours that are broken out for label visibility will be redrawn as independent segments. Specify the layer for these broken segments in the box to the right of this toggle.

When **Label Contour Ends** is checked, contour ends will be labeled.

When **Draw Box Around Text** is checked, a rectangle will be drawn around contour elevation labels.

When **Label Index Contours Only** is checked, only the index contours will be labeled. This option is active only when "Draw Index Contours" has been selected in the Contour tab of the main dialog.

**Hide Drawing Under Labels** activates a text wipeout feature that will create the appearance of trimmed segments at the contour label, even though the contour line is still fully intact. This feature provides the user with
the best of both worlds; you have clean looking contour labels, yet the contour lines themselves remain contiguous. This feature will also hide other entities that are in the immediate vicinity of the contour label.

When **Align Text with Contour** is checked, contour elevation labels will be rotated to align with their respective contour lines. This option also activates the Align Facing Uphill feature explained below.

When **Align Facing Uphill** is checked, contour elevation labels will still be rotated to align with their respective contour lines, but the labels will be flipped in such a manner that the top of the text label will always be toward the uphill side of the contours. So as the labels are read right side up, the contours will be progressing uphill.

Use **Internal Label Intervals** to choose between Label Intervals or Distance Interval. Label Intervals will label each contour with a set number of labels. Distance Interval lets you specify a distance between labels.

**Selection Tab**

When **Specify Selection Options** is checked, you can control what type of entities *Triangulate & Contour* uses. This is an excellent method of "filtering out" unwanted entity types.

Points, 3D Polylines, 2D Polylines, Lines, Inserts are standard AutoCAD entities types.

Carlson Point Inserts refer to Carlson points which include the block SRVPNO* with the point number, elevation, and description attributes.

Spot/Bottom Elevation Inserts include text entities that start with 'X'.

From File allows you to triangulate from the points in a coordinate (.CRD) or ASCII file. This option also provides access to the use of Point Groups as a data source.
Chapter 14. Surface Menu
The contours are smoothed, reduced, drawn at an interval of 2, and highlighted at an interval of 10 with labeling on the index contours.

**Pulldown Menu Location:** Surface  
**Keyboard Command:** tri  
**Prerequisite:** Data entities in the drawing, including points, inserts, lines, 2d polylines, 3d polylines, elevation text, 3d faces, and points from ASCII or coordinate (.CRD) files.  
**File Names:** \lsp\tri4.lsp, \lsp\tri4.dcl, \lsp\tri4.arx

### Contour from TIN File

**Function**

This command creates contours directly from a TIN file (.flt or .tin) without the need to have the TIN drawn on the screen. The routine starts by opening the dialog for *Triangulate and Contour*, allowing the user to specify triangulation, contour and label settings. After pressing *OK* on the initial dialog, a second dialog opens, allowing for the selection of the TIN file from which to create the contours.  

See the *Triangulate and Contour* section in the manual for a detailed description of each of the settings.
Prompts

Fill out the Triangulate and Contour Dialog information with the desired options.
Select the desired TIN file and choose Open.

Loading edges...
Loaded 1994 points and 5944 edges
Created 3936 triangles
Removed 9 disconnected edges.
Reading points... 0
Contouring elevation 497
Inserted 1926 contour vertices.
The user may be prompted for additional information depending on settings used in the Triangulate and Contour dialog box.

Pulldown Menu Location: Surface >> Contour from...
Keyboard Command: cntrTIN
Prerequisite: A TIN file (.flt or .tin)
File Name: \lsp\tri4.arx

Draw Triangular Mesh

This command draws a triangulation (.flt or .tin) file as either 3D LINES or 3DFACEs. Since 3DFACE entities can be shaded within the 3D Viewer Window or 3D Surface FlyOver, or with the AutoCAD 3D Orbit command, this is an excellent tool for visual surface inspection. 3D Lines cannot be shaded.
Triangulation (.flt or .tin) files can be created by *Triangulate & Contour*.

**Prompts**

**Select TMESH File to Draw**
Choose a triangulation (.flt or .tin) file from the file selection dialog. You are then prompted for options:

If using Inclusion/Exclusion Perimeters, you will be prompted to select them as the routine executes.

**Loading edges...**
**Loaded 198 points and 234 edges**

This Triangulation mesh was drawn as 3DFaces with the Draw Triangular Mesh command, and then colorized by elevation within 3D Viewer Window

**Pulldown Menu Location:** Surface >> Draw Surface
**Keyboard Command:** drawtri
**Prerequisite:** A triangulation (.flt or .tin) file

**File Name:** \ lsp \contour4.arx

## Contour Elevation Label

This command can be used to simultaneously create elevation labels on a group or groups of contour polylines at elevation. To place the labels, pick two points crossing the contour polylines at the desired label location. The program will find all the contour polylines that intersect the picked line (defined by the two picked points) and will place labels at the intersection point of each contour. A second crossing line can be initiated immediately, so multiple areas can be quickly labeled while remaining in the command. The actual "z" elevation of the contour line determines the label value.

### Contour Label Options Dialog

![Contour Label Options Dialog](image)

**Label Layer** specifies layer name for the contour labels that will be created.

**Label Style:** specifies the text style to be used for labels.

**Horizontal Scale** is used in conjunction with the Text Size Scaler to determine unit height of the contour labels.

**Text Size Scaler** is a scaler that will be multiplied by the horizontal scale to set the actual text height of the labels in AutoCAD units.

**Decimals** sets the decimal precision for the labels to be created.
**Label Position** determines the label position in relation to the contour polyline.

- **On Contour** centers the label on the contour line.
- **Above Contour** places the label above the contour line. If this option is used, the options for Break Contours at Label and Draw Broken Segments become inactive.

**Ignore Zero Elevation Polylines** enables the routine to filter out all entities with an elevation of zero.

**Hide Drawing Under Labels** activates a text wipeout feature that will create the appearance of trimmed segments at the contour label, even though the contour line is still fully intact. This feature provides the user with the best of both worlds: you have clean looking contour labels, yet the contour lines themselves remain contiguous. This feature will also hide other entities that are in the immediate vicinity of the contour label.

When **Align Text with Contour** is checked, contour elevation labels will be rotated to align with their respective contour lines.

When **Break Contours at Label** is checked, the contour lines will be broken and trimmed at the label location for label visibility.

When **Draw Broken Segments** is checked, segments of contours that are broken out for label visibility will be redrawn as independent segments. Specify the layer for these broken segments in the box to the right of this toggle.

**Label By Distance** places the labels by distance along the contour. The user is not prompted for screen picks of contour crossing when this option is used.

- **Interval** sets the distance interval to be used between labels on each contour.

When **Draw Box Around Text** is checked, a rectangle will be drawn around the elevation labels.

**Label Index Only:** When checked, only Index contours are labeled.

**Prompts**

**Contour Label Options Dialog Opens** Select the desired options and press OK.

**Define a line which slices the contours at the desired label locations.**

**Pick 1st point:** *pick a point*

**Pick 2nd point:** *pick a point*
By selecting two points the contour lines that cross the line defined by the two points are labeled.

**Pulldown Menu Location:** Surface >> Contour Labels  
**Keyboard Command:** gclabel  
**Prerequisite:** polylines with elevation (contour polylines)  
**File Names:** \lsp\gclabel.lsp, \lsp\contour4.arx

**Move Label Along Contour**

This command slides an existing contour label along a contour, maintaining its alignment with the contour. The label must have originally been created with the *Break Contours at Label* option Off. If the option to *Hide Drawing Under Labels* was used when the label was created, the wipeout will move with the label when using this command.

**Prompts**

Select contour label to move: *Pick label*  
Pick new contour label position: *Move mouse to relocate label*

**Pulldown Menu Location:** Surface >> Contour Labels  
**Keyboard Command:** move_ctr_label  
**Prerequisite:** generated contour labels  
**File Name:**

**Volumes By Triangulation**

Volumes By Triangulation is an alternative volume method that compares two triangulation networks. This method is different from the grid based volume routines (*Volumes By Layer, One Surface Volumes, Two Surface Volumes, Stockpile Volumes, etc.*) and the cross section volume routine (*Calculate Section Volume*). Volumes by Triangulation calculates faster in most cases than the other methods, and it is the most accurate because it uses true TIN to TIN prismoidal volumes. This added accuracy in general is very small. The grid resolution is usually sufficient to model.
the surface for the grid based volumes. The Volume By Triangulation accuracy applies well when there is a feature like a 5 foot wide ditch. Then the grid resolution would need to be less than 5 feet to model the ditch which might be difficult on a large site.

The disadvantage to this routine is that it lacks the output options that help the analysis of the volume such as Difference Contours. Also Volumes By Triangulation does no extrapolation and stops calculating volume at the perimeter of the smaller of the two triangulation networks. Volumes By Triangulation is better when used with point data instead of contour data because contour data requires triangulating all the contour polylines as breaklines which creates a large triangulation network and is slower.

The triangulation networks to compare are defined in .tin or .flt files that are created by Triangulate & Contour with the Write Triangulation File option. Note that while both file formats are supported, the newer binary triangulation file format (.tin) is twice as fast to load and save, and half the size, of the .flt triangulation file format. For this reason, the .tin file format is recommended. Before using this command, run Triangulate & Contour twice to create an triangulation (.TIN or .FLT) file for each surface. The volume calculation is limited by either the extent of the triangulation networks or by an inclusion/exclusion perimeter(s). These perimeters must be closed polylines.

Output data includes area, tons by density, average thickness, shrink and swell, ratio, and total volume.

Prompts

Select EXISTING surface Tmesh File
Choose an .flt or .tin file
Select final elevation or surface TIN [Elevation/<TIN>]? press Enter
Select FINAL surface Tmesh File Dialog
Choose another .flt or .tin file.
Choose Predefined Boundary Dialog Choose none.
Select Inclusion polylines select objects
Select Exclusion polylines select objects
Volume Report Choose viewing option
Comparing Triangulation files: C:\SCAD2006\DATA\TRI1.FLT
and C:\SCAD2006\DATA\TRI2.FLT
Cut volume: 66891.35 C.F., 2477.46 C.Y.
Fill volume: 43458.01 C.F., 1609.56 C.Y.
Keyboard Command: trivol
Prerequisite: Two .flt or .tin files

Triangulation File Utilities

This command allows you to modify TIN surfaces in a variety of different ways, then allows for 3d viewing and shading of the modified surface and finally for saving the file with a choice of output formats. The focus of the routine is to elevate or lower the TIN or selected areas within the TIN, merge TINs with other surfaces, or use data from other TIN files to apply to the current TIN. Operations can be performed on the entire TIN or just on user selected Inclusion and/or Exclusion areas. The routine will automatically rework the TIN network for conformation to a selected boundary, say a building outline. In the case of said building, a value of 10 could be subtracted from the building outline. This will drop all of the triangulation within the outline by 10', thus creating a model of the excavated area for the building. The modified TIN can then be saved to a new file, which could be used to compute an excavation volume with Volumes by Triangulation. This routine does not allow for manual reconfiguration of the
TIN network. This is performed under Surface Tools, also in the Contour pulldown menu. This routine also includes conversions to and from TIN files, DXF files and 3D Face entities.

Begin with the dialog shown here. First select a TIN model. You may choose between an .flt or .tin file, a DXF file (that includes 3DFACE entities), or 3DFACE entities in the current drawing. Specify the subject area by choosing inclusion or exclusion perimeters, then press the next button.

**Load TIN File:** Allows you to specify a triangulation (.flt or .tin) file to load.

**Load DXF File:** Allows you to specify a DXF file to load. Only loads 3DFACE entities from the selected DXF file.

**Select 3D Faces:** Allows you to select 3DFACE entities from the current drawing. This also includes rectangular 3d faces from a plotted grid.

**Pick Bounding Polylines:** Allows you to select any inclusion/exclusion perimeter(s). When this button is selected, the user is taken back to the drawing and prompted to select the perimeters. Press Enter when the selections are finished to return back to the dialog.

**Fast TIN Intersect:** When checked, this command will perform a simple and fast check for overlapping triangles, so is the preferred choice in most cases. However, if problems with the TIN are suspected, this option should be unchecked, so that a complete and thorough check and repair of the TIN is performed.

**Fill-in-holes:** When checked, any missing triangulation or gap in the surface will be automatically filled in with additional triangles. This option has to be set before loading the TIN file to take effect.

**Region Mode:** This option deals with nested or overlapping boundaries. When checked, AutoCAD hatch pattern logic is applied, in which all nested boundaries are used in an alternating fashion, so that an Inclusion Boundary within an Exclusion Boundary is still recognized. If this option is not checked, everything within an Exclusion Boundary is ignored.

**Next:** Press this button to proceed to the next dialog after all selections have been made.

The next dialog allows you to perform mathematical operation(s) on the loaded TIN. Each operation is described below. Keep in mind that generally these operations are to be performed on an area inside your inclusion perimeter (but excluding anything inside your exclusion perimeters). If you do not specify any perimeters, the desired operation/s will be performed on the entire TIN.
Add Value: Prompts for a value to Add to the subject area of the TIN.
**Subtract Value:** Prompts for a value to Subtract from the subject area of the TIN.

**Multiply Value:** Prompts for a value to Multiply to the subject area of the TIN.

**Divide Value:** Prompts for a value to Divide to the subject area of the TIN.

**Add TIN:** Raises the subject area of the current TIN by the elevation value from a second user selected TIN file. This function is most applicable to applying a strata thickness TIN.

**Subtract TIN:** Lowers the subject area of the current TIN by the elevation value from a second user selected TIN file.

**Min TIN:** This does a comparison between the current TIN and a second user selected TIN file, and applies the lower value of the two TINs to the subject area.

**Max TIN:** This does a comparison between the current TIN and a second user selected TIN file, and applies the higher value of the two TINs to the subject area.

**Merge TIN:** Merges the current subject TIN into a second user-specified TIN file. There are three methods:

- **Current TIN inside/Second TIN outside boundary:** This method is only available when Bounding Polylines are selected in the first Triangulation File Utilities dialog. The current TIN will be used inside the boundary polylines and the second TIN is used everywhere else. The current TIN file should be the smaller of the two surfaces since the subject file will be joined or merged into the second file. For example, to merge a pad design into existing ground with this method, choose the pad design as the current TIN, pick the pad perimeter as the bounding polyline and use existing ground as the second TIN.

- **Second TIN inside/Current TIN outside boundary:** This method uses the second TIN inside the boundary and the current TIN everywhere else. The outline of the second TIN is used as the boundary if no bounding polylines were selected in the initial dialog. For example, to merge a pad design into existing ground with this method, choose the existing ground as the current TIN and choose the pad design as the second TIN.

- **Wipe, combine and repair Current TIN where overlaps Second TIN:** This method removes triangles from the current TIN for areas that overlap the second TIN. Then the second TIN is added into the current TIN surface and the gap between the current and second TINs is triangulated to stitch them together. This method is useful when the two TINs don't have matching have elevations on their common boundary. Then this method will create a transition zone between the TINs.

**Enhance Flats:** This routine eliminates flat triangles by adding a data point inside the triangle at a different...
elevation to subdivide the triangle. The elevation of this point is calculated based on the slopes of the neighboring triangles.

**Offset:** Performs a perpendicular offset (from the face/s) to the TIN surface by the specified amount.

**Simplify:** Causes edges within the Tin mesh to be collapsed to reduce the number of triangles, edges, and points within the mesh while having a minimal impact on the overall shape of the mesh.

**Tolerance:** This setting is used by the Simplify command described below. Specify the maximum average distance that any point can be moved outside of the plane of any triangle that connects to that point. Values might range from .01 to .1 for most purposes.

**Hold Breaklines:** Further analyzes the TIN by focusing on the edges, calculating the angular difference between adjacent triangular faces. If the angular difference between edges is greater than the specified Breakline Angle, it is considered to be a breakline, and it is preserved. If it's angular difference is determined to be below the Breakline Angle, it becomes a candidate for removal. In that case, the Breakline Weight factor is applied to the corresponding vertex, adjusting it's original value. If the resulting value is still below the Tolerance, it is then removed. The number of vertices removed is inversely proportional to the Breakline Weight factor, so the greater the Breakline Weight factor, the fewer vertices that are removed, the lower the Breakline Weight factor, the more vertices that are removed.

**TIN Statistics:** Generates a report of the TIN statistics, including number of points, edges, and triangles, and minimum and maximum Z value.

**Subdivide:** Subdivides triangles to make them more equalateral.

**Set New Elev:** Sets all TIN faces in the subject area to the elevation specified.

**Set NULLs to Elev:** Sets all NULL values in the subject area to the elevation specified.

**Set Elev to NULL:** Sets all of the elevation values in the subject area to NULL.

**Set Elev by Surface:** Sets all TIN faces within the subject area to the elevations from a second surface file within the same area. You will be prompted to select a second TIN file or grid file. Only areas common to both surfaces will be applied to the subject TIN.
**Output Options:** The following three options determine what part or parts of the TIN modifications that will be saved to the new TIN file. If the entire TIN is to be saved, all three options should be toggled on.

- **Insides:** If this is the only option checked, only changes made to the TIN within the inclusion perimeter will be saved. TIN entities outside of the perimeter will not be saved to the named file.
- **Border:** When the routine re-works the TIN to fit around a perimeter, a small horizontal offset is automatically applied to prevent the formation of vertical faces. The Border function will save changes made to TIN in this offset area.
- **Outsides:** If this is the only option checked, TIN entities inside of the inclusion perimeter will not be saved to the named file. Everything outside of the perimeter will be saved.

**Save As TIN:** Saves the current TIN as an .flt or .tin file.

**Save As DXF:** Saves the current TIN as a .dxf file. This format can be used by many other CAD programs.

**Draw As 3DFaces:** Draws the current TIN as 3D Faces in the current viewport. The Layer window is used to specify the layer that the faces will be created in.

Converts the left mouse button to a zoom function. Hold the button down and move the mouse up or down to zoom in and out.

Converts the left mouse button to a rotate function. Hold the button down to rotate the view in any X, Y or Z direction. When the XY appears in the window, the rotation will occur relative to the XY axis. When the mouse is moved toward the outer perimeter of the window, the XY will change to a Z. Holding the button down while the Z is visible will rotate the drawing on the Z axis.

Converts the left mouse button to a pan function. Hold down on the button while moving the mouse to pan. Holding down the mouse wheel will also serve as a pan function in any of the above modes.

Toggles shading on and off.

Restores the graphics to plan view.

Reverses the effects of all operations performed on the TIN and reverts it back to its original status.
This icon exits the routine. If the TIN has been modified, you will be prompted to save.

**Pulldown Menu Location:** Surface  
**Keyboard Command:** TINUTIL  
**Prerequisite:** 3D Faces, a TIN file or a DXF file.  
**File Name:** \lspl\tri4.arx

## Surface Manager

The *Surface Manager* toolkit allows the user to modify pre-defined triangulated surfaces, making real-time modifications and updates to contours and associated TIN (Triangulated Irregular Network) definitions. Functionality includes swapping TIN lines, adding breaklines to the surface, adding or removing points, adjusting point elevations, removing TIN lines, drawing or removing contour lines and labels, re-contouring at a different interval or with different label settings, etc. Contour lines are automatically updated to reflect any changes made to the TIN. A surface must be named and saved by of one of the surface modeling routines (in the Triangulate tab) as a prerequisite to using the *Surface Manager* tools.

All of the tools available in the *Surface Manager* are also available in the *Surface > Triangulation Surface Manager* fly-out menu, as shown in this figure. Their functions are identical but require a surface to be set current. Changes made apply only to the current surface.
The Surface Manager dialog box contains the following options:

**Set Current** designates a surface as current for editing with various surface tool functions, such as modifying TIN lines, setting a new contour interval, labeling contours, etc.

**Add** allows you to add a surface by selecting a surface model file (.TIN or .FLT).

**Remove** allows you to remove a surface from the list of stored surfaces.

**Rename** allows you to rename a surface.

**Edit** allows you to perform various TIN-related modifications to the current surface. Using the *Edit* function will activate the command line, where the user will be prompted with the following options:

Add Point (AP) adds a triangulation point to the network by picking a point from the screen. The pick must be inside an existing triangle. The elevation for the selected point is interpolated from the surrounding TIN network. This is a good method for adding additional triangulation to the surface in a sparse area. Also, a new elevation can be specified for the picked point. This function does not create Carlson points, and the point will not be saved to the .CRD file.

Remove Point (RP) removes an existing triangulation intersection from the TIN network. The affected triangulation re-adjusts to compensate for the missing intersection. Contours update accordingly.

Add Breakline (AB) adds a breakline to the surface by picking beginning and ending points on the screen. The endpoint snap automatically turns on. Only one breakline can be created at a time. The TIN network will reconfigure to follow the new breakline and update the contours. This does not create 3d polylines in the drawing.

Swap Edge (SW) swaps common TIN edges to create two different triangles from the original triangle configuration. Contours automatically update to reflect changes made to the TIN. Some common edges may not be swapped because of the orientation of the two triangles.

Set Elevation (SP) Sets a new elevation for a specified TIN intersection. The affected TIN is adjusted and the contours are updated.

Remove Tri (RT) removes a TIN line from the surface by picking a TIN line or selecting an interior point. Contours are removed from the affected area.

Hide Tris (ST) turns the TIN network on and off.

Point addition/removal and elevation-related changes made to the TIN are only reflected in the surface file and the contours resulting from that surface file. Point changes are not saved to the .CRD file and 3D linework is not updated in the drawing. Use traditional methods to update these entities if desired.

**Prompts**

The command line will prompt as follows:

Add Pnt(AP), Remove Pnt(RP), Add Breakline(AB), Swap edge(SW), Set elev(SP)
Remove Tri(RT), Show/Hide Tris(ST)

**Adding points, Pick point or enter keyword:** Type in the two letters of the function to be performed and press enter.
Add Points
Add Pnt(AP), Remove Pnt(RP), Add Breakline(AB), SWap edge(SW), Set elev(SP)

Remove Tri(RT), Show/Hide Tris(ST)

Adding points, Pick point or enter keyword: Press Enter to accept the default mode of Adding Points. Pick a point inside the TIN model at the desired location. The default elevation will be interpolated from the TIN model.

Enter the elevation of new point [559.112171]: 560

The surface will be recalculated using the input data.

Add Breakline
Add Pnt(AP), Remove Pnt(RP), Add Breakline(AB), SWap edge(SW), Set elev(SP)

Remove Tri(RT), Show/Hide Tris(ST)

Adding points, Pick point or enter keyword: RP Pick close to the area that you want an elevation point removed.

Add Breakline
Add Pnt(AP), Remove Pnt(RP), Add Breakline(AB), SWap edge(SW), Set elev(SP)

Remove Tri(RT), Show/Hide Tris(ST)

Adding points, Pick point or enter keyword: AB

Pick near the 1st point of breakline: Pick a point

Pick near the 2nd point of breakline: Pick a point When adding a breakline, OSNAP Endpoint will default on.
Swap Triangle Edge
Add Pnt(AP), Remove Pnt(RP), Add Breakline(AB), SWap edge(SW), Set elev(SP)
Remove Tri(RT), Show/Hide Tris(ST)
Adding points, Pick point or enter keyword: SW
Please select an internal edge to swap: Select desired edge.

Notice the additional breakline from point 13 to point 20.

Edge to be swapped, notice contour changes.
Set Point Elevation
Add Pnt(AP), Remove Pnt(RP), Add Breakline(AB), SWap edge(SW), Set elev(SP)
Remove Tri(RT), Show/Hide Tris(ST)
Adding points, Pick point or enter keyword: SP
Pick near the point to have elevation set: Pick near point 34.
Enter new elevation of the point [597.200000]: 600

Remove TRI Line
Add Pnt(AP), Remove Pnt(RP), Add Breakline(AB), SWap edge(SW), Set elev(SP)
Remove Tri(RT), Show/Hide Tris(ST)
Adding points, Pick point or enter keyword: RT
To conclude the Surface Edit mode, *press Enter* at the end of the internal command sequence. This will return to the Surface Manager dialog.

**Properties** allows the user to alter the drawing display properties for TIN lines, contours and labels for the selected surface. Applicable dialogs from Triangulate and Contour are used to provide a full set of options. When accessed, settings for the current surface display configuration are set. To make a modification, simply specify the desired change and press ok. For instance, if Draw Triangulation Lines was checked on, unchecking the box and pressing ok will redraw the surface without the TIN lines. If the contours were drawn at 1 foot intervals, setting the interval value to 2 and pressing OK will redraw the contours at 2 foot intervals. Refer to the *Triangulate and Contour* section of the manual for a more detailed explanation of the options below.
Done exits the Surface Manager and saves any modifications performed to the surface/s updating the .flt or .tin file.

**Pulldown Menu Location:** Surface >> Triangulation Surface Manager  
**Keyboard Command:** surface_mgr  
**Prerequisite:** A triangulated (non-grid) surface

### Make 3D Grid File

This command creates a grid (.GRD) file which serves as a surface model for use in many of the other Surface routines. The program internally makes a triangular network of the data points (if Triangulation is selected as the modeling method) and then interpolates the elevation values of a rectangular grid at the specified grid resolution. Data points can be either points, inserts, lines, or polylines. Lines and polylines are treated as breaklines in the triangulation.

Gridding as a means of modeling surface features is generally less favorable than triangulating as the surface is defined only at the intersection of the grid lines. This can lead to inaccuracies around local features such as ditches or curb lines, since the grid resolution must be small enough to adequately capture the changes in these local regions. Contrast this with Triangulated Networks which carry all this information at every point along the features. Gridding can, however, be useful for modeling large sites in general trends such as watershed analyses and large-scale volume computations.
The grid location is specified by first picking a lower left corner and then an upper right corner. The screen cannot be twisted when this is done because grids always run north-south and east-west.

The dialog box sets the range of elevations to process, modeling method and grid resolution. Each of these items is described below.

- **Range of Elevations/Values to Process**: Entities with elevations or values outside the range to process are ignored and will not be used for the gridding.
- **Modeling Method**: The modeling method almost always should be triangulation for surface topographic grid files. Polynomial, inverse distance, kriging and linear least squares apply to random data points for surfaces like underground features, usually sourced by such methods as drillholes, data tables, etc.
- **Triangulation Mode**: When using Triangulation and Polynomial methods, there are four triangulation modes.
modes: AutoDetect, Triangulation Only, Intersection with Triangulation and Intersection Only.

- **Auto Detect** method automatically chooses between the Triangulation Only and Intersection with Triangulation methods. If the selected surface entities are primarily made of polylines, then the Intersection with Triangulation method is used. Otherwise the Triangulation Only method is used.

- **Triangulation Only** method builds a triangulation surface out of all the selected points, lines and polylines. All lines and polylines are treated as breaklines. Grid node elevations are calculated based on the triangulation.

- **Triangulation with Subdivision** method uses the subdivisional surfaces modeling method. This option causes each triangle in the triangulation surface model to be subdivided into an average of three smaller triangles per subdivision generation. This gives a much smoother surface model, where instead of one triangle, there are now three or more.

- **Intersection Only** method goes directly to the Steepest Intersection method using the selected lines and polylines. The Steepest Intersection method is used to assign the grid node elevations from the linework of the triangulation lines and the selected lines and polylines. The triangulation step is skipped and any selected point data is not used. This method can be used for making grids out of polylines such as a contour map as long as the surface is defined just by contour polylines without needing spot elevation points. Skipping the triangulation step makes this method a lot faster especially for large files.

**Grid Resolution:** The grid resolution is specified by either the number of grid cells or by the size for each grid cell. It is usually best to set the Dimensions of a Cell to a known size, and the program will calculate the "number of cells in X and Y." While the program can handle really large grids with no limit, a general rule of thumb is to keep the total number of grids cells under 500,000 (about 700 by 700 cells) to limit the processing time. The grid location and resolution can also be specified by using the position/resolution from an existing grid file. In this case, the location and resolution of the new grid will match those of the selected grid file which is useful for routines that require two grid files with identical locations and resolutions.

No elevations are calculated on grid cells that extend beyond the extent of the data. The figure shows an example of how the grid is calculated to the limits of the data points. Extrapolation can be used to calculate elevations for the grid cells that are beyond the data limits. When there are grid cells with no elevation in a grid (.GRD) file, many routines will prompt *Extrapolate grid to full grid size?* Extrapolation fills in all the grid cells. The method to extrapolate uses a safe calculation that tends to average out or level the extrapolated values. So extrapolated grid areas are not as accurate as grid areas within the limits of the data. *Grid File Utilities* can be used to apply and save extrapolation to a grid file. The *Plot 3D Grid* command can then draw the grid file so that you can see the extrapolation.

A Carlson grid (.GRD) file has the following format:

```
Line 1 is the lower left Y coordinate
Line 2 is the lower left X coordinate
Line 3 is the upper right Y coordinate
Line 4 is the upper right X coordinate
Line 5 is the X direction grid resolution
Line 6 is the Y direction grid resolution
```

The rest of the lines are the Z values of the grid intersects starting from the lower left moving in the left to right direction and ending at the upper right. If the intersect has no value, the letter 'N' is saved instead of the Z value for Null values. An example is shown in the Display-Edit Report dialog.
Griding from Contour Maps

A grid file can be created from contours represented as polylines with elevation. The program calculates the elevation of each grid corner by looking for contour intersections in eight directions (N, S, E, W, NE, SE, SW, NW) and then interpolating the elevation between the two steepest intersections.

To accurately model the surface, it might be necessary to add entities in addition to the contour polylines. For one, spot elevation points can be added for the high and low points. Otherwise the grid model might plateau at the last contour. Also 3D breaklines need to be added on long narrow ridge and valley contours because in these areas the program will find the same contour when it looks for intersections in the eight directions. When all eight intersections are the same contour, the interpolated grid elevation equals the contour elevation instead of rising up the ridge or dipping in the valley. The 3D breaklines force interpolation along the ridge or valley. To draw these polylines, set the OSNAP to Nearest and run the 3D Polyline command. Then draw the polyline by picking the contour polylines where the breakline crosses them. Another way to quickly create breaklines is to first draw 2D polylines. Then convert these polylines into 3D polylines with the Screen option in the 2D to 3D Polyline by Surface Model command found on the 3Dpoly menu. There is also an automatic way to draw these breaklines. Under 3D Data, use the command: Create Ridge polylines from Contours.

Prompts

Grid File to Create File Selection Dialog
Enter a name for the grid file.
Use position from another file or pick grid position [<Pick>/File]?
Pick Lower Left grid corner <8111.88,3985.08>: pick a point for the lower left limit of the grid
Pick Upper Right grid corner <8366.88,4195.08>: pick a point

Make Grid File dialog box
In this dialog, you specify the grid resolution and whether or not to include data points with zero elevations. You can specify the resolution by entering the number of grid cells in the X and Y directions. By the Dimensions option, you are set to set the X and Y size for each grid cell.

Reading points ...
Select points, lines, polylines and faces to grid from.
Select objects: Specify opposite corner: 1075 found
Select objects:
Reading points ... 980
Finding points on breaklines ...
Ignored 2729 duplicate points.
Inserting breaklines 3480 ...
Triangulating points ... 980
Assigning grid values> 1800
Writing grid file: C:\Carlson 2008\WORK\example1.grd
Pick the Lower Left grid corner: pick a point for the lower left limit of the grid
Pick the Upper Right grid corner: pick a point

Pulldown Menu Location: Surface
Keyboard Command: mkgrid
Prerequisite: Entities that define the surface
File Names: \lsp\dtmmkgrid.lsp, \lsp\makegrid.dcl, \lsp\makegrid.arx

**Draw 3D Grid File**

This command draws the 3D grid mesh of the chosen grid (.GRD) file. Each grid cell can be drawn as a 3D Face entity, Polyface mesh, Text or temporary lines. 3D Faces and Polyface Meshes can be viewed/used in the following commands: 3D Viewer Window, Viewpoint 3D, Hide, Shade, 3D Surface FlyOver, and Slope Zone Analysis.
If **Use Vertical Exaggeration** is checked, grid elevations are multiplied by the value specified.

**Exaggeration Method** specifies whether to use an *Absolute* exaggeration method or *Relative to Base*, which uses the specified base elevation.

Specify the type of entities to draw in **Draw Method**. 3D Faces are described above. The Preview Only option draws the grid using temporary vectors. This method provides a much faster way to view the grid. However these temporary vectors are erased when the viewport is modified. This means as soon as you execute zoom, redraw, regen or plot, this grid will disappear. You can quickly redraw the grid by typing in VG for View Grid at the command prompt. Polyface Mesh is similar to 3D Faces except it is a single entity. The Text option will label the grid elevation at the grid corner. The text is placed center justified over the grid corner. To reduce clutter, there is an option to skip rows and columns.

Specify the layer for the grid entities in **Layer Name**.

Specify the initial viewing direction in **View**.

When **Color by Elevation** is checked, the grid will be colored based on a table of user-defined elevation ranges and the assigned colors. There is also an option to subdivide the grid cells at the color zone transitions. This is similar to the Elevation Zone Analysis command. Use the Specify Elevation Zones command to define ranges and colors.

When **Draw Side Faces** is checked, the program will draw vertical faces around the perimeter of the grid. The side faces will be drawn vertically from the grid perimeter to the Sides Base Elevation. You may optionally specify the Sides Base Elevation, it defaults to 0.00.

When checked, **Reverse Face Order** changes the direction of the points for a grid cell from clockwise to counterclockwise. The order applies to shading the grid cell in 3D render viewers such as the **3D Viewer Window** command. The grid cell will only appear shaded when viewing the grid cell from the clockwise side. Viewing from the other side will show a wire frame. The default is to show the shaded side from the top-down view. This option allows you to draw the grid so that the underside of the grid is shaded.
When checked, **Draw Corners Only** will draw the side lines only at the grid corners. Otherwise side lines are drawn down each perimeter grid cell.

When checked, **Extrapolate Grid to Full Size** draws the entire rectangular surface of the grid.

When **Use Inclusion/Exclusion Perimeters** is checked, it allows you to select inclusion and exclusion areas. Only grid cells inside the inclusion polylines will be drawn. Grid cells inside the exclusion polylines will not be drawn.

When checked, **Subdivide Grid Around Inclusion Perimeter** subdivides grid cells that are partially inside and outside the perimeter into smaller resolution grid cells.

![Drawn grid file using inclusion perimeter and side faces option viewed with Viewpoint 3D](image)

**Pulldown Menu Location:** Surface >> Draw Surface  
**Keyboard Command:** plotgrid  
**Prerequisite:** a grid (.GRD) File  
**File Names:** \lsp\plotgrid.lsp, \lsp\cntr_grd.arx

### Two Surface Volumes

*Two Grid Surface Volumes* calculates the cut and fill volumes between two surfaces modeled by grid (.GRD) files. These two grid files must have the same location and resolution. To create the grid files, use the *Make 3D Grid File* routine. When creating the second grid file, choose *Use position of another file* and select the first grid file. Using the position of the first grid file sets the location and resolution of second grid to match the first.

There are several other routines that calculate volumes based on grid files. Grid based volumes can be calculated by *One Grid Surface Volumes, Volumes by Layer, Stockpile Volumes, and Pond/Pit Volumes*. These routines have special prompting and calculate the grid surfaces and volume in one step.

Volumes by Two Surface Volumes has three steps:

1. Creating the first grid file with *Make 3D Grid File*
2. Creating the second grid file with *Make 3D Grid File*
3. Running *Two Grid Surface Volumes*

One advantage to this command is that you have more output options to help analyze volumes.

Besides grid based volumes, volumes can also be calculated between triangulation surfaces using the *Volumes by Triangulation* commands. Cross section end area is another volume method that is used by the *Calculate Sections Volume* command in the Civil Design module.
There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the volume within this inclusion area is calculated. **Important:** Whenever possible you should use a polyline that represents the limits of disturbed area as the inclusion perimeter. Volumes within an exclusion area are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine.

If the grid contains grid cells that have no elevations, you have the option to extrapolate elevations from the grid cells with elevations. When you choose not to extrapolate, no volume is calculated for the grid cells left without elevations. In general, extrapolation is not very accurate and should be avoided whenever possible. Sometimes you may get small amounts of cut in stockpiles that should only be fill, or small amounts of fill in pits that should only be cut. These extraneous quantities are due to extrapolation at the border and should be small enough to be ignored. When inclusion or exclusion polylines are used, the program will automatically extrapolate the grids. In addition to writing a volume report to the file, printer or screen, there are several volume report options.

- **Write Difference Grid File** creates a grid (.GRD) file of the elevation difference of the two grid files.
- **Draw Difference Contours** creates a contour map of the difference or depth between the two grid files.
- **Draw Elevation Difference in Each Cell** plots the elevation difference at the grid corners which is the same as the Elevation Difference routine.
- **Draw Volume in Each Cell** plots the calculated volume for each grid cell and is an excellent way to verify the volume calculation. If a cell contains both cut and fill, both values will be plotted.
- **Calculate Elevation Zone Volumes** calculates the cut and fill between different elevation ranges.
- **Draw Cut/Fill Color Map** fills each grid cell with different shades based on the average cut or fill in the cell. Red shades are used for cut and blue for fill. There is an option to draw a color legend. You can subdivide the grid cells at zone transitions. Also, there is an option to control the zone intervals and range.
- **Use Report Formatter** allows you to customize the report by choosing the fields to report and their order. Also the report formatter can be used to output the report data to Microsoft® Excel or Microsoft® Access.
- **Process Another Area with Current Grids** runs Two Surface Volumes again using the same grid files but different inclusion/exclusion polylines. This option saves the step of reloading the grid files to calculate volumes from the same grids for multiple areas.

The **Cut Swell Factor** value is multiplied by the cut volume in the report.

The **Fill Swell Factor** value is multiplied by the fill volume in the report.
**Report Tons** allows you to enter the material density and the program will report the cut and fill tons in addition to volume.

Given two accurate grid (.GRD) files, this routine will calculate accurate volumes. To verify the volume calculation, it is a good idea to check the grid (.GRD) files either by drawing them with *Draw Surface >> Draw 3D Grid File* and viewing them with *the 3D Viewer* or by contouring the grids with the *Contour Grid File* command.

![Existing surface](image1)

Existing surface

![Final surface contours with a closed polyline](image2)

Final surface contours with a closed polyline

Contours from the Draw Depth/Difference Contours option
Cut contours are red, fill contours are blue, daylight contours are green.
This is a good way to check that both surfaces are modeled correctly and to verify the volumes.

**Sample Two Surface Volumes report:**

```
Volume Report

Comparing Grid: C:\scad2006\data\simo.grd
and Grid: C:\scad2006\data\final.grd
Lower left grid corner : 186551.67,57624.98
Upper right grid corner: 186828.81,57897.09
X grid resolution: 75, Y grid resolution: 75
```
X grid cell size: 3.70, Y grid cell size: 3.63
Total inclusion area: 37016.71 sq ft, 0.850 acres
Cut to Fill ratio: 1.14
Cut (C.Y) / Area (acres): 3642.35
Fill (C.Y) / Area (acres): 3182.70
Cut vol: 83570.89 cubic ft, 3095.22 cubic yards
Fill vol: 73024.56 cubic ft, 2704.61 cubic yards

Prompts

Select the Inclusion perimeter polylines or ENTER for none:
Select objects: pick a closed polyline for the limits of disturbed area
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none:
Select objects: press Enter

Specify Base Grid File Selection Dialog
Choose a grid (.GRD) file to process.
Extrapolate grid to full grid size (Yes/<No>)? press Enter If you enter Yes to this prompt, surface elevations will be computed for any grid cells that have null elevations.

Sample report from the Calculate Elevation Zone Volumes option:
(Calculates the cut and fill in different elevation ranges at a user-specified interval and beginning at a user-specified starting elevation.)

<table>
<thead>
<tr>
<th>Volumes by elevation zone</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Zone 20.00 to 30.00</td>
<td></td>
</tr>
<tr>
<td>Cut volume : 0.30 cubic ft, 0.01 cubic yards</td>
<td>Fill volume: 107.90 cubic ft, 4.00 cubic yards</td>
</tr>
<tr>
<td>Zone 30.00 to 40.00</td>
<td></td>
</tr>
<tr>
<td>Cut volume : 4.88 cubic ft, 0.18 cubic yards</td>
<td>Fill volume: 73021.14 cubic ft, 2704.49 cubic yards</td>
</tr>
<tr>
<td>Running total:</td>
<td></td>
</tr>
<tr>
<td>Cut volume : 5.18 cubic ft, 0.19 cubic yards</td>
<td>Fill volume: 73129.05 cubic ft, 2708.48 cubic yards</td>
</tr>
<tr>
<td>Zone 40.00 to 50.00</td>
<td></td>
</tr>
<tr>
<td>Cut volume : 65044.26 cubic ft, 2409.05 cubic yards</td>
<td>Fill volume: 0.25 cubic ft, 0.01 cubic yards</td>
</tr>
<tr>
<td>Running total:</td>
<td></td>
</tr>
<tr>
<td>Cut volume : 65049.44 cubic ft, 2409.24 cubic yards</td>
<td>Fill volume: 73129.29 cubic ft, 2708.49 cubic yards</td>
</tr>
<tr>
<td>Zone 50.00 to 60.00</td>
<td></td>
</tr>
<tr>
<td>Cut volume : 17786.85 cubic ft, 658.77 cubic yards</td>
<td>Fill volume: 0.00 cubic ft, 0.00 cubic yards</td>
</tr>
<tr>
<td>Running total:</td>
<td></td>
</tr>
<tr>
<td>Cut volume : 82836.29 cubic ft, 3068.01 cubic yards</td>
<td></td>
</tr>
</tbody>
</table>

Specify Final Grid File Selection Dialog
Choose a grid (.GRD) file to process.
Extrapolate grid to full grid size (Yes/<No>)? press Enter

Volume Report Options dialog
This shows a grid drawn by *Plot 3D Grid File* and volume values drawn by the Draw Volume in Each Cell option of the Two Surface Volumes routine. Cut appears as negative and fill as positive. Notice that cells bordering cut and fill regions contain a little of both.

**Pull Down Menu Location:** Surface >> Volumes By Grid Surfaces  
**Keyboard Command:** volcalc2  
**Prerequisite:** Two grid files  
**File Names:** `lsp\volcalc.lsp`, `lsp\volcalc.arx`

### Volumes By Layer

This is the easiest yet still equally accurate method for calculating volumes. For this command, volumes are calculated in one step by a simple window of the area, selecting the items, and calculate.

First, you must specify the grid location and resolution. The grid location should enclose the area for volume calculations. Next the program asks for the layer names of the entities for the base and final surfaces. You designate the layers to use for each surface either by typing the layer names or by picking from the screen, then during the routine you select the entities to use. You may safely use the keyword `ALL` to select the entities, since you have pre-defined the layers to use, and all those entities not on the specified layers will be filtered out. These entities, for use in modeling the surfaces, can be points, lines (such as triangulation lines), 2D polylines (such as contours), and 3D polylines (such as breaklines).

Inclusion and exclusion perimeters may optionally be specified to limit the volume calculation area on the grid. An inclusion perimeter should be used if there is a closed polyline for the limit of the disturbed area. Then the program internally generates grids of the surfaces from the entities on the corresponding layers and then calculates and reports the volume. The main disadvantage to this routine is that it doesn't have the special output options of *Two Grid Surface Volumes* such as Depth Contours.
Prompts

Command: layervol
Pick Lower Left limit of surface area: pick lower left corner of grid
Pick Upper Right limit of surface area: pick upper right corner of grid

You are then prompted to designate layers:

Select entities on layers of Existing surface. select sample object(s)
Select objects: Specify opposite corner: 3 found
Select objects: press Enter to conclude selection.
Select entities on layers of Final surface. select sample object(s)
Select objects: Specify opposite corner: 10 found
Select objects: press Enter to conclude selection.
Reading points ...
Select surface entities on corresponding layers.
Select objects: all filters out those objects not on designated layers
85 found
Select objects: press Enter to conclude selection.
Reading points ... 9396
Assigning grid values > 5300
Pass > 28 Null Z values left > 0
Writing grid file: C:\Documents and Settings\USER\grid1.grd
Assigning grid values > 5300
Pass > 43 Null Z values left > 0
Writing grid file: C:\Documents and Settings\USER\grid2.grd
Select the Inclusion perimeter polylines or ENTER for none: select inclusion perimeter
Select objects: 1 found
Select objects: press Enter to conclude selection.
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: press Enter for none.
Spot Elevations By Surface Model

This command will calculate the Z coordinate of any point that falls within the surface model. Use this command to calculate the elevations for points of a design for slope staking or for putting spot elevations on a topography map. The calculated points can be stored in the current coordinate (.CRD) file. A surface model is either selected from a grid (.GRD) or triangulation (.TIN or FLT) file or internally calculated from the existing entities on the drawing.

Spot elevations can be calculated at various user-specified points or at a specific interval. For random spot elevations, the user picks or enters the X,Y coordinates for each spot elevations. The elevation at the current position of the crosshairs is displayed in real-time in a small window. For interval spot elevations, the alignment for the intervals is defined by a polyline that must be created before starting this routine.

Prompts
Source of surface model (File/<Screen>? press Enter Use the File option to select a grid (.GRD) or a triangulation (.TIN or .FLT) file.

Layer for points <POINTS> press Enter

Add spot points to Coordinate File (Yes/<No>? Yes This option stores any points created in this routine to a .crd file and draws Carlson point entities.

Draw nodes only (Yes/<No>? press Enter This prompt only appears if Add points to Coordinate File is off. This option either draws only AutoCAD POINT entities or an X mark and elevation text.

If you specified the use of a file for the surface model, you are then prompted to select the surface model file.

If you specified the use of Screen entities, you are prompted for:

Pick Lower Left limit of Surface area:
Pick Upper Right limit of surface area:
then the following dialog box appears with the settings to make a 3D Grid file:

For picked point spot elevations:

Random spot elevations or interval along pline (<Random>/Interval)? press Enter
Enter or pick point (Enter to end): pick a point
Enter or pick point (Enter to end): press Enter

For spot elevations along a polyline:

Random spot elevations or interval along pline (<Random>/Interval)? Interval
Pick the centerline polyline: pick a polyline
Interval along polyline <50.0>: 25
Number of left offsets <0>: 1
Enter left offset interval <25.0>: 10
Number of right offsets <0>: 2
Enter right offset interval <10.0>: press Enter

Spot Elevations with Add to Coordinate File off
and Draw Nodes Only off

Chapter 14. Surface Menu 587
Interval spot elevations for points 1-32
"Random" spot elevations for points 33-37

Pulldown Menu Location: 3D Data
Keyboard Command: spotelv
Prerequisite: Surface entities or a grid (.GRD) file
File Names: \lsp\flatpond.lsp, \lsp\pond.arx

**Tag Hard Breakline Polylines**

This command tags polylines with a description so that Triangulate & Contour can identify these polylines as hard breaklines. The tag is invisible and doesn't change the polyline. Triangulate & Contour will not smooth the contours as they cross these hard breaklines, even with contour smoothing turned on. For example you could tag 3D polylines that represent a wall or a curb so that the contours go straight across without smoothing curves. If contour smoothing is turned off, this tag had no effect.

**Prompts**

Select hard breakline polylines. (For no smoothing in Triangulate & Contour)
Select objects: Select breaklines to tag
Select objects: press Enter to conclude selection
Set 14 polylines as hard breaklines.

Pulldown Menu Location: 3D Data >> Hard Breaklines
Keyboard Command: hardbrk
Untag Hard Breakline Polylines

This command removes hard breakline description tags from polylines. These tags are used by Triangulate & Contour to identify polylines as hard breaklines. Contours are not smoothed as they cross these hard breaklines, even with contour smoothing turned on. This routine untags polylines so that contours are smoothed across them. If contour smoothing is turned off, hard breaklines have no effect.

Prompts

Select polylines to remove hard breakline tag from.
Select objects: select polylines
Pulldown Menu Location: 3D Data >> Hard Breaklines
Keyboard Command: softbrk
Prerequisite: Polylines with hard breakline tag
File Name: \lsp\softbrk.lsp

Design Pad Template

This command creates design slopes from a perimeter polyline at specified cut/fill slopes to reach existing ground. This routine can be used to design building pads, pits, roads, ditches, stockpiles, etc. The design is drawn as 3D polylines for the cut/fill slopes and for the daylight perimeter where the design meets existing ground.

Before beginning this routine, you must have drawn the polyline representing the outside edge of the feature to model. The edge is drawn as a polyline which can be either a 2D or 3D closed or open polyline. For a 2D polyline, the program will prompt for an elevation for the pad perimeter. With a 3D polyline, the pad perimeter is set to the elevations of the 3D polyline. For an open polyline, the program will prompt for the side for the design. With a closed polyline, the program designs the slopes either outward or inward depending on the settings in the dialog.
Under Source of Slope Target Surface Model, choose between a Surface File (.GRD, .FLT, .TIN), Screen Entities, or a specific Elevation. If using Screen Entities, the routine internally calculates a gridded model, the limits of which are specified by screen picks. Make sure that the grid area covers the entire area for the pad including room for the cut/fill slopes.

For closed pad perimeters, there is a Slope Direction from Closed Plines option to draw the slopes inward or outward from the perimeter. The outward method starts the slopes at the design elevation of the perimeter and projects out to intersect the existing surface. The inward method projects the slopes inside to reach the grid surface or a set elevation. Outward sloping would be used for such things as building pads, parking lots, etc. where the interior remains as a defined surface. Inward sloping would be used for such things as the top edge of an excavated pit or pond where the interior side slopes project downward at the specified slopes until reaching the original ground surface.

Under Design Slope Format, choose between Ratio, Percent, or Template. The use of a Template allows for complex slopes to be applied, and is also an alternative approach to road design. The template (.TPL) file is created in the Design Template routine in the Roads menu. When using a template, the pad perimeter represents the centerline. One way to create the pad perimeter for the template is to use the Profile to 3D Polyline command which converts a 2D centerline to a 3D polyline using a design profile. With a template, the program uses not only the cut and fill slopes from the template file but also draws all the template grade points such as edge of road, curb and ditch. The subgrade, superelevation and template transition options of the template file are not used in this command. These options are only applied in the Process Road Design command. The grade points are drawn as 3D polylines parallel with the centerline. Cross section 3D polylines that include the grade points are also drawn at the specified interval.

Use Another Surface for Pad Interior will bring up a prompt for another Surface file (.GRD, .FLT, .TIN) to use for the design surface within the starting pad perimeter. Otherwise the program will model the pad interior by straight interpolation from the starting pad perimeter elevations. For example, if a building pad has a starting pad perimeter at a set elevation and the pad is supposed to be flat, then this option is not needed. This option is needed in a case where you are designing a pit and the starting pad perimeter is a 3D polyline that follows an undulating pit bottom.
surface. The pad design will model the pit side slopes. In order to model the undulating bottom of the pit, you need the Use Another Surface for Pad Interior option to select a surface that models the pit bottom.

**Use Different Slopes for Separate Sides** allows you to specify different slopes for different sides of your pad polyline. If this is toggled ON, the Assign Pad Cut/Fill Slopes dialog is invoked, where you can create multiple Slope Groups along the Pad Template polyline and set the Cut and Fill design ratios for each.

![Assign Pad Cut/Fill Slopes dialog](image)

**Use Slope Pad Design** allows you to set a cross slope amount for the top of the pad. You will be prompted to screen pick two points that designate the slope direction. For automatic balancing of cut/fill quantities, you will be prompted to find the optimal slope and slope direction.

**Draw Slope Direction Arrows** draws an arrow on the outslopes that points in the downhill direction. Arrows on fill slopes are drawn as solid filled.

**Solid Cut Arrows** allows you to choose between drawing the cut arrows as solid filled or as wire frame.

**Round Exterior Corners** holds the outslopes around the corners. Otherwise the side outslopes stay straight until they meet at the corners as shown in the figure.

**Erase Previous Pad Entities** erases drawing geometry created with this command previously.

When **Draw Side Slope Polylines** is ON, Design Pad Template will draw 3D polylines perpendicular to the pad perimeter from the pad to the catch point.

**Color Side Polylines** assigns different colors to Cut and Fill Side Polylines to make them easier to distinguish.
Example of pit design for option of Use Another Grid for Pad Interior

Pad corner without round corners option

Pad corner with round corners option

**Side Polyline Spacing** specifies the interval at which to draw the Side Slope Polylines. Besides at the interval, side slope polylines are also drawn at grid corners.
Cut volume is multiplied by the **Cut Swell Factor** in the final volume report.

Fill volume is multiplied by the **Fill Shrink Factor** in the final volume report.

You must specify the **Pad Layer Name** that the pad 3D polylines will be drawn on.

There is an option to calculate volumes for the pad design. The volumes are calculated by comparing the existing surface with the pad design. The inclusion perimeter for the volume calculation is the daylight perimeter polyline which represents the limits of disturbed area. The existing surface model is defined by the existing surface file (.GRD, .FLT, .TIN) or screen entities selected at the beginning of the command. The pad design surface is calculated by making a surface from the pad 3D polylines including the starting pad perimeter, the side polylines and the daylight perimeter.

Besides calculating the volumes in the **Design Pad Template** routine, you can also calculate the volumes with the **Two Surface Volumes** command, or the **Volumes by Triangulation** command. Two Surface Volumes works with two grid files, Volumes by Triangulation works with two TIN files. The design surface for Two Surface Volumes can be the final output surface from Design Pad or you can create a design surface with **Make 3D Grid File** using the 3D polylines created in **Design Pad**. You could also create a TIN surface of the design surface using **Triangulate and Contour**. Some of the reasons to use either the Two Surface Volumes command or the Volumes by Triangulation command are that these volume routines have more output options (cut/fill color maps, etc.) and you can check the volumes by plotting or contouring the surface files. Also, you can combine several pads and other final surfaces by running **Make 3D Grid File or Triangulate and Contour** and then use these volume commands to calculate the overall site volumes.

The design is drawn as 3D polylines and the earthwork volumes are calculated. Before ending, the program allows you to adjust the design by changing the pad elevation, slopes and offset. The program can find the cut/fill balance by automatically adjusting the pad elevation. If adjustments are specified, the pad polylines are redrawn and the volumes recalculated. At the end, there is an option to trim existing contours inside the disturbed limits of the pad. Then there is an option to draw contours on the pad. If contouring is selected, a dialog lets you set the contouring options. Usually you should specify a new contour layer and turn off smoothing.

**A few Key things to note:**

1. If the Source of Slope Target Surface Model is set to a Surface File, and the surface file used is a grid file, then the surface produced from the designed pad will be a grid surface and a grid file (.GRD).
2. If the Source of Slope Target Surface Model is set to a Surface File, and the surface file used is a TIN file, then the surface produced from the designed pad will be a triangulated surface and a TIN file (.TIN).
3. If the Surface used as a Target Surface is listed in the Surface Manager, the prompt seen in the Design Pad Template command is whether or not to Update the Surface, which is the Target Surface, so if you say "Yes," your Existing Ground Surface will now essentially contain the designed pad. So if you want to maintain an unedited version of Existing Ground, you may want to start with a copy of the Existing Ground Surface.
4. If the Surface used as a Target Surface is not listed in the Surface Manager, the prompt seen in the Design Pad Template command is whether or not to create a new surface of the combined surfaces.
5. If you respond "Yes" to the prompt about whether to contour the designed pad, the contouring dialog box has an option of whether to write the designed pad as a new surface, which will be only the area within the limits of the new design, not the entire Target Surface and design pad surface combined.

**Prompts**

**First you are presented with the Design Pad Template dialog box.**
If the Source of Slope Target Surface Model is set to a Surface File, you will first be asked to:

**Pick the top of pad polyline: select perimeter polyline**

Then the Select Slope Target Surface dialog box is presented. Choose the Slope Target Surface file, pick Open. You then proceed to enter the slope parameters of the pad...

If the Source of Slope Target Surface Model is set to a Screen Entities, you will first be asked to:

**Pick Lower Left limit of pad disturbed area: pick lower left** These prompts appear for the Screen Entities surface model method.

**Pick Upper Right limit of pad disturbed area: pick upper right** Be sure to pick these limits well beyond the area of the top of pad polyline in order to make room for the outslopes.

**Make Grid File Dialog** After selecting the limits of the disturbed area the program will generate a 3D grid that represents the surface. Specify the grid resolution desired and select OK.

Then, **Pick the top of pad polyline: select perimeter polyline**

Then proceed to enter the slope parameters of the pad...

**Enter the fill outslope ratio <2.0>: 2.5**

**Enter the cut outslope ratio <2.0>: 2.5** After entering outslopes slope ratios, a range of elevations along the pad top will be noted.

**Enter the pad elevation <29.54>: 39**

**Calculate earthwork volumes (<Yes>/No)? press Enter**


**Adjust parameters and redesign pond (Yes/<No>)? press Enter**

**Write final surface to grid file (Yes/<No>)? press Enter** This option will output a grid file using the elevations of the pad within the disturbed area polyline and using the original ground surface everywhere else.

**Trim existing contours inside pad perimeter (Yes/<No>)? press Enter**

**Contour the pad (<Yes>/No)? press Enter**

Existing contours with top of pad perimeter polyline
Pad template with contours

3D view of pad with DTM of surface and triangulation faces of pad

Template to apply in Design Pad Template
Existing surface with 3D polyline centerline

Result of Design Pad Template showing template grade polylines, cross section polylines, cut/fill slopes, and final contours

Viewpoint 3D view of Design Pad Template
Design Pad Template can also handle self-intersecting side slopes

**Pulldown Menu Location:** Surface  
**Keyboard Command:** pad  
**Prerequisite:** A pad perimeter polyline and surface entities or a surface file for an intercept target.  
**File Names:** \lsp\flatpond.lsp, \lsp\pond.arx
Slope Zone Analysis

This command calculates the surface area of a site in different slope zone ranges. This command can use either a surface model file, (.TIN, .GRD, or .FLT), or 3D Face drawing entities, which can be generated by the Plot 3D Grid File command, the Draw Triangular Mesh command, or the Draw Triangulation Faces option of Triangulate & Contour. For each slope zone, the 3D Faces can be hatched with any AutoCAD hatch pattern, including the SOLID pattern, or left empty with the NONE pattern.

![Slope Zone Options](image)

This command can also generate contours of the slope zones based on the calculated slope at each point of the 3D Faces. The slopes can vary greatly between neighboring points. When contoured directly, these slope data points produce incoherent contours. Instead this routine applies a filtering algorithm that reduces the noise. There is another option to output a grid file of the slope values.

There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the slope area within the inclusion polyline is calculated. Slope area within an exclusion polyline are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine. Without inclusion and exclusion polylines, all the slope area of each selected 3D Face is used.

**Prompts**

Source of surface model: [File/<Screen>]? F for File
Slope Zone Options dialog box. Choose whether to Draw Slope Zone Contours, whether to Output Grid File of Slope, and Slope Format. Pick OK
Select surface model file.
Define Ranges dialog. Specify the slope zones, colors and patterns from lowest to highest. Pick OK.
Select the Inclusion perimeter polylines or ENTER for none: select perimeter(s) or press Enter
Select the Exclusion perimeter polylines or ENTER for none: select perimeter(s) or press Enter
Report is generated.
If you choose to draw Slope Zone Contours, the Contour Options dialog box is presented.

Note: If you choose to use Screen entities instead of a surface model file, you are prompted whether to:

- Apply hatch patterns to grid cells [Yes/<No>]
- Freeze grid layer after processing [Yes/<No>]

Chapter 14. Surface Menu
Surface contours

3D Faces from a grid surface model

3D Faces created by *Triangulate & Contour* with the Draw Triangulation Faces option
Slope zones that follow the surface contours using the triangulation 3D Faces

Chapter 14. Surface Menu
Pulldown Menu Location: Surface >> Slope Analysis
Keyboard Command: szone
Prerequisite: Surface model file (.TIN, .GRD, or .FLT), or 3D Faces entities
File Names: \lsp\elanal.lsp, \lsp\contour4.arx

Profile Defaults

This command allows you to specify the default parameters for working with profiles.
**Horizontal Scale:** Specify the horizontal scale.

**Vertical Scale:** Specify the vertical scale.

**Text Size Scaler:** Specify the text size scaler. This value is multiplied by the horizontal scale to obtain the final text height.

**Symbols Size Scaler:** Specify the symbol size scaler. This value is multiplied by the horizontal scale to obtain the final symbol size.

**Profile Annotations Layer:** Specify the layer that the profile text will be plotted on.

**Object Height for Sight Distance Calcs:** Specify the object height value used when a sight distance is calculated.

**Eye Height for Sight Distance Calcs:** Specify the eye height value used when a sight distance is calculated. The sight distance defaults are set to the AASHTO standards but can be changed as conditions dictate such as for an accident study or for metric values.

**Vertical Curve Drawing Resolution:** Specify the length for line segments that are generated to represent vertical curves. Default value is 10.0

**Vertical Curve PC & PT Points Layer:** Specify the layer that the endpoint nodes of the vertical curve will be plotted on.

**Station Type:** Specify the format for the station labels: 1+00 is the default, 1+000 is for metric, NO.0 is the Korean format.

**Keyboard Command:** PRD

**Prerequisite:** None

**File Name:** \lsp\scadprof.dcl, \lsp\prd.lsp

---

**Quick Profile**

This command allows you to create a profile in one step. The alignment for the profile can be defined using picked points, a centerline file or a polyline. The surface for the profile can be defined by 3D screen entities or surface files (grid or triangulation). Since picked points are the default for the horizontal alignment, the command is as
quick as select surface type (screen or file), then *Pick, Pick, Enter* and view. The resulting profile is displayed in a graphic dialog box with real time data reporting. As the crosshairs are moved across the profile in the window, the station, elevation and slope data corresponding to the current crosshair location appear in the lower right of the window. A second crosshair on the plan view corresponds to crosshair movement along the profile so the user knows exactly where the current profile point is on the plan view. Also the Adjust Alignment function allows you to drag a horizontal alignment point and update the profile in real-time.

**Vertical Exaggeration:** Determines the amount of vertical exaggeration for the profile in the window.

**Drag Action:** Determines whether the right mouse button functions as "Zoom" or "Pan" in the profile window.

**Grid Ticks Only:** Instead of the full graph as shown above, Grid Ticks only plots only ticks along the horizontal and vertical axis near the station and elevation text.

**Adjust Alignment:** Allows you to pick a horizontal alignment point and while moving it, the profiles are updated in real-time. You can also select a horizontal alignment segment and move the whole alignment position. The Adjust Alignment function is only available when surface files are used as the source of the surface model.

**Save:** Writes the current profile data to a .PRO file.

**Draw:** This draws the profile with grid in the drawing. The user has options for horizontal and vertical scales and the layer of the profile. The Draw Profile command includes more options for drawing the profile. In order to use this command, you must first create a .PRO file using the Save command described above.

**Exit:** Exits this command.

**Help:** Opens on-line help.
Note that the Draw option will exit the Quick Profile command after the drawing is complete. A typical completed drawing, in this case with two surfaces, is shown below. Note also that the horizontal stationing text offset follows the setting in the Draw Profile command itself.

![Graph showing completed drawing with two surfaces and stationing text offsets.]

**Prompts**

**Pick starting point (CL-Centerline, P-Polyline):** screen pick alignment points for profile  
**Pick second point:** pick next point  
**Pick next point (Enter to end):** press enter to end  
**Tested 58 of 58 Entities Intersects found > 33**

**Dialog Box**

Opening file c:\Carlson2008\DATA\quickpro.pro for write. Note that the 2nd surface profile, if used, is named QUICKPRO2.PRO.

**Keyboard Command:** quickpro  
**Prerequisite:** 3D screen entities and a grid (.GRD) or triangulation (.FLT) file  
**File Name:** \lsp\quickpro.lsp

**Profile from Surface Entities**

Profile from Surface Entities creates a profile from contours, triangular mesh, and other 3D drawing entities. The method is to draw a polyline as the profile centerline. Then the profile is derived from the intersections of this polyline with the 3D entities. For added accuracy in pulling the profile, include the triangular mesh as well as the contours.
File: Displays the name of profile to be created.

Beginning Station: Specify the beginning station for the profile.

Interpolate Endpoint Elevations from Beyond Profile Extents: When checked, the program will look past the ends of the centerline for additional intersections with 3D entities. These additional intersections will then be used to interpolate the elevation at the starting and ending station of the centerline.

Extrapolate Endpoint Elevations to Extents of Profile: This option uses the slope of the last two elevation points of the profile and calculates the elevation of the endpoint from this slope.

Station by another reference centerline: When checked, the program will prompt you to pick another centerline polyline. The intersection points along the first centerline are then projected onto the second centerline. The profile then stores the elevation of the intersection with the station along the second centerline.

Breakpoint Descriptions from Layers: When checked, breakpoint descriptions are assigned based on layer name of surface entities. These descriptions are used in routines such as Input-Edit Profile and Profile Report.

Ignore Zero Elevation Lines in Surface Model: When checked, any zero elevations selected in the surface model are ignored.

Profile Offsets: Specify optional offset profiles. Enter offsets separated by a space. Example: 30 -30 (to create 30' left and 30' right offset profiles). After entering the offset values, press TAB to select file options described below.

Offset Profiles to: Specify whether offset profiles should be created as separate profile (.PRO) files, or included in a single profile (.PRO) file. Only available if you specify Profile Offsets above. Offset profiles are automatically named by combining the profile name and the offset. For example, if the profile is named NATGRD.PRO and you create a 30' right offset profile, it will be named NATGRD30.PRO.

Prompts

Profile File to Write dialog Specify a new profile file (.PRO) name to create.

Profile from Surface Model dialog Make choices, click OK.

Polyline should be drawn in direction of increasing stations.

CL File/<select polyline which represents the profile centerline>: pick the centerline (Do not press Enter.)

Select Lines, PLines, and/or 3DFaces that define the surface for profiling.

Select objects: C (for crossing and window everything the centerline crosses) or All (to select all objects on the drawing)
Export Topcon Grid or TIN File

This command writes a Topcon TIN file (.TN3) from 3d Faces, TIN lines, or triangulation files (.TIN, .FLT). If you choose to export from an existing surface file (.TIN or .FLT), you are only prompted to specify the file to read and the name and location for the Topcon file (.TN3) to create. If you specify the use of Screen entities for the source data, the following prompts are presented.

Choose Type of Export

- **Triangle Faces**: Triangulation networks that consist of edge matched 3DFaces defined by three points.
- **Triangle Edges**: Triangulation Networks that consist of edges drawn with Lines defined by two points.
- **Triangulation File**: A Carlson triangulation file (.FLT only).

**Source Units**: Select the appropriate unit type of the entities to be exported, then press NEXT.

If the Triangulation File option is chosen, a standard windows file selection dialog will open to allow for the selection of the .flt file.

If Triangulation Edges or Faces are used for the export, you must select the entities to be exported from the screen. The following dialog opens:
Manually Select allows on-screen selection with any of the various methods (Window, Crossing, Crossing Polygon, etc.)

All on a Selected Layer allows selection of a single entity. The command then selects all Lines or 3DFaces on the layer of the selected entity for export, filtering entities not on selected layer.

Generally, you can select any entities drawn on the screen without special care. The command filters out all types except Lines or 3DFaces depending on the type selected.

When Processing Lines: Crossings, crossing polygon, and fence selection sets can often result in "spikes" around the edges. The command generally discards these spikes, or reconnects them. In any case, better results are developed with clean selections of drawing entities.

Pressing NEXT will open the following dialog:

Other Features to Export: Often, landmark lines, or other features will assist in orientation to the user when using the TN3 file in the field. For example, property lines, project centerlines, or other well established reference lines. These features may be added and displayed on the TN3 by choosing them at this prompting. The Other Features dialog opens with all three Source Formats.

Selections are made as described above.
Once the selections are made and the dialog reappears, press NEXT.

**Naming the TN3 File:** After all the triangulation and feature items are selected from the graphics screen, the command requests a name for the output file. Once a name is given, the following dialog reviews all the selections made. A description for the job can be added at this time. Press Finish when ready to proceed.

```
TopCon TN3 Export (Feb. 22, 2005)

Output to File: C:\Documents and Settings\wason\My Documents\Client Files\text.TN3
From File C:\Documents and Settings\wason\My Documents\Client Files\text.ft

Descriptor Up To 32 Characters (required)
Existing Surface

Cancel  Finish
```

The program will process the selected entities and/or files and report as shown here:

```
TopCon TN3 Export (Feb. 22, 2005)

9572 Exported - Complete - File Saved

Exit  Run Simulation
```

To view the final output, press the Run Simulation button, or press Exit to return to the Carlson program.
Run Simulation Dialog

**Pulldown Menu Location:** Surface >> Import/Export  
**Keyboard Command:** topcon_tin  
**Prerequisite:** 3D Face entities plotted usually created by the *Make 3D Grid File* command, or a surface file (.TIN or .FLT)  
**File Names:**

### Profile from Points on Centerline

This command creates a .PRO file from points and a centerline that is represented by a polyline or centerline file. The elevations of the profile are derived from the elevation of the points and the stationing for these profile points is calculated from the distance along the centerline. The points must be within the offset distance from the polyline in order to be included in the profile. The profile is created by projecting the points perpendicular onto the alignment to determine the station and the elevation comes from the point elevation. The polyline or centerline should be drawn (or defined) in the direction of increasing stations. The points can be selected from point entities in the drawing (Screen), by point numbers from the current coordinate file (Numbers), or by point group as defined by the Point Group Manager (Group).
Prompts

**PROfile file to Write** dialog box: Enter a new profile file name to write.

**CL File/<Select polyline that represents centerline>:** *pick a polyline or choose C for Centerline*

Select Centerline file if Centerline option is used. If the desired points are further from the centerline, enter a larger maximum offset tolerance.

Note: for all selected points, the points should be located on the real Z axis.

**Select the Carlson points along the centerline.**

**Select objects:** Select the point entities.

**Keyboard Command:** profpts

**Prerequisite:** A polyline centerline and points

**File Names:** \lsp\profpts.lsp, \lsp\regrade.arx

---

**Input-Edit Profile File**

This command is a spreadsheet type editor for profile (.PRO) files. Besides editing a profile, this routine can be used to just view the contents of a profile. Also, a new profile can be entered by editing a previously empty or non-existing file.

The command starts by prompting for the profile file to edit. Alternately, you can run Input-Edit Profile by double-clicking on a profile polyline that is drawn on a profile grid.

The opening dialog below shows the layout of this editor. At the top of the dialog, you can dynamically see the profile and vary its appearance by using zoom and pan. You can change the look of the profile more by using the vertical exaggeration multipliers. The station, elevation and slopes are also shown at the lower left of the dialog, fluctuating with the movement of the cursor. Then there are between five and nine columns for the possible fields in a profile. Which columns are active depends on the type of profile: generic, road, sewer, pipe, crossing or circular. Six rows are visible at a time. To view different rows, use the scroll bar on the right. When a greater amount of columns are in use, use the scroll bar at the bottom. The Profile Name edit box is an optional identification name used by multiple profiles in Draw Profile. The Add Row and Remove Row buttons, when used, will dynamically...
and immediately make changes to the profile image at the top.

On the right is a column for Check Stations which report the elevation at the specified stations. The Check Stations are not stored in the profile. This is a design tool for viewing the elevations at certain stations while adjusting the profile data. The last line has eight action buttons.

**Add Row:** Adds a new row into the profile after the current row.

**Remove Row:** Removes the current row.

**Type of Profile:** Choose. Column titles and the amount of columns will change accordingly.

**Hold Next Slopes:** A toggle that may applied or left blank.

**Use K-Value:** Toggles between displaying K-Value and Sight Distance in the fifth column for road profiles.

**Select Reference profile:** An option to show a second profile as reference. When a reference profile is active, the Check Stations and graphic window report the cut/fill with the current profile and the elevation of the reference profile. Also with a reference profile active, the spreadsheet adds a column for depth.

**Vertical Speed Tables:** This button is enabled only when you edit a road profile. Please refer to the documentation on Input-Edit Road Profile for the information on Vertical Speed Tables.

**Next:** Used for navigation when editing a .PRO file containing multiple profiles, loads the next profile.

**Previous:** Used for navigation when editing a .PRO file containing multiple profiles, loads the previous profile.

**Transform:** Allows you to either Translate or Scale the profile. Translate globally adds or subtracts value to stations and/or elevations within the specified range of stations, while Scale will apply the specified scale factor to stations and/or elevations within the specified range of stations.

**Load:** Used for loading another, existing .PRO file for editing.

**Save:** Saves the profile using the current profile file name. The current profile file name is displayed in the top title bar of the dialog box.

**SaveAs:** Allows you to save the profile under a different profile file name.
Keyboard Command: profedit
Prerequisite: None
File Names: \lsp\profile.dcl, \lsp\profedit.arx

Draw Profile

Draw Profile is a flexible routine for drawing a profile anywhere in the drawing. The profile may be drawn with or without a grid or with just tick marks. The vertical curve annotations, for a road profile, and manhole annotations, for a sewer profile, may also be drawn. Draw Profile uses the profile information that is stored in .PRO files. Once the profile is drawn using Draw Profile, the design and labeling routines of the Profiles dropdown are applicable to the profile. The first step in Draw Profile is to choose the profile (.PRO) file(s) you want to draw.
The Draw Profile dialog box appears, and contains all of the settings for creating the profile.

**Draw Grid:** This option will draw a grid and axis elevations for the profile. Pick Setup to access Grid Setup dialog.
**Grid Direction:** Profiles can be drawn Left to Right (the default) or Right to Left. Although most profiles are drawn left to right, if you have a road that runs east to west and you wish to draw the profile stationing beneath the actual road stationing, then choosing a Right to Left profile may be appropriate. Unavailable when Draw Sheet is checked.

**Vertical Grid Adder to Top:** This adds the specified amount of grid to the top of the profile.

**Vertical Grid Adder to Bottom:** This adds the specified amount of grid to the bottom of the profile.

**Draw Elevation Bar:** Click on this option if you desire to have a vertical barscale displayed. It will run up and along the left-most vertical grid line of the profile.

**Label Scale:** Click on this option and you obtain a scale drawn at the lower left corner of the profile.

**Draw Elevation Labels Only On Left Side:** This option eliminates elevation labels on the right side of the profile.

**Offset Elevation Text:** This option offsets the left-side vertical axis text using the specified Offset Scale.

**Offset Station Text:** This option offsets the horizontal axis Station text by the specified Offset Scale, allowing the insertion of elevation or other information above the stationing. It is often used in conjunction with the Label Horizontal Axis options.

**Grid Type:** This selects the type of Grid to generate. The choices are Grid Lines, Ticks Only, Ticks and Dots, Ticks and Checks.

**Station Text Orientation:** This option allows you to specify the orientation of the station text shown along the bottom of the profile. The example below shows both options:
Draw Sheet: When checked, the profiles will be drawn in paper space. Plan Only, Profile Only, or Plan and Profile sheets can be created. Each plan and profile sheet is created in its own layout tab. When the plan and profile is drawn, you are placed in tilemode=0 and paper space. Click the "model" space tab (shown below) to return to model space to edit the plan view features, for example. The options within Sheet Setup become available when this toggle is checked on. Pick Setup to access the Sheet Setup dialog:

**Layout Name:** Enter a name for the paper space "tabs" to be assigned to each layout for each sheet. The program will automatically divide the plan view and the profile view into sheet layouts, and if the length of the profile extends beyond a single sheet, then multiple layouts are created, with the layout name ID incremented by 1. If you enter "ms" to go to model space within a layout tab, you can pan to alter the plan view position. Its best to zoom in/out and edit within the Model tab. The Layout tabs appear at the bottom of the screen, along with the "Model space" tab to go back to standard plan view:

**Block Name:** This is the drawing name for the plan and profile sheet to be inserted. Carlson provides a standard plan and profile drawing in the form of Profile.dwg located in the Support subdirectory. You may wish to revise Profile.dwg, add your company logo, and re-save it as Profile1.dwg or you could add your own complete version of a Plan and Profile sheet. If you choose the latter, you should examine the scale, dimensions and the lower left
corner of Profile.dwg, and try to duplicate those dimensions and corner coordinates in your own drawing. It is also important to store all your standard profile sheets in the Support subdirectory. You cannot draw Right to Left in Sheet mode. Note that the Sheet mode will re-orient the centerline left to right, which may cause text (such as the stationing) to plot upside down, until you use the Flip Text command under the Edit menu.

**Sheet Width:** This is the profile width, in inches, on the sheet. Even though the sheet is a fixed size, you can limit the length of the plot to 32 inches or less with this entry. If we used an entry of 16 for the example profile above, two plan and profile sheets would be created, because the first sheet would go from station 0+00 to 3+20 (16 inches at a 20 scale) and the second sheet would finish from 3+20 to 4+51.91. In English units, a typical entry here would be 30 for 30 inches.

**Overlap Station:** In multiple plan and profile sheet plotting, after the first sheet, all subsequent sheets will have the first 2 stations in common with the last 2 stations on the previous sheet, if the Overlap Station option is turned on. For example, if the last 2 stations are 3+10 and 3+20 on sheet 1, then sheet 2 will start with 3+10, then 3+20, with this option turned on. With this option turned off, if the first sheet ends with 3+20, then the second sheet would begin with 3+20.

**Sheet Contains:** This drop list allows the selection of which type of sheet to generate. The choices are Plan and Profile, Plan Only or Profile Only.

**Plan View Lower Y:** This sets the lower position of the paper space window for the plan view. With Lower Y set to 9 (inches above the base of the sheet) and Top Y set to 21, there is a 12 inch vertical window, running the full Sheet Width (typically 30 to 32). This window for the plan view can be expanded or reduced with these settings.

**Top Y:** This sets the top vertical limit for the plan view window, measured in inches from the bottom of the plan and profile sheet.

**Draw North Arrow in Plan View:** This draws a North Arrow in plan view.

**Draw Layout Plan View Borders in Model Space:** This draws the borders in Model Space.

**Plot at 1:1:** With this clicked on, the sheet will be paper size, designed to be plotted at 1:1. A 30-inch profile sheet will measure 30 units, even though the centerline and profile may be 1500 feet in length. If the Scale 1:1 option is turned on, then you cannot check the distances of features using commands such as Bearing and Distance on the Inquiry menu, because the distances will be scaled down by a factor equal to the drawing scale (for example, at 1"=50', the reduction in scale factor is 1/50 or 0.02). You can set the absolute starting coordinate for the 1:1 scaled plot by setting the Sheet Lower X and Sheet Lower Y. With this clicked off, the profile will drawn full size, with a 1500-foot profile measuring 1500 feet.

**Fit Each Vertical:** With this option turned on, the command will recognize the lower and upper vertical elevations of the profile and set the vertical axis elevation range to enclose the actual elevation limits of the profile. With this option turned off, you can enter the lower vertical elevation range, dropping it down further to increase the lower margin. Whether or not the Fit Each Vertical option is turned on or off, you are always prompted for the top elevation range.

**Tile Sheets:** If clicked on, only one Layout is created in paper space, and all sheets appear in this single Layout as tiles of individual sheets, much like the tiles mode of viewing files within Windows Explorer.

**Label Match Line:** When clicked on and multiple sheets are plotted with plan view option on, a match line will plot in the plan view.
Prompts (Draw Sheet option)

You are first asked to select the polyline that represents the centerline, and the program best fits the centerline in the plan view portion of the plan and profile sheet, then captures all of the associated drawing that will fit in that paper space window. If the length of the polyline divided by the scale exceeds the Sheet Width entry (for example, 5000 feet of road divided by 50 Horiz. Scale is 100, which exceeds the sheet width), then multiple plan and profile sheets will be automatically created. A 5000 foot road at 50 scale with a 30-inch sheet width, would lead to 3 full sheets of 1500 feet each and a "leftover" fourth sheet showing the last 500 feet.

**Bottom Vertical Spacing <0.0>? press Enter**

The program places the profile plot flush against the bottom of the vertical grid, by default. This prompt allows for an offset, moving the profile plot up off the bottom of the grid. If the lowest elevation of the profile is 940 by default, entering 10 would start vertical axis labeling at 930, and if the vertical scale was 5 units, this would push the vertical plot up 10 units or 2 standard grid intervals.

**Top Elevation of Profile Grid <945.0>: press Enter**

**CI File/Select polyline that represents centerline:** Select the centerline polyline (if Draw Plan has been clicked on).

**Beginning Station <0.0>: press Enter**

The items below refer again to the profile options that are independent of the Draw Sheet option:

**Draw Horiz Axis Elev:** This option creates elevation labels along the horizontal axis. Pick Setup to access the Horizontal Axis Elevations settings dialog.
**Draw Horiz Label Box:** This option draws a boxed area underneath the profile. It is best used in standard Draw Grid mode, with Draw Sheets clicked off. Pick Setup to access the Horizontal Label Box Setup dialog. An example of the resulting plot is shown here:
Draw Break Point Sta: Will label these values along the profile line above each break point in the profile. Pick Setup to access the Break Point Station Setup dialog.

<table>
<thead>
<tr>
<th>Station</th>
<th>0+00.00</th>
<th>0+13.45</th>
<th>0+24.43</th>
<th>0+50</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elevation</td>
<td>140.09</td>
<td>139.95</td>
<td>140.66</td>
<td></td>
</tr>
</tbody>
</table>

Draw Break Point Elev: Will label these values along the profile line above each break point in the profile. Pick Setup to access the Break Point Elevation Setup dialog.
**Draw Break Point Desc:** Will label these values along the profile line above each break point in the profile. Pick Setup to access the Break Point Description Setup dialog.

**Starting Station:** This field defaults to the starting station in the selected profile(s). If changed, the starting station can move forward, clipping out the first part of the profile. When you are not plotting sheets, you must set the starting station to the end of the previous sheet's ending station to force a multiple sheet layout.

**Ending Station:** This field defaults to the ending station in the selected profile(s). A profile that is 3000 feet in length could be plotted in 2 parts, first station 0 to 1500, then station 1500 to 3000, using the Starting Station and Ending Station options.

**Label Text Scaler:** This sets the size of text used for vertical curve annotation to the horizontal scale times the scaler, when you are working in English units. In metric units the text height would be 0.01*horizontal scale*scaler.

**Link To Files:** This setting controls the linkage of the plotted profile(s) to the actual profile file(s) (.PRO), determining how changes to the file affect the plotted profile(s). If set to Off, there is no linkage, Prompt will
ask whether to update the plotted profile(s) when the file changes, and Auto will automatically update the plotted profile(s) when the file changes.

**Match Line Elevations:** For high relief profiles that might otherwise extend up and into the plan view portion of the drawing, the Match Line Elevations option can be used to break the profile and redraw the remaining portion with its own vertical scale, as seen above.

**Elevation Range:** This is the range of elevations that is used in conjunction with the Match Line Elevation option. If the range is exceeded (that is, if the range above is 20), the program will break the profile and draw the remainder with a separate vertical axis range.

**Grid Scale and Interval Settings**

**Horizontal Scale:** This scale applies primarily to text size. If the text scaler is 0.1 and the horizontal scale is 50, then text size will be $0.1 \times 50 = 5$.

**Horizontal Grid Interval:** This sets the spacing of the grids that run vertically from the horizontal scale.

**Horizontal Text Interval:** This sets the spacing of the stationing text that appears along the horizontal axis. When using a large "Axis Text Scaler", the horizontal axis text can become too large, and it often necessary to space the horizontal text interval at twice the horizontal scale.

**Vertical Scale:** This scale sets the vertical exaggeration of the profile. If the horizontal scale and vertical scale are the same, then the vertical is not exaggerated. Profiles are often plotted with a 5 or 10 vertical exaggeration. For example, the horizontal scale may be 50, but the vertical scale may be 5.

**Vertical Grid Interval:** This sets the spacing of the grids that run horizontally between the vertical axes on the left and right side of the profile.

**Vertical Text Interval:** This sets the spacing of the elevation text that appears along the vertical axes.

**Label Settings:** These 4 buttons are where you gain access to control over specific label settings for different profile types.

Layers, Colors, Text Styles and Linetypes buttons provide access to settings for each of these features of the profiles.
**Load Settings:** Loads a saved collection of Draw Profile settings, saved in a (.PFS) file.

**Save Settings:** Saves all Draw Profile settings in a (.PFS) file.

When OK is clicked at the base of the dialog box, the prompting at the command line continues. In this example, assume that a road profile has been selected, since more prompts will occur with road profiles than with generic profiles.

**Prompts (Road profile example)**

**Erase existing profile from drawing** [Yes/No]? N This prompt appears only if you have previously drawn the profile.
Next a dialog appears to set the Profile Grid Elevation Range by specifying the Top and Bottom Elevations. Adjust as desired, pick OK.

![Profile Grid Elevation Range dialog box]

Pick Starting Point for Grid <8779.55, 5716.36>: *pick a point for the lower left corner of the grid*

Assuming a road profile has been selected, the following dialog box appears:

![Vertical/Circular Curve Settings dialog box]

**Include K-value:** This option is a function of the change in slopes on either side of the point of vertical intersection.

**Include Sight Distance:** This option is computed by the delta slope and is a function of whether the vertical curve is a sag or a crest.

**Include Grade:** This option draws slopes along the tangent portion of the vertical curves, with slope direction arrows.

**Draw Vertical PVC and PVT Lines:** This option draws vertical lines emanating from the PVC and PVT of all vertical curves.

**Position Text Below Line:** This option draws the PVC, PVI, and PVT information under the picked location for the vertical curve labeling.
**Pick Each Label Position:** If there were more than one vertical curve in the profile, this option allows you to pick a vertical position for each of the vertical curve's annotation.

**Draw Slope Direction Arrow:** Draws an arrow to indicate slope direction.

**Number of Decimal Places:** Choose the decimal precision used in the elevation and stationing annotation for vertical curves.

Next, select a point vertically that corresponds to the position of the left-right lines under which is written percent grade and above which is written the vertical curve length, sight distance, and K-factor, if requested. The PVC, PVI, and PVT stations and elevations are written above or below this picked point depending on dialog box settings.

Sewer Options:
Additional Prompting for Multiple Profiles

Detected multiple profiles within C:\CARLSON PROJECTS\2006-0124\DATA\PRO\EXAMPLE.PRO

Note that the Profile from Surface Entities command can store additional profiles into the same profile file.

**Draw profiles on same or different grids (Same/\<Different\>)? press Enter** This determines whether the multiple profiles will be drawn together on the same grid or drawn on separate grids.

**Uniform or variable grid size (Uniform/\<Variable\>)? press Enter** This selects between one-size-fits all grids or
individually sized grids for each profile.

**Keyboard Command:** drawprof  
**Prerequisite:** A .PRO file  
**File Names:** \lsp\drawprof.lsp, \lsp\profile.dcl, \lsp\vcplot.lsp, \lsp\endsewer.lsp

## Profile to 3D Polyline

This command converts a 2D polyline centerline into a 3D polyline that follows the elevations of the profile. Horizontal and vertical curves are represented as a series of polyline segments since 3D polylines cannot contain arcs. Profile to 3D Polyline can be combined with other commands for plan-view road design as follows:

1. Draw 2D polyline centerline.  
2. Profile from Surface Model - to create existing surface profile.  
3. Design Road Profile - to design the final profile with vertical curves.  
4. Profile to 3D Polyline - create a 3D polyline of the road centerline.  
5. Offset 3D Polyline - offset the 3D polyline centerline left and right by the horizontal and vertical distances.  
6. Design Pad Template - run twice for left and right polylines of road to tie into surface at specified cut and fill slopes. This creates the limits of the disturbed area. Or use Join Nearest, Direct Connect Endpoints, to create a closed loop pad with one run of Design Pad Template for simple ramps, driveways and access roads.  
7. Triangulate & Contour - draw final contours using road 3D polylines.  
8. Volumes - use any of the volumes commands to calculate cut and fill volumes.

### Prompts

**Layer Name for 3D Polyline <3DPROF >:** press Enter  
**Select profile centerline polyline:** pick a polyline  
**Station by another reference centerline [Yes/<No>]?** N for no. This option will prompt for a second centerline to use for stationing.  
**Enter the starting station <0.0>:** press Enter  
**Select Profile File**  
**Starting station of centerline <0.0>:** press Enter  
**Erase centerline (Yes/<No>)?** Y This option will erase the original 2D polyline centerline.

![Example of road design in plan-view with Profile to 3D Polyline](image-url)
Profile To Points

This command creates Carlson points along a horizontal alignment polyline using a profile file to compute the point elevations. The created points are stored in a coordinate (.CRD) file and can also be drawn on screen in the layer specified by the user. Station text, profile name, and special points (vertical and horizontal PC's and PT's) can be stored in the point description depending on user settings.

Create points at Profile special points: Includes vertical PC and PT points.
Create points at Centerline special points: Includes horizontal PC and PT points.
Create points at Station Intervals: Allows you to specify intervals for point creation.
Interval On Line Segments: Specify station interval for line segments.
Interval On Curve Segments: Specify station interval for curve segments.
Station to Begin Intervals: Specify station to start intervals.
Prompt For Additional Odd Stations: Any station can be entered to create additional points with elevations derived from the profile.
Create Points on Centerline: When checked, points will be created on the centerline.
Create Left Offset Points: When checked, left offset points will be created. Specify the offset in the edit box.
Create Right Offset Points: When checked, right offset points will be created. Specify the offset in the edit box.
Vertical Offset Of Profile: Specify the vertical offset. Enter zero for no vertical offset.
Plot Points: When checked, points will be plotted in the drawing, otherwise points are only added to the current coordinate (.CRD) file.
Include profile name in point descriptions: When checked, the profile name will be used as the prefix on the point description. For example, if the profile name is DESIGN.PRO, then the point description might be
DESIGN 0+63.37

Decimal Places: Specify the display precision for points that are plotted in the drawing. This setting does not affect the coordinates stored in the CRD file.

Centerline by: Click either Polyline or CL File.

Type of Centerline: Click either Roadway or Railroad.

OK: Specify files.

Prompts

Select Coordinate File to Process
If the current coordinate is set, it is used automatically without this prompt.

Select profile centerline polyline: pick a polyline

Station by another reference centerline [Yes/No]? N for no. This option will prompt for a second centerline to use for stationing.

Starting station of centerline <0.0>: press Enter

Choose Profile to Process dialog: Specify a profile name.

Starting point number <1>: press Enter This defaults to the point number after the highest one currently in the CRD file.

Station for additional point (ENTER to end): press Enter This option will create a point at the specified station. Prompt occurs only if option is specified in dialog.

Keyboard Command: pro2pts

Prerequisite: A .PRO file and a centerline polyline

File Name: \lsp\profedit.arx

Convert LDD Contours

This command allows you to convert Autodesk Land Desktop contours (known as AECC_CONTOUR objects) into polylines. You must have the AEC Object Enabler installed before using this command. If you do not have the

**Note:** If no object enabler is installed, opening a Land Desktop drawing with contours will display large boxes for each contour, essentially outlining the extents of each one. In this case you will need to download the object enabler. If the object enabler is installed, contours will appear normally, and you can use this command to convert them to standard lwpolylnes or you can use the AutoCAD Explode command. The Carlson Convert LDD Contours command is preferable only in the fact that it will search the drawing for AECC_CONTOUR objects and convert only those, while an AutoCAD Explode command could inadvertently explode other entities that you do not wish to be exploded.

You can use the *List* command to determine if contours are polylnes or AECC_Contour objects. Here is an example listing:

```
AECC_CONTOUR Layer: "CONT-MJR"
Space: Model space
Handle = 429
Major Contour Interval
Elevation: 1005.00
Smoothing: None
Number of Vertices: 48
Open
Length: 560.25
Constant width: 0.00
Style Name: Standard

Prompts

Select AEC Contours to convert
Select objects: *pick the AEC contour entities*

Pulldown Menu Location: Surface >> Import/Export
Keyboard Command: aec.cntr
Prerequisite: AEC Contours to convert
File Name: \ls\dtm1.fas

Profile Conversions

There are eleven Profile Conversion commands, all of which are listed below. The first nine in the list are Import Profile commands. These commands allow you to convert a single profile file from their respective program to the Carlson profile (.PRO) format. For each, you are prompted to select the file to be imported, then provide a Carlson profile file name. Underneath each of the nine brief descriptions shown are, in bold, the prompts that you see in dialog box form and/or on the command line.

The last two commands listed below are Export Profile commands. They allow you to convert a single Carlson profile (.PRO) file to Sofdesk (.TXT) format, or a single Carlson profile (.PRO) file to Leica (.GSI) format. You are prompted to select the Carlson profile file, then provide a name for the Sofdesk or Leica file.

**Import Columnar Text**
Allows you to Import a comma or space delimited text file to create a profile (.PRO) file.

**Import CAiCE Profile**

Allows you to convert a single CAiCE (.KCP) profile file to the Carlson profile (.PRO) format. You are prompted to select the CAiCE file, then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** caice2pro  
**File Name:** \lsp\profedit.arx

**Import Leica Profile**

Allows you to convert a single Leica profile (.GSI) file to the Carlson profile (.PRO) format. You are prompted to select the Leica file then provide a Carlson profile file name.

**Choose Leica/Wild File to Readdialog** Select existing file.  
**Choose Profile to Writedialog** Select file name.  
**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** wildpro2  
**File Name:** \lsp\profedit.arx

**Import MOSS Profile**

Allows you to convert a single MOSS profile (.INP) file to the Carlson profile (.PRO) format. You are prompted to select the MOSS file then provide a Carlson profile file name.

**Choose MOSS Profile File to Readdialog** Select existing file.  
**Choose Profile to Writedialog** Select file name.  
**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** moss2pro  
**File Name:** \lsp\profedit.arx
Import Softdesk Profile

Allows you to convert a single Softdesk profile (.TXT) file to the Carlson profile (.PRO) format. You are prompted to select the Softdesk file then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** dcapro2  
**File Name:** \lsp\profedit.arx

Import Sokkia/SDR Profile

Allows you to convert a single Sokkia/SDR (.SDR or .RAW) profile file to the Carlson profile (.PRO) format. You are prompted to select the Sokkia/SDR file, then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** sdr2pro  
**File Name:** \lsp\gisutil.arx

Import Spanish ALZ Profile

Allows you to convert a single Spanish ALZ profile (.INP) file to the Carlson profile (.PRO) format. You are prompted to select the Spanish ALZ file and then provide a Carlson profile file name.

**Choose CLIP File to Read** dialog: Select existing .ALZ file.  
**Choose Profile to Write** dialog: Select file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** alz_to_pro  
**File Name:** \lsp\eworks.arx

Import Spanish RAS Profile

Allows you to convert a single Spanish RAS profile (.RAS) file to the Carlson profile (.PRO) format. You are prompted to select the Spanish RAS file and then provide a Carlson profile file name.

**ISPOL File to Read** dialog: Select existing .RAS file.  
**Choose Profile to Write** dialog: Select file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** ras_to_pro  
**File Name:** \lsp\eworks.arx

Import Terramodel Profile

Allows you to convert a single Terramodel (.RLN) profile file to the Carlson profile (.PRO) format. You are prompted to select the Terramodel file, then provide a Carlson profile file name.

**Pulldown Menu Location:** Profiles > Profile Conversions  
**Keyboard Command:** tm2pro  
**File Name:** \lsp\gisutil.arx

Export Softdesk Profile
Choose Profile File to Read dialog Select existing .PRO file.
Choose Softdesk File to Write dialog Enter new Softdesk file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: dcapro1
File Name: \lsp\profedit.arx

Export Leica Profile

Choose Profile File to Read dialog Select existing .PRO file.
Choose Wild File to Write dialog Enter new .GSI file name.
GSI file format [<8>/16]? press Enter

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Commands: wildpro1
File Names: \lsp\cogoutil.arx
Index

plus-0.5in
2 Tangents, Arc Length, 158
2 Tangents, Chord Length, 158
2 Tangents, Degree of Curve, 160
2 Tangents, External, 159
2 Tangents, Mid-Ordinate, 159
2 Tangents, Radius, 157
2 Tangents, Tangent Length, 160
2D Align, 105
2D Polyline, 28, 32, 152, 455, 458
2D Scale, 99
3 Point, 156, 164, 165
3-Radius Curve Series, 163
3D Entity to 2D, 128
3D Polyline, 28, 85, 86, 124–126, 154, 183, 324, 365, 387, 401, 455, 456, 458, 509, 577, 628
3D Polyline by Slope on Surface, 126
3D Polylines, 126
3D Viewer Window, 137, 140, 528, 543, 556, 557, 579
AASHTO, 18, 318, 329, 438, 478, 603
Add Grid Lines, 361
Add Grid Ticks and Dots, 360
Add Intersection Points, 113
Add Points At Elevation, 125
Add Polyline Vertex, 114
Align by Two Pairs of Points, 266
Align Points, 271, 291
Alphanumeric, 222, 248, 261
Angle/Distance, 287
Angle Mode, 199, 222
Annotation, 3, 24, 318, 336, 359, 603
Aperture Object Snap, 242
Arc Length, 158, 160, 438, 445
Arrowhead, 180, 300, 304
ASCII File, 205, 257
ASE, 81
Assign Pipe Width to Polyline, 378, 404
Assign Template Point Centerline, 488, 495, 506
Assign Template Point Profile, 485, 495
Attribute Layout ID, 250, 251, 297
Audit, 76
Authorizing Carlson Survey, 10
Auto Annotate, 113
AutoCAD Overview, 52
Automatic Point Numbers, 250
Auto Tablet On, 222
Average Profiles, 377
Average Section Files, 406
Basic Road Design With Volumes, 32
Bearing & 3D Distance, 195
Berm Grades, 469
Best Fit Curve, 164
Blips, 112, 193, 194
Block Explode, 87
Boundaries, 174
Boundary, 28, 174, 181, 561, 562
Boundary Polyline, 3, 181
Break, 89, 92, 93, 103, 117, 118, 351, 352, 393, 419, 420, 620, 621
Break, At Selected Point, 93
Break, Select Object, 2nd Point, 93
Break, Select Object, Two Points, 93
Break at Intersection, 93
Break by Crossing Polyline, 91
Breakline, 545, 565, 568–571
Breaklines, 391, 544, 545, 565, 588, 589
Breakpoint Descriptions, 321, 393, 606
Break Polyline at Specified Distances, 92
Calculate End Area, 433, 436
Calculate Offsets, 165, 461, 529, 532
Calculate Section Volumes, 431, 432
Carlson File Types, 24
Carlson Points, 98, 286, 314, 524
Carlson Registration, 12
Centerline Conversion, 449
Centerline Conversions, 449
Centerline File, 36, 449, 488, 500
Centerline ID, 449
Centerline Report, 448
Centroids, 432, 498
Change Attribute Style, 95
Change Block/Inserts Resize, 98
Change Block/Inserts Rotate, 96
Change Block/Inserts Substitute, 97
Change Elevations, 94, 261, 270
Change Layer, 121, 148
Change Point LayerColor, 306
Change Polyline Elevation, 121
Change Polyline Width, 120
Change Properties, 94
Change Style, 96
Change Text Font, 101
Change Text Oblique Angle, 103
Change Text Size, 102
Change Text Width, 102
Channel Sample, 25
Check Elevation Range, 121
Chord Bearing, 196
Chord Length, 157, 158, 162
Circle, 156, 277, 278, 422
CLAYER, 16, 146
CL File, 37, 110, 321–324, 364, 367, 379, 389, 402, 448, 455, 606, 611, 630
Clipboard, 72, 73, 84
Close, 60, 89, 117, 120, 152, 154, 457, 590
Closure, 2
Coal Sections, 229
Color by Elevation, 579
Command Entry, 16
Compare Points, 272, 273
Composite Bed Qualities by Density, 229
Compound Curve, 438–440, 480
Compound or Reverse, 162
Configuration, 25, 27, 230, 239
Configure, 220, 223, 238, 239, 248, 249, 251, 260, 274, 288, 314, 396, 397, 409
Contour Elevation Label, 558
Contour from TIN File, 555
Contours, 120, 237, 396, 501, 549, 551, 552, 555, 559, 560, 568, 577, 581, 582, 589, 599, 631
Convert C&G to Carlson Points, 312
Convert Carlson Points to Ashtech GIS, 314
Convert Carlson Points to C&G, 311
Convert Carlson Points to Eagle Point, 315
Convert Carlson Points to Land Desktop, 311
Convert Carlson Points to Simplicity, 312
Convert Carlson Points to Sofidesk, 314
Convert Civil 3D to Carlson Points, 310
Convert CRD to Land Desktop MDB, 309
Convert CRD to TDS CR5/Convert TDS CR5 to CRD, 309
Convert Eagle Point to Carlson Points, 315
Convert Geodimeter to Carlson Points, 314
Convert Land Desktop MDB to Carlson Points, 309
Convert LDD Contours, 630, 631
Convert Leica to Carlson Points, 314
Convert PacSoft CRD to Carlson CRD, 314
Convert Simplicity to Carlson Points, 313
Convert Softdesk to Carlson Points, 311
Convert Surveyor1 to CRD, 309
Coordinate File, 25, 205, 256, 260, 263, 282, 288, 367, 403, 492, 587, 630
CooRDinate File Utilities, 261
Coordinate File Utilities, 95, 200, 248, 249, 254, 262, 275, 288, 311, 314, 316
Coordinate Transformation, 26, 265
Copy Polyline Section, 85
Copy To Layer, 84
Crandall, 2
Create Polyline ID Labels, 119
Crosshairs, 237
Cross Sections, 387, 537
CSTYLE, 16
Curve - Arrow, 180, 181
Curve Calc, 164, 165
Curve Edit Mode, 443
Curve Info, 196, 221
Custom, 6, 7, 25, 65, 66, 172, 217
Deed Description, 26
Define Strata, 229
Delete Points, 271
Delta Angle, 162
Densify Polyline Vertices, 111
Depth Contours, 584
Description for Points, 271
Design Centerline, 438, 440, 448, 493
Design Pad Template, 3, 27, 365, 463, 589, 591, 593, 595–597, 628
Design Profile, 493
Design Road Profile, 33, 324, 331, 365, 493, 628
Design Sewer/Pipe Profile, 333
Design Template, 38, 328, 463, 468, 477, 483–485, 488, 491, 493, 494, 503, 508, 509, 513, 516, 519, 530, 590
Digitize End Areas, 399, 436
Digitize Sections, 397, 399, 400, 415, 417, 494
Discussion Groups, 29
<table>
<thead>
<tr>
<th>Term</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display-Edit File</td>
<td>197</td>
</tr>
<tr>
<td>Display Last Report</td>
<td>197</td>
</tr>
<tr>
<td>Display Order</td>
<td>145, 217</td>
</tr>
<tr>
<td>Disturbed Area</td>
<td>492, 499, 500</td>
</tr>
<tr>
<td>Ditch</td>
<td>468, 469, 477, 482</td>
</tr>
<tr>
<td>Ditch Grades</td>
<td>468, 469</td>
</tr>
<tr>
<td>Dozer</td>
<td>26, 71</td>
</tr>
<tr>
<td>Dozer Push</td>
<td>25</td>
</tr>
<tr>
<td>Dragline</td>
<td>25, 27</td>
</tr>
<tr>
<td>Draw-Locate Points</td>
<td>252, 271, 286</td>
</tr>
<tr>
<td>Draw 3D Grid File</td>
<td>578, 582</td>
</tr>
<tr>
<td>Draw By Example</td>
<td>178</td>
</tr>
<tr>
<td>Draw Centerline File</td>
<td>447</td>
</tr>
<tr>
<td>Draw Grid</td>
<td>18, 345, 350, 360, 614, 619</td>
</tr>
<tr>
<td>Drawing Block</td>
<td>184</td>
</tr>
<tr>
<td>Drawing Cleanup</td>
<td>73, 76</td>
</tr>
<tr>
<td>Drawing Explorer</td>
<td>13, 46, 204–209</td>
</tr>
<tr>
<td>Drawing Inspector</td>
<td>193, 194, 249</td>
</tr>
<tr>
<td>Drawing Setup</td>
<td>13, 179, 198, 199, 201, 221, 222, 235, 236, 255, 282, 417, 425, 426, 454, 459</td>
</tr>
<tr>
<td>Drawing Template</td>
<td>61</td>
</tr>
<tr>
<td>Draw Menu</td>
<td>151</td>
</tr>
<tr>
<td>Draw Pipe 3D Polyline</td>
<td>377, 404, 409</td>
</tr>
<tr>
<td>Draw Polyline Blips</td>
<td>112</td>
</tr>
<tr>
<td>Draw Polyline File</td>
<td>72</td>
</tr>
<tr>
<td>Draw Profile</td>
<td>26, 32, 33, 319, 320, 324, 342, 344, 345, 355, 359, 376, 377, 404, 435, 604, 605, 611, 613, 614, 624</td>
</tr>
<tr>
<td>Draw Profile Grid</td>
<td>359</td>
</tr>
<tr>
<td>Draw Section Alignment</td>
<td>389</td>
</tr>
<tr>
<td>Draw Section File</td>
<td>417, 491, 492, 495</td>
</tr>
<tr>
<td>Draw Triangular Mesh</td>
<td>556, 557, 598</td>
</tr>
<tr>
<td>Draw Typical Template</td>
<td>473</td>
</tr>
<tr>
<td>Duplicate Points</td>
<td>272</td>
</tr>
<tr>
<td>Dynamic Annotation</td>
<td>222</td>
</tr>
<tr>
<td>Eagle Point</td>
<td>55, 315, 316</td>
</tr>
<tr>
<td>Earthworks File</td>
<td>433, 436</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>80</td>
</tr>
<tr>
<td>Edit Multiple Pt Attributes</td>
<td>296</td>
</tr>
<tr>
<td>Edit Point</td>
<td>256, 280</td>
</tr>
<tr>
<td>Edit Point Attributes</td>
<td>249, 295</td>
</tr>
<tr>
<td>Edit Points</td>
<td>285</td>
</tr>
<tr>
<td>Edit Polyline Section</td>
<td>116</td>
</tr>
<tr>
<td>Edit Polyline Vertex</td>
<td>114, 115</td>
</tr>
<tr>
<td>Edit Symbol Library</td>
<td>232</td>
</tr>
<tr>
<td>Edit Table</td>
<td>330</td>
</tr>
<tr>
<td>Edit Text</td>
<td>100</td>
</tr>
<tr>
<td>Elevation Difference</td>
<td>429, 581</td>
</tr>
<tr>
<td>Elevation Zones</td>
<td>579</td>
</tr>
</tbody>
</table>

End Areas, 25, 421
Enter and Assign, 254
Enter Profile On-Screen, 324
Enter Right of Way, 449, 451
Entities to Polylines, 110
Entity Insertion Point Rotate, 99
Erase by Closed Polyline, 82
Erase by Layer, 81
Erase Outside, 83
Erase Point Attributes, 301
Erase Points, 286
Erase Select, 81
EW File, 433
Existing Section, 494, 497, 499
Explode Carlson Points, 308
Export Text, 264
Export Text/ASCII File, 258, 264, 283
Export Topcon Grid or TIN File, 607
Extend, 3, 28, 88–91, 153–155, 244, 375, 392, 405, 411, 432, 433
Extend Arc, 89
Extend by Distance, 89, 90
Extended Point Information, 249
Extend Sections to Offset Limits, 405
Extend To Edge, 88
Extend to Intersection, 88
Extract Project Archive, 210
Extrapolate, 126, 321, 392, 576, 583, 606
Extrapolate Grid, 580
Extrapolation, 576
Fence Diagram, 25
Ferm Codes, 25
Field to Finish, 2, 16, 25, 168–170, 251, 295
File Menu, 58
Fillet, 28, 107, 125, 127
Fillet 3D Polyline, 125
Find Point, 195
Fix Point Attribute Overlaps, 302, 305
Flip Text, 103, 347, 455, 460, 617
Flood Note, 236
Freeze Layer, 149, 286
Freeze Points, 286, 287
General Commands, 54
Geodimeter, 314
Geologic Column, 25
GIS File, 251
GIS Links, 23
GRD file, 393
<table>
<thead>
<tr>
<th>Term</th>
<th>Page Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid File</td>
<td>117, 120, 126, 221, 253, 393, 577, 578, 581, 583, 594, 598</td>
</tr>
<tr>
<td>Grid File Utilities</td>
<td>25, 71, 576</td>
</tr>
<tr>
<td>Guardrail Expansion</td>
<td>469</td>
</tr>
<tr>
<td>Hatch</td>
<td>171–174, 219, 549, 602</td>
</tr>
<tr>
<td>HEC-2</td>
<td>26</td>
</tr>
<tr>
<td>Highlight Crossing Pines</td>
<td>122</td>
</tr>
<tr>
<td>Horizontal Axis Crossings</td>
<td>363, 364</td>
</tr>
<tr>
<td>Horizontal Axis Elevations</td>
<td>349, 359, 362, 618</td>
</tr>
<tr>
<td>Hydrograph</td>
<td>26</td>
</tr>
<tr>
<td>Image Adjust</td>
<td>132</td>
</tr>
<tr>
<td>Image Clip</td>
<td>131</td>
</tr>
<tr>
<td>Image Frame</td>
<td>130</td>
</tr>
<tr>
<td>Import/Export LandXML Files</td>
<td>69, 400</td>
</tr>
<tr>
<td>Import Text/ASCII File</td>
<td>2, 15, 257, 264</td>
</tr>
<tr>
<td>Import Xref to Current Drawing</td>
<td>66</td>
</tr>
<tr>
<td>Input-Edit Centerline File</td>
<td>440</td>
</tr>
<tr>
<td>Input-Edit End Area File</td>
<td>434</td>
</tr>
<tr>
<td>Input-Edit Point</td>
<td>249, 256, 273</td>
</tr>
<tr>
<td>Input-Edit Profile File</td>
<td>342, 611</td>
</tr>
<tr>
<td>Input-Edit Road Profile</td>
<td>326, 331, 343, 612</td>
</tr>
<tr>
<td>Input-Edit Section Alignment</td>
<td>387, 391</td>
</tr>
<tr>
<td>Input-Edit Section File</td>
<td>409, 417, 490, 494, 495, 497–499, 507</td>
</tr>
<tr>
<td>Input-Edit Super Elevation</td>
<td>478, 495</td>
</tr>
<tr>
<td>Input-Edit Template Series</td>
<td>482, 483, 493, 508</td>
</tr>
<tr>
<td>Inquiry Menu</td>
<td>189</td>
</tr>
<tr>
<td>Insert</td>
<td>187, 188, 221, 244, 282, 285, 327, 434, 543, 553, 556, 578</td>
</tr>
<tr>
<td>Insert Multi-Point Symbols</td>
<td>168</td>
</tr>
<tr>
<td>Insert Symbols</td>
<td>166, 168</td>
</tr>
<tr>
<td>Installing Carlson Software</td>
<td>4</td>
</tr>
<tr>
<td>Instruction Manual and Program Conventions</td>
<td>24</td>
</tr>
<tr>
<td>Intersections</td>
<td>535, 546</td>
</tr>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Isolate Layer</td>
<td>149, 252</td>
</tr>
<tr>
<td>Issuing Commands</td>
<td>53</td>
</tr>
<tr>
<td>Join</td>
<td>17, 74, 104, 127, 128, 500</td>
</tr>
<tr>
<td>Join 3D Polyline</td>
<td>125</td>
</tr>
<tr>
<td>Join Nearest</td>
<td>3, 110, 127, 365, 628</td>
</tr>
<tr>
<td>Label/Draw Right of Way</td>
<td>451</td>
</tr>
<tr>
<td>Label Contours</td>
<td>552</td>
</tr>
<tr>
<td>Label Profile Differentials</td>
<td>380</td>
</tr>
<tr>
<td>Label Sewer Laterals</td>
<td>381</td>
</tr>
<tr>
<td>Label Station-Offset</td>
<td>458, 460</td>
</tr>
<tr>
<td>Label Zeros</td>
<td>253</td>
</tr>
<tr>
<td>Land Development Desktop</td>
<td>4, 75</td>
</tr>
<tr>
<td>Layer Control</td>
<td>145</td>
</tr>
<tr>
<td>Layer ID</td>
<td>191</td>
</tr>
<tr>
<td>Layer Inspector</td>
<td>192, 193</td>
</tr>
<tr>
<td>Layer Report</td>
<td>192</td>
</tr>
<tr>
<td>LDD</td>
<td>75, 309–311</td>
</tr>
<tr>
<td>Leica</td>
<td>314, 383, 385, 632, 634</td>
</tr>
<tr>
<td>License Agreement</td>
<td>4, 11</td>
</tr>
<tr>
<td>Limit of Break Points per Section</td>
<td>387</td>
</tr>
<tr>
<td>Limit Polylines</td>
<td>229</td>
</tr>
<tr>
<td>Link Points with Coordinate File</td>
<td>249</td>
</tr>
<tr>
<td>Links Manager</td>
<td>269</td>
</tr>
<tr>
<td>LisCad</td>
<td>314</td>
</tr>
<tr>
<td>List Elevation</td>
<td>194</td>
</tr>
<tr>
<td>List Points</td>
<td>255, 256, 271</td>
</tr>
<tr>
<td>Load Saved Report</td>
<td>197</td>
</tr>
<tr>
<td>Locate on Real Z Axis</td>
<td>250, 253</td>
</tr>
<tr>
<td>Locate Point</td>
<td>16, 28, 250, 255, 302</td>
</tr>
<tr>
<td>Locate Template Points</td>
<td>538</td>
</tr>
<tr>
<td>Make 3D Grid File</td>
<td>574, 580, 593, 610</td>
</tr>
<tr>
<td>Manhole</td>
<td>334–336, 341, 375</td>
</tr>
<tr>
<td>Map Points from</td>
<td>264</td>
</tr>
<tr>
<td>Maps</td>
<td>577</td>
</tr>
<tr>
<td>Mass Diagram</td>
<td>496</td>
</tr>
<tr>
<td>Mass Diagram Output File</td>
<td>432</td>
</tr>
<tr>
<td>Max Samples</td>
<td>226, 228</td>
</tr>
<tr>
<td>Median Design</td>
<td>464</td>
</tr>
<tr>
<td>Merge Profiles</td>
<td>376</td>
</tr>
<tr>
<td>Merge Sections</td>
<td>407</td>
</tr>
<tr>
<td>MicroStation</td>
<td>71, 72</td>
</tr>
<tr>
<td>Mirror</td>
<td>28, 107</td>
</tr>
<tr>
<td>Mortgage Block</td>
<td>236</td>
</tr>
<tr>
<td>Mouse Click Settings</td>
<td>231</td>
</tr>
<tr>
<td>Move</td>
<td>83, 90, 138, 152, 249, 261, 269, 270, 300, 304, 305, 441, 463, 560</td>
</tr>
<tr>
<td>Move Label Along Contour</td>
<td>560</td>
</tr>
<tr>
<td>Move Point Attributes Single</td>
<td>299</td>
</tr>
<tr>
<td>Move Point Attributes with Leader</td>
<td>300, 305</td>
</tr>
<tr>
<td>Move Points</td>
<td>294</td>
</tr>
<tr>
<td>Multi-Point Symbols</td>
<td>169, 171</td>
</tr>
</tbody>
</table>
Index

MXS File, 387, 388, 393, 395, 408, 409
NADCON, 265
New, 59, 60, 68, 95–97, 120, 127, 131, 146, 174, 221, 251, 260, 266, 269, 276, 288, 290, 326, 327, 330, 335, 393, 408, 409, 478, 481, 492, 565
Nodes, 253, 587
North Arrow, 348, 617
Note File, 400
Numeric, 222
Object Linking, 77, 221
Obtaining Technical Support, 29
Offset 3D Polyline, 124
Offset & Elevation Label/Report, 430
Offset Cutoff, 75
Offset Point Entry, 165
Offset Profiles, 321, 606
OLE objects, 62, 215, 216
Open, 60, 69, 77, 90, 137, 213, 248, 262, 312, 313, 319, 320, 410, 491, 556, 559, 594, 604, 605, 631
Output Coordinate File, 496, 499
Overlay Section File, 405
Ownership, 26
Page Setup, 62, 63, 214
Pan, 136, 138, 221, 305, 319, 441, 604
PC, PT, Center, 156
PC, Radius, Arc Length, 157
PC, Radius, Chord, 157
PC Point, 158
PDSIZE, 221, 249
Pipe Depth Summary, 374
Pipe Polylines, 408
Pipe Size, 27
Pipe Width, 324, 377, 404, 409
PI Points, 443, 454, 458
Pivot Point Rotate by Bearing, 98
Place Image by World File, 177
Plot Preview, 62
Point Defaults, 250, 251, 297, 306
Point Description, 195, 254, 270, 308, 352, 461, 485, 621
Point Entity, 297
Point Entity Grouping, 77, 249
Point Group Manager, 276, 280, 323, 610
Point ID, 191, 269, 485, 488
Point Layer, 221
Point Links, 249
Point Notes, 249, 462
Point Number Report, 272
Point Object Snap, 242
Point Protect, 70, 257, 275
Point Range, 26, 263
Points Menu, 248
Points on Centerline, 367, 629
Polygon Processor, 26
Polyline by Nearest Found, 183
Polyline File, 71, 72
Polyline Info, 197
Polyline Slope, 386
Polyline Slope Report, 370
Polyline to Centerline File, 447, 449, 506, 510
Polyline to Right of Way, 450, 451
Pre-calculated grids, 26
Preferences, 211, 217, 241
Print EW File Report, 436
Process Only Strata with Beds, 229
Product Overview, 2
Profile Conversions, 382–385, 631–634
Profile Defaults, 318, 331, 361, 602
Profile from 3D Polyline, 322, 510
Profile from Grid or Triangulation Surface, 322
Profile from Pipe Polylines, 324, 378
Profile from Points on Centerline, 323, 610
Profile from Surface Entities, 320, 358, 605, 627
Profile ID, 376
Profile Offset Text, 378–380
Profile Report, 321, 368, 369, 606
Profiles Menu, 317, 404
Profile to 3D Polyline, 365, 590, 628
Profile To Points, 366, 629
Project Explorer, 13, 207
Properties and Layers, 56
Properties Manager, 108, 146, 147
Properties Toolbar, 57, 146
Purge, 78, 79, 193
Quick Keys, 16, 28
Quick Profile, 319, 320, 603, 605
Quick Section, 390, 391
Quick Sections, 390
Radius Point, 161, 162, 196, 456
Railroad, 165, 367, 388, 630
Raster Image, 175
Reactors, 77
Reame, 27
Recover, 77
Redo, 81
Redraw, 134, 388
Reduce Polyline Vertices, 71, 75, 111
Reduce Vertices, 3, 414, 549, 551
Regen, 134
Registration, 10, 13
Remove Duplicate Polylines, 116
Remove Groups, 77
Remove Polyline Arcs, 117, 120
Remove Polyline Segment, 117
Remove Polyline Vertex, 118
Remove Reactors, 77
Renumber Points, 270, 273, 307
repackaged, xiii
Replace Text, 20, 104
Report Formatter, 21–23, 25, 27, 28, 70, 123, 197,
205, 206, 208, 222, 229, 256, 293, 400, 428,
462, 491, 498, 581
Report Grade Elevation, 462
Report Log, 221
Rescale Drawing, 236
Residuals, 27
Resize Point Attributes, 302
Restore Due North, 145
Restore Layer, 149
Reverse Curve, 480
Reverse Polyline, 110, 111, 513
Review Profile Links, 376
Right of Way, 437, 450, 451, 469
Rigid Body Transformation, 268
RoadCalc, 401
Road Design, 19, 27, 47, 49, 328, 329, 392, 417, 449,
450, 464, 466, 468, 472, 475, 483–485, 488,
491, 492, 496, 500
Road Design Inspector, 536
Road Network, 520–522, 524, 525, 527, 535
Roadside Ditch, 27
Roads Menu, 437
Rotate by Pick, 99
Rotate Points, 143, 271, 289
Rotate Text, 101
Runoff, 27
Sag & Crest Report, 373
Save, 61, 68, 139, 147, 176, 212–214, 221, 239, 247,
269, 280, 308, 319, 343, 355, 377, 388, 398,
399, 416, 425, 441, 446, 479, 486, 488, 492,
550, 566, 604, 612, 624
Save/Load Tablet Calibration, 239
Save As, 61, 566
SB-Slope, 27
Scale, 100, 106, 108, 139, 172, 177, 188, 199, 200,
221, 222, 237–239, 271, 292–294, 300–302,
304, 318, 343, 346, 348, 349, 352, 353, 359,
363, 364, 370, 376, 387, 396, 397, 399, 414,
418, 422, 430, 433, 454, 459, 551, 552, 558,
603, 612, 615, 617, 618, 621, 622
Scale Point Attributes, 300, 302
Scale Points, 292
Screen Pick Point, 271
SDPS, 228
Seam Stacking, 228
Search Radius, 228
Section Alignment, 36, 37, 388, 405
Section Conversion, 401
Section Conversions, 400
Section Defaults, 387, 393
Section File, 47–49, 392–394, 401, 405–409, 424,
429, 432, 468, 492, 494–496, 500
Section ID, 407
Section Name, 417
Section Report, 400, 428, 429, 501
Sections from Grid or Triangulation Surface, 393
Sections from Points, 395, 494
Sections from Polylines, 394
Sections from Surface Entities, 391, 407, 494
Sections Menu, 386
Sections Points from Pipes, 408
Sections Points from Right of Way, 408
Sections Points from Surface Entities, 407, 408
Sections to 3D Polylines, 401
Sections to Points, 402, 403
SEDCAD, 25, 227
Select by Area, 130
Select by Elevation, 129
Select by Filter, 128
Selection of Items, 55
Sequential Numbers, 178
Set/Reset X-Hairs, 237
Set Coordinate File, 204, 248, 260, 438
Set Data Directory, 15
Set Layer, 148
Set Polyline Origin, 120
<table>
<thead>
<tr>
<th>Index</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Strata Quantities, 28</td>
<td></td>
</tr>
<tr>
<td>Subgrades, 488</td>
<td></td>
</tr>
<tr>
<td>Superelevation, 27, 479, 481, 516</td>
<td></td>
</tr>
<tr>
<td>Surface 3D FlyOver, 140</td>
<td></td>
</tr>
<tr>
<td>Surface 3D Viewer, 140</td>
<td></td>
</tr>
<tr>
<td>Surface Entities, 32, 38, 387, 408, 415</td>
<td></td>
</tr>
<tr>
<td>Surface Inspector, 27</td>
<td></td>
</tr>
<tr>
<td>Surface Manager, 567, 568, 572, 574, 593</td>
<td></td>
</tr>
<tr>
<td>Surface Menu, 542</td>
<td></td>
</tr>
<tr>
<td>Surface Model, 110, 142, 155, 321, 365, 390, 391, 393, 418, 590, 593</td>
<td></td>
</tr>
<tr>
<td>SurfC3, 18, 25, 27, 524</td>
<td></td>
</tr>
<tr>
<td>Symbol Library, 27, 166, 249</td>
<td></td>
</tr>
<tr>
<td>Symbol Size, 221, 548</td>
<td></td>
</tr>
<tr>
<td>System Requirements, 4</td>
<td></td>
</tr>
<tr>
<td>System Variable Editor, 245</td>
<td></td>
</tr>
<tr>
<td>Tablet Calibrate, 237, 396, 400</td>
<td></td>
</tr>
<tr>
<td>Tablet Calibration, 238, 239, 396, 397</td>
<td></td>
</tr>
<tr>
<td>Tag Hard Breakline Polylines, 588</td>
<td></td>
</tr>
<tr>
<td>Tang, PC, Radius, Chord Length, 161</td>
<td></td>
</tr>
<tr>
<td>Tang, PC, Radius, Delta Angle, 162</td>
<td></td>
</tr>
<tr>
<td>Tangent, PC, Radius, Arc Length, 160</td>
<td></td>
</tr>
<tr>
<td>Tangent, PC, Radius, Tangent Length, 161</td>
<td></td>
</tr>
<tr>
<td>TDS, 2</td>
<td></td>
</tr>
<tr>
<td>TDS CR, 309</td>
<td></td>
</tr>
<tr>
<td>Technical Support, 29</td>
<td></td>
</tr>
<tr>
<td>Template Point Centerline, 328, 450, 488, 489, 495, 505, 506, 509, 513</td>
<td></td>
</tr>
<tr>
<td>Template Point Profile, 328, 475, 485–487, 492, 495, 502, 509, 510, 513</td>
<td></td>
</tr>
<tr>
<td>Template Points, 463, 539</td>
<td></td>
</tr>
<tr>
<td>Template Transition, 475–478, 482, 495, 502–506, 532</td>
<td></td>
</tr>
<tr>
<td>Terramodel, 384, 401, 633</td>
<td></td>
</tr>
<tr>
<td>Text Enlarge/Reduce, 100, 102</td>
<td></td>
</tr>
<tr>
<td>Text Explode To Polylines, 71, 104</td>
<td></td>
</tr>
<tr>
<td>Text Size, 100, 179, 387, 422</td>
<td></td>
</tr>
<tr>
<td>Text Style, 454</td>
<td></td>
</tr>
<tr>
<td>Thaw Layer, 149, 287</td>
<td></td>
</tr>
<tr>
<td>Thaw Points, 287</td>
<td></td>
</tr>
<tr>
<td>TIF file, 178</td>
<td></td>
</tr>
<tr>
<td>Title Block, 3, 233</td>
<td></td>
</tr>
<tr>
<td>Toolbars, 232</td>
<td></td>
</tr>
<tr>
<td>Topsoil Removal, 492, 495, 496</td>
<td></td>
</tr>
<tr>
<td>Topsoil Removal/Replacement, 483, 495</td>
<td></td>
</tr>
<tr>
<td>Transit, 328, 468, 469, 475, 477, 478, 504, 505, 517, 521, 526, 534</td>
<td></td>
</tr>
<tr>
<td>Translate Points, 143, 271, 287</td>
<td></td>
</tr>
<tr>
<td>StrataCalc, 25</td>
<td></td>
</tr>
<tr>
<td>Strata Isopach Maps, 25</td>
<td></td>
</tr>
<tr>
<td>Set Project/Data Folders, 201</td>
<td>201</td>
</tr>
<tr>
<td>Settings Menu, 198</td>
<td></td>
</tr>
<tr>
<td>Setting Up a Project, 13</td>
<td></td>
</tr>
<tr>
<td>Set UCS to World, 240</td>
<td></td>
</tr>
<tr>
<td>Sewer, 27, 333, 335, 336, 357, 381, 382, 626</td>
<td></td>
</tr>
<tr>
<td>Sewer Annotation, 336</td>
<td></td>
</tr>
<tr>
<td>Sewer Structure, 27</td>
<td></td>
</tr>
<tr>
<td>Shade, 139</td>
<td></td>
</tr>
<tr>
<td>Shrink-Wrap Entities, 182</td>
<td></td>
</tr>
<tr>
<td>Sight Distance, 35, 318, 327, 332, 343, 356, 360, 603, 612, 625</td>
<td></td>
</tr>
<tr>
<td>Sliding Side Area, 3</td>
<td></td>
</tr>
<tr>
<td>Slope Distance, 370</td>
<td></td>
</tr>
<tr>
<td>Slope Ratio, 370, 394, 495</td>
<td></td>
</tr>
<tr>
<td>Slope Report, 370</td>
<td></td>
</tr>
<tr>
<td>Slope Zone Analysis, 404, 598</td>
<td></td>
</tr>
<tr>
<td>Slope Zone Section Analysis, 403</td>
<td></td>
</tr>
<tr>
<td>SMI, 25, 401, 438, 498</td>
<td></td>
</tr>
<tr>
<td>SMI Chain File, 498</td>
<td></td>
</tr>
<tr>
<td>Smoothing, 551, 631</td>
<td></td>
</tr>
<tr>
<td>Smooth Polyline, 112</td>
<td></td>
</tr>
<tr>
<td>Softdesk, 311, 314, 382–385, 401, 631, 633, 634</td>
<td></td>
</tr>
<tr>
<td>Sokkia/SDR, 384, 633</td>
<td></td>
</tr>
<tr>
<td>Special Leader, 3</td>
<td></td>
</tr>
<tr>
<td>Spiral, 166, 439, 443–445</td>
<td></td>
</tr>
<tr>
<td>Spiral Curve, 165</td>
<td></td>
</tr>
<tr>
<td>Spiral In, 443</td>
<td></td>
</tr>
<tr>
<td>Spirals, 438</td>
<td></td>
</tr>
<tr>
<td>Spline, 75</td>
<td></td>
</tr>
<tr>
<td>Split Bed by Parameters, 229</td>
<td></td>
</tr>
<tr>
<td>Split Text into Two Lines, 103</td>
<td></td>
</tr>
<tr>
<td>Spot Elevations, 587</td>
<td></td>
</tr>
<tr>
<td>Spot Elevations By Surface Model, 586</td>
<td></td>
</tr>
<tr>
<td>SRVPNO, 190, 250, 307</td>
<td></td>
</tr>
<tr>
<td>Stage-Storage, 326</td>
<td></td>
</tr>
<tr>
<td>Standard Align, 106</td>
<td></td>
</tr>
<tr>
<td>Standard Copy, 84</td>
<td></td>
</tr>
<tr>
<td>Standard Explode, 86</td>
<td></td>
</tr>
<tr>
<td>Standard Offset, 85</td>
<td></td>
</tr>
<tr>
<td>Standard Report Viewer, 19, 196, 197, 256, 360, 404, 436</td>
<td></td>
</tr>
<tr>
<td>Start Point Number, 250, 251</td>
<td></td>
</tr>
<tr>
<td>Startup Wizard, 13, 15, 221</td>
<td></td>
</tr>
<tr>
<td>State Plane, 265, 293</td>
<td></td>
</tr>
<tr>
<td>Station-Elevation-Slope Report, 371, 372</td>
<td></td>
</tr>
<tr>
<td>Station-Offset, 498, 501</td>
<td></td>
</tr>
<tr>
<td>Station/Elevation, 368</td>
<td></td>
</tr>
<tr>
<td>Station Polyline/Centerline, 451, 454</td>
<td></td>
</tr>
<tr>
<td>Store Project Archive, 209, 210</td>
<td></td>
</tr>
<tr>
<td>Tablet Calibrate, 237, 396, 400</td>
<td></td>
</tr>
<tr>
<td>Tablet Calibration, 238, 239, 396, 397</td>
<td></td>
</tr>
<tr>
<td>Tag Hard Breakline Polylines, 588</td>
<td></td>
</tr>
<tr>
<td>Tang, PC, Radius, Chord Length, 161</td>
<td></td>
</tr>
<tr>
<td>Tang, PC, Radius, Delta Angle, 162</td>
<td></td>
</tr>
<tr>
<td>Tangent, PC, Radius, Arc Length, 160</td>
<td></td>
</tr>
<tr>
<td>Tangent, PC, Radius, Tangent Length, 161</td>
<td></td>
</tr>
<tr>
<td>TDS, 2</td>
<td></td>
</tr>
<tr>
<td>TDS CR, 309</td>
<td></td>
</tr>
<tr>
<td>Technical Support, 29</td>
<td></td>
</tr>
<tr>
<td>Template Point Centerline, 328, 450, 488, 489, 495, 505, 506, 509, 513</td>
<td></td>
</tr>
<tr>
<td>Template Point Profile, 328, 475, 485–487, 492, 495, 502, 509, 510, 513</td>
<td></td>
</tr>
<tr>
<td>Template Points, 463, 539</td>
<td></td>
</tr>
<tr>
<td>Template Transition, 475–478, 482, 495, 502–506, 532</td>
<td></td>
</tr>
<tr>
<td>Terramodel, 384, 401, 633</td>
<td></td>
</tr>
<tr>
<td>Text Enlarge/Reduce, 100, 102</td>
<td></td>
</tr>
<tr>
<td>Text Explode To Polylines, 71, 104</td>
<td></td>
</tr>
<tr>
<td>Text Size, 100, 179, 387, 422</td>
<td></td>
</tr>
<tr>
<td>Text Style, 454</td>
<td></td>
</tr>
<tr>
<td>Thaw Layer, 149, 287</td>
<td></td>
</tr>
<tr>
<td>Thaw Points, 287</td>
<td></td>
</tr>
<tr>
<td>TIF file, 178</td>
<td></td>
</tr>
<tr>
<td>Title Block, 3, 233</td>
<td></td>
</tr>
<tr>
<td>Toolbars, 232</td>
<td></td>
</tr>
<tr>
<td>Topsoil Removal, 492, 495, 496</td>
<td></td>
</tr>
<tr>
<td>Topsoil Removal/Replacement, 483, 495</td>
<td></td>
</tr>
<tr>
<td>Transit, 328, 468, 469, 475, 477, 478, 504, 505, 517, 521, 526, 534</td>
<td></td>
</tr>
<tr>
<td>Translate Points, 143, 271, 287</td>
<td></td>
</tr>
</tbody>
</table>
Triangulate & Contour, 365, 543, 544, 557, 561, 588, 589, 598, 600, 628
Triangulation, 17, 25, 27, 69, 226, 228, 322, 393, 522, 543, 544, 554, 556, 561, 574–576, 580, 598, 600, 607
Triangulation File Utilities, 561, 564
Trim, 29, 50, 87, 107, 257, 500, 594
Trim by Point Symbol, 306
Tutorial, 31
Twist, 96, 99, 101, 221, 301, 302, 460
Twist Point Attributes, 301
Twist Screen: Line Pline or Text, 144
Twist Screen: Standard, 143
Twist Screen: Surveyor, 144
Two Surface Volumes, 580–582, 584, 593
Typical Template, 46, 463, 464, 474, 475
Undo, 81, 87–90, 116, 131, 152, 155, 181, 269, 275, 288, 290, 291, 325, 332, 377, 378, 404, 438, 439, 449, 450
Units Control, 240
Universal Transverse Mercator, 265
Untag Hard Breakline Polylines, 589
Update Drawing from CRD File, 270
Update Sections from Polylines, 407
Using the Carlson Software Manual, 2

Variable Offset, 85
Ventilation, 27
Vertical Angle Mode, 251
Vertical Curve, 35, 318, 332, 603
View Menu, 133
Viewpoint 3D, 142, 502, 544, 578, 580, 597
Volume, 3, 18, 51, 365, 374, 394, 432, 436, 492, 497, 498, 544, 560, 561, 580–584, 586, 593, 628
Volumes By Layer, 584
Volumes By Triangulation, 560, 561

Web Site, 30
What is New, 17
Wild, 254, 257, 383, 385, 632, 634
Wildsoft, 271
Write Block, 186
Write Polyline File, 71, 104

Xref Manager, 67, 68
Zeiss, 257, 258
Zone Polylines, 71
Zoom - Center, 135
Zoom - Dynamic, 134
Zoom - Extents, 135
Zoom - Previous, 135
Zoom - Window, 134
Zoom IN, 135
Zoom OUT, 135
Zoom Points, 136
Zoom Selection, 136

Index